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Copyright 

This documentation is protected by law. All rights, especially the right of 
duplication, circulation, and translation, are reserved. 

No part of this publication may be reproduced in the form of copies, microfilms 
or other processes, or transmitted into a language used for machines, 
especially data processing machines, without the express written consent of 
the publisher. 

All copyrights reserved. 

All other product names are trademarks of the corresponding manufacturers. 
Errors in and changes to the contents as well as program modifications 
reserved. 
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AG. 

This product uses MAGIX patented technology (USP 6,518,492). 
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Other mentioned product names may be registered trademarks of the 
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Preface 

Congratulations on your purchase of Samplitude 11.5 Producer! 

Creating your own music or video soundtracks in a home studio has become 
more and more popular. But the wide variety of available equipment and 
software often confuses both beginner and professional musicians alike. You 
may find yourself asking questions like "What do I really need?", or "What's the 
best value for my money?" 

Samplitude 11.5 Producer is the perfect solution: Fast and easy-to-handle 
music production on your PC, from recording to mastering. Transform your PC 
into a complete sound studio. 

All you need to produce and arrange in high-quality is a conventional sound 
card, but additional studio equipment can easily be added.  

The following pages will introduce to you in detail the various functions and 
possibilities offered by Samplitude 11.5 Producer. 

Have fun with Samplitude 11.5 Producer.  

Your 

MAGIX team 
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Support 

Dear MAGIX customer, 

Our aim is to provide convenient, fast and solution-focused support at all 
times. To this end, we offer a wide range of services: 

 Unlimited web support: 
As a registered MAGIX customer, you have unlimited access to web support 
offered via the convenient MAGIX service portal on http://support.magix.net, 
including an intelligent help assistant, high-quality FAQs, patches and user 
reports that are constantly updated. 
The only requirement for use is product registration on www.magix.com 

 The online community - on-the-spot support and a platform for exchange: 
MAGIX customers have free and unlimited access to the online community at 
www.magix.info, which includes approx. 100,000 members and offers the 
opportunity to ask members questions concerning MAGIX products as well as 
use the search function to search for specific topics or answers. In addition to 
questions & answers, the knowledge pool includes a glossary, video tutorials 
and a discussion forum. The multiple experts, found round-the-clock on 
www.magix.info guarantee quick answers, which sometimes come within 
minutes of a question being posted.  

 Email support for MAGIX products: 
8 (eight) weeks of free email customer service (starting from the purchase 
date) is automatically included with the purchase of any new MAGIX product. 
MAGIX guarantees fast processing of your request and an immediate reply. 
Premium email support: 
If you experience problems after the 8 weeks of free email support have 
expired, you can purchase a Premium email support ticket in the MAGIX Shop 
for USD 12.99 | CAD 13.99 |  GBP 9.99 |  AUD 18.99 | ZAR 120.00 | EUR 
12.99 | SEK 119.00 | NOK 99.00 |  DKK 99.00. This ticket applies to a 
specific problem and is valid until it is solved; it is therefore not restricted to 
one email. 
Reporting evident program errors is exempt from this regulation. 

Please note: To be able to use the Premium email support and free product 
email support via the Internet, you have to register your MAGIX product using 
the serial number provided. This can be found on the CD case of your 
installation CD or on the inside of the DVD box. 

 Additional telephone service: 
Besides the large number of free customer service offers, we also offer a 
fee-based telephone customer service. 
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Here you can find a summary of our technical support telephone numbers: 
http://support.magix.net/ 

Mail (Europe): MAGIX Development Support, P.O. Box 20 09 14, 01194 
Dresden, Germany 

Mail (North America): MAGIX Customer Service, 1105 Terminal Way #302, 
Reno, NV 89502, USA 

Please have the following information at hand: 
 Program version 
 Configuration details (operating system, processor, memory, hard drive, etc.), 

sound card configuration (type, driver) 
 Information regarding other audio software installed 

MAGIX Sales Department 

You can reach the MAGIX Sales Department workdays for help with the 
following questions and problems: 

 Orders 
 Product consulting (pre-purchase) 
 Upgrade requests 
 Returns 

Europe 

Monday - Friday, 09:00-16:00 GMT 

U.K.: 0203 3189218  
Denmark: 699 18149  
Sweden: 0852500858  
Finland: 09 31581630 
Norway: 0210 30665 

North America 

9 am to 4 pm EST Mon-Fri 
Phone: 1-305-722-5810  
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Before you start 

Package contents 

Program disc: This disc contains the Samplitude 11.5 Producer installation 
manager. 

Printed manual: The print manual contains all necessary information for a 
quick start with the program. 

Note: The complete documentation can be found after installing Samplitude 
11.5 Producer as a PDF-file under "Start" -> "Programs" -> "MAGIX" -> 
<"Programmname"> -> "Documentation". 

 

System requirements 

For Microsoft® Windows® 7TM | XPTM | VistaTM 

 Processor: Intel® Pentium® or AMD® Athlon® 1.2 GHz and up 
 RAM: 512 MB (1 GB recommended) 
 Hard drive space: 3 GB free 
 Graphics card: Resolution 1024 x 768 
 Sound playback: Full duplex 16-bit sound card or ASIO-enabled sound card 

(recommended) 
 DVD drive 

Optional: 

 Burn CDs/DVDs with CD/DVD±R(W) recorder 
 MP3 export with Windows Media Player 10, or higher 
 Access to and publication on www.magix.com and on MAGIX Online World 

only with Internet connection and an up-to-date browser 
 Sending emails possible with Internet access and existing Microsoft® OutlookTM 

or Microsoft® Outlook ExpressTM standard email software 

Note: Artist rights and ancillary publisher copyrights must be respected. Only 
non copy-protected audio CDs can be imported. 
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Serial number 

A serial number is included with each product, and although it is not required 
for the installation of the software, it does enable access to additional bonus 
services. Please store this number in a safe place. 

What can a serial number do? 

A serial number ensures that your copy of Samplitude 11.5 Producer is clearly 
assigned to you and only you, and it makes improved and more targeted 
customer service possible. Abuse of the software can be prevented with a 
serial number, since it ensures that the optimum price/performance ratio 
continues to be offered by MAGIX. 

Where can the serial number be found? 

The serial number can be found on the reverse side of your CD/DVD case. If 
your product, for example, is packed in a DVD box, then you'll find the serial 
number on the inside. 

For versions that have been especially optimized for the Internet (download 
versions), you'll receive your serial number for activating the software directly 
after purchasing the product via email. 

When will you need the serial number? 

The serial number is required when you start or register Samplitude 11.5 
Producer for the first time. 

Note: We explicitly recommend registering your product, since only then are 
you entitled to get program updates and contact MAGIX Support. Entering the 
serial number is also required for activating codecs. 

 

Installation 

Step 1: Insert the program disc into the drive. The installation program starts 
up automatically. If the disc doesn't run automatically, 

 open Windows Explorer and click the letter of the CD-ROM drive 
 or double-click on "Start.exe" to start the installer. 
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Step 2: To begin the installation of Samplitude 11.5 Producer, click on "Install". 
The Samplitude 11.5 Producer installation program will appear. 

Hint: During installation, you will be asked (in case there are multiple users on 
your computer) if you would like to set up for the administrator. The option 
"Administrator only" restricts use of the program to the specified administrator. 
The "All users" option allows all users of the computer to use the program. 

Simply follow the on-screen instructions to complete the installation process, 
and then click "Continue". All files are now copied onto the hard drive. 

Step 3: Once the installation is complete, confirm the message by pressing 
"Finish". Now you can start the program at any time from the Windows "Start" 
menu. 

Uninstalling the program 

If you would like to uninstall Samplitude 11.5 Producer, you can do so via the 
control panel under "Software". Or go to "Programs > MAGIX > Samplitude 
11.5 Producer > Service and Support > Uninstall Samplitude 11.5 Producer". 
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More about MAGIX 

myGOYA 

Well connected: Products and services online from MAGIX 

Discover the possibilities of myGOYA. Every MAGIX product offers a direct and 
easy-to-use gateway to the world of online multimedia. 
 Present your photos, videos, and music directly in your Online Album or in 

worldwide Internet communities. 
 Find professional templates & content for enhancing your personal projects. 
 Design your own personalized website using professional Flash® design with 

photos, videos, music & impressive animations.   
 Order brilliant photo prints to be sent directly to your doorstep. It's quick, 

easy, and well-priced. 

Experience these and many more online services at 
http://www.mygoya.com. 

 

MAGIX Premium Club 

Our exclusive club for all MAGIX customers who own a registered product. 
MAGIX Premium Club members have access to a wide range of services: 

 Free product updates & services 
 Exclusive club events & surprises 
 News & info about the club, and much more 

Membership is free. 

You can find more information about this topic on the web at 
www.magix.com 

Hint: You can register your product either directly from the program using the 
"Help" menu, or with your product registration number at www.magix.com. 
You can find your product registration number on your program CD. Earlier 
network card numbers with the example format XY-58241-45 are still valid. 

 

http://www.mygoya.com/�
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MAGIX News Center 

The MAGIX News Center features links to current online tutorials and tips & 
tricks on the software application examples. The "News" is indicated by color 
according to content:  

 Green indicates practical tips & tricks for the software 
 Yellow reports the availability of new patches and updates 
 Red for special offers, contests and questionnaires 

If no new messages are present, the button will appear gray. When the MAGIX 
News Center is clicked, all of the available information will be displayed. Click 
the messages to reach the corresponding website. 
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Introduction 

What is Samplitude 11.5 Producer? 

Samplitude 11.5 Producer is a multitrack recording and editing application for 
all types of audio material featuring unlimited editing options. It's easy to use 
and follows three simple steps: 

 

1. Download and record 

You can download CD tracks, MP3 songs, wave files, video soundtracks, or 
sounds & samples from the hard disk, the CD-ROM drive, or the Internet. You 
can even make your own recordings from a stereo system or with a 
microphone. Everything you download or record is displayed as an object on 
the Arranger's tracks.  

 

2. Arrange and edit 

Basically, all tracks stacked virtually above each other will be played 
simultaneously, and everything that follows horizontally will be played in 
subsequent order. However, you can mute the objects stacked above each 
other.  

Every object – that is, every sound, every song – can be cut up or have effects 
added. For example, if you want to shorten a song, move the object with your 
mouse to the length at which you would like the song to be – done! Want to 
freshen up your sound? Then open the equalizer and either select a preset that 
fits, or modify your sound "by hand”. 

Arranging and editing is essentially all about cutting, blending, adding, mixing 
effects, and placing audio material into the right positions and into the right 
tracks. But it’s also about play and experimentation. If it fits, throw it in! 
Without experimentation there is no innovation. Samplitude 11.5 Producer 
allows you to experiment, and experiment wildly. There’s no risk of your audio 
material being damaged. All editing functions are "non-destructive”. 

 

Export and use 

Regardless what you're experimenting with, in the end something usable 
should come out of it. Samplitude 11.5 Producer has everything you need to 
be productive: 

 Homemade audio CDs which can be played by any standard CD player 
 Unique MP3 collections, e.g. as a source of material for your MP3 player 
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 Podcasts: Simply export the project as a podcast and - if you want - publish it 
online using MAGIX Podcast Service online (the MAGIX Podcast Service can 
be reached via the "Online" menu.) 

 And much more. The export principle is simply "what you hear is what you 
get". That is, what you export sounds exactly as it sounded in the 
arrangement during playback in Samplitude 11.5 Producer. 

 

What’s new in Samplitude 11.5 Producer? 

Step-by-step mode 

The step-by-step mode leads beginners and users who want to achieve quick 
results through all relevant stages of a music production: Recording > Editing > 
Mixdown > Mastering > Exporting > Burning CDs & Publishing. 

It can be set via "Workspace > Easy". 

 

Optional accompaniment 

You can add a variety of different accompaniments in different music styles to 
your recordings – ideal as a source of inspiration. The accompaniments can be 
found in the recording workspace of the step-by-step mode. 

 

New instruments 

The program includes three new virtual instruments with high sound quality 
and intuitive user interfaces: the piano "Century Keys", the saxophone 
"Saxophonia", and an authentic "Jazz Drums" set. All three instruments (and 
many others) can be accessed via the button "Synth > Vita". 

 

Upload and Sharing 

You can publish your songs directly via Facebook, My Space TM, and Twitter. 
This works via the online platform Soundcloud ®. You can load your songs 
straight from the program to Soundcloud ® with a simple click and create a link 
to your Facebook, MySpace, or Twitter account.  

The Soundcloud® upload feature can be found in the "Online" menu (or in the 
"Export" area of the step-by-step mode). 

 

More Help 

We have made Samplitude 11.5 Producer even more user friendly: The video 
tutorials as well as the tutorials in the "Help" menu have been expanded 
considerably. The toolbar now includes an integrated search function that 
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searches for functions in the program as well as relevant topics in the program 
Help. 

 

Effects rack with presets from professional studio producers 

We have added many useful effects presets from well-known professional 
producers to the effects rack. 

 

The features 

The best possible sound quality 

This feature is especially important to every music lover: Samplitude 11.5 
Producer offers unique sound quality for digital music editing. 

 100% sound neutrality: Benefit from Samplitude, professional audio software 
that's been used for years in sound studios and radio & TV stations around 
the world. Samplitude's unique feature is that the original sound of audio files 
is not diminished by any specific audio discoloration, as is often the case with 
other programs. 

 24-bit/48 kHz recordings: Your own recordings can be made with the correct 
hardware in professional, high-quality, high-resolution 24-bit/48 kHz format. 

 32-bit floating point: Internal sound processing is executed via the 32-bit 
floating point process for especially differentiated and high-quality calculation. 
This way, the audio picture can be created with especially high dynamics. 
Digital distortion and clipping is virtually impossible. 

 

Formats and interfaces 

Import: MIDI standard formats (MID, GM, GS, XG), WAV (24 & 32-bit), WAV 
with codec, MP3, CD-A, OGG Vorbis, AIFF, FLAC, MOV, AVI (audio tracks) 

Export: MIDI standard formats (MID), WAV (24-bit), WAV with codec, MP3, 
CD-A, OGG Vorbis, AIFF, WMA, FLAC, QuickTimeTM, AVI (as video sound) 

Interfaces: VST, ASIO, ReWire, DirectX®, SMPTE, MTC, MC (master and slave) 

 

Synthesizers 

Samplitude 11.5 Producer comes with the following synthesizers that you can 
play directly on your PC keyboard, via your mouse or with a MIDI keyboard: 

 MAGIX Vita: A sampler with incredibly realistic-sounding, "classical" 
instrumental sounds like different guitars (Power Chords, clean electric guitar, 
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acoustic guitar, bass guitar), different pianos, percussion, strings, brass, 
woodwinds (each as an individual set & as an ensemble set), and much more. 

 Drum & Bass: For bass and drum tracks in "Drum 'n' Bass" sound 
 Beatbox 2: For computer beats and computer sounds 
 LiVid (Little Virtual Drummer): For "real" acoustic drum tracks 
 Robota: For "mean" electronic sounds 
 Revolta 2: An analog, varied, and powerful-sounding 12-voice synthesizer 

with sound matrix, noise generator, and a complete effects section with nine 
effect types. With this synthesizer, you can create any electronic music you 
can imagine. The sound presets were created by the sound designer for 
Access Virus and Rob Papen's Albino. 

 Atmos: For natural sounds or atmospheres like rain, thunder, or wind. 

 

Effects and effects plug-ins 

Samplitude 11.5 Producer offers the following effects and effects plug-ins: 

 Equalizers: 10-band graphic and 4-band parametric 
 Echo/Reverb + Room Simulator 
 Vocoder 
 Vandal SE: Authentic simulation of classic guitar effects, tube amplifiers, and 

speakers. 
 Essential FX: Basic effects for unique sounds (stereo delay, chorus/flanger, 

phaser) 
 Vintage Effects Suite, consisting of chorus, flanger, analog delay, 

distortion, filters, and the low-fi effect BitMachine. 
 Mastering Suite, consisting of equalizer, vitalizer (stereo enhancer), 

multiband compressor, and audio meter + limiter. 
 Compressor with many presets such as limiter, Deesser, noise gate, 

expander, or leveler and in different models, e.g. as the multiband 
compressor Multimax. 

 Tape simulation: High-quality simulation of analog tape compression 
 Stereo FX: For editing the stereo bandwidth 
 Declipping: For eliminating digital clipping 
 Timestretching/resampling/pitchshifting: For correcting pitch and length 
 Elastic Audio easy: Dynamic pitch correction with harmonization (creates up 

to 4 choir voices) 
 am-track SE: High-quality tape machine sound emulation makes typical 

aspects of the large, saturated sound characteristics of magnetic recordings a 
digital-quality reality. 

 

MIDI integration 

Samplitude 11.5 Producer helps you arrange, load, record, edit, and play MIDI 
data just as easily as audio data. You can combine wave sound files with MIDI 
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files for controlling the sound chip on your sound card or VST instrument 
plug-ins or external synthesizers, and then arrange everything together. 

For MIDI recordings and editing you can use the extensive MIDI editor with 
piano roll, drum editor, velocity/controller editor, and event list. 

MIDI object recording can be started directly from the arranger by setting the 
recording mode in the track box to MIDI. 

 

Multitrack recorder (MR-64) 

The multitrack recorder (MR-64) looks like a hardware mixer and can also be 
operated in the same way. It can also be launched as an alternative to the 
current mixer interface to make multitrack recordings just like with a real mixer. 
The MR-64 unites the advantages of the analog look with digital technology: 
realistic appearance, direct workflows, and familiar functionality. 

 

Soundpool manager 

The Soundpool manager helps control, preview, and load MAGIX Soundpool 
loops. Hundreds of loops are included, and many more can be found at 
Catooh. The loops are categorized into "styles" (e.g. ambient, dance, hip hop, 
rock, etc.) and "instruments" (e.g. drums, bass, guitars, etc.). The name of the 
loop file also informs you about the kind of sound you can expect. Every loop 
can be previewed by clicking it. Monitoring is adjusted to the loops in the 
arranger. For example, first a framework of bass and drums is constructed and 
then played back in a loop, and as you search for the right guitar sounds in the 
Soundpool manager, the monitoring will be matched with the drum loop. Every 
loop can be loaded into the arranger by dragging it or by double-clicking. The 
Soundpool manager can be launched via the "Manager (view page 262)" 
button. 

 

Jam Session 

The JamSession lets you create complete songs single-handedly. The program 
simulates working with hardware "Looping delays", like, for example, the 
Gibson Echoplex. The difference is that Samplitude 11.5 Producer creates an 
arrangement  during "looping" which can later be edited and compiled into a 
complete song. During a Jam Session, everything you do is recorded. The 
most important thing with the Jam Session is the fun factor – there can never 
be too much of it! 

Activate "Solo Jam Session" via the "Playback" menu. 
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Tutorial 

In this chapter we will introduce the most important features of Samplitude 
11.5 Producer. You will learn how to create an arrangement with audio and 
MIDI as well as the powers of both formats. You will also receive information 
about essential parts of the program so that you can take advantage of all 
possibilities of Samplitude 11.5 Producer. 

 

Step-by-step mode 

Samplitude 11.5 Producer offers a step-by-step mode for beginners and users 
who want to achieve quick results. All major tasks when producing music in a 
virtual recording studio are solved in five, clearly defined steps. 

 

Recording: First, vocals and instruments are recorded on multiple tracks. 

Editing: The recorded material is then edited, with a focus on cutting and 
arranging.  

Mixing: The tracks are mixed, i.e. positioned within the volume and stereo 
panorama. 

Mastering: In the end, the entire sound is edited with effects. 

Export: After you have completed all stages, the next step is to "output" your 
material, either as a classic audio CD or as a song file in MP3 or WAV format. 
Or you can upload and publish your song directly on the Internet. 

In what follows, we will present these five steps in more detail, because "Easy 
Mode" offers the fastest start into the program. 

 



 
 

 26 Tutorial  

www.magix.com

Quick setup 

After starting the program for the first time, the "Quick Setup" dialog appears. 
In this dialog, you can specify which sound card configurations you would like 
to use. Usually you will not have to change anything, because Samplitude 11.5 
Producer automatically selects the correct settings. If you are using several 
sound cards, however, you can select the one you want to work with from the 
menu. 

 

You can also set your plug-in directory for VST plug-ins and other elements.  

The settings dialog appears only once when you start the program for the first 
time, giving you the chance to check and adjust the settings of Samplitude 
11.5 Producer. After that, you can open the dialog by pressing "y" on your 
keyboard (or via "File" > "Program settings" > "System/Options"). 

 Beginners should not change the settings at all and simply click "OK". 
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Start selection 

The start dialog, which appears after every program start, opens: 

 

In "Project settings", you can give your project a name (for example, the name 
of the song you want to record) and specify the number of tracks and a track 
directory. Everything can be changed at a later stage. 

The main purpose of this dialog is to open a new or an existing project that 
was saved previously. Since we are still at the beginning, we don't have any 
existing projects yet. Therefore, we will create a new project: 

 Click on "New Project". 

The interface will open in step-by-step mode with the "Recording" setting. 
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Recording 

In this view, you can do multi-track recordings via a connected microphone, for 
example. 

 

It is recommended not to record an entire song at once, but to record the 
different instruments and voices one after another on different tracks. For 
example, if you wrote a song that you usually accompany with the guitar, you 
should record the guitar without vocals first and then add the vocals later, in a 
second step. This has the advantage of being able to entirely focus on one 
aspect, i.e. the instrument or vocals, thereby improving recording quality. 

The top area displays multiple empty tracks of your project, which are 
arranged one below the other. The control panel for the recording is located 
below the tracks. The large display, especially of the time display, enables 
better control of the recording. This is useful, because as a singer or pianist, 
you don't want to have to look at the screen continuously in order to follow the 
progress of the recording. Thanks to the large display, a side glance from the 
distance is sufficient to see where the recording stands. 
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 You can activate background music 
via Accompaniment. This function is 
more of gimmick and allows you to 
experiment! Let yourself be inspired 
by the different accompaniments to 
create your own melodies. 

 Metronome adds a regular clicking sound, which serves as a rhythmic 
orientation. The sound should be output via headphones to ensure that it is 
not recorded. You can select different speeds via the arrow keys. 

 Practice Speed allows regular playback speed to be reduced. This way, you 
can record at half speed and use the result with normal speed. 

 Monitor lets you preview audio material and monitor it while recording. The 
level displays what enters the sound card inputs. If it reaches the upper red 
range, the input level is too high. In this case, you should reduce the input 
volume. 

If you are ready to start your first test recording, click on the red "Record" 
button. Samplitude 11.5 Producer now starts recording and indicates this in 
the record window by displaying a counter with the passed record time. 

After recordings is complete, an audio file with the recording appears in the top 
track. 

 

Now you record on other tracks. The red button to the left of every track 
displays which track is currently being recorded. In the top picture this is track 
2.  
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You can enable any track for recording by clicking with the mouse and then 
record on any track. 

 

Editing 

In the "Editing" view, the record field is deactivated and only the Arranger is 
visible. 

 

Samplitude 11.5 Producer offers almost unlimited possibilities for audio editing. 
In step-by-step mode, the focus is one removing slight irregularities from the 
audio material. 

Let's just say you accidently knocked the microphone against something while 
you were singing and now your otherwise good recording is ruined because of 
the cracks. Instead of using the cleaning effects from the effects menu, we can 
simply cut out the crackling. This is the easiest and most effective method for 
removing isolated cracks. 

 Play back your recording (the easiest way to do so is by using the spacebar 
on your keyboard) and search for the section that you want to cut out.  
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 You can move the playback marker in the bar ruler above the first track at any 
time by clicking. 

 

 If necessary, zoom into the display to get a better view of the waveform 
display. To do so, use the horizontal and vertical zoom buttons located in the 
bottom right-hand corner: 

 

 Place the playback marker just before the crackling and press the "t" key on 
your keyboard (or click on the "Scissors" symbol in the toolbar). 

 Now place the playback marker just after the crackling and press the "t" key 
again. 

 Click on the isolated piece containing the crackling and delete it from the 
track. 
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Did you cut out too much by mistake? No problem: The object handles located 
at the edges can be used to recover deleted material and vice versa, to 
remove bothersome rests. 

 To do so, select the section you want to edit with the mouse. 

 

 Move the mouse pointer exactly on top of the handle. After it has turned into a 
double-arrow, you can move the front part to the right or to the left with the 
mouse button held down – ideal for fine-tuning your cuts. 

As mentioned before, Samplitude 11.5 Producer offers many more editing 
possibilities. We will discuss more options later. For now, we will leave it at this 
simple editing exercise. 
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Mixing 

The next area of the step-by-step mode opens the mixer. All other elements 
are hidden to provide a better overview.  

 

With the Mixer you can adjust and even automate the volume and panorama of 
the recorded tracks. Furthermore, you can add effects and much more.  

 Adjust the volume of the individual tracks with the sliders in the lower part of 
the mixer until you have a balanced result and every instrument in the song is 
sufficiently accounted for.  

 Take some time and experiment with the effects (Aux, Inserts, Sound FX, 
Dynamics, EQ) on the individual tracks. 
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Mastering 

The "Mastering" area of the step-by-step mode opens the Mastering Suite, 
which is used to optimize the overall sound. 

 

 The Mastering Suite includes four devices, which are organized on top of 
each other in an effects rack. Which device is used for what purpose? 

Equalizer: For regulating the sound characteristics. You can set four frequency 
bands separately in the graphical control panel. 

Vitalizer: A stereo effects processor that allows you to change the stereo 
width. In "Multiband mode" only the mids are edited. 

Multimax: A multiband compressor for editing the volume and the sound 
impression. 

Limiter: To prevent overmodulation. 
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Export 

After successfully passing through the four stages of the step-by-step mode, 
the result is a first, perfect song. The last stage, "Export", is where you decide 
what you want to do with your song.  

 

There are four options to choose from: 

Burn CD: An audio CD that can be played back on any CD player is the typical 
way of exporting your song. 

Save as Wave: An audio file in WAV format is the standard format for audio 
productions. It can be played back with different software and on multiple 
devices and features crystal-clear sound. 

Save as MP3: MP3 is a space-saving alternative to WAV that can be played 
back directly in the player. 

Upload: This uploads the song directly to the Soundcloud® community. 

This was intended as a first, quick overview of the step-by-step mode! 

 

Switch workspace 

Now that you have a rough idea of what digital music production is about, lets 
take a look at the advanced options. Let's go to the "Workspace" box at the 
bottom of the screen and switch to "Power User" mode, the mode for 
ambitious users. 
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Recording in the Arranger 

You can also record directly in the Arranger, i.e. outside of the step-by-step 
mode. Here's how it works: 

 If necessary, activate the transport control via "View" > "Transport Control". 

 

Recording the first track 

 Right-click the "Record" button on the transport console. 

 

Enter all of the necessary settings for recording in the dialog which appears. 

Hint: If the transport console is hidden, show it by clicking the "Transport" 
button in the lower part of Samplitude 11.5 Producer. 

 By default, the "Monitor" button is always selected (if not, then click "Monitor" 
to activate it). This function lets you preview audio material and monitor it while 
recording. The level will display what enters the sound card inputs. If it reaches 
the upper red range, the input level is too high. In this case, you should reduce 
the input volume. 
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 Click on the "Record" button. Samplitude 11.5 Producer now starts recording 
and indicates this in the record window by displaying a counter with the 
passed record time. 

 

 Now stop the recording at a suitable position by pressing the "Stop" button. 

Samplitude 11.5 Producer then stops recording. You can now either use the 
recording or delete it. You can repeat the recording without saving the first 
attempt on your hard drive. If you want to use your recording, Samplitude 11.5 
Producer will add the audio material to the first track as an object. 

 

You can listen to the result anytime by clicking on the "Start" button in the 
transport control or by pressing the space bar. 

 

Record another track 

Now we will record a second track. If the record dialog is still open, please 
close it. 

 Activate the "Record" button in a second track by clicking on the red "Record" 
button to the left in the second track. The track is now ready for recording. 

 Right-click on the "Record" button in the transport control. You can now enter 
further settings for recording. As we want to play the first track while the 
second is being recorded, you will have to activate "Play during recording". 
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 Click on the "Record" button. 
 Now stop the recording at a suitable position by pressing the "Stop" button. 

Note: "Play during recording" mode requires that your sound card can play 
audio material while recording new material (full duplex mode). Some sound 
cards can either record or play, but can't do both at once. In such a case you 
should deactivate "Play during recording". 

 

Integrate audio material 

Now add new, already available audio material. Audio material can be added to 
your virtual project from different sources and in different file formats. You can 
add audio CDs, WAV files, MP3 files, sample CDs (such as the MAGIX 
Soundpool series), as well as other audio files. There are several possibilities 
for loading audio material: 

 In the menu bar, click "File -> Load/Import -> Load audio file..." and select a 
file via the import dialog. 

 Activate the integrated file browser via the "Manager" button at the lower edge 
of the screen. This accesses all drives and folders on your computer. Any 
audio file can be dragged by holding the left mouse button to the track (drag & 
drop). 

 

 You can also drag audio files directly from Windows Explorer® into the 
Samplitude 11.5 Producer arrangement.  

 Audio tracks first have to be copied onto the hard drive separately. To do this, 
click into the top menu bar in Samplitude 11.5 Producer on "File -> 
Load/Import -> Load audio CD track(s)..." 

 

VIP and wave projects 

A wave object is created for each audio object that you can see in the 
arranger. You can generally work on two project types:  
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 Virtual project (VIP): This is an arrangement made up of different objects. The 
tracks in the virtual project are for recording or loading audio material onto 
several tracks. You can conveniently record and create sound on different 
tracks. 

 Wave project: This is the audio material of one object. 

Hint: If you delete an object in a virtual project, the audio material and the 
corresponding wave project on your hard drive will be retained. 

Switch to a wave project (your first recording, for instance), mark the 
corresponding object in the VIP by clicking on it, click into the top menu bar of 
Samplitude 11.5 Producer on "Object", and select the option "Edit wave 
project...".  

 

If you have opened a wave project, then you will see the wave display of the 
audio material in enlarged view. The acoustic properties are directly visible in 
wave form, and where there's something to see, there's something to hear, 
and the higher the peak of the wave form, the higher the volume will be. Press 
the space bar on your keyboard to play back the wave project. 

In wave projects you can directly edit your audio material. Direct editing of the 
material is particularly useful: Mark a range in the wave project with the mouse 
and then press "Del". After editing the audio material you can close the wave 
project. You now have to decide whether you want to accept the changes or 
discard them. If you want to accept the changes, then click on "Save project". 
The original audio file will now be overwritten. 
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Arranging MAGIX Soundpool sound loops 

Up until now, you have only been working with your own material. Next, we 
would like to show you how to build your own songs using the included 
Soundpool loops. 

MAGIX Soundpools offer professionally produced, short audio files - so-called 
"samples". They have been produced to be perfectly combined with each 
other and looped. "Looping" means creating an entire instrument track from a 
single audio sample. This entails replaying the sample sequentially to provide 
the impression of a repeating musical leitmotif. This process is used today in 
almost every area of modern pop music. 

 It's best to create a new, empty arrangement first. Click "File" and select the 
option "New virtual project (VIP)". 

 Click the "Manager" button and select the tab "Soundpool" to display the 
Soundpool samples. 

 

 

 The "styles" are displayed on the left side of the Soundpool manager. If you 
have inserted a MAGIX Soundpool DVD, for example, then you can select a 
style here to display only those samples which were created for a particular 
style. Samplitude 11.5 Producer shows "Rock" because this style is included. 

 Next, select the instruments that you want to use. At the start, we recommend 
choosing a drum sample to create the initial percussive structure. Open up the 
"Drums" folder. 

 To preview, click once on a file in the Soundpool manager file list. To load it, 
drag the desired file to the track. Once you let go of the mouse button, the file 
will appear as an audio object at that position. 
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 Each object can be moved in any way in the arranger with the mouse; 
horizontally on a track as well as vertically between tracks. Drag the drum loop 
to the first track and all the way to the left (at the beginning). 

 

 Next, the sample will be looped, i.e. the short object will be played over and 
over. Click the audio object's handle at the lower right and drag it to the right 
as far as you imagine you will need for the first part of your song - probably 8 
bars or so. The object will be properly placed on the first 8 bars of the first 
track. 

 Make sure that the playback range is as long as the extended sample - 8 bars 
in our example. To do so, click above and to the right in the timeline and drag 
out the playback range to match the length of the looped object. 

 

 Now press the play button (space bar is faster). The drum sample will loop for 
8 bars. This means that the playback cursor starts right at the front, moves 
across the playback range, and then transfers to the start again once the end 
is reached without any interruptions. You can also move the playback marker 
independent of the playback range by clicking on the lower section of the 
timeline. 

Note: All additional loops can be previewed during playback and inserted. This 
lets you preview new potentially interesting samples for your arrangement to 
test if they work. If continuous playback gets on your nerves after a while, then 
you can always interrupt it by pressing the space bar again. 

 Next, try loading a suitable bass line. Open up the bass folder, test some of 
the bass samples there, and then drag a bass loop you like onto the second 
arranger track. 
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Note: Melody producing instruments are arranged by pitch, i.e. every sample 
features multiple variations which provide different levels of pitch. By 
combining different variations of a pitch, you can produce chords. 

 Add new instruments to your drum and bass loops. This way, any number of 
files can be dragged from any folder into the arranger and positioned on top of 
one another, on multiple tracks, or behind one another. 

 

Tip: This lets you create complete songs and also a professional framework for 
your recordings. 

 Because not all instruments are normally looped for the entire arrangement, 
gaps should be built into the architecture of your song to provide musical 
variation. To do this, looped objects can be cut or loaded multiple times to 
create the required empty spaces. To learn more about editing objects, read 
the quickstart in "Editing objects (view page 44)". 
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Add synthesizers 

 
To open the software synthesizer folder of Samplitude 
11.5 Producer, click the "Synth" button. 

After selecting a synthesizer, the corresponding control console will appear 
where you can program the rhythms, melodies, chords, and sounds of the 
synthesizer. 

Synthesizers become independent objects after they are programmed, and 
then they can be moved around just like other objects on the Arranger. 

 

Exception: Vita (and all associated Vita instruments) and Revolta 2 remain 
coupled in the track where they are placed. They are controlled via MIDI 
objects. 

Experiment with the various synthesizers in Samplitude 11.5 Producer to 
discover the possibilities. 
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Editing objects 

Editing objects is the same for all object types. The following options are 
equally available for audio objects, synth objects, and MIDI objects 

 Many object edits require the objects to be selected first. Individual objects are 
highlighted with a mouse-click. Multiple objects can be selected when the 
"Shift" key is held depressed. You can also click and drag out a rectangle to 
select multiple objects. All objects contained therein will be selected ("rubber 
band selection"). 

 All objects in the VIP can be shortened or looped by moving the mouse to one 
of the lower corners of the object until it turns into a stretch symbol. You can 
now reduce the size of the object. Any disturbing passages at the beginning or 
end of the recording can be removed simply by moving the ends inwards. 

 If the option "Create looped object" is activated in the top menu bar under 
"Object", you can stretch the object with the right handle. Use this feature to 
create entire rhythm tracks from short drum samples by simply stretching the 
object apart. 

 At the top corners of every object there are two fade handles that can be 
adjusted to fade an object in or out. The handle at the top center can be used 
to adjust the volume of the objects. 

 

 Several objects can be combined with others to make up a group, to avoid the 
objects being unintentionally moved out of relation to each other. First, mark 
the individual objects. Next, click in the toolbar on the "Group" symbol. 

 All objects can be split into multiple objects. Select the option "Split objects" in 
the "Edit" menu (or press "T" on the keyboard). The selected object will be 
split at the position of the playback marker. 

 Right-clicking on the object also opens a context menu for you to select the 
object editor. Here you can make all important settings for the corresponding 
object. For instance, in the object editor, you can add effects to audio objects 
and change MIDI object quantization. 
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Tip: The object editor can be opened permanently; it adjusts its settings 
depending on the object which is currently selected. 

 

MIDI recordings 

MIDI recordings are created for operating VST instruments or external 
synthesizers with the help of a MIDI keyboard. The instruments will not be 
recorded as audio data, but rather remote controlled via the MIDI data format. 
Every detail of this remote control - i.e. every button press, every note, every 
velocity level - can be corrected and edited retroactively via the MIDI editor. 
Please read more on this in the section "Editing MIDI (view page 48)". 

 

What is MIDI? 

A few words about MIDI: MIDI files do not contain the actual sound like audio 
files, but only the note control information. This data is interpreted and played 
back by the VST instrument or synthesizer.  MIDI is thus a kind of remote 
control for synthesizers. This has some advantages: 

 MIDI files need a lot less memory than wave files. 
 MIDI files can be adapted to any tempo (BPM) without affecting the sound. 

The playback tempo is simply changed. 
 Transposition of MIDI files to other pitches is also easy. As a result, a section 

in a song does not have to be saved in several different keys. The version in C 
major is perfectly sufficient. It can then be transposed to any key easily. 

The disadvantage of MIDI files: The audio is not yet determined and is only 
produced during playback. 
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Preparing a MIDI recording 

Prepare an empty track in your VIP for recording.  

 Click "R".  
 Then click "Track Editor" in the lower half of Samplitude 11.5 Producer's 

program screen to make track settings. 

 

 Use the small triangle to open up the MIDI section. 

 

Here you can now define the in- and outputs for your MIDI data on the 
selected track. 

 Input (In): This could be a MIDI keyboard which you use to enter MIDI notes 
and which are then recorded by Samplitude 11.5 Producer. 

 Output (Out): This could be a virtual instrument (VST instrument) that plays 
back the MIDI notes entered via the MIDI keyboard as sounds. To select a 
VST instrument, click the small triangle next to "Out" in the Track Editor and 
select "New instrument". 

Note: All global MIDI settings can be found in the "System" dialog ("Y" key), 
submenu "MIDI".  
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"In" and "Out" in the Track Editor allow you to assign a special "Receive" and 
"Send" channel to every track for MIDI data. This is important if you want to 
control an external synthesizer via a MIDI keyboard, for example. 

For instance, if your MIDI keyboard is transmitting on MIDI channel 1, you 
should enter the value "1" in the "In" menu. During recording, Samplitude 11.5 
Producer will receive all MIDI notes transmitted on channel 1 by a MIDI 
keyboard. 

You can generally assign a specific MIDI channel to external MIDI synthesizers. 
For instance, if your external synthesizer is addressed via MIDI channel 4, you 
should also enter the value 4 under "Channel Out" in the Track Editor in order 
to be able to address the external synthesizer via this track. 

 

MIDI record modes 

There are several methods of recording MIDI, and you can set the MIDI record 
mode in the transport control.  

 

 Normal: This recording mode corresponds to that of audio recording, i.e. a 
new MIDI object is created over the existing object for each recording 
process. The old object remains intact. This way you can record multiple takes 
of a passage and then compare them in the Take Manager later on. 

 Overdub: The data is recorded into an already existing object, and available 
and newly recorded MIDI data is mixed together. 

 Multi-overdub: The data is recorded into an already existing object, available, 
and newly recorded MIDI data are mixed together. However, existing objects 
remain the same. 

 Replace: The data is recorded to an existing object and any MIDI data is 
overwritten.  

After you have selected MIDI record mode, you can prepare the corresponding 
track by clicking on the "R" button for recording. Now start recording by 
clicking on the "Record" button in the transport control. 
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Edit MIDI 

MIDI editor 

You can use the MIDI editor for editing MIDI data. To access the MIDI editor, 
right-click on the object, open the context menu, and select the "MIDI editor." 
The MIDI editor displays the data of the MIDI object. 

MIDI data can be edited in the MIDI editor in five main areas: 

 Matrix editor (piano roll) 
 Drum editor (toggling between the drum editor and piano roll is possible) 
 Controller editor (velocity, MIDI volume…) 
 List editor (event list) 
 Score editor 

Here various tools like the pencil or eraser are available. 

Fundamentally, changing, moving, or deleting notes always refers to all 
selected MIDI events (red) with just a few exceptions, e.g. you can select a 
group of notes in the piano roll and then change the velocity of these note 
groups to modify all selected notes simultaneously. 
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Working with the matrix editor 

The matrix editor is particularly useful for conveniently arranging MIDI notes 
(piano roll). 

 

In the matrix editor, you can edit MIDI notes for controlling sound generators 
like synthesizers, drum machines, and virtual instruments (VST instruments). If 
a MIDI instrument is activated, you can play it via the keyboard at the left of the 
screen. Clicking on a key makes the synthesizer create the corresponding 
sound. 

 

Now select the pencil tool and paint the notes into the score sheet. 
MIDI notes can also be sustained by holding the left mouse button 
or double-clicking. 

 The "Eraser" tool deletes notes from the note field.  

 
The "Step recording" button enables step-by-step audio recording.  

Tip: The tool for drawing the pattern is particularly interesting. Use the 
selection tool to select specific notes and press the key combination "Ctrl + P". 
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The selected notes are played as a sound pattern. Switch to the pattern 
drawing tool. You can now easily sketch the sound pattern with only one click. 

Tip: Pressing the "left" and "right" arrow keys on your keyboard moves 
forwards/backwards in the notation, respectively. The cursor up/down keys 
adjust the note pitch in stages. 

 

Using the controller editor 

 

 

In the controller editor you can adjust MIDI parameters such as 
velocity. A simple click in the left part of the MIDI editor opens the 
controller editor. Clicking on the small button above opens a context 
menu. Here you can select a MIDI parameter and then sketch it with 
the pen tool in the controller editor.  

 

Multi-object editing 

With the new MIDI editor you can now edit several MIDI objects together in the 
MIDI editor. Please select the MIDI objects in the arrangement in sequence by 
holding "Ctrl" and then clicking on the MIDI editor button to open it. In an 
already opened MIDI editor you can include additional MIDI objects by clicking 
on them while holding down "Shift". 

 You can access individual MIDI objects via the 
drop-down menu next to the name. 

Hint: Right-clicking on this position opens the object editor so that you can 
quickly toggle between the object and MIDI editor. 

 

From MIDI to audio 

If you are controlling an external MIDI synthesizer in your arrangement, you can 
convert its sounds into audio tracks with the Samplitude 11.5 Producer record 
function. This is particularly recommended if you want to enrich sounds 
created with your external MIDI synthesizer with audio effects, convert your 
project into MP3, or burn it onto disc. 

 Connect the audio output of your external MIDI synthesizer to the audio input 
of your sound card. 
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 Set an audio track to "armed" by pressing "R". 
 Start audio recording as usual. The MIDI data will be played and recorded 

simultaneously via the record function. The result is an audio file that can be 
edited and exported together with other multimedia files. 

Tip: Do not delete MIDI tracks in the arrangement after you have generated 
audio files from them, simply mute them with the "Mute" button. You can then 
later change melodies and beats composed via MIDI and record them as audio 
files again. 

Note: If you prefer VST instruments as synthesizers, it makes more sense to 
use the Track freeze (view page 354) function from the "Track" menu. 

 

Effects 

You can considerably enhance your music productions with effects. Clever use 
of effects adds depth to your song and simply sounds better. Samplitude 11.5 
Producer has plenty of effects. Experiment with the various effects in 
Samplitude 11.5 Producer and learn how to use them. 

 

Calculating audio effects 

You can add audio effects in three different levels: audio objects, tracks, and in 
the master. When played, effects are first calculated in the audio objects. Track 
effects are then added. The master effects are added last. 

First, start with the object effects to distort individual objects while other 
objects in the same track remain the same. For instance, if you have saved a 
groove consisting of several audio objects on one track, you can edit the last 
object of the groove with a distorter. 

Use track effects like reverb, etc. on any objects located on a single track. 
Finish off your song with powerful master effects that have an effect on the 
entire song. 

Effects in audio objects: Right-click on an object to open the context menu 
and add an object effect. You can access the object effects directly via the 
context menu. Object effects can be selected and subsequently edited via the 
object editor. 
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Effects in tracks: To adjust track effects in 
the mixer, open the mixer by clicking on 
"Mixer" in the lower part of Samplitude 11.5 
Producer. In the "Ins" section, click on the 
arrow symbol of an effect slot in the 
corresponding channel. 

Effects in the master: Open the mixer to add 
master effects. You will find the master 
section at the right edge of the mixer. Here 
you can install the desired master effects. 

Hint: Track effects and master effects are 
always real-time effects. 
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Burn CD 

Once your VIP is finished, you can burn it onto disc. Click on the button with 
the CD symbol. The CD burning dialog now opens. 

 

Now click on the "Burn CD" button... 
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Program desktop overview 

VIP window 

 

1 Menu bar: You'll find menus in the main window of Samplitude 11.5 
Producer directly under the title bar. A keyboard shortcut can be allocated 
to every menu entry.  

2 Toolbar: Toolbars are made up of buttons which carry out specific 
commands with a mouse click. They can be found above and below the 
project window. More information on the individual button bars can be 
found in the button overview. More information on the individual toolbars 
can be found in the keyboard shortcut overview. 

3 Grid/Marker bar: The grid/marker bar is positioned above the first track in 
the VIP. In the upper half, you'll find the marker bar where the markers and 
playback cursors can be positioned. The lower half displays the grid list 
which displays the project time depending on the selected unit of 
measurement. You can also open various ranges. 

4 Project window/clip: A "clip" refers to part of the project visible in the 
project window. Which section of the project it is depends on the position 
of the section and the zoom. 
There are many commands for moving (scrolling) the visible clip and 
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customizing its size (zooming). These can be opened via the menu view, 
the grid/marker bar, and the shortcut keys. 

5 Track box: The track box is the front range of a VIP track. It contains 
various controls which range from mixer functions and monitoring 
commands to other track parameters. More information on the individual 
controls of the track box can be found in the Track box overview (view 
page 61). 

6 Track editor: The left border of the arrangement window enables access to 
all important parameters of the selected track. Record and monitoring 
status, volume, panorama, MIDI/audio in- and outputs, plug-ins, AUX sends 
and EQ settings are displayed in well-arranged sections and can also be 
edited directly in this view. 

7 Setup/Zoom/Position buttons: This part of the work area helps manage 
each of the four different setup and zoom settings project clip displayed in 
the VIP window. Similarly, the "Pos", "Len", "End", "Mouse", and "Mixer" 
fields can be configured by right-clicking them. 

8 Status display: The status display appears at the bottom border of the VIP 
window. For longer actions or calculations a bar is displayed whose width 
shows the current state of operation. 
Furthermore, CPU load information on the processor load, latency, buffer, 
etc. is updated and displayed constantly. The status display can also be 
opened via the "Window -> Status display" menu. 

 

Transport control 

Keyboard shortcut:  Ctrl + Shift + T 

 

The transport control window contains the most important commands for 
playback, recording, and positioning. 

Note: The transport control can be integrated as a toolbar. Select the option 
"Activate docking for transport control" in the timeline menu and then move the 
transport control to the desired position. 

Play, stop, fast forward/rewind buttons: These control playback position just 
like a cassette player. 
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Right-clicking the "Play" button: This opens the "Stereo master" mode's 
playback parameters window. Specify the sample rate, playback device, 
scrubbing/varipitch options, etc. 

Right-click the "Record" button: Opens the recording parameters window. 
Adjust recording settings like "Play while recording"; you can also start a mono 
or stereo recording straight from this window. 

Record button: Starts the recording for all activated tracks, i.e. tracks with a 
red "R" button in the track info to the left. The recording devices have to be set 
up beforehand by right-clicking the "R" button. 

Time display: Displays the current playback position. The unit of measurement 
can be selected by clicking the small triangle. 

Range buttons: You can save ranges with buttons "1" and "2". Use the arrow 
symbol to open previously used ranges. 

L/E time display: Displays the length and end position of an area and can be 
edited by double-clicking. 

"Edit": Opens the marker manager for extensive marker editing. More 
information can be found in the chapter "The Managers". 

Marker buttons 1-12: Clicking will save the current playback position to one of 
the 12 marker buttons. If one position has been saved, the marker will appear 
bright. Another click on the same marker moves the play position to the 
corresponding marker. Right-clicking deletes the saved marker again, making 
it available again to be assigned. 

Audio dropdown menu: Set up the desired recording mode. 

Standard mode (playback during record): This is the typical recording mode 
for multitrack productions. This adds further tracks to already available audio 
material while playing. 

Punch marker mode: This setting starts a recording process which can be 
started and stopped at any time during playback by clicking. 

"Moni": This button activates Samplitude 11.5 Producer's record monitoring 
feature, i.e. all tracks with an active "R" button display the adjacent input 
signals in the peak meters. Right-clicking the "Moni" button lets you select 
from the various monitoring modes. 
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Note: Detailed information about monitoring can be found in Samplitude 11.5 
Producer's help chapter "System settings -> Global audio options -> 
Monitoring settings". 

"Sync": This button opens the synchronization settings dialog. Further 
information can be found in the help chapter "MIDI in Samplitude 11.5 
Producer -> Synchronization". 

"Punch" button: This button switches Samplitude 11.5 Producer to "Punch" 
mode. This means that a recording can be started "on-the-fly" using the record 
button during playback at any time, also multiple times back-to-back. "Punch 
In" and "Out" markers are placed automatically. A punch recording is ended by 
pressing the "Record" button; playback is not affected. 

"In" button: This button sets the starting point for a punch recording. 

"Out" button: This button sets the end point for a punch recording. If "Punch 
In" and "Punch Out" markers are set, the punch recording can be started using 
the "Record" button.  While the recording button is flashing, playback occurs 
until the "Punch In" marker has been reached. Once reached, the recording 
button turns red. Recording is active until the "Punch Out" marker is reached, 
and then Samplitude 11.5 Producer changes back to playback mode. 

"Loop" button: Use this to switch to "Loop" mode, and a specific range will be 
played back repeatedly. 

MIDI record modes: The following MIDI record modes are available: normal, 
overdub, multi-overdub, and replace. The different modes determine how the 
newly recorded MIDI files will be added to the VIP. 

Tempo section: You can adjust playback speed and tempo of the entire 
arrangement in the tempo section of the transport control. All objects in the 
VIP are adapted to the speed of your choice via the timestretching feature. You 
can also switch on the metronome by pressing "Click". Right-clicking the 
"Click" button opens the metronome's settings dialog. 

Scrub control: The "Scrub control wheel" adjusts the playback speed. This can 
be used to locate audio passages. The buttons beneath it can be used to start 
playback forwards and backwards at a slower speed. This can also be used to 
improve control over audio passages, for example to edit out crackles or other 
errors later on. 
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Track editor 

1 Track number display and track name: 
Right-clicking on the track name opens the 
"Track settings" dialog. 

2 Switches off all tracks with the exception of the 
one selected. 

3 "M" button: Mutes the track. 

4 Record icon: Activates the track for the 
recording. 

5 Lock: Enables you to protect objects in the 
track and prevents unintended moving or 
deleting of an object. 

6 The loudspeaker symbol: Switches on playback 
of the incoming signals when the "Rec" button is 
active, if "Manual monitoring" is selected in the 
system options. 

7 Volume input field and volume control 

8 Peak meter: Both LED displays show the input 
and output signal for the track. 

9 Panorama button: Controls the position within 
the mix. 

 

10 "FX": Access the activated track's effects. You can copy, insert, reset, 
save, or load them. Save your personal track effect settings in the program 
directory in "FX presets -> Track FX". Of course, you can also create new 
subfolders. 

11 "MIDI" button: Switches the track to MIDI recording and opens the MIDI 
section of the track editor. 

12 Automation: This area provides Automation of MIDI controllers, VST 
parameters, and certain effects in the track. 

 

Automation 

1 Right-clicking opens the context menu 
2 Select the plug-in you would like to automate 

here. 

 
3 Select the parameter you would like to automate 

here. 

The slider controls the selected parameter while automation is drawn. 
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MIDI 

1 Arrow: Opens and closes the respective dialog 
box. 

2 In device: Opens the MIDI input device menu. 
3 Out device: Opens the MIDI output device menu. 
4 Channel in: Set the MIDI input channel here. 
5 Channel out: Set the MIDI output channel here. 
6 Program: This slot is responsible for selecting the 

program for the MIDI instrument. 

 

7 Bank MSB: Set the device-specific control 
change messages for controlling your external 
instrument here. 

 

8 LSB: Set the device-specific control change messages for fine-tuning your 
external instrument here. 

9 Drum map: Select a drum map for allocating MIDI notes to the 
device-specific sound here. 

10 Transpose: Transpose the notes of the respective MIDI input or output up 
or down here. 

 

Audio 

 

"In" slot: Specifies the audio input device, i.e. a sound 
card. 
"Out" slot: Specifies the audio output device. This may be 
a sound card output or (in "MIDI" mode) a VST instrument, 
for example. 
Gain: Set the sensitivity of the input here. 
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Plug-ins 

Activates the sound effects rack containing various track 
effects, plus a compressor. 
In the first slot, you can also select a MAGIX synth to be 
controlled via the track. Clicking on the button to the 
right of the field beside "Plug-ins" activates and opens 
the "DirectX/VST plug-ins" dialog to put together a 
plug-in setup for this track. 

 

AUX 

Here you can specify the AUX send feed for which you 
can then select the desired effects in the AUX return 
channel in the Mixer view. 

 

EQ 

Contains the parametric EQ for this track. Right-clicking 
opens a convenient input window. 

Comments 

Track info section for quickly adding notes on tracks. 
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Track box 

 

1 Track number display and track name: Right-clicking on the track name 
opens the "Track settings" dialog. 

2 "S" button: Switches off all tracks with the exception of the one selected. 

3 "M" button: Mutes the track. 

4 "Rec": Activates the track for the recording. A right mouse click opens a 
menu to switch to recording mode: If the track is set to MIDI recording, 
then the MIDI section in the track editor will open. 

5 The loudspeaker symbol: Switches on playback of the incoming signals 
when the "Rec" button is active, if "Manual monitoring" is selected in the 
system options. 

6 Lock: Enables you to protect objects in the track and prevents unintended 
moving or deleting of an object. 

7 "FX": Access the activated track's effects. You can copy, insert, reset, 
save, or load them. Save your personal track effect settings in the program 
directory in "FX presets -> Track FX". Of course, you can also create new 
subfolders. 

8 Peak meter: Both LED displays show the input and output signal for the 
track. 

9 Volume: Controls the track's volume. 

10 Panorama: Controls the position within the mix. 

Both the "Vol" and "Pan" buttons activate curves that allow the volume and 
panorama in the track to be automated. 
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Workspaces 

The purpose of a workspace is to sort menu entries and toolbars in such a 
manner that you have a good overview of Samplitude 11.5 Producer's 
functions. Workspaces bundle commands with regard to certain tasks such as 
mastering, editing, or recording. 

Besides hiding menu entries (Options -> Program preferences -> Edit 
keyboard shortcuts and menus -> Hide menu) and redesigning toolbars 
(right-click on the toolbar), you can also save your settings as a preset. 

You will see the selection box for the workspace at the bottom left corner of 
the VIP window. Some workspaces are already defined. "Power user" displays 
all toolbars and commands, and is a good starting point for defining 
customized workspaces. 

Creating a new workspace: To create a new workspace, open the context 
menu by right-clicking on the workspace bar and selecting "New workspace". 
You will now be asked to enter a name for your workspace. The new 
workspace contains all settings of the previously activated workspace as well 
as your current changes. All further adjustments are automatically saved in the 
workspace. Manually saving is not required. 

Adjusting the workspace: Open the context menu and click on "Edit 
workspace". Here you can select which toolbar you want to be displayed in 
your new workspace. You can activate or deactivate each bar individually, or 
add/remove individual symbols. You can also hide menu items in "Edit menu". 
Simply select the corresponding menu item from the keyboard shortcuts, and 
then press the "Show menu item" or "Hide menu item" button. 
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Mouse functions and mouse modes 

Universal mode 

Right mouse button: Displays context sensitive pop-up menu. 
Left mouse button: In universal mode a distinction is made between 

the upper and lower half of a track in the VIP. 
More mouse functions are available for the left 
mouse button. 

 

Mouse functions for the upper half of the track: 

 Stretch and move ranges (with "Shift") 
 Set the start position of the play cursor by clicking next to the object 
 Reduce the horizontal zoom level by double clicking next to a range 
 Increase of the horizontal zoom level by clicking on a range 

 

Select objects 

Single click selects objects (or group of objects). 

Single click + Ctrl selects multiple single objects. 

Single click + Shift selects multiple objects, including all objects between the 
two clicks. 

If you click left next to an object, you can sketch a rectangle with the mouse 
button pressed down by dragging the mouse the right. All objects contained 
therein are selected (lasso function). 

 

Moving objects 

Objects (or a group of objects) are moved if you click into their lower half and 
drag them to the desired position while holding the mouse key. 

Dragging + Shift moves objects or object groups up or down the track list 
without changing the time position.  

Dragging + key "k" move the object under the mouse pointer, plus all objects 
behind on the same track. 
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Duplicating objects 

Dragging + Ctrl duplicates one or more objects. To do this you also have to 
click the lower half of the object. 

Dragging + Shift + Ctrl duplicates one or more objects and allows the objects 
to be moved up or down the track list without changing the time position. 

 

Lasso function 

Object lasso: If you click left next to an object in the lower half of the track, 
you can sketch a rectangle with the mouse button pressed down by dragging 
the mouse the right. All included objects are selected. 

Volume and panorama lasso: If you click left next to an object in the lower half 
of the track, you can sketch a rectangle with the mouse button pressed down 
by dragging the mouse the right. All contained volume and panorama points 
are selected. 

 

Volume and length of individual objects 

You can individually adjust the volume and length with the five object handles. 

Object handles: The upper handle changes the object volume. The changed 
level is shown in dB in the upper left-hand corner of the VIP. 

Side handles: Fade-in or fade-out. The fade curves used here can be set in the 
crossfade editor. 

Lower handle: Adjusts the length of an object. 

 

Volume and panorama automation curves 

The volume and panorama curves can be used to graphically adjust the 
volume and stereo panorama curves of the tracks. Movable handle points are 
created on the curve. 

Double clicking on the automation curve creates a new curve event. Another 
double click on the same curve event deletes the event. Selected handles can 
also be deleted by selecting "Delete curve handles" from the edit menu. 

A volume or panorama handle is selected simply by clicking it. Several handles 
are selected by holding "Ctrl" while clicking. 
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If you click right next to an object, you can sketch a rectangle with the mouse 
button by dragging the mouse to the right. All volume and panorama points 
contained are selected (lasso function). 

Selected volume and panorama points can be moved with the mouse. To 
move several points, you have to hold "Ctrl" while dragging. 

 

Curves / Object mode 

This mode differs from the universal mode only in that the track is not split in 
two halves. 

Play cursor, fields, and zooming are not set in the upper part of the track, but 
rather in the beat line above the first track. All other functions are handled by 
the universal mode (tracks are split). 

The curves/object mode is less complicated to use and is therefore a default 
setting. 

 

Range mode (safe mode) 

Right mouse button: Displays context sensitive popup menu. 

Left mouse button: Selecting ranges and moving ranges ("Shift"). Objects or 
automation curves cannot be changed by accident (i.e. "Safe mode").  

 

Create ranges 

In range mode, ranges are sketched by clicking and dragging the mouse 
pointer while holding the mouse button. 

The range mode is a "safe" mode, since objects or curves cannot be moved 
accidentally. 

 

Play cursor 

Single clicks place the play cursor anywhere in the track. 

 

Zoom 

Double clicks outside of a selected range (or no range) zoom out. Double 
clicks inside a selected range zoom in.  
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Quick switch to other mouse modes 

Using the "." (period key) temporarily switches to the object mode to allow 
objects to be moved.  

Using the "–" (minus key) temporarily switches to curve mode to allow 
automation curve events to be moved and manipulated. 

 

Curve mode 

Right mouse button: Context menu 
Left mouse button: Offers a range of functions. I.e.: 

 

Volume and panorama rubber band 

When you click on the track near an object, you can, by pulling the mouse to 
the left or right, spread a rectangle by holding down the mouse key. This will 
select all volume and panorama points contained in the selection box. 

 

Volume and panorama gradients for the whole track 

Using the panorama and volume curves, volume and stereo panorama 
graduations can be graphically recorded. For this purpose sizing handles which 
are moved are created on the curve. 

A double click on the volume or panorama curve creates a new handle, and 
another double click clears it. Selected handles may also be cleared by 
selecting the option ”clear handles” in menu ”edit”. You may select a volume or 
panorama handle by a single click. You will select further handles by holding 
"Ctrl" while clicking. 

When you click the track on the right beside an object, you can spread a 
rectangle with the mouse held down. This selects all volume and panorama 
points contained within (rubber band function). You may move selected volume 
and panorama handles with the mouse. To move several handles, "Ctrl" must 
be kept depressed. 

 

Cut mode 

Right mouse button: Context menu  
Left mouse button: You can use the mouse cursor like a pair of scissors to 
crop objects. 
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Pitchshift / Timestretch mode 

Right mouse button: Context menu 

Left mouse button:The lower right tab allows an object to be compressed or 
stretched. A timestretching effect is created: The object is not played as a loop 
or shorter version, but simply in a different play tempo. 

Using the center tab, the pitch can be altered via pitchshifting. 

 

Draw volume mode 

Right mouse button: Displays context sensitive popup menu. 

Left mouse button: Draws volume automation curves into VIP tracks. "V" 
needs to be active for a respective track prior to drawing the volume curve. 

 

Draw panorama mode 

Right mouse button: Displays context sensitive popup menu. 

Left mouse button: Draws volume automation curves into VIP tracks. "P" 
needs to be active for a respective track prior to drawing the panorama curve. 

 

Wave edit mode (only wave projects) 

Right mouse button: Context menu 

Left mouse button: Freehand drawing function for wave format.  

 

Scrub mouse mode 

Right mouse button: Context menu 

Left mouse button: Scrub function. Click project to pre-listen with control over 
play tempo. The project will be played forward and back controlled by the 
distance of the mouse pointer from the actual play cursor position. The larger 
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the distance the faster the play tempo. You can set 3 individual scrub modes in 
the play parameter window . 

 

Zoom mode 

Right mouse button: Zooms out of the project. 
Left mouse button: Zooms into the project. 
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Button overview 

When the program is first started, only the tools and mouse mode bars are 
opened in the upper right corner of the monitor. All further ones may be added 
via menu ”windows”. 

All toolbars may be placed on the screen at discretion, and they are 
automatically arranged in the upper part of the screen by a double click onto 
the header line. 

 

Toolbar (left section) 

 

1 New Virtual Project 
2 Load VIP  
3 Load audio file 
4 Export/save 
5 Cut 
6 Copy 
7 Insert 
8 Split object  
9 Glue object 
10 Undo (Undo) 
11 Restore (Redo) 
12 Grid on/off 
13 Auto crossfade on/off 
14 Crossfade editor 
15 Group 
16 Ungroup 
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Toolbar (right section) 

 

1 Set marker 
2 Set CD track 
3 Set subindex 
4 Set pause 
5 Set CD end 
6 Set indices at object borders 
7 Make CD 
8 Loop playback 
9 Play range 
10 End playback (stop) 
11 Recording options [R] 
12 Multi-cards/MIDI recording 
13 Mixer 
 

Mouse mode bar 

 

1 Universal mode 
2 Range mode 
3 Curve mode 
4 Object and curve mode 
5 Cut mode 
6 Pitchshift/Timestrech mode 
7 Draw volume mode 
8 Draw panorama mode 
9 Draw wave mode (wave projects only) 
10 Scrubbing mouse mode 
11 Zoom mode 
 



 
 

Button overview 71  

 

www.magix.com

Position bar (left side) 

 

1 To beginning 
2 One section left 
3 Half section left 
4 Half section right 
5 One section right 
6 To end 
7 To previous object edge 
8 To next object edge 
9 To previous marker 
10 To next marker 
11 Zoom in 
12 Zoom out 
13 Show entire project 
14 Zoom to range 
15 1 pixel = 1 sample 

 

Position bar (right) 

 

1 Zoom range 1 second 
2 Zoom range 10 seconds 
3 Zoom range 60 seconds 
4 Zoom range 10 minutes 
5 Reduce section vertically (zoom out) 
6 Increase section vertically (zoom in) 
7 Show all vertically 
8 Show range vertically 
9 Zoom into waveform 
10 Zoom out of waveform 
11 Overview mode 
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Range bar 

 

1 Play cursor to start of range 
2 Play cursor to end of range 
3 Fold range to the left 
4 Fold range to the right 
5 Start range at previous zero point 
6 Start range at next zero point 
7 End range at previous zero point 
8 End range at next zero point 
9 Range editor 
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Functional overview 

Working with objects in the VIP 

Loading an audio file into a VIP object 

Method 1: Loading a file into a VIP 

Mark a range in the VIP and load the wave file with "File -> Open project -> 
Audio file". The file is inserted at the beginning of the selected range as an 
object. The range also denotes the track into which the wave file is inserted. 

Method 2: Drag & drop from Windows Explorer 

Open Windows Explorer and arrange the Explorer and Samplitude 11.5 
Producer windows so that both are at hand. Access the audio file in Explorer 
that you would like to use, and then simply drag it over into Samplitude 11.5 
Producer while holding down the mouse button. 

 

Load ranges from wave projects into the VIP 

 Open a wave project.  
 Mark the range which is to be incorporated into a virtual project. 
 Create a new virtual project with "File -> New multitrack project" ("E") or with 

the corresponding button in the toolbar.  
 Tile the open windows by pressing enter. 
 Drag the selected range in the wave project into the virtual project by clicking 

the left mouse button into the range and then dragging it into a VIP track. 
 A new object is created in the VIP at the position the mouse button was 

released. 

 

Accessing audio material in an object 

 Select any object. 
 In the object menu, select ”Destructive editing”. The same menu option is 

available from the context sensitive menu by right clicking on the object. 
 This opens the corresponding wave project window. The marked range 

represents the audio material that is used in the VIP object. 

 

Selecting an object with the Mouse 

Clicking the left mouse button selects the desired object. 
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Prerequisite for this is the selection of the correct mouse mode: Object mode, 
object & curve mode, and universal tool mode all offer this functionality. In the 
universal tool mode, the object is selected by clicking on the lower half of the 
object. 

The five handles on the outline of the objects identify any selection of objects. 
While the mouse button is held down the outline of the object is displayed. 

Clicking the mouse button outside of the object deselects the object. 

 

Moving and duplicating objects 

Once one or several objects have been selected, they can be shifted vertically 
(by track number) and horizontally (in the timeline) while holding the left mouse 
button. As soon as you let go of the left mouse button, the object will be 
placed at the current position. 

If several objects have been selected in different tracks, the selected group can 
be moved vertically only so far that all objects remain within the tracks. 

If "Shift" is pressed when moving the objects, the time position is retained and 
you can only change the track. 

If "Ctrl" is pressed while moving the object selection, then a copy of the object 
selection is created. In this case, the copy of the original object selection is 
placed at the destination. The original objects maintain their position. 

 

Changing object borders in virtual projects 

The lower object handles of a selected object can be used to alter the object 
borders. The mouse can be used to change the object beginning or end. The 
object length can only be changed within the confines of the physical wave 
project window. 

This means that the beginning of the object can not be extended beyond the 
beginning or end of the corresponding wave project. Conversely, the end of 
the object cannot be extended beyond the beginning or end of the 
corresponding wave project. 

 

Fade in / Fade out and object volume 

The object handle in the top center can be used to set the object volume. The 
exact volume level in dB during the change is visible in the pop up window at 
the object.  
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The top left and right-hand handles of the object change the fade in and fade 
out settings of the object. 

Since these changes are applied in real time during playback of the project, 
then the original audio material is left intact. This allows easy set up of fades 
and volume levels without having to fear data loss. 

The curve types when fading in and out can be set in the crossfade editor. 

 

Overlapping objects 

A track (channel) can only play back one object at a time. 

If one object is moved over another object, then the previous object is partially 
or completely taken out of the playback list (much like one sheet of paper 
covers another partially or completely). The invisible part of a covered object 
will not be audible. By moving the covering object out of the way, the covered 
section or the complete object can be made audible again. To create a 
crossfade between two objects that are intersecting each other, the crossfade 
editor in the "Edit" menu can be used. 

 

Object editor 

 
 

The object effects window 

FX inserts 

AudioStudio FX inserts supports the following high-end audio effects:  

 Clean FX (denoiser, dehisser) 
 Sound FX  
 Vocoder (also contains a real-time freehand correction filter to filter out 

dissonant frequencies  
 FFT-EQ with SoundCloner 
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These effects are assigned to each audio object in real time.  

In the "Volume/Pan" section you edit panorama and volume-specific settings.  

The "On" buttons switch plug-ins on or off.  

Plug-ins 

The plug-in section offers you a very effective dialog for plug-in processing. 
With one click on an effect slot a menu opens in which you can select DirectX 
and VST plug-ins. This menu also contains an entry for the effects from the 
"Vintage effects suite". 

The practical "On" button makes it possible to switch the plug-ins on and off in 
a flash for comparison purposes. The "Edit" key makes it possible to configure 
the selected plug-ins and their settings. More detailed information can be 
found in the "Plug-ins" section. 

 

The position / fades window 

The length and end values of an object are given numerically in a number of 
formats. 

For all entry fields regarding duration, you can select a duration length from a 
list on the right. 

Position/Length  

Object start/end: Numerical entry field in the VIP  

Object length: Numerical object length. 

How to move an object in increments: Here the increments for shifting the 
object is numerically edited. The object is then shifted according to the 
selected increment when you press the arrow key behind the input field.  

Wave start: Shifts the wave content within the object. 

Wave project: Allows you to exchange wave projects and objects. 

 

The pitchshifting / timestretching window 

Pitch and duration of an object can be changed independently at the same 
time. In this window you can adjust pitchshifting and timestretching parameters 
for the selected object. For more details (in particular regarding the modes 
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used) please read "Resampling / Timestretching / Pitchshifting" in the "effects" 
section.  

Timestretching and pitchshifting can be employed independently of each other 
(except when resampling). 

Pitchshifting: Pitch realignment can be entered either as a factor relative to the 
initial value or absolutely in semi-tones and percentages.   

Timestretching (change of speed): Speed realignment can be entered either 
as a factor relative to the initial value or absolutely as a new object length. You 
can also enter a completely new tempo so long as the original speed of the 
object is entered. This is read either directly from the wave project, from the 
loop length, or determine automatically by stretching a range over the object. 

Note: One of most frequent applications of the object editor is the organization 
of your own CDs. Each song can be a separate object. This creates an 
extremely flexible working environment that is fast and efficient. 

 

Ranges 

Ranges are selected sections of the arrangement that can be set for editing or 
re-opening later on. When creating ranges you are not bound to object 
borders, individual tracks or any other limitations like markers. Ranges that you 
search for are displayed inverted. By switching on the "Grid" function in the 
"Project options" you can set the step size of the selection. 

 

Selecting a range 

To select an area, move the mouse pointer to the top half of an object and 
press the left mouse button. Move the mouse pointer within the object while 
keeping the mouse button held. Now you can see an inverted rectangle 
between the starting point and the current mouse position. Once you let go of 
the mouse button, the range will be selected. 
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The play cursor always automatically remains at the beginning of the range, 
even if you can't see it at this moment in time. To expand the range onto other 
tracks, click on the top half of the selected object again and drag the mouse 
down vertically while keeping the mouse button held. If you hold the Shift key 
and click in the range, all objects with a centrepoint within the selection 
rectangle will be selected. 

 

You can also select a range by dragging the mouse across the timeline. This 
will then be indicated by a different color. Double clicking this range in the 
timeline selects a range in the selected track; double clicking again selects the 
range over all tracks, and double clicking once more restores the simple 
timeline selection.  

In the timeline selection you can also position the play cursor outside the 
range. The range will be retained in Loop mode. This way you can start 
playback in front of or within a loop. In this case, the range edges may also be 
modified during playback. The playback range may be deleted by dragging to 
size 0. . Click the range borders in the timeline to position the play cursor at 
the playback borders. Double clicking the timeline outside of the range 
removes the playback range. 

 

Leaving a range 

To select a different range, click somewhere in the project other than the 
current range, and simply draw a new range. 
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Reactivating the range 

Enter shortcut Shift + Backspace. By clicking on this command repeatedly you 
can restore the last five ranges. You can execute the same function by clicking 
on the button with the left arrow in the transport control. 

 
 

Change range borders 

Timeline selection enables you to change the range edges by positioning the 
mouse over them. The mouse icon changes to a double arrow. The range 
borders may now be changed by dragging horizontally. 

To change the edge of an existing track range (start, end, top edge, or bottom 
edge), left click inside the range of the existing area and hold down the mouse 
button. Next, leave the range in the direction of the edge you would like to 
change while holding down the mouse button. As soon as the edge of the 
existing range has been crossed, the range edge will follow the movements of 
the mouse pointer. Once you have newly defined the range border, you can let 
go of the mouse button. The start of the range may be changed via the arrow 
keys, and the range's end may be changed by pressing "Shift + arrow". 

 

Horizontal movement of a range 

Left click within the existing range while holding down "Shift" and hold down 
the mouse button while moving the range horizontally. 

 

Saving and opening ranges/special range commands 

Selected ranges may be saved via the "Range" menu or by pressing "Alt" and 
via the function keys "F2 - F10", and then opened again via "Ctrl + F2 - F10".  

"Alt + F4" however, shouldn't be used, since this is a Windows command that 
closes the current screen. Similarly, "Alt + F9" should not be used either, since 
this is used for 4-point cut editing in Samplitude 11.5 Producer. On the other 
hand, you can redefine this keyboard shortcut for Samplitude 11.5 Producer 
whenever you like via "Options -> Program settings -> Shortcuts" and via the 
"Edit" menu. 
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Ranges may also be saved and renamed without any restrictions by pressing 
"Alt + F11". 

These and other special functions for defining, changing, and using ranges are 
available in the "Range" menu. This includes a range editor dialog for the exact 
numerical input of ranges and the range manager for quickly and easily viewing 
and selecting ranges. 

All menu commands for editing ranges are explained in the menu reference 
under "Range". 

 

Examples for working with ranges 

Sample 1: Moving multiple neighboring objects to a new position. Instead of 
selecting each object separately while holding down the Ctrl key, you can 
select a range that contains all objects. Select the desired objects via "Object 
-> Select objects -> Select objects in active track". 

Example 2: To remove a section of a song from the VIP window completely. 
This may be, for example, a verse of a song that should be cut out in order to 
reduce the overall length of the track. Select a range and activate all tracks by 
double clicking twice to select the affected verse. Next, select "Edit -> More -> 
Delete with time/ripple" to remove the verse. 

Example 3: To play a selected range as a loop. Activate the "Loop" button in 
the transport control. In this case, the range edges may be modified by 
dragging the handles on the edges. This enables previewing prior to making a 
cut. 

 

Working in wave projects 

A wave project contains the audio files. Objects in VIP refer to these audio files.  

Access the wave project via the respective wave window.  

When a VIP is open, you can’t normally see the wave window. In order to view 
it as an icon, activate the ”wave project as icon” option in the menu window. 
To hide it again, select ”Hide wave project”. 

The name of the wave project is in the title bar of the wave window along with 
the bit resolution, the length of the sample, and the resulting memory 
requirements. To activate a wave project, the appropriate window must be 
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clicked with the mouse. Samplitude 11.5 Producer can administer many wave 
projects on screen simultaneously. 

 

Virtual wave editing 

Samplitude 11.5 Producer now offers real non-destructive (virtual) wave 
editing. Basically, wave project edits are saved in a virtual domain as long as 
editing is being processed. This saves an enormous amount of time when 
editing waves! 

In order to start non-destructive wave editing, deactivate the settings in 
"Options -> Project properties -> Destructive wave editing mode”.  

When you select ”wave editing”, the wave project will by default be set to 
non-destructive editing mode. 

Selecting ”Destructive edit” confines the wave project to destructive wave 
editing mode. 

In the title bar of the wave window you can always see which wave editing 
mode (destructive or non-destructive) you are currently working in. The wave 
project in the image above is thus in destructive mode.  

 

Using markers 

Position marker 

Position markers serve as reminders for position points. They are visible as in a 
special line at the top edge of a project as named orange bars. Markers can be 
placed during playback as well as during recording. 

 Markers in wave projects are saved in the audio file (*.wave) as so-called 
"audio markers" and are available in this form in other applications as well. 

 Markers in wave projects can also be viewed and set in the VIP object (VIP 
display options). 

 A project can contain any number of markers. The first ten can be accessed 
directly using the number keys and receive the corresponding names "1" to 
"10". You can save these by pressing "Shift + 0 - 9". By pressing the 
corresponding number key you can jump back to the marker once again. 

 With the menu point "Range -> Remember marker -> Other"  you can define 
and name other markers.  

 To delete a marker, click on it and press "Del". markers can be moved by 
grabbing them and dragging them to where you want to go, the mouse 
pointer changes into a double arrow. 
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 If you right click within a marker line, a context menu will appear for access to 
all important commands. 

 You can manage and name markers in the marker manager ("Tools" menu or 
marker context menu). 

 To stretch a range between any two markers, click on the first marker, and 
then click on the second marker while holding down "Shift". This selects a new 
range. 

 To quickly move between the marker positions, use the shortcuts. See 
"Keyboard shortcuts" ("Range -> Move play cursor -> marker left/right"). 

CD markers 

CD markers are triangular markers for various CD burn functions. There are 

 CD track markers 
 CD subindex markers 
 CD pause markers 

MIDI markers 

 Beat markers for tempo changes at a specific position in the project 
 Signature markers for changes of the beat type from the marker position 

onwards (e.g. from 4/4 beat 3/4 beat)  
 Beat marker (option "Lock musical position (bar)"). Beat markers assign a 

certain musical position to a certain part. This way, the bar frame/grid and 
MIDI events can be easily synchronized with existing audio material. 

 

Volume 

The volume levels of objects and tracks/channels can be changed at various 
stages. 

 

Wave Project Level 

The volume level changes are applied to the audio material with "Effects -> 
Normalize -> Normalize file", or with "Fade in/out". 

The audio data is changed. The computer usage is not affected during 
playback. 
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Object level 

Every object can have an independent setting for its volume level. This can be 
performed by changing the upper handles of the object or with "Effects -> 
Amplitude/Normalize -> Normalize object". 

The audio data is not changed. The calculations are performed in real-time 
during playback. 

 

Track level 

The volume of every track can be changed dynamically with the volume 
automation curve and the volume fader in the mixer or the VIP. 

The audio data is not changed. The calculations are performed in real-time 
during playback. 

 

Output mode 

You can setup the output mode in the playback parameter dialog ("P"). 

With the "Sample rate" option you can choose a different sample rate as 
playback. "Device" allows you to select the desired playback device (if you 
have more then one active sound card). 

Please note that some sound cards are not be able to playback all sample 
rates.  

Note: Different recording and replay devices for individual tracks can be 
selected in the track information dialog rather than the play parameter window. 
Track information opens by clicking on the track number.  

 

Record 

Hard drive recording 

The device used to digitize audio signals is already included on the sound card 
and is called an analog/digital converter (A-to-D, ATD or A/D). In order to 
record, the A/D Converter gathers samples of the signal to be digitized in 
determined time lapses and measures its frequency. The rate is called ”sample 
rate” and normally lies in the kHz ranges. KHz means a vibrating frequency of 
several thousand times per second. The higher the rate, the more samples are 
taken by the A/D converter and the more natural the digital transformation of 
the sound will be. 
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The precision with which the A/D converter measures the analog signal is 
determined by the sample resolution. The finer the resolution, the better the 
digital transformation. 

CD-quality audio recordings are recorded with a sample rate of 44.1 kHz and 
16-bit resolution. 

 

Recording source 

First of all, the recording source must be connected to the sound card. There 
are several ways to do this, depending on your equipment. 

Microphone: Microphone signals must first be amplified before the sound card 
modifier can record them. Most sound cards have separate microphone inputs 
that pre-amplify signals, but the results are rarely professional. 

Quality: Connection to an external mixer or external microphone amplifier 
produces far better results. 

Amplifier: If, for example, you possess a guitar amplifier that has a line-out 
output, you can connect it with the line-in input on the sound card. 

Stereo system: The stereo system’s amplifier usually has a separate line-out. If 
instead, you see ”Aux. out sockets,” then you should use these. Connect them 
with the input on the sound card (usually shown in red). Normally, a 
high-fidelity (hi-fi) amplifier has cinch sockets and sound card mini-stereo catch 
sockets. You must have the corresponding cable to connect these properly. 

If the amplifier doesn’t have separate outputs (other than the loud speakers), 
then you can use the headphones socket for recording. In this case, you need 
a cable with two mini-stereo headphone connectors. This process has an 
advantage: you can control the signal level through the phones input. The 
disadvantage is that phones outputs are normally not very good. With cassette 
recordings, always use the cassette deck line out. Record transfers often leave 
you no other choice... Never connect a record player’s outputs directly to the 
sound card, because the phono signal must be pre-amplified first. If you don’t 
have a pre-amplifier, the only way to do this is via the phones output or an 
external amplifier 

 

Adjusting the signal 

Digital recordings through the sound card need optimal control in order to 
obtain the best sound quality. 

Once the recording source is connected to the sound card, open the recording 
dialog with the "Record" button and start the recording source. 
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You can check the control on the LED displays in the recording dialog. 

If the level is too high, reduce the incoming signal. If the recording source is 
connected through the amplifier or tape deck’s line out connectors, then you 
can reduce the incoming signal only by using the sound card’s mixer window. 
This is located in the recording dialog under the "Level control" tab. 

If you reduce the input sensibility with the sliding regulator (fader), then you 
also reduce (with many sound cards) the precision of the resolution of the 
digitized analog signal. This is why these controls should be kept at the loudest 
possible setting! 

The standard for optimal adjusting is naturally the loudest section of the 
material. This should be turned to the maximum setting 

 

Digital transfer 

With the recording function, digital audio data can be transferred to the hard 
drive through a digital interface (e.g. S/PDIF or ADAT). 

ADAT or DAT recorders normally produce data with a sampling rate of 48 kHz. 
For a CD project with 44.1 kHz you must convert the sampling rate. This is 
carried out in real time by Samplitude 11.5 Producer. The digital signal is read 
at 48 kHz, but is automatically converted and inserted into the project as an 
audio file at 44.1 kHz. 

For this to occur correctly, you must first set the sample rate of the incoming 
signal in the recording dialog. Click on the "Dev." button in the recording 
dialog. In the following dialog (sound card characteristics), set the audio 
recording formats supported by the sound card. 

Now, connect the digital output of your recorder to the digital input of your 
sound card, and now start recording! 

 

24-bit audio support 

Audio files in Samplitude 11.5 Producer can not only be recorded in 16-bit 
quality, but also in far superior 24-bit resolution. Simply click the ”device” 
button in the recording dialog, and select the ”24-bit” option under ”sound 
card properties”. 24-bit recordings require a high-quality audio card with 20 or 
24-bit converters, as well as a 24-bit-compatible NME drive. 24-bit audio 
material can also be transmitted via audio cards with SPDIF digital interfaces. 

We have had positive experiences with the 24-bit audio cards produced by 
Marian, RME, SEKD and Terratec. 
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The high resolution audio files are stored and edited in the 32-bit ”floating 
point” file format by Samplitude 11.5 Producer. This ensures the full 24-bit 
quality independent of the gauge. The dynamics may increase to over 140 dB, 
while the recording’s jamming transmission sinks (depending on the type of 
audio card) to 110 dB and more. Thanks to floating point processing, there is 
no need to worry about internal editing being distorted. Floating point 
processing only starts to distort at around 1,500 dB above zero, in contrast to 
a 16-bit signal which distorts immediately once the zero dB line has been 
crossed. 

Even in cases whereby audio material is intended for burning onto a 16-bit CD, 
it is worth selecting 24-bit recording, since all effects calculations are made in 
a higher quality and therefore no ”rounding” mistakes can be detected in the 
audible 16-bit range. 

24-bit recordings (via storage as 32-bit float files) take up twice as much 
storage space on the hard disk as 16-bit recordings. But with current hard disk 
storage capacities, it works out as a good compromise when one considers 
the increase in quality. 

High resolution audio files can be imported and exported as 24-bit wave files, 
enabling trouble-free file exchange with other high-quality audio systems. 

 

Further recording dialog possibilities 

The recording dialog also offers: 

 A string instrument tuner for creating the best sound possible before 
recording. Deviations from the standard pitch are graphically displayed. 

 The option of laying track markers (either manually or automatically) while 
recording a CD.  

 The option to directly incorporate a variety of audio formats, e.g. to save hard 
disk space. 

Please read the “Recording options” section of the “Playback menu” chapter to 
learn about all of the recording dialog options.
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Tips & tricks 

A few tricks that help make working with Samplitude 11.5 Producer easy: 

 

Working with projects 

 The "A" key will select the complete sample as a range. 
 "Home" and "End" set the play cursor to the beginning or end; all selected 

ranges will disappear. 
 A range can be selected from one exact marker position to the next by 

clicking on the marker above the wave. Next, hold "Shift" and click on the 
second marker. 

 Using the "Shift + mouse click" a range can be moved horizontally. 
 "Shift + Ctrl + arrow keys" will flip a range to the right or left. This is a great 

way of testing a loop at a different position. 
 Objects in Virtual projects can be displayed in two different modes. By 

pressing "Tab" you alternate between the modes. Pressing "Shift + Tab" will 
open a dialog window in which you can set the parameters of the display 
modes. 

 Using "Ctrl + mouse click" on an object copies the object. 
 Double clicking the mouse button on the volume curve creates and deletes 

volume handles. Activate the volume automation curve with "V" in each track 
of the VIP! 

 Change the function of the mouse buttons in VIPs with "Preferences -> Mouse 
mode", or use one of the mouse mode buttons in the mouse mode toolbar! 

 The function "Lock objects" allows you to lock objects to prevent accidental 
movement. This is especially useful for multitrack recording when the individual 
tracks need to stay in sync with each other. 

 To determine the tempo of a selected range (BPM), open the snap definition 
dialog ("Shift + R") and select the number of beats the selected range 
represents (for example: 4) in the "Free bar snap" section. Next, click on the 
"Get range" button in the "Free bar snap" section to retrieve the length of the 
selected range. The BPM display in the "Fixed bar snap" section now displays 
the BPM of the audio section. 

 Try the right mouse button on various components of the VIP window! A 
context-sensitive popup menu is displayed which features useful functions 
depending on the window component you clicked on. Among them are 
objects, "Record" and "Mute" buttons, and the scrollbars. 

 "Delete" deletes markers when the play cursor (real-time cursor) is located 
exactly on the marker. The same key deletes any selected objects and deletes 
ranges that are selected. 

 "T" separates a selected object at the position of the play cursor. If a range is 
selected within the object, the object is separated on the range borders, which 
results in three objects. If auto crossfade mode is active while the separation 
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takes place, Samplitude 11.5 Producer adds smooth crossfades at the 
separation points. These crossfades can later be edited for further refinement. 
Use the crossfade editor to change the crossfade aspects. 

 Multiple zoom levels can be saved to the four "Z" buttons in the lower 
left-hand corner of the virtual project window. Use "Shift + left mouse click" to 
store a zoom level to a specific preset button. When clicking on a previously 
assigned preset button, the zoom level is recalled. The "S" preset buttons can 
be used with "Shift + left mouse click" to store a complete window 
configuration set. This includes the scroll position of the window and the 
mute/solo assignments for the tracks. This offers four mute/solo groups that 
can be quickly recalled. 

 Multiple objects can be selected by holding "Ctrl" and individually clicking on 
the desired object. 

 Holding "Shift" and clicking the mouse button behind the last object you want 
to select will select objects between the two points. 

 wave, HDP, and RAP projects, as well as stored objects, can be opened with 
Windows Explorer by dragging them from the Explorer window to the 
Samplitude 11.5 Producer window. A special menu option is available to open 
Explorer from within Samplitude 11.5 Producer with "Tools -> Explore the 
HDP directory". The default folder opened in Explorer is the same as the HD 
project settings in the system dialog ("Y"). 

 "Shift + Tab" can be used to display the VIP display mode dialog. This dialog 
allows you to change VIP display aspects like the VIP window behavior when 
an object or range is moved toward the currently displayed window borders 
(VIP border scroll). 

 Press "Enter" and all open windows are tiled on the Samplitude 11.5 Producer 
screen. This is a good starting point when using drag & drop functionality to 
move ranges and objects between individual project windows. 

 Use the menu option "Edit -> Edit tracks" to manipulate complete tracks. This 
includes adding new tracks, inserting tracks and rearranging tracks. 

 

Mixer 

 Clicking the right mouse button on a mixer effect control knob or element 
opens the associated effects dialog. 

 A double click on the middle of a control knob or element returns it to the 
passive default setting. Another double click resets the element to the 
previous position. 

 Clicking on the left or right outer limits of a control knob changes the setting in 
individual increments. 

 In the mixer window, multiple channels can be soloed simultaneously. When 
holding "Shift" and clicking on "Solo", all previously soloed channels are 
un-soloed and the single channel is soloed. 

 The "Master normalization" function in the mixer window can be used to 
instantaneously adjust the output level to 0 dB, no matter how loud or soft the 
master output signal is. 
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Performance 

If errors occur during playback, you have the following options: 

 Increase the VIP and HD buffer in the system dialog ("Y"). 
 Zoom out to project full view ("A" button at position bar) 
 Deactivate the "Autoscroll" function in the playback parameters dialog ("P"). 
 Reduce the number of displayed image elements of the VIP window in the 

object display in virtual projects dialog ("Shift + Tab"). 
 Bounce several tracks by mixdown and mute the original tracks. 
 Reduce the used real-time effects in the object editor or mixer. 
 Do not use plug-ins, since they increase the CPU load. 
 In Windows NT, the playback performance of the hard disk system is 

particularly good if the corresponding files are played for the first time. So, if a 
VIP with many tracks is not played perfectly, save it, close all windows ("H") 
and open the VIP again. Now the NT file system performance is optimum 
again. 

 It often helps to run two copies of Samplitude 11.5 Producer at the same time 
(simply start it twice from the desktop). This allows you to work on an 
extensive effect processing, a longer recording, the creation of a CD, or any 
other unattended procedure, while working on another aspect of a second VIP 
or project. When working on dual processor systems in Windows NT, both 
instances use the full capacity of one of the processors. Even under Windows 
95 this technique can be used to work more effectively. Make sure you disable 
the option "Check space bar for playback…" in the system dialog ("Y") to 
prevent the program in the background to stop any process. 

 

Recording / Playback 

 The recording window can be displayed by pressing "R". The recording can 
be started with "R" and stopped with "S" when the recording window is 
displayed and active. 

 Playback can be started and stopped with the space bar. When stopping, the 
play cursor returns to the original position. If the playback is stopped with "0" 
on the numeric keypad, the cursor will stop at the current playback position. 
Continuing to hold "0", while moving the mouse (scrubbing) can alter the exact 
position. 
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Effects and effect plug-ins 

Samplitude 11.5 Producer contains many high-quality effects and effects 
plug-ins (MAGIX plug-ins) as well as interfaces for external VST plug-ins and 
DirectX plug-ins. 

 

What effects are there, and how are they used? 

There is generally a difference between the effects types. The following effects 
occur in Samplitude 11.5 Producer: 

Real-time effects: These effects are also referred to as "non-destructive" or 
"virtual" effects, and they are added to the original sound while it is played. 
This means that the original file remains unchanged on the hard drive. 

Offline effects: These effects are also called "destructive effects", and they are 
added to the audio file before it is played; either the original file is changed, or 
a copy is created on the hard drive for working with. 

These effects are independent effects modules, i.e. they are provided by third 
party vendors or programmers. In Samplitude 11.5 Producer we distinguish 
between three types of effects plug-ins: "MAGIX plug-ins", "DirectX plug-ins", 
and "VST plug-ins". 

The area of application is a further criteria for effects. The following are 
integrated into Samplitude 11.5 Producer: 

 Object effects (can be accessed via the object editor or the "Real-time 
effects" menu) 

 wave effects (can be accessed via the "Offline effects" menu) 
 Track effects (can be accessed via the trackbox plug-in selection button or 

the trackbox plug-in) 
 Mixer channel effects (can be accessed via the "Insert" section of the mixer): 

These real-time effects affect track effects the same way as complete tracks. 
 AUX effects: (accessible via the track editor and trackbox): These effects can 

be installed identically for several tracks, or individually. 
 Surround effects (accessible via the insert selection box of the corresponding 

Surround bus channel, track editor, and trackbox): These effects serve for 
editing surround material. 

 Master effects (can be accessed via the "Master" section of the mixer): These 
effects are for editing the master sound. 
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Most of the effects modules, i.e. equalizers, compressors, reverb, echo, etc., 
can be used in several of the above versions. However, they are only 
described at one position within this documentation. All effects and effect 
plug-ins that are NOT offline effects and can be activated via the "Offline 
effects menu" are explained in the following sections of this chapter. The other 
effects which can also be activated via the "Offline effects" menu, are 
described in more detail in the "Offline effects menu" chapter. 

 

Saving effect parameters (preset mechanism) 

The effect dialogs contain preset selection boxes. These presets are saved and 
recalled to/from the "FX preset" directory (a subdirectory of the main 
Samplitude 11.5 Producer program directory). 

If a preset is not located in this directory, it still can be loaded via the "Load 
setup" function, but it will not automatically appear in the selection box, so 
you'll need to browse for it. 

Effects that are added/launched from within the mixer or object editor are 
pre-configured with the values assigned to the virtual project. If the virtual 
project is to adopt particular changes made to the settings in the effects 
dialog, then you will need to click on "OK" to transfer them to the VIP. 

You also have the possibility to apply the settings of the last destructive effect; 
a corresponding entry can be found in the "Options" box. If there is no 
destructive application of the effect, then the parameters selected in the list 
entries will be applied to the default parameters for destructive editing. 

 

Dehisser 

The Dehisser eliminates regular ”white” noise typically produced by analogue 
tape recordings, microphones, pre-amplifiers, or converters. 

Noise level: Set the Dehisser’s input threshold as precisely as possible. Low 
settings result in incomplete deletion of the hissing. An incomplete deletion of 
the hissing produces artifacts and should be avoided. High settings produce 
dull results. Useful signals (e.g. the blow of a wind instrument) that are similar 
to hissing are also filtered away. If the level of the hissing is low, the setting is 
no problem. 

Audio type: Lets you set the audio material that is to be edited; the algorithm 
is adjusted accordingly. 
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Noise reduction: Set the attenuation of the hissing in decibels. It often makes 
sense to reduce the hissing by only 3 to 6 dB in order to keep the audio 
material sounding natural. 

Removed hiss: To test your results, you can listen to the filtered-away part of 
the music prior to downloading or burning onto a CD. Remember, this is for 
test purposes only. 

Quality: The processing quality can be set in two stages. You can use this to 
precisely adjust the values in the dialog for standard quality adjustment without 
skipping playback, and can then select a higher quality for final burning. 

Adaptive: The value for the noise level parameter is set automatically by 
determining the hiss contained in the signal. If the noise level value is changed, 
its effect becomes relative, i.e. the resulting value is determined from the 
automation as well as the noise level controller settings. 

One advantage of this is that you no longer have to set the noise level value 
manually and that this value can also be adjusted later if the noisy portion 
fluctuates, e.g. if you use music tracks with differing hiss levels within one 
project. 

If the noise level is constant, then a better result may be obtained manually 
(adaptive off). However, the noise level value must then be set precisely. 
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"Sound FX" (object editor, mixer channels, 
Mixmaster) 

Sound FX features an effects rack with the following virtual effects devices: 

 
 

Equalizer 

The 10-track equalizer divides the frequency spectrum into 10 areas (tracks) 
and supplies them with separated volume controls, which allows you to 
achieve many impressive effects, from the simple rising of the bass, to total 
sound transformation. If you raise the low frequencies too much throughout the 
whole level, it can cause distortions. In this case, lower the master volume 
using the master volume control on the main screen. 

Thumb controls: Each of the 10 frequency areas can be raised or decreased 
separately by the 10 volume controls. 

Link bands: Using this switch you can match the frequency areas in a flexible 
way to avoid overemphasizing single frequency areas that sound artificial. 

A/B: If you have selected a preset for the effect and later you change it 
manually, you can compare the original preset sound with the new adjustments 
using the A/B switch. 
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Reset: Reset inserts the sound effect into the neutral starting position where 
no processing power is used and where no effect is calculated in the sound. 

Touchscreen (right EQ section): This is the ”sensor field” of the EQ: Use your 
mouse to draw a curve that will be transferred immediately into the 
corresponding EQ control adjustment. 

 

Compressor 

The compressor is essentially an automated dynamic volume control. Tune 
dynamics are limited; loud passages stay loud, and low-passages become 
louder. Compression is often used to make the material more powerful. The 
degree of compression is adjusted by the ratio control, and ”Threshold” 
determines the entry threshold. Rise and decrease of time can be influenced 
by attack and release. 

The processing is realized ”in advance”, as often occurs in high-quality studio 
equipment. This means that there won’t be any overdriven peaks or other 
artifacts, as the algorithm can never be ”surprised” by the peak levels. 

Sensor field: The sensor field of the compressor can be intuitively altered with 
mouse movement. 

Ratio: This parameter controls compression intensity. 

Threshold: Adjusts the entry threshold of the compression. 

Attack: Adjusts the time in which the algorithm responds on the rising level. 
Short attack times can produce a ”pumping” sound as the volume is reduced 
or raised. 

Release: Adjusts the time in which the algorithm responds to decreasing 
levels. 

A/B: If you have selected a preset for the effect and later you change it 
manually, you can compare the original-preset-sound with the new 
adjustments using the A/B-switch. 

Reset: Reset places the sound effect to the neutral starting position where no 
processing power is used and where no effect is calculated in the sound. 

Load/Save: Stores the current adjustments as an effect file in order to use 
them for other projects. 
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Vitalizer 

The Vitalizer enables the justification of the audio material in the stereo 
panorama to be adjusted. If stereo recordings sound unfocused and 
undifferentiated, an extension of the stereo base-width often provides 
increased transparency. 

Use the maximize function to move the echo and improve the stereo picture, 
for example, into the foreground. 

 

Volume controller: Adjusts the volume of every single channel to adjust the 
complete panorama. The reduction of left and right levels is displayed under 
the control buttons in dB. 

Pan-direction: Use this controller to move the sound source from the middle 
into stereo panorama. The signals at the outer edges of the sound picture 
remain unchanged. 

Multiband: This option switches from "Stereo FX" to "Multiband" mode. Stereo 
editing only applies to the middle frequency; the bass and highs remain 
unchanged. 

Bandwidth/maximize sensor field: Adjusts the base width between mono 
(extreme left), unchanged base width (normal stereo), and maximum base 
width (wide, extreme right). Raising the base width (values over 100) diminishes 
mono compatibility. Recordings edited this way may sound slightly hollow 
when listened to in mono. 

Maximize strengthens the spatial component of the recording, which also 
increases the stereo transparency without influencing the mono compatibility. 

Stereo meter (correlation gauge): This provides a graphical display of the 
phase relation of the audio signal. Use this to review the orientation of the 
signal in the stereo balance and the effect of the stereo enhancer. To maintain 
mono-compatibility, the "cloud" shown should always be higher than it is wide. 

 

Echo / Reverb 

Reverb 
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"Reverb" gives you a high-quality reverb which can be specified further using 
"Room Size", "Time" and "Color" and mixed into the original sound with "Mix". 
You can choose between various reverb styles in the presets. 

Room size: This controller controls a room simulator, which calculates the 
reverb effect according to the room size. If the controller is turned all the way 
to the left, then it sounds as if the audio object was recorded in a very small 
room. If it is turned all the way to the right, it sounds as if the audio object was 
recorded in a cathedral. 

Time: This is where you set the reverb tail's length, i.e. the sound's "sustain" 
level. 

Color: Control the sound of the reverb here, dampen or brighten it. 

Mix: This controller determines how much of the unprocessed original sound 
(dry signal) is subjected to reverb (wet signal). 

Echo 

The echo effect is further refined with "Delay" and "Feedback" amounts and 
calculated into the original sound by means of "Mix". 

Delay: This sets the period of time between the individual echoes. The more 
the control is turned to the left, the faster the echoes will follow each other. 

Feedback: This adjusts the number of echoes. Turn the dial completely to the 
left, there is no echo at all; turn it completely to the right and there are 
seemingly endless repetitions. 
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Parametric equalizer (track effects, mixer channels, 
Mixmaster) 

 

This dialog contains a 4-band parametric equalizer. With the parametric 
4-band equalizer, filters can be activated on four freely selectable frequency 
bands in order to adjust the sound of a sample. You can produce wide-band 
frequency adjustments for both high and low pass ranges as well as 
small-band corrections of specific frequency ranges. 

Use the Play/Stop button to activate the real-time preview function. This lets 
you check the acoustics of the filter setting before it is calculated into the 
sample by clicking "OK". 

Freq. (frequency): The center frequency of the individual filters can be set 
between 10 Hz and 24 kHz with the frequency controllers. Freely choosing the 
frequency enables multiple filters to be set to the same frequency in order to 
have a greater effect. 

Q (Bandwidth): Here you can set the bandwidth of the individual filters to 
between 10 Hz and 10 kHz. 

Gain: These controllers allow you to raise or lower the filter. Setting the 
controller to 0 deactivates the filter and doesn't use CPU power. 
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Volume: Use this controller to adjust the master volume should the level rise or 
sink too much while filtering. 

Setup 1-3: Here you can switch between three different filter setups so that an 
acoustic comparison between the various settings can be performed, for 
example, during the preview function (Play/Stop button). 

 

MAGIX Mastering Suite (Mixmaster) 

 
 

Parametric equalizer 

The parametric equalizer consists of four filter bands to form the sound of the 
music track. Each band is a filter with a typical “bell shape”. Within a certain 
frequency range around an adjustable middle frequency you can increase or 
reduce the signal level gain. The width of this frequency range is called 
bandwidth. The bandwidth is defined by the Q value. The higher the Q value, 
the narrower and steeper the filter curve. 

You can influence the basic sound of the mix by increasing and decreasing the 
broadband so as to give it more “depth” (lower center 200-600 Hz) or more 
“air” (Highs 10 kHz). You can also decrease the narrow bandwidth (high Q 
value) in the frequency response to remove, for example, disruptive 
frequencies. 
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Graphic: The resulting frequency path of the equalizer is displayed in the 
graphic. The frequency is spread out horizontally, the increase or decrease of 
the respective frequency, vertically. The blue bullets 1-4 symbolize the four 
wave bands. You can move them around with the mouse until you find your 
desired frequency response. 

Peak meter: With the peak meter you can control the output level of the 
equalizer. The adjacent master gain controller can be used to balance the level 
with the EQ. 

Edit: The “Edit” button opens the fine tuning for the four bands: 

Parameter selection: With the buttons on the right you can select the 
parameter that can be adjusted with four faders of each band. Furthermore, 
there are number keys to enter every parameter of the bands. 

Gain dB: These controllers allow you to raise or lower the filter. Setting the 
controller to 0 deactivates the filter and doesn’t use CPU power.  

Freq. Hz: The center frequency of the individual filters can be set between 10 
Hz and 24 kHz with the frequency controllers. Freely choosing the frequency 
enables multiple filters to be set to the same frequency in order to have a 
greater effect. 

Q (bandwidth): Here you can set the bandwidth of the individual filters to 
between 10 Hz and 10 kHz. 

There is still a peculiarity among bands 1 and 4: Their filter curve can be 
changed from a normal “peaking” EQ filter to “shelving” (this is the basic 
setting) and high (band 1) or high-pass (band 4). When using the “shelving” 
filter, a soft increase or decrease in all frequencies happens above or below 
the filter frequency, the Q parameter does not have a function here. With a 
low-pass or high-pass filter, all frequencies below (low-pass) or above 
(high-pass) the set frequency are filtered out. 

 

Vitalizer 

The Vitalizer enables the justification of the audio material in the stereo 
panorama to be adjusted. If stereo recordings sound unfocused and 
undifferentiated, an extension of the stereo base-width often provides 
increased transparency. 
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Use the maximize function to move the echo and improve the stereo picture, 
for example, into the foreground. 

 

Volume controller: Adjusts the volume of every single channel to adjust the 
complete panorama. The reduction of left and right levels is displayed under 
the control buttons in dB. 

Pan-direction: Use this controller to move the sound source from the middle 
into stereo panorama. The signals at the outer edges of the sound picture 
remain unchanged. 

Multiband: This option switches from "Stereo FX" to "Multiband" mode. Stereo 
editing only applies to the middle frequency; the bass and highs remain 
unchanged. 

Bandwidth/maximize sensor field: Adjusts the base width between mono 
(extreme left), unchanged base width (normal stereo), and maximum base 
width (wide, extreme right). Raising the base width (values over 100) diminishes 
mono compatibility. Recordings edited this way may sound slightly hollow 
when listened to in mono. 

Maximize strengthens the spatial component of the recording, which also 
increases the stereo transparency without influencing the mono compatibility. 

Stereo meter (correlation gauge): This provides a graphical display of the 
phase relation of the audio signal. Use this to review the orientation of the 
signal in the stereo balance and the effect of the stereo enhancer. To maintain 
mono-compatibility, the "cloud" shown should always be higher than it is wide. 
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Multimax 

MultiMax is a compressor with three independent frequency bands. The 
dynamics are edited separately for each band. 

The benefit of a multi-band compressor in comparison to a "normal" 
compressor is that the "pumping" tendency and other disturbing side effects 
are dramatically reduced when editing the dynamics. For instance, it can 
prevent a bass top peak from "reducing" the entire signal. 

Multi-band technology also lets you specifically edit individual frequency 
ranges. 

 

Link bands: When this function is activated and one fader is adjusted, all 
faders are changed in the same ratio. However, the way the dynamics are 
edited is not affected. 

Limiter: MultiMax includes a limiter that prevents clipping by automatically 
lowering the level if it is set too high. Quiet parts remain unaffected.  

High quality: When the "High quality" setting is activated, an even more 
precise algorithm is used which, however, requires more processing power. 
We recommend that you switch on this setting before you export the project. 

Bass/Mid/High: These knobs control the level of compression for each 
frequency band. 

Setting the frequency bands: The settings of the frequency bands are 
changed directly in the graphic. Simply click on the separator lines and move 
them. 

Presets 

In MultiMax, you can use the presets to open further special functions: 

Dynamic expander: Too high a compression rate will result in audible noise 
(usually defined as a pumping sound). Radio recordings in particular are 
recorded with very high compression rates to increase the perceived volume. 
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Unfortunately compression reduces the dynamics (interval between the 
quietest and loudest part). The expander enhances the dynamics of the 
recording. 

Tape NR-B Decoder: Samplitude 11.5 Producer simulates decoding of Dolby 
B + C noise suppression if no Dolby player is available. Cassettes recorded 
with Dolby B or C sound more muffled and slurry if played back without 
corresponding Dolby.  

Noise Gate: This cleaning function completely suppresses noises which are 
below a certain volume threshold. This lets you create song transitions that are 
entirely noise-free, for example. 

Leveler: This setting automatically sets the entire material to an identical 
volume level. The volume control knob is no longer required. You can use this 
function to equalize greater volume differences within a song. To equalize 
volume variations between different songs, you can also use the function 
"Loudness adaptation" from the Effects menu. 

DeEsser: These special presets are for removing overstressed hiss sounds 
from speech recordings. 

 

Digital audiometer 

On the lower border of the MAGIX Mastering Suite there is a digital audiometer 
which provides separate control method displays for every channel for 10 wave 
bands. This device is used for orientation, for selective equalizer editing, etc. 
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Vintage Effects Suite (track effects, mixer channels, 
mix master) 

Analog Delay 

 

This delay offers creative playing along with common delay effects. "Analog" in 
this case means, for instance, that you can change the delay times while 
playing without the risk of typical, scratching artefacts developing. Instead, the 
times are softly faded out, similar to the old tape echo machines that used the 
tape speed to change the delay and where the system also had a certain 
sluggishness.  

"analog" in terms of this delay also means that typical tape echo sounds can 
be mimicked, e.g. tape speed fluctuations and reduced highs during playback 
("feedback"). The feedback has a two-band filter that can be used to create 
dark, high, or mid repetitions depending on the settings.  

These properties can be useful, for example to create "wild" dub/reggae-style 
delays that move towards the center of the sound with each repetition and 
even grind slightly. In this case, "analog" means that you cannot digitally 
overdrive the delay. Even in a 'looped' repetition, the signal cannot be 
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distorted indefinitely, but it is compressed by an increasingly slight degree and 
distorted similar to a tape. 

 

Analog delay parameter 

Analog delay has the following parameters: 

Delay type 

Delay type (l + r): Left and right delay times can be controlled separately (see 
below). You can choose a note value for the control pots to snap to. Even and 
syncopated note values from 1/2 to 1/32 are available. Note that the delay 
times are always in relation to the project’s current tempo. 

 Link button (lock symbol): Press this button to control the “delay type” 
pots for both channels simultaneously. 

Mix: Adjusts the ration between the original signal and the echo. 

Modulation 

Speed: The tape warble speed. Low values result in very light fluctuations, high 
values result in drastic warbling. 

Depth: The warble intensity. When this control is turned all the way to the left, 
there is no pitch modulation. For a subtle "analog" feel, we recommend a 
setting between the 9 and 11 o’clock position. 

Filter 

"Low" This control progressively reduces the bass frequency as it is 
turned to the right, making the signal sound "thinner". 

"High"  Once turned all the way to the right, the control only 
attenuates the treble very lightly; turned completely to the left, 
the delay repetitions become progressively less treble. 

Feedback 

Width: This controls the stereo width of the delay repetitions. When you turn 
“Width” to the right, an additional effect is produced: the panning of the delays 
increases. This is commonly referred to as a "ping-pong" delay. 

Drive: When this control is turned all the way to the left, the delayed signal is 
repeated only once. Turned all the way to the right, the feedback is seemingly 
endless and the repetitions continue for a long time.  
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The actual strength of the effect is dependent on the material, since the 
feedback loop (as explained earlier) is addressed via compression and uses a 
"tape saturation" effect. If you send a "loud" signal to the delay, then the 
feedback will sound longer than at a lower level as compression "brings it up" 
to a certain level. If you are used to "purely digital" delays, then this might take 
some getting used to, but it will probably sound "livelier". 

 

Flanger 

 

The "Flange" effect is similar to that of the chorus, but does have a different 
technical and historical background. It came about by chance: Someone 
(various sources say John Lennon) slowed down one of two running 
interconnected tape machines in a studio with his hand. The result: The rather 
brief delay of the second signal compared to the first resulted in cancellations 
within the frequency spectrum, leading to a so-called comb filter effect (the 
sum of both signals creates "peaks" and "lows" in the spectrum that look 
familiar to the teeth of a comb).  

Flanging is basically a chorus effect, but it has a lower delay time (less than 10 
ms). "Release" or signal doubling is not highlighted here; the result is a much 
more creative frequency response deformation.  
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A "complete" flange effect will definitely require feedback: The flange portion is 
returned to the input to increase the effect. People often talk about the "jet 
effect", since it resembles a jet on take-off. 

 

Flanger parameters 

Speed: Modulation speed. 

Depth: The overall amount of modulation. 

Feedback: The volume of the internal feedback loop. 

Mode:  

Normal: Flanging. 

Dual: Two parts, panned left and right.  

Quad: Four parts, alternately panned left and right. 

Quad pan: Like “Quad”, but the “Depth” control also sets the intensity of the 
signal’s pan movements between left and right. 
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Filter 

 

"Filter" is a "modulation" effect like chorus and flanger. However, it controls the 
frequency response of a modulation source as well as the pitch. There are 
various filter types and modulation sizes available for this.  

Possible areas of application are synthesizer sounds (filter sweeps on pads) or 
creative distortions of drumloops (e.g. for variations, fills, etc). With guitars you 
can create typical 'wah' effects: either by tempo modulation or in a special 
mode, modulation via the envelope curve. The decisive factor is the current 
signal strength above the frequency set for the filter. 

 

Filter parameters 

Speed: The modulation speed is set by note values ranging from 1/1 to 1/16 
(even or dotted). Similar to analog delay, the tempo information is automatically 
provided by the arrangement.  

A peculiarity of the final position of the controller:  
Tempo synchronization stops and modulation is controlled via the signal level. 
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Freq: This is the base frequency for modulating the filter, and generally takes 
place above this frequency, i.e. the modulation increases the filter frequency. 

Depth: This control determines the modulation depth, i.e. the amount by which 
the speed control (or envelope mode, as described above) increases the base 
frequency. For extreme effects, turn “Freq” all the way to the left and “Depth” 
all the way to the right. 

Filter modes 

Low-pass  A filter with a slope of 24 dB/octave and a small 
amount of resonance. The treble frequencies above 
the base frequency (cut-off frequency) are filtered 
steeply. This is great for filter sweeps on synth pads 
and drum loops. 

Band-pass  Only the frequencies around the base frequency are 
passed through the filter (24 dB slope with 
resonance). Use this mode to create wah-wah effects 
for guitars. 

Band 
elimination 
(„Notch-Filter")

 Two parallel filters (–36 dB) with linked base 
frequencies create two ‘notches’ in the frequency 
spectrum. This allows you to create interesting sounds 
(e.g. guitar chords), and it sounds similar to a phaser. 

High-pass  This mode achieves the opposite effect to the 
low-pass filter. Frequencies below the base frequency 
are filtered steeply. If you ‘thin out’ sections of your 
track (for example, a drum track) with a tempo-based 
modulation, this can sound very effective when 
contrasted with the full-range frequency spectrum (for 
example, if the filter is turned off for the next object). 
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Chorus 

 

The chorus pedal creates characteristic "floating" sounds which one typically 
recognizes from guitar or synth pads. You can add acoustic "depth" to an 
instrument to add more power to the sound or to create the illusion that it 
exists multiple times.  

The chorus sound is created by using the so-called Doppler effect. You 
probably have noticed this phenomenon daily life: The sound of an 
approaching ambulance sounds higher than when it is moving away. This 
effect is a result of the speed of the sound which first increases and then 
decreases, thus also changing the sound pitch. If there were a second siren at 
your location, an oscillation would develop between both sounds (just like 
when two instruments are out of tune). 

Chorus also splits the signal in at least two: direct sound and effects part. The 
double effect is created by a short signal delay of the effect.  

This delay is within the range of 10-30 ms (as in this one), this means that it is 
short enough to be perceived as an "echo". The times would also be similarly 
short if you were to double a guitar track for instance. A short delay in the mix 
already sounds "doubled" but is not authentic. This is where the 
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above-mentioned "out-of-tune" effect comes in: The pitch of the effect signal is 
slightly modulated by gently "drifting" forward and backward in the delay curve. 
The result is a floating effect where the speed is influenced by drifting 

 

Chorus parameters 

You can enter the following parameters to control the floating effect: 

Speed: Modulation speed. Low speeds create an even, continuous 
development. High speeds produce vibrato-like qualities, but can also result in 
an "underwater" effect. 

Depth: Modulation depth. This determines how strongly the speed affects the 
pitch modulation.  

Mix: This sets the balance between the direct signal and the effects signal.  

Mode: You can choose between four operating modes of the chorus effect:  

“Normal” is a combination of the direct signal and the detuned delay signal.  

“Normal, low-pass” is designed for bass-heavy signals like bass guitar. The 
bottom end of the signal stays clear and well-defined, the effect is only audible 
for the mid and treble frequencies.  

“Dual” makes the source sound more lively than a single "part". The sound is 
spread over the stereo panorama, which makes this mode seem "wider". The 
character of the sound becomes livelier than with a single voice only, and it is 
also distributed over the stereo panorama, making the mode sound "broader". 

“Quad, low-pass” is ideal for creating sounds such as deep synth pads with 
tight bass frequencies. 

Tip: Similar to the stomp boxes our vintage effects are modeled on, there is a 
"footswitch" below the pedal’s logo that can be clicked to turn the effect on or 
off for A/B comparisons. All the effects of the Vintage Effects Suite have been 
designed like this. 
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Distortion 

  

The distortion pedal is a "high gain" distorter for crunch and lead guitar 
sounds. If you like typically "British" amp sounds and want to quickly record a 
guitar track with little effort, this pedal is for you. 

An entire valve pre-amp circuit has been modeled, including the typical EQ 
curve. The amplification is "valve-typical", i.e. it doesn't start quickly but is 
harmonic and soft. Even at full power the pedal still reacts softly to a guitar and 
its settings (e.g. pick-up choice and tone controller). For instance, you can 
influence the distortion even more by using the volume knob on the guitar. 

There are only three parameters on this effect; however, these interact with 
each other and can thus generate quite a variable sound: 

 Low: The "bass" controller. This allows you to set the share of basses, even 
after the distortion. The type of prefiltering is important for guitar amps in 
particular, and is characteristic for the basic sound. You should set the bass 
controller depending on the basic sound of the guitar and the sound you are 
aiming for ("powerful" or "cut"). 

 High: Mainly controls the share of highs before and after the distortion. If you 
are not using an external guitar speaker as a monitor, we recommend setting 
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the controller to the middle position or even moving it slightly to the right. This 
way the "sharp" highs disappear, which all guitar amps generate without the 
suitable loudspeaker. At the same time the mids stand out more, which gives 
the sound more "kick". On the other hand you can further emphasize the 
highs if you want the sound to be more neutral.  

 Drive: The level of distortion. This controls the amplification used to operate 
the "virtual valve circuit" (max. 60 dB). As the level increases, the valve goes 
into overdrive and generates typical distortions. For a slightly distorted sound 
("crunch"), it's sufficient to set the controller to 10-11 hours at maximum; the 
modeled circuit also provides the usual "weight" for power rock chords, and 
more. The further you turn this controller to the right, the more the mids of the 
signal move to the fore so that the "high-gain" lead sound is better heard.  

You can also use the distortion effect in combination with the amp simulation! 

 

BitMachine 

 

Audio material can always be edited into high quality with Samplitude 11.5 
Producer. Nevertheless, there are some situations, for example, a more 
imperfect lo-fi sound would perfectly suit a drum loop or a synthesizer sound. 

Remember, for example, the first hardware samplers from the 80s that usually 
only ran at 8 or 12-bit rates and at low sample rates. With the BitMachine, 
changing the sound with such an "antique" device is no problem. 

You can use the BitMachine to bring back to life the times when minimalist and 
scratchy soundchips in home computers were commonplace. 

The BitMachine opens up a gateway to "acoustic time travel" where you can 
encounter bit and sample rate reduction and downstream filters based on 
analog models.  

Furthermore, the effect has a modulation section with which you can control 
individual parameters using an oscillator (LFO) or the input signal.  
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We have designed a range of "typical" presets to demonstrate the time travel 
abilities of the BitMachine. These can be opened at the top right of the 
interface 

The following section describes the details of BitMachine: 

 

"Filter" section 

The filter in the BitMachine is a digital model of one of the most well-known 
filters in music electronics, i.e. the "Chamberlin 2-pole" filter used in old 
Oberheim synthesizers. These types of filters sound exceptionally musical. 
They can also be used quite creatively in the BitMachine, but should not be 
used exclusively to smooth out existing artifacts.  

The filter works in the so-called "high-pass" mode, i.e. it lets through deep 
frequency (or medium) material according to setting, and dampens highs and 
medium areas. 

Freq: 

You can specify the cut-off frequency of the filter using "Freq". Filtering starts 
above this frequency. 

Reso: 

The signal in the area around the cut-off frequency can be strongly elevated to 
just below self-oscillation. Sharp, cutting sounds are possible at this level, and 
the effect becomes even clearer when you vary the cut-off frequency. 

Drive: 

Both of the individual filters of the connections mentioned above have the 
ability to overmodulate themselves internally. With the "Drive“ dial, you can 
regulate the amount of overmodulation. The more you turn this dial up, the 
more the signal is overmodulated. In this case, the parameters of the internal 
workings of the filter interact with one another. Increasing drive weakens the 
resonance, but, at the same time, the signal gets more volume, more bass and 
becomes acoustically fuller.  

Note: The two smaller dials from this section are explained under "Modulation". 

 

"Modulation" section 

You can automate your effects via the settings in the modulation section. 



 
 

 114 Effects and effect plug-ins  

www.magix.com

Here, you’ll find the so-called low frequency oscillator (LFO), which resonates 
with adjustable speed. You can influence the speed and type of resonance. 

To influence the resonance, use the two small dials in both the reduction and 
filter areas. These four dials display modulation targets.  

Example: You’ve left the dial for the sample rate at its default setting. Change 
the small dial beneath from its middle position to either side. The modulation 
for the dial value is added to the sample rate: The LFO now controls these 
parameters proportionately and the sample rate reduction resonates at this 
modulation. 

You can use this technique on other dials as well. You just have to make sure 
that the main dial isn’t turned up to full, because then the modulation wouldn’t 
have any effect. The modulation is always added to the set value. 

Example: Turn the small dial beneath the "bits" dial fully to the left (Value: -50) 
and the one beside it (beneath "sample rate") to the right (+50). You’ve now 
assigned a modulation to both parameters with the LFO. They are not changed 
uniformly, but rather opposite to one another: A negative setting is nothing 
more than an inversion of the modulation, so you’re effectively turning down 
the control signal. 

waveforms of the modulation section 

We’ve already explained this example with the help of sine oscillation. The LFO 
can be in: 

 Sine form 
 Square wave (0 or 1, no intermediate level) 
 Random value (an internal randomizer will be queried at the set speed) 

Oscillator speed 

The LFO speed is specified with the "speed“ dial. If the "sync“ button is active, 
then the LFO adapts to the song speed, and the dial locks musical values into 
place (e.g. ¼ note). Rhythmic paths of the sound distortion are therefore 
enabled. You can also switch off this synchronization and set the speed 
manually (in Hz).  

Modulation with the "Envelope follower“ 

In the modulation section you’ll find a fourth button, the audio input signal. If 
this mode is active, then the signal itself can be called upon to extract 
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“modulation tension”; a so-called "envelope follower" continuously scans the 
volume of the input signal. 

Note: The BitMachine doesn’t recognize the type of audio signal automatically. 
For this reason, you should set the input sensitivity roughly with the "gain“ dial. 
To do this, use the control LED: With accurate detection of the signal 
dynamics, assigning the four small dials to modulation lows is easier and you 
can use the full control range.  

In envelope mode, the "speed“ dial is used to control the response speed of 
the envelope (the display now switches to milliseconds). Lower times result in a 
faster response, higher times make the envelope rise (and fall) slower. You 
should experiment with the signal according to its complexity. The presets 
provided can only point you in a rough direction. 

 

"Reduction" section 

Bits 

This dial controls the resolution of the audio material. Turning the dial to the left 
results in 16-bit quantization (CD quality). The further it is turned to the right, 
the lesser the signal dynamic becomes. In extreme cases (1-bit), there are only 
"on“ or "off“ states.  

At the intermediate levels, you’ll notice an increase in the background noise 
and a decrease in the dynamics. For example, 8-bit quantization will exhibit 
dynamics of only 48 dB. Quieter points in the material sound noisy and very 
quiet points sound "capped“. This effect is amplified the more you turn the dial 
to the left until it starts crackling or "groaning". 

Sample rate 

The audio material is "down-calculated" with this dial, i.e. the internal sample 
rate is reduced. A new separation ratio between old and new rates is created. 
In relation to this ratio, a sample from the data stream will be "dropped“ at the 
various points. 

Note: The two smaller dials from this section are explained under Modulation. 
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Tape simulation (plug-in) 

Tape simulation offers you the possibility of giving your recordings an "analog 
touch" by imitating typical aspects of a tape recording. In a lot of studios, 1" 
and 2" tape machines are still used because they are thought to create a 
fullness of sound, "warmth" and "saturation" that contrasts with the more 
neutral and analytical sound of digital technology. 

There are numerous factors that are decisive for the sound expressiveness of 
tape-based recordings. Some of these are: 

 Distortions that occur when the tape is played in the saturation range, 
 changes to the frequency response, since recording and playback-side filter 

steps prepare the signal. All machines also feature more or less pronounced 
peaks in the frequency spectrum, above all in the bass range (so-called "head 
bumps"), 

 loss of highs through self-erasure resulting from the HF stream ("bias", 
pre-magnetization) and intermodulation between the wanted signal and the HF 
signal. 

 

Level: Sets the input level. You decide when the "virtual tape" is saturated and 
how strong the effect of this color effect should be. The signal will gain more 
"loudness". 

EQ low/hi: Adjusts the frequency response (spectral balance controller). You 
can choose whether you would like the output signal to have a richer bass 
level or whether it should have more highs. This adjusts the pre-filtering at the 
"recording end" as well as playback equalization. 

However, please note that the frequency response of the simulation will not be 
neutral even if the "EQ low/hi" controller is set to neutral. There will always be 
some slight frequency-selective amplification.  
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The distortion resulting from use of the tape simulation can quickly create 
"acoustic fatigue", especially for material that is rich in highs. A direct 1:1 
comparison with the tape section switched off reveals the differences more 
easily. Slight editing with the simulation is generally sufficient to achieve an 
"analog touch". 

 

Essential FX 

MAGIX Essential FX is a collection of "bread and butter effects" for the most 
important applications. They are embedded as VST plug-ins (MAGIX plug-ins 
directory) and may be used in the object or in the track. For object application, 
see "FX plug-ins" in the "Audio effects" chapter or "Track effects" in the "Mixer" 
chapter. 

These are simple but solid tools with clear feature sets for daily application. 
They include fewer controllers and require less resources. 

 

Stereo delay 

The stereo delay is a simple too for typical bread and butter delay effects. The 
"analog algorithm" qualifies as a special feature that produces the sound of 
echo devices from the old days. 

 
 

Stereo delay parameters 

 Mode: This selects between the essential algorithms. 
 Digital: Normal, transparent delay 
 Analog: Simulation of a bucket brigade delay (BBD). These devices, which 

originate from the pre-digital era, used analog building blocks for storage. The 
signal was held for a short time in a relatively simple circuit and then moved on 
to the next. This "bucket brigade" principle created a longer signal delay. But 
since each element of the chain led to a loss of the signal and would increase 
the system noise with longer delays, the devices would use a compander: At 
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the input, the signal's dynamics are compressed, and then they are expanded 
again at the output end. The simulation in the eFX delay mimics the loss and 
compander behavior to produce these typical audio characteristics, especially 
at longer delay periods and higher repetition rates (feedback). 

 Delay L/Delay R: Specify the delay period for the left and right channels here. 
 Tempo sync: If this button is active, the plug-in is directed at the 

host/sequencer tempo. In this mode, changes are made to the delay period 
via the L/R delay using the musical snap grid (e.g. 1/4 note). 

 Damping: This specifies the cut-off frequency at which the highs are 
dampened during the delay. This useful for making the delays reverberate 
more naturally or for creating special effects (reggae/dub-style effects). 

 Feedback: This parameter regulates the internal amplitude of the delayed 
signal that is fed back to the input. In "Digital" mode, this process is 
completely transparent; in "Analog", on the other hand, higher values, a very 
loud input signal, or the sum of these will make the use of dynamics 
compression audible. In both modes, the nullification of the feedback 
parameter is in the center of the fader. To the right, the plug-in works in "Dual 
delay" mode (both sides work independently), and to the left, "Ping pong" 
mode will be activated (the delayed signal alternates between the left and right 
sides). 

 Mix: Regulates the mix ratio of the original signal and the delayed portion. 

 

Chorus/Flanger 

This plug-in offers a simple way to make signals sound more interesting, 
"spacier", thicker, etc. by modulating or delaying the pitch. The classical 
domain of application is for guitars, Hammond organs, electric pianos, or 
synths. 

Chorus and flanger are two closely related effects, which is why we have 
included them in a single plug-in. They normally differentiate in terms of delay 
time, type of modulation, and degree of internal feedback. 
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Chorus flanger parameters 

 Mode: 

- Mono chorus: In this mode, the signal is fed through a delay unit and the 
pitch is modulated. Original and delay copy are mixed into a monophonic 
output signal. 

- Stereo chorus: Compared to mono chorus, two copies of the original are 
created, modulated against each other, and then fed accordingly to the set mix 
ratio to the left and right output channel. 

- Mono flanger & stereo flanger: Similar to the other modes. In this case, lower 
delay periods and a slightly changed modulation are processed. 

 Rate: This specifies the speed of the modulation. Lower rates provide slight 
hovering effects, and high speeds produce a wobbling, typically distorted 
"underwater" sound. 

 Depth: This parameter specifies the depth of the modulation, i.e. the 
maximum deviation of the modulation and the resulting pitch bending. 

 Feedback: This parameter defines the portion of the delay that is sent back to 
the input. Feedback causes the effects of modulation to be more drastic and 
cutting.  

Nullification of the feedback is set at the middle of the fader. Set to the right, 
the feedback is fed to the input equi-phasal; to the left, the feedback occurs. 
Both variants may sound very different depending on the signal, since they 
prefer different frequency ranges for dissonance. 

 Mix: Regulates the mix ratio of the original signal and the delayed portion. 
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Phaser 

The phaser is often mistaken for a flanger due to its typically sharper and 
cutting effect. In any case, the pitch is not modulated. Instead, the modulation 
process burrows multiple notches into the frequency response, somewhat like 
a comb filter. Just like an airplane taking off, the phaser functions with a similar 
jet effect. It is suitable for enduring signals like synth surfaces or for producing 
sound designs like atmosphere or distortion effects. 

 
 

Phaser parameters 

 Mode: The selection includes a number of filter stages. At 4 stages/8 stages, 
a more plastic effect is achieved, and more complex patterns are reached at 
16 stages. Please note that the more stages are involved, the more computing 
time will be needed. 

 Rate: Speed of filter modulation. The essential effect is the same for both 
chorus and flanger. 

 Depth: Similar to chorus/flanger, whereby it's the filter notches that are 
addressed, and not the pitch modulation. 

 Feedback: The feedback portion produces a more drastic effect in this case. 
Similarly to the chorus/flanger, co-phasal or opposite-phase feedback is 
possible.  

 Mix: Regulates the mix ratio of the original signal and the delayed portion.  
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Vandal SE 

 

Virtual Guitar & Bass Amplification 

VANDAL is a complete simulation suite for guitarists and bassists. The plug-in 
is capable of simulating the entire signal chain, from input to stomp boxes, 
amplifiers, microphone loudspeaker boxes and post-processing studio effects, 
all in top quality. 

 

Input level: VANDAL and the real world 

Independent of the preferred software, amp modeling has to feature 
impeccable integration with audio hardware and ASIO drivers. Please ensure 
stable and latency-free operation and the largest possible signal-to-noise ratio 
of the converter or the complete analog section when selecting appropriate 
equipment. If in doubt, ask your audio equipment dealer for advice and 
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consider your entire computer system. On-board sound systems are not 
recommended due to their rudimentary or unsuitable driver sets and the often 
below-average signal quality.  

Before making any "serious" endeavors in VANDAL, please make sure that 
your audio interface is supplied with a sufficiently controllable signal level from 
your instrument. The input signal at the audio interface should be "saturated", 
but it should not be overmodulated. Compared to the possibly desired 
distortions created within the plug-in, an AD converter distortion will sound 
abrupt and horribly digital, and the the worst part is that you will never be able 
to remove it. 

If very loud velocities sometimes reach the upper modulation limits and the 
average level stays at -12 or even -20 dB, everything is normal. The less noise 
your audio hardware has in the process, the better. We recommend working 
with devices that feature a resolution of at least 20 or 24 bits. A simple 16-bit 
sound card will stop being fun to use at the very latest when high-gain sounds 
come into play. 

If possible, use an interface with a high-resistance instrument input (often 
labeled "HiZ"). Line or microphone inputs are not very well-suited for this; due 
to the relatively high impedance values of (passive) guitars or basses, this sort 
of input has a dampening effect on the instrument. The sound will seem dull 
and "dead" as a result...  

If the interface does not feature an instrument input, insert a separate guitar 
pre-amp, a DI box, or even a simple pedal (not switched to "true bypass).  

Instruments with active pickups or electronic components are less affected by 
this adjustment problem. 

Please take this opportunity to also check the latency or the buffer size used 
by your audio system. A good ASIO driver should let you play with a latency of 
only a few milliseconds between the stroke and the calculated sound output 
from the software. Values under 5 ms are considered good. You may have to 
experiment to find the lowest limit at which your system functions stably. If you 
notice ugly crackling or even long drop-outs, then try a higher latency.  

 

Input level reloaded: VANDAL's input level 
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After you have made sure that the external levels are clean, you should take a 
closer look at the input level; this controller is located at the top left of the 
console. Just like with a genuine guitar or bass setup, it's important to ensure 
the highest possible input level in order to be able to work optimally. This is 
even more important for distorted sounds and natural high-gain playing styles. 
You should make use of metering for this as well (the LED indicator next to the 
input control). If needed, activate the noise gate and adjust it so that it lightly 
suppresses the input signal during pauses in playing. VANDAL does not cut 
the input as hard as classic gates do, but instead regulates them finely via the 
signal energy, beginning with the highs, at the point where noise is most 
audible. 

 

Samplitude 11.5 Producer preset and scene selection 

Would you like to know about everything that VANDAL can do as quickly as 
possible? Just start strumming away and listen or flip through some of the 
included presets. These are available via the list in the upper edge of the 
console.  

 

A preset includes all settings for the main elements of VANDAL, i.e. stomps, 
amp settings, cabinet simulation, studio effects, and a series of control 
parameters. 

All settings for the main elements (such as the amp) are subdivided into 
"scenes" within a preset. This "scene memory" is located to the right of the 
preset list. You may create up to four variations of a preset using scenes. 
Numerous included presets make regular use of the scene concept. We will 
examine this working method more concretely later on. 

Presets may be switched by clicking on the list or using the arrow symbols. 
You can also use the left and right cursor keys. 

Scenes may be switched by clicking on the adjoining number (1 to 4) or on the 
name field of a scene. Alternatively, you can use the up/down arrow keys. 

Of course, presets and scenes in VANDAL may also be controlled via MIDI.  
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Presets are located in a subfolder within the VANDAL folder on the hard drive. 
These may be changed however you like, sounds may be exchanged with 
peers using VANDAL, and your preset library may be expanded without limits. 

 

Chromatic tuner 

The chromatic tuner in the console has an 
automatic circuit which analyzes the recently 
played sound and shows the note and 
deviation from the idea (in cents) on the display. 
Simultaneously, the point moves up (too high) 
or down (too low) along the scale or stops in 
the center when the tuning is exact. 

The arrows indicate the direction of the tuning (up or down). 

The mute button switches the output signal from VANDAL to mute for as long 
as the chromatic tuner is activated (tuning fork symbol). 

 

Stomp Boxes (pedals) 

The real world has produced a series of effect devices popular with guitarists 
and bassists in the "stomp box" format. We've also included a rich palette of 
these devices.  

 

Samplitude 11.5 Producer includes four "stomp slots" for use with effects 
equipped from the list. The signal flow within this chain runs from left to right. 
Stomps can be moved around freely, by dragging an unused area on a pedal's 
surface. 

When a stomp is assigned to a slot that's already occupied, the two change 
their places. Dragging while holding the [CTRL] key creates a copy of the pedal 
at the new location. 

Each stomp box may be detached from the signal path using the "foot switch" 
or the blue button next to the selection list. An inactive device does not utilize 
the CPU. 
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Some stomps may be familiar to you; we reproduced some real prototypes 
with regard to functionality or sound, or simply got some inspiration from 
others. Some, in contrast, were created from the ground up and offer original 
sound ideas.  

We're constantly developing the selection of existing stomps that are available. 
With each plug-in update, it is our intention to constantly supply you with fresh 
"food for thought" in addition to technical improvements. Look for updates to 
Samplitude 11.5 Producer at http://www.vandalamps.com. 

The following stomps were available at the time this manual was printed (each 
in its own category): 

 

Amplifier 

Amplifier Concept 

VANDAL essentially offers 2 different amplifiers; a guitar amp and a bass amp. 
These may be selected from the list in the "amplifier panel" below the stomp 
view. 

 

As we mentioned, in VANDAL we found our own way and avoided modeling 
specific amplifier brands and models. The amplifiers are setup variably, 
allowing you to get a number of different sound characteristics out of your 
VANDAL amp. Internally, these circuit designs work exactly the same as the 
real versions. We improvised at some musically decisive points by just relying 
on our ears. 

 

Amp/cabinet template 

The extremely variable concept for amps and cabinets within VANDAL is great 
for individualists, but it would take a bit of time to imitate a band mate's 
40-year old Marshall with speakers of the same vintage. If you want to use a 
combination like this often, then it's nice to have a library for it, which is exactly 
what the templates are for. 

Our team of experienced musicians has compiled a multitude of settings for 
the amp and speakers. These templates may be changed at any time, or you 
may create your own if a particular combination of amp and box is especially 
appealing. 
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Guitar amp 

 

Circuit philosophy 

 

 

The VANDAL guitar amp offers three different pre-amp modes and two 
switchable end stage models. This basic configuration may be 
changed via the wrench symbol on the right side of the amp. 

The pre-amp has three modes of operation: 

 

 Classic (think Fender, early Marshalls, or the first Mesa/Boogie amps) 
 British (oriented on Marshall Super Lead / "Plexi") 
 Modern High Gain (design similar to "souped-up" amps like Rectifier, Soldano 

or Peavey 6505) 

More about pre-amp modes and their properties resulting from channel 
selection can be found in the chapter "Pre-amp Channels" (view page 127). 

The last stage has two modes: 

 

 Class A, low power: A simple, low-performance, but musically pleasant 
distortion. In "A" mode, only a half-wave of the signal is amplified. To do this, 
the signal is brought to approximately half of the amplification range of the end 
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tube(s) through bias voltage, because tubes always amplify only a half-wave of 
an alternating circuit. A class-A circuit may be put together using only a few 
components and sounds very "warm" because of its constantly asymmetrical 
characteristic curve shape (some even harmonics appear). This amplifier, 
however has the disadvantage of low efficiency or low output performance 
and a comparatively high liability of erosion. The latter has been left out of the 
modeling, of course...  

 Class A/B, high power: In this case, each half-wave has its own tube, which 
(almost) doubles the efficiency. Class A/B router amps are more complicated 
to implement (and calibrate). Compared to Class A, the sound characteristics 
include descriptions such as "sovereign" and "powerful", but somewhat 
"colder", because they result in almost exclusively odd harmonics. Using 
positive and negative feedback via the output transformer, an additional 
"sound design" is often added here. For this reason, VANDAL's A/B power 
amp features more juice in its lows and more bite in its highs. 

 Presence: On many amplifiers, this pot is located next to the EQ section, 
although a presence boost actually takes place inside the power amp circuit. 
Most push-pull amps use negative feedback (from the output transformer 
back to the power amp's input) to linearize the amplification process. 
Lowpass-filtering this feedback signal and mixing it (anti-phased) with the input 
results in boosting the mid and treble region. Using presence, the sound takes 
on a livelier and more up-front character. 

 SAG control: Many older tube amps use rectifier tubes to transform AC 
current to DC (instead of conventional semiconductor diodes used today). 
However, a tube is a high-resistance component, and can't produce an even 
current flow during steep load changes. This "sagging" feature of a 
cranked-up tube amp is the acoustical result of these short-lived interruptions. 
Moderate sagging is initially perceived in the attack; it sounds somewhat 
compressed, but in a "lively" way. If the effect is even stronger, it changes the 
entire signal. Besides the dynamics, the harmonics spectrum also changes, 
because operating point of the tubes is shifted. 

 Sagging occurs in this form only in push-pull end phases; in principle, Class A 
amps always draw constant (maximum) current from the mains.  

 Intensive sagging will result in creating less "presence", as the overall signal 
gain in the power amplifier decreases, thereby generating only small voltage 
excursions to feed back on the power amp's input. 

 

Preamp channels 

 

The guitar amp is set up with three channels in all preamp 
configurations (Classic, British, Modern High Gain). 
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 Clean: This channel should create no distortions. If the incoming channel is 
"hot enough", then it will be distorted in a typical tube fashion. The model will 
use only half of a double triode; in principle, a simple amplification takes place 
at the "working level". 

 Crunch: Amplification stage number, circuit and, last but not least, the 
resulting sound all vary:  

- Two amplification stages are used in the "Classic" preamp setting. This 
model uses a long-established design that is similar to the classic 
Fender amps or the first Marshalls. The "classic" preamp delivers 
saturated lows that are only slightly dampened by the second stage. 
As a result, this circuit delivers the typical "brown" sounds of older 
vintage amps. 

- The "British" switch is inspired by dual input stages, such as Marshall 
"Plexi" variants (JTM, "Super Lead", etc.). The signal is sent to half of 
each triode circuit, and these favor different frequency ranges ("warm", 
"bright", etc). The "British" circuit in the VANDAL amp uses a set 
mixing ratio for both tube portions. In contrast to the "Classic" version, 
this preamp setting sounds more "alive" and reacts much more 
sensitively to dynamics, pick-up selection, and gain settings/guitar 
volume. 

- "Modern High Gain" delivers the typical fat sound that is rich in highs, 
similar to American amps like the Mesa/Boogie & Co. in 3 cascading 
amplification stages. Before the second and the third stages, the 
proportion of lows and highs is regulated, so that low tunings and 
quick passages are amplified without any "mud" and the signal always 
remains clear and assertive. 

 Lead: In all preamp modes, the lead channel consists of an additionally 
cascaded tube circuit. In the "Classic" and "British" preamp setting, the lead 
channel may be viewed as more of a modification of "tuning" of vintage 
aspects. The "Modern High Gain" variant really gets going here. In this setting, 
VANDAL playfully takes on even drop-C or -D tunings. 

Tip: Even if you don't want to use up all your gain in the crunch & lead 
channels, you can still try to go "a level higher" and take the (pre) gain level 
down a little for a slightly distorted sound. This increases the sound's 
complexity, and it will also seem more lively. 
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Pre & post gain 

 

You can set up the desired amplification factor with 
the pre and post gain controllers. The pre-gain 
controller corresponds to the normal "gain" controller 
on most amps. 

Using the post-gain controller, the currently active channel's overall volume 
may be adjusted to another channel, or a certain channel may be raised (e.g. 
for a solo). 

Don't worry about switching settings around in the middle of things; the 
amplifier will remember the gain settings when channels are changed. 

 

Voicing 

 

There are a number of more or less open secrets with 
regard to the different signature sounds of guitar 
amps. This one might sound "bluesy", but doesn't 
sound so great with more gain, and the other is 
contoured for grindcore metal and fat sounds, but 
maybe it's a little anemic otherwise... How does this 
work? 

Most amps in the real world use more or less the same or similar circuitry 
designs. The important thing is the number of amplification stages involved. 
Each new stage not only increases the level of audio complexity, it also has a 
large influence on how the way the signal is treated before and after that stage. 
Filtering is the key: 

In addition to preset filtering circuits between the amplification stages, we gave 
VANDAL a little something we call "curve EQ". Assuming that you are using an 
EQ pedal before the amp, you can change the distorted sound drastically, 
because instead on the overall sound, you can favor certain frequencies. Curve 
EQ does something similar: it's located (in some cases in multiple instances) at 
strategic points between individual amplifier stages, and it filters the signal 
before it is distorted by the next stage. This is known as "voicing". For fun, turn 
a curve in both directions and move around a bit with the frequency controller 
in the spectrum. This will give the amp a completely different character. By 
combining channels, pre-amp modes and voicing, you can create a completely 
individual amp sound and even imitate other amps. 
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Equalization 

 

The actual sound control (the "tone stack") 
functions rather conventionally: VANDAL 
offers low, mid & high settings.  

Everything functions like the passive sound regulation network in genuine amps 
so that the controllers influence each other to produce numerous variations. 
Depending on the preamp mode, the activation frequencies are slightly 
different. 

 

Reverb 

 

Genuine studio reverb devices are great, and VANDAL has two of 
them included in both multi-effect units. However, styles such as 
surf, twang, sixties, and others require a spring reverb. We've 
drawn on famous reverb spirals for our modelling. 

Everything sounds natural with complete authenticity. This means that it has an 
old-school style rattle and typical rippling on the attack. 

 

Master 

 

The master control may be used to determine more than just the 
total amp volume. Since this is located before the end tubes in real 
amps, you can also use it to control the end stage distortion level. 

This is very easily perceived in the class A mode; it doesn't just get louder, it 
also becomes more compressed and distorted. 

If you are used to amps without a master volume, simply leave this at the 
maximum setting and control gain via a pre-stage and the final volume and the 
cabinet simulation or at the console output. 
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Bass amplifier 

 

During development of the VANDAL bass amp, it was our main goal to create 
a recipe consisting of the best amp designs in a single amp featuring an 
all-tube design that would be simple and easy to use.  

The core features of the VANDAL bass amp are: 

 Multi-stage tube preamp (with extra distortion stage) 
 Contour control for extra-fat bass and glittering highs 
 Controllable optical-electrical compressor 
 4-band sound control 
 Class A/B tube end stage 

 

Gain control 

 

The input level of the first amplification stage is set in the bass amp 
via the gain controller. Low to medium values leave the signal 
relatively neutral, and high values softly increase saturation. 

 

Contour 

 

The contour circuit is a filter stage that works similarly to the 
"Loudness" function. This control lets you give the bass sound an 
underlying character without additional EQ measures. 

Turned all the way left, no effect will be present. However, the more the control 
is turned to the right, the more the mids will be thinned out and lows and highs 
raised. It's sort of like an "instant slap". 

 



 
 

 132 Effects and effect plug-ins  

www.magix.com

Comp (opto compressor) 

 

After the contour circuit, the signal passes through the 
compressor stage (Comp). This is a simple but extremely musical 
"optical-electrical" design: the bass triggers a light source (e.g. an 
LED or a luminescent film) that is coupled with a photo resistor. 

The louder you play, the more light falls on the photo resistor, which in turn 
dampens the signal. This may already be familiar to you from the most famous 
studio compressor for bassists, i.e. Urei LA2A, which functions according to 
the same principle. 

There aren't that many settings to change in such a simple compressor. The 
control times are mostly determined by the sluggishness of the photo resistors. 
The comp control only sets the signal strength, which is routed to the light 
source. 

 

Drive 

 

After any possible compression, "Drive" provides the option to 
take the bass sound to the next level. The drive circuit is an 
additional amplification stage, which is proportionally mixed to the 
main signal. Signal distortion takes place depending on the 
frequency: 

In spite of a level of distortion, the basses remain relatively clean and 
contoured. This guarantees complete "traction" of the signal when the 
controller is set all the way to the right. 

 

Equalization 

The following equalization 
stage offers 4 frequency 
ranges, in which case the 
two mid bands are variable.  

Some bass amps allow their EQ circuits to have a drastic effect on the signal. 
We decided on a softer filtering with an edge slope of 6 dB/octave to avoid 
fully counterfeiting the essential character of the instrument in spite of the four 
bands. 
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Master 

 

The final master volume controller sets the volume at the final 
stage. Similar to the guitar amp, the end tubes are also engaged 
in this case as much as remains sensible. 

Through the interaction of gain, drive & master, countless saturations and 
distortion textures may be modeled as needed. 

 

Cabinet simulation 

 

As was mentioned at the start, we went our own way in simulating the 
speakers and cabinets. In place of impulse responses from microphoned 
cabinets, we've calculated the individual components of this sort system: 

 Loud speakers  
 Housing 
 Recording space 
 Microphone 

True to our "custom amplification" philosophy, this process provides total 
freedom and a certain measure of personal dynamics, which is the final 
deciding factor at the end concerning whether the system feels "lively". 
VANDAL also takes subtle effects into account, such as the reaction of the 
speaker's housing, the effect of this on the end stage that is applied, and so 
on. 

 

Speaker selection 

 

The speaker selection list allows you to choose from a selection of speakers of 
various sizes and sound characteristics. These are organized according to 
guitar and bass types: 

Guitar 

 10“ UK Vintage 12“ UK Vintage 12“ UK Modern 12“ UK Blue 10“ US Alnico 
15“ US Alnico 15“ US Fat 



 
 

 134 Effects and effect plug-ins  

www.magix.com

Bass 

 10“ Custom Rock 10“ Custom Alu 15“ Custom Rock 15“ Custom Alu 

 

Housing selection 

 

Various housing types may be combined with the available speakers in the 
housing list. This selection list is also organized according to guitar and bass 
types. 

Guitar 

 1x12“ US Combo Open 1x12“ US Combo Closed 2x12“ UK 4x12“ UK 4x10“ 
US Tweed 

Bass 

 4x10“ Ported (Bassreflex) 1x15“ Ported (Bassreflex) 

The housing has a significant effect on the resulting sound with a selected 
speaker. In general, open housing types are somewhat weaker on the lows, 
but go lower and sound somewhat more neutral than closed types. Larger 
housings also sound "bigger" and maybe "fatter". However, this is not always 
desired; for a guitar solo or for certain styles like blues, a small combo housing 
may be much more assertive or simply more "charming". 

It's up to your creativity whether you would like model the cabinets on realistic 
role models (e.g. 12" vintage speakers in a 4 x 12 housing) or place a 10-inch 
design in a 15-inch box. Refer to the "Advanced settings" a little further on for 
all other variations to help you create your own "personalised" speaker. 

 

Microphones 

 

Cabinet simulation offers two separate microphones for the recording of the 
virtual speaker in a modeled recording space (MIC 1 & MIC 2). Similar to a 
real-life situation, you may position a virtual microphone stand in a space to 
achieve interesting mixing ratios and stereo effects.  

For each of the two available microphones, you may select from a list which 
includes several popular studio types featuring characteristic sound models: 
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 Condenser, Dynamic 1, Dynamic 2 

For each selected microphone, a range of sound design parameters is 
available: 

 Axis: The "on axis" (controller to the left) setting 
corresponds positioning of the microphone directly in the 
middle of the speaker cone. In this position, the sound will 
have many highs, but may sound piercing. For this reason, 
the microphone will often be positioned a bit "off axis" in 
order to achieve a softer sound. 

 Distance: This control allows you to remove the 
microphone from the speaker and position it further away 
in the recording studio. This way you can make the sound 
more alive and loosen it up acoustically. Using two 
microphones with different panoramas (see below) enables 
you to create extremely realistic stereo images (note that 
the axis parameter has a decreasing effect in relation to 
the increasing distance). 

 Pan: This parameter distributes the microphone signal in 
the stereo sum at the output of the cabinet simulation. 

 Level: This adjusts the microphone volume. 

 

Rack effects (FX1/FX2) 

 

There are effects that don't always work well when placed before the amp, e.g. 
reverb or delay, especially when they are distorted. Normally, these effects are 
better placed at the end of the signal chain. 

For final processing and enrichment or whatever else you need, we offer two 
separate studio-quality effects units that behave just like real 19" rack devices. 

Many of these algorithms create a stereo signal. As required, make sure that 
the channel strip is being calculated as stereo in the audio sequencer track. 
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Effects units may be selectively operated one behind the 
other (serial) or parallel. Switching may be changed via the 
mode switch. 

The following algorithms & effects are available: 

 Mono Delay (msec & tempo sync): Selectable as a simple delay with freely 
adjustable delay time or synched to the sequencer tempo with a musical 
raster. In case of higher feedback values, a reduction of the damping 
frequency is required to provide natural echo sound. 

 Stereo Delay (msec & tempo sync): Features two models, just like mono 
delay. Repetitions may take place on separate channels (feedback controller 
to the right: dual delay) or in ping-pong mode (controller to the left), in which 
case the signal alternates between the sides.  

 Chorus: Produces a typical "floating/shimmering sound" via modulated 
detuning of a signal to "thicken" the sound or spread it across the stereo field. 
Detuning is achieved via a short delay, the length of which may be varied via 
the modulation. This produces the so-called "Doppler" effect and broadens 
the signal. 

 Flanger: Similar in terms of the algorithm that is applied to chorus, but 
different in that the delay time is significantly lower and delay works via 
repetitions (feedback). The flanger sounds more cutting and up-front than 
chorus. 

 Phaser: A modulation effect just like chorus & flanger, but in this case no 
detuning takes place. Filter components periodically alter the signal's "phase 
response" (principle of the "phase shifter"). When mixed into the original, 
characteristic notches are produced in the frequency spectrum response 
(comb filter effects). 

 Room Reverb/Hall Reverb: Reverb offers realistic simulation of realistic 
reverberation. Room creates the impression of a small to mid-sized recording 
room, while reverb produces the impression of a concert hall. A particular is 
that both effects algorithms provide a modulation parameter, which may 
remove possible resonance at low dosages and can produce a soft chorus 
effect at higher values. 

 Vintage Plate Reverb: The algorithms used in this type of reverb are quite 
similar to the ones that popular hardware effects units back in the 80s used to 
emulate that certain dense space of reverb plates. The resulting sound is 
correspondingly "wide", spacial and responds very directly, with immediate 
dispersion and no single echoes. Modulation of the reverb tail is also possible 
here, to minimize the typical ringing of the underlying metal-plate model. 

 LoFi: Depending on its setting, this algorithm adds grit to the sound or a 
certain measure of signal destruction. Turn down the internal sample rate as 
much as you like to steal a few bits from the sound's resolution. Definitely an 
unconventional method... 
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 Vintage Compressor: Ideal for thickening up the signal a little. The algorithm 
emulates an older popular circuit design that is similar to studio legends like 
the Urei 1176 or simple compressor pedals. A so-called "FET building block" 
simply, effectively, and quite musically controls the volume via the input level, 
the set compression level, the compression ratio, and the response responses 
(attack and release). 

 3-Band EQ: This sound controller works like a conventional mixer with a 
controller for the bass, the highs, and two controllers for the variable mids. 
This adds the final polish to your sound. 

 

VANDAL SE vs. VANDAL 

This version of the Plugin VANDAL SE has a restricted functionality compared 
to the full version of VANDAL. 

The following additional functions are available in the full version of VANDAL: 

 A lot more stomp boxes: 6 (instead of 2) Overdrive/Distorsion Effects, 4 
(instead of 2) Modulation Effects and additionally 4 Delay/Reverb Effects, 5 
Volume/Dynamics Effects, 4 EQ/Filter/Wah-Wah Effects and Octaver. We're 
constantly developing the selection of existing stomps that are available, so 
more effects will show up later. 

 Scene Memory: Each preset can have up to four variations, called Scenes. 
 MIDI Remote Control: Each sound parameter can be remotely controlled via 

MIDI or VST parameter automation. You can step through presets or scenes 
via MIDI commands. In combination with a MIDI footstep controller or a 
pedal,VANDAL will become a complete, live-playable effect device. 

 Patch Lists: You can manage lists of presets and switch presets via MIDI 
program change commands. 

 Advanced settings for the cabinet simulation and the default behavior when 
loading the plugin, presets and when switching presets or scenes. 
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Track dynamics 

Samplitude 11.5 Producer provides two different dynamics modules: one that 
can be opened via the "Offline effects" menu (talked about in further detail in 
the corresponding chapter), and a second one that is only available via the 
track effects and in the mixer. 

 

Use this editor to edit the dynamics of a sample. All functions can be 
previewed in real time. 

The graphics display shows the corresponding resulting dynamics curve to 
improve the overview. 

The following functions are available: 

Compressor: The dynamics of a piece are limited, loud sequences are 
dampened, quiet sequences are retained. Compression is often used to add 
power to audio material or to increase the loudness. The level of compression 
is adjusted by the ratio controller, the activation threshold is determined by the 
threshold. You can also influence the attack and release. 

Limiter: Only the loudest passages are limited (above the threshold). Quiet 
passages remain unedited. Limiters are used to reduce the occurrence of big 
level peaks without reducing the master dynamics. After the limiter process, 
the master level can be increased using normalization without having to worry 
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about overmodulation. The limiter setup preset sets a threshold of -0.2 dB 
when using the limiter as a peak limiter in the master range of the mixer. 

Limiter 100%: Performs the same editing as the limiter, but the level is 
immediately raised to 0 dB. This corresponds with normalization in one single 
step. 

Expander: The dynamics of a piece are increased; loud sequences remain 
quiet, quiet sequences become even quieter. Dynamics expansion is often 
used for recording speech with a high noise level. The expansion causes the 
level of the speech to be raised as the noise is suppressed. Please note that a 
powerful denoising algorithm is also provided. 

Gate: Very quiet passages (below the threshold level) are dampened or set to 
zero. This way, hissing can be effectively suppressed during pauses between 
individual takes. Using the "Gate" function also makes sense at high 
compression levels (ratio > 5) to raise the most quiet passages and prevent 
background noise. 

Ratio: This parameter controls the strength of the corresponding effect; 1.0 
means that there is no effect. 

Threshold: The volume threshold can be set below or above the one which 
applies the effect. 

Attack: Sets how quickly the algorithm takes to react to increasing sound 
levels. 

Release: Sets how quickly the algorithm takes to react to falling sound levels. 

Gate level: This parameter specifies which levels should be set to 0. 
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Track delay/reverb 

Samplitude 11.5 Producer provides two different dynamics echo/reverb 
modules: one that can be opened via the "Offline effects" menu and which 
shall be talked about in further detail in the corresponding chapter, and a 
second one that is only available via the track effects and in the mixer. 

 

Use this editor to calculate an echo effect into a sample. To avoid 
overmodulating the sample, there should be a certain volume control reserve, 
i.e. the sample data should not be allowed to reach the maximum/minimum. 
This can be accessed using the normalization function (some 70%), if required. 

Echo delay / Rev. time: This button displays the delay between the individual 
echoes/original signal and the first echo in seconds. You should note that the 
delay is dependent on the sample rate, that is, a change in the sample rate 
after creating the echo leads (logically) to a change in the echo delay. 

Reverb properties: Here the values for the size of the simulated room and the 
reverb coloration can be specified numerically as well as by using the scroll 
bars. 

Wet/Dry balance %: Here the dampening between the individual echoes can 
be entered as a percent. A number close to 100% results in slower sounding 
echoes, a value under 40% has quick sounding delays. 
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Elastic Audio Easy 

General information on the Elastic Audio editor 

Elastic Audio is a specialized editor for changing the pitch of audio material. 
Resampling and pitchshifting algorithms can be automated, and a basic 
frequency recognition enables the user to change around considerably the 
pitches of monophonic audio material.  

Pitch-shifting algorithms are able to change a melody in the pitch without 
influencing the tempo. Samplitude 11.5 Producer provides various pitchshifting 
algorithms that can be used based on existing material. 

Elastic Audio has the following capabilities 

 Recognition of the basic frequency in monophonic audio material. 
 Automatic and manual correction of the basic frequency process in 

monophonic audio material. 
 Manual correction of the pitch of notes from monophonic audio material. 
 Changing melodies in monophonic audio material.  
 Harmonizer for creating additional voices 

Note on timestretching: Timestretching cannot be automated, but can 
continue to be used statically when using Elastic Audio. 
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Edit window 

  

The pitch characteristic is shown in the editing window. To customize the pitch 
correspondingly, the original pitch of the audio material must, of course, be 
known. Fundamental to the functionality is therefore a preliminary pitch analysis 
of the material. This is basically only for tonal, monophonic material like solo 
vocals, solo instruments, and speech. 

The analysis function starts automatically when the editor is opened. The 
analysis requires more time with longer objects. After the analysis is complete, 
the objects are split up into individual "slices" according to the recognized 
pitches. The medium pitches of a slice determine its position in the graphic, 
independent of the set progression of the pitch curve inside the slice. On the 
borders of the slice objects, two handles are created on the pitch curve. These 
handles can be moved in order to produce an increasing or decreasing pitch 
characteristic, but still keep the small changes in the basic frequency (vibrato). 

The “Tune” function for automatic pitch correction can be found beside the 
"Draw pitch" function. 

 

Axes labelling and legends 

Y axis: Pitches in notes. The notes can be deselected on the keyboard. They 
won’t be used in the automatic pitch correction or in quantized drawing. The 
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corresponding guidelines for scales can be used by selecting the basic tone 
and scales in the box “Edit slice object”. 

Orange line: New pitch characteristic (editable) 

Grey line: Original pitch characteristic (result of the analysis) 

Red line: Harmonizer voices. 

 

Fundamentals of the Elastic Audio editor 

Opening the Elastic Audio editor 

Select the object that should be edited in the editor. The Elastic Audio editor 
for a selected object is opened via "Menu effects -> Audio". 

Interaction between Elastic Audio editor and objects 

Temporal corrections to notes are not run in the editor itself, but rather by 
splitting and moving the objects in the VIP.  
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Description of all control elements 

Edit PROJECT OBJECT box 

These options and parameters always effect the whole object loaded into the 
editor, and therefore all of the slices.  

Algorithm: You can choose between the modes: monophonic voice (preset), 
standard, smooth, and beat marker slicing. 

For more information on the algorithms, read the corresponding paragraph on 
the time processor! 

Curve smoothing: This parameter brings about the smoothing of the given 
pitch curve using a time constant (in ms). When smoothing to a large extent, 
jumpy pitch-shifts change from a “kick” to a glissando. 

Formant control: Selecting the "Monophonic voice" algorithm may result in 
so-called formants. Formants are sound components typical for the character 
of instruments or the human voice. With instruments they mainly result from 
the geometry of the resonance body. Human formants are created by the 
anatomy of the vocal tract.  

With most algorithms the formants are also influenced by changing the pitch. 
Using the monophonic voice algorithm you can change the position of the 
formants independent of the pitch. Acoustically, this corresponds with 
stretching or compressing the above mentioned geometry, and this can lead to 
interesting effects... 

 

HARMONIZER box 
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Chord: Here you can set the chord that makes up the parallel voices of the 
harmonizer, and a distinction is made between major and minor. The settings 
of the keyboard are taken into account, unless the option "Lead voice" has 
been activated. 

Humanize: At a low setting this causes high quantization of the parallel voices 
and makes the effect sound very artificial. If you select a very high humanize 
value, the pitches of the individual voices will vary and the cue will be shifted so 
that you get the impression of an amateur ensemble. 

Create voices: This button generates voices. 

Harmonic adjustment: Parallel voices are usually generated by taking the 
keyboard and humanize settings into account. However, if this option is 
deactivated, then the voices are always kept exactly parallel to the orange 
curve. 

  

Edit SLICE OBJECT box 

Options for automatic pitch correction 

Basic tone: Basic tone of the scale. In the chromatic scale this setting is still 
not taken into account. 

Scale: Type of scale. Major/minor or modes 

Pitch characteristic tune!: This button quantizes (“levels out”) the pitch 
characteristic of selected slices. 

With quantization smoothing you can determine the “Strength” of 
quantization, and lower values are quantized the most. Consequently, small 
pitch fluctuations always occur in natural sound sources, e.g. vibrato, 
disappear (“Cher effect”).  
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Reset: Resetting the selected slices. The orange curve is superimposed over 
the grey curve, and the slice is reset to the original medium pitch. 

Playback control 

  

Reset: Recalculates and resets the pitch curves of the loaded material. 

Stop/Play: Stops/Starts the playback of the arrangement.  

Play solo: Only the object loaded into the editor is played. 

Bypass: Switches the effect on or off. 

 

Tools in the Elastic Audio easy editor 

You can use various tools to edit slices and the pitch curve. The two tools can 
be freely assigned to each mouse button. The tool assigned to the left mouse 
button is displayed in blue and the right mouse button in red. Click with the 
corresponding mouse button on the desired console button. An exception is 
the zoom tool with which can be assigned to both mouse keys. 

 

Selection tool (arrow) 

 
You can now move the slice objects up and down. 

This modifies the pitch of slice objects as a whole, and slice objects and curve 
handles can also be selected. Multiple selection is possible with "Ctrl" or 
"Shift". 

Freehand draw function 

 
You can freely draw the pitch curve using the draw tool. 

If you press "Shift" as well, a straight line will be drawn between the start 
position on drawing and the current mouse position. When "Ctrl" is pressed, 
the slice objects are combined when drawing. 

Drawing with quantization 
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This is the tool used for quantized drawing. 

Quantized means that the line is horizontally free but the curve snaps onto the 
grid of the tones of the selected scale under "Tune". 

Drawing a straight line using "Shift" and compiling slice objects with "Ctrl" is 
also possible in quantized draw mode. 

Rubber-band tool 
Use the rubber band tool to bend the pitch curves between two 
neighboring handles. 

Here the middle of the curve is moved while the curve handles remain the 
same. In combination with moving the curve handles at the slice object edges, 
you can also move the pitch characteristic and attain micro-tone structures 
(vibrato). 

Cut tool 

 
This can be used to split audio material manually into slice 
objects (according to the notes). 

If automatic recognition is not sufficient, then slice objects can be connected 
to one another using "Ctrl" + the drawing pens. 

Eraser 

 
Use the eraser to reset the output value of the orange curve. 

The pitch characteristic then corresponds to the original again and the curve 
corresponds to the recognized curve. 

Magnifying glass zoom tool 

 
Zoom tool: Left mouse button "Zoom" zooms in and the right mouse 
button zooms out. 

Left-clicking and dragging can stretch out a range which can then be zoomed 
entirely. 

Navigation tool 

 
With the navigation tool, the visible clip can be moved vertically and 
horizontally. 

 
  

Applications of the Elastic Audio easy editor 

Pitch correction (intonation correction) with monophonic audio material 
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Getting started (for all subsequent editing): 
 Load objects into the Elastic Audio easy editor. 
 Set the desired selection state. All slices are selected directly after the 

analysis. 
 Select suitable algorithms – you should test here to see if "monophonic voice" 

(see above) is the suitable algorithm. 
 Now the pitch can be edited with the mouse tools by editing the orange curve 

or the pitch of the slice objects. 

Manual correction of the whole pitch of a pitch slice 
 Select the slice with the selection tool (arrow). 
 Move vertically with the mouse.  

Automatic correction of the pitch characteristic 
 Select the slice objects with the selection tool (arrow). 
 Select the scale in the Edit slice objects group and, if required, deselect the 

tones which are not to be quantized in the keyboard by clicking on them. 
 Press the "Tone pitch characteristics" button 
 With the parameter "Quantization smoothing" you can reduce the "strength" of 

the quantization. 

In principle, this editing process more or less levels off pitch characteristics 
inside a slice. 

Correction of the increase or decrease in the pitch. 
 Select the slice objects with the selection tool (arrow). 
 Click and drag the pitch curve by moving the two handles at each end of the 

slice objects or on the orange lines.  

Free redefinition of the pitch / Creation of frequency modulations like 
warblers and vibrato. 
 Select the slices with the Selection tool (arrow). 
 Select the drawing tool (quantized or not). 
 Draw in the pitch modulations. 

Creating "Plastic voices" (Removing vibrato by strong quantization of the 
micro pitch characteristic) 
 Set the parameter Quantization smoothing to 0. 
 Press the "Tone pitch characteristics" button 
 If required, switch off format correction when using the "Monophonic voice" 

algorithm.  

Creating "Robot voices" – quantizing to a pitch 
 Select the slice(s) with the selection tool (arrow). 
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 Select the draw tool for quantized drawing. 
 With artifacts: Increase the "Quantization smoothing" parameter. 

Creation of parallel voices 
 Set desired chord. 
 If necessary, change the "Humanize" parameter and press "Create voices" to 

generate the voices again. 

 

Pitch-sliced-objects and VIP objects 

The basic frequency analysis reduces the pitch slices to pieces which ideally 
correspond to one note in the music's melody or one syllable in speech. For 
speech the pitches correspond to the level of the vowels. 

After the analysis, all of the slices are shown selected (blue). 

The subdivision into slices can be corrected manually. The slices are cut apart 
with the scissors tool, and then merged together with the rubber band gripper 
tool ("Ctrl" held down). 

The blue line represents the mid-range pitch for each object and results 
approximately from the average value of the pitches in the slice. 

In selected pitch-sliced objects the functions found in the “Editing 
sliced-object” group can be applied, i.e. the correction of the pitch sequence 
and the mid-range pitch. 

The option to reset the corrections for selected slices is also available. 

Selecting sliced objects 

Sliced objects can be selected and deselected. "Ctrl + A" selects all slices; 
clicking on the “empty space” deselects them. 

 

Fundamental frequency analysis correction 

General options 

The fundamental frequency analysis and the related fundamental 
frequency-dependent pitch-slice-analysis may fail or cause errors for the 
following reasons: 

 Reverbed material, 
 Runtime stereophonics, 
 False analysis, 
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 Voiceless vocals (sibilants...), 
 Noisy sounds. 

In the last two cases, analysis cannot return a result as the fundamental 
frequency is not available. 

MAGIX Elastic Audio provides the user with the opportunity to achieve good 
results using many manual options, whereby the fundamental frequency 
analysis does not or cannot deliver any results. 

Error in the fundamental frequency analysis 

Symptoms: 
Sound: The pitch varies strongly for a short period and does not correspond to 
the set value or characteristic. 

When using the monophonic voice algorithm, additional strongly distorted 
noises arise. The algorithm, which depends on the fundamental frequency 
recognition itself, fails. 

Graphics in the editor: The curve exhibits a short strong jump and behaves in 
a very jerky manner. 

Solutions: 
 With the help of the eraser you can try superimposing the original curve at 

these points. 
 If you set high values for the curve smoothing parameter, then short 

"hiccups" can be reduced in severity or prevented completely. 

Correction of slice borders 

So that the automatic or manual correction of the mid pitches of slices 
provides correct results, the slice borders have to match well with the note 
borders. 

The slice borders can be manually 
changed by connecting two slices to one 
another with the pen 

Ctrl + or  

and using the cutting tool to cut through 
at the correct position. 
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Keyboard commands and mouse-wheel assignments 

Navigation using the mouse wheel  
Horizontal scrolling: mouse wheel 
Vertical scrolling: Alt + mouse wheel 
Vertical zooming: Shift+ mouse wheel 
Zoom horizontal: Ctrl + mouse wheel 
Zoom hor. + vert. Ctrl + Shift + mouse wheel 

Ctrl + space bar 
Space bar 
Ctrl + A 
A 
Ctrl + Z  
Ctrl + 1-8 
Ctrl + Shift + 1-8 
Shift + Alt +P 
Ctrl + Cursor up 
Ctrl + Cursor 
Cursor left 
Cursor right 
Home 
End 
Ctrl + Cursor 
Ctrl + Cursor 
Shift + R 
 
Ctrl + NUMPAD 4,5,6
Alt + NUMPAD 4,5,6 
 
NUMPAD 4,5,6 

Play solo/Stop 
Play/Stop 
Select all 
Update view 
Undo 
Select tool for left-hand mouse button 
Select tool for right-hand mouse button 
Show/hide pitch curve 
Enlarge waveform 
Enlarge waveform 
Play cursor to the left 
Play cursor to the right 
Jump to object start 
Jump to object end 
Zoom in 
Zoom out 
Alter scaling mood (Frequency for chamber 
note a). 
Saves zoom snapshots 1,2,3 
Loads zoom snapshots 1,2,3 
without any vertical zoom 
Zoom snapshots 1,2,3 with vertical zoom 
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Installing VST plug-ins 

Install VST plug-ins according to the manufacturer's instructions. VST 
instruments and VST effects are not entered into the Windows registry, but 
must be saved in a certain directory. 

Samplitude 11.5 Producer searches for installed VST instruments in the "VST 
Plug-ins" program subfolder. VST instruments may be installed either in this 
folder or another path may be specified. If a VST plug-ins folder is already 
installed on the system, then please use the existing folder. The existing path 
must be specified in the system settings (keyboard shortcut: "Y" key) via 
"Effects > VST/DirectX/ReWire" (multiple paths may be specified). Simply 
enter one path after the other; each path will be scanned. Samplitude 11.5 
Producer will automatically find new plug-ins that have been installed if they 
are present in the specified folders. If you add VST plug-in subfolders into the 
main VST folder (e.g. "Equalizers", "Filters", "Modulation", etc.), then these will 
be displayed as submenus when VST plug-ins are loaded. 

 

The first time the program is launched, a search for existing instruments and 
plug-ins is executed (when the track settings are opened). Here, not only are 
all the plug-ins imported, but they are also checked for their usability within the 
program. This search is only required once; the next time it is opened, the 
track settings will be opened immediately. 

Tip: For problems with your current configuration, you can reset all paths and 
installed instruments or plug-ins. To do this, delete the "VSTPlug-Ins.ini" file in 
the Samplitude 11.5 Producer folder. All paths will have to be newly entered. 
Plug-ins which were removed from the program prior to this will still be shown 
again.  

 

Effect calculations 

When working withSamplitude 11.5 Producer, audio material manipulation can 
be performed on five levels. The signal flows through these five levels in 
sequence: 
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1. wave editing (destructive editing), 
2. Manipulations on the object level in virtual projects (real-time processing), 
3. Volume and panorama automation, including track volume fader in the 

mixer or VIP (real-time processing), 
4. Real-time effects in the mixer tracks (real-time processing), 
5. Real-time effects in the "mix master" section (real-time processing). 

When working with volume, panorama, and filter manipulations, the sequence 
is not important. For example, it isn't important whether you apply a filter 
function first and then change the volume, or vice versa. Even when working 
with multiple effects, the input signal level is unimportant. this includes reverb, 
delay (echo), resampling and timestretching, or pitchshifting. 

However, all dynamics functions and those that remove or reduce noise 
(dehisser and noise reduction) are dependent on the input signal level and in 
some cases on the frequency response of the input signal. If you have found 
an optimal setting for the parameters, then you should not apply other changes 
to effects blocks that precede these types of effects. 

 

Samplitude 11.5 Producer as an external effects 
device 

With the help of ASIO driver support, you can also use Samplitude 11.5 
Producer as an external effects device. The signal is pushed through the 
real-time effects section by Samplitude 11.5 Producer and then sent again. All 
real-time effects from the mixer can be used directly: MAGIX AmpSimulation , 
MAGIX Multimax, reverb, echo, compressor, 4-band equalizer, and vocoder. 
You need an ASIO driver for your sound card (required). 

Here’s how it works: 

 In the system dialog ("Y"), select the “ASIO software monitoring with track 
effects“ option from the “Record options“ tab. 

 Connect your instrument (e.g a guitar amp) to the sound card. 
 Select one or more real-time effects for the track activated for recording. 
 Play it. The sound now has the selected effects added to it. 
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Automation 

Samplitude 11.5 Producer provides lots of comprehensive automation 
possibilities at track level. You can enter automation movements in realtime or 
draw them manually. The created automation data are visible as controller 
movements in the corresponding plug-in or as a curve in the automation track. 
An unlimited number of automation curves are available on each track. The 
volume automation curve is set to 0 dB at the middle of the track and +6dB at 
the top of the track. 

 

The following dynamics automation settings are available at track level: 
volume, panorama, AUX sends, EQs, and plug-in control elements and MIDI 
controllers. 

 

Automation – context menu 

To open automation, right-click on the "Vol" button in the track box or on 
button Rd/T in the "Automation" category of the Track Editor. 

 

First entries in the automation context menu 

The first entry indicates which parameter you have automated, e.g. Effect 0 
volume or Effect 1 pan. By checking the corresponding entry you can activate 
the corresponding automation curve. If you haven't activated an element, No 
effect (track) will be displayed. 

 

Editing curves 

Create 

The curve generator will create a beat-based volume curve for you which 
pulses according to eighth, quarter, half, or full notes. As an option for the 



 
 

Automation 155  

 

www.magix.com

beat-based envelope curve calculation you can enter a minimum and 
maximum value, or define the delay values. 

 

Alternatively, you can also let the curve generator write an envelope curve 
scan. 

 

Invert 

This command inverts the active automation curves. 

 

Thin out 

This function thins out the active automation curve by reducing the number of 
automation events. While recording, the automation events are placed in very 
short intervals. The command "Thin out" reduces the number of curve points. 
The course of the automation is then displayed and reproduced even more 
accurately.  

 

Copy / Paste / Delete 

The activated automation curve can be copied/pasted into other tracks and 
deleted. 

 

Inactive 

Use this command to deactivate the selected automation curve. This means it 
will remain intact, but no longer affect the corresponding parameter. 
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Delete all curves 

This command deletes all automation curves of the corresponding track. 

 

Automation mode 

Specify the Automation mode here. 

 

Do not display automation. 

Deactivate the display of the automation curves for all tracks with this option. 

 

Display track automation (default setting) 

If you select this display option, then only the track automation will be 
displayed. 

 

Display selected curves only 

This function displays only the selected curves for the corresponding track. 
This helps to keep an overview if several automation curves have been 
created. 

 

Display unselected curves (cannot be activated) (Default setting) 

The unselected automation curves are grayed-out. They cannot be activated 
with the mouse. 

 

Display unselected curves (can be activated) 

The unselected curves are also grayed-out, but can now be activated with the 
mouse. 

The last section of the context menu lists the ranges for which automation 
parameters are available during automation of the corresponding track or the 
corresponding object.  
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Automation modes 

 

The automation modes define how automation data should be saved or 
displayed. Set the automation mode for each channel/track. Different 
automation modes may be selected by right clicking the automation button in 
the mixer channel. Clicking this button toggles between the last activated 
mode and "Read" mode. "Copy to all tracks" applies the currently selected 
automation mode to all tracks/channels. 

 

Off mode 

All automation functions are deactivated on Off Mode, all already written 
automation sequences are ignored. 

 

Read Mode 

All recorded automation parameters are played in Read Mode. The automation 
button is usually set to this state. 

 

Touch mode 

In "Touch" mode, automation data is only recorded as long as you touch the 
selected control element with the mouse or touch it from your external 
controller. Automation recording is stopped when you release the 
corresponding key. Once released, the control element will move back to the 
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previously recorded position. You can set the fader return time in the "MIDI 
controller automation" dialog in "Settings -> Time constant for user entry". 
The "MIDI controller automation" dialog can be accessed by right clicking the 
automation button in the track editor. 

 

VST plug-in/VST parameters dialog 

All of the parameters that may be automated may also be selected and 
activated in the VST plug-in's parameters dialog. 

This allows automation to be recorded directly via the selected parameter 
controllers during playback. 

You can open the parameter dialog in the plug-in's menu via "Plug-in -> 
Parameter". 

 

Recording automation in "Read" mode 

The easiest way to write automation in "Read" mode during playback is via 
the "Ctrl + Alt + switch/controller" shortcut, while working directly in the 
plug-in/instrument/mixer interface. This way allows an automated recording to 
be made at any time. As long this key combination is held down, you may also 
automate the selected parameters in "Read" mode. 

If a mixer/VST control element is clicked with the same key combination "Ctrl + 
Alt" while stopped, a corresponding inactive curve will be created 
automatically for editing in "Draw" mode. 

 

"Draw" mode 

Select "Draw automation curves" mode to draw automation curves for a 
parameter or a MIDI controller. 

 

You can now draw the automation curve straight into the chosen track using 
the pen tool for the selected parameters. 
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Edit automation curves 

Alongside the normal mouse mode for editing already recorded curves (create 
or delete curve point), a special   

 
"Curve edit" mode 

 
or "Object / Curve" mode 

is provided. 

In Curve edit mode you can directly draw, move and delete curves with a 
double click. The mouse cursor switches between a Hand or Moving tool. If 
your mouse is not directly above the curve, you can select an area of 
automation points using the calculation tool. 

In Object / curve mode you can also create new points on the curve or move 
and delete curves with a double click. If you move away from the curve using 
your mouse, you will automatically switch to object mode, in which you can 
move objects and edit the start & end position, the fade-in & fade-out phases, 
and the object volume. 

Detailed information about curve modes can be found in "Screen elements -> 
Toolbars -> Mouse mode bar". 

 

Move automation curve with audio/MIDI data 

To move the audio material to a new position on the timeline along with the 
automation curve, the automation curve will have to be connected to the 
object. This is possible via "Link curves to objects" mouse mode. Click this 
button in the mouse mode toolbar to get started. 

 
Objects may now be moved or copied together with your curve points. 

Note: If you only wish to move or copy the curve points, follow the instructions 
above and simply delete the objects once moved/copied. The curves remain 
intact. 
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To copy the curve points, simply use "Curve edit" mode and drag out a section 
by moving the mouse from right to left over a curve while holding down the 
mouse button, copy the curve points via "Ctrl + C", and then insert them into a 
different track at the current play cursor position via "Ctrl + V". 
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Mixer 

Overview 

You can open the Samplitude 11.5 Producer mixer via "Window -> Mixer". It 
strongly resembles a hardware mixer. As a result of the digital environment, 
however, it is by far more flexible than an analog mixer. 

All settings made in the mixer are processed and edited in real time. This 
includes track and master effects, panorama and level settings, device 
allocations for individual tracks/buses as well as device allocations for the 
master section. 
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Operating the mixer 

Every VIP track has its corresponding mixer track. However, you can hide any 
VIP or mixer track in the track manager. 

 

Alternative mixer skins 

In "System audio ("Y") -> Design -> Skins" you can select an alternative mixer 
skin. Another option for changing the mixer skins is to click on the system 
menu in the mixer window (the symbol at the top left corner of the mixer 
window). 

 

Using the keyboard 

 Cursor keys: Select the active mixer element (fader, button, or switch) 
 Page up/Page down: Changes the value of the active mixer element 
 Home: Resets the mixer element to its preset (passive) initial value. Press 

"Home" again, and the element is reset to the last value, allowing a simpler 
comparison between the altered and initial preset states. 

 End: Opens the assigned subwindow of an element, e.g. the EQ window for 
one of the EQ buttons. This corresponds with right clicking on a button. 

 Return: Enables the numeric entry for a marked window box. 

 

Operating the mixer with the mouse and keyboard 

Left click: A control element is selected. 

Ctrl & left click: Several control elements can be selected (multi-selection). 

Shift & left click on buttons: Allows special functions to be changed, e.g. mute 
single track or solo single track (although they are members of an active 
group). 

Shift & left click on buttons or faders: Reverses the link selection (negative 
selection). 

Ctrl & left click: A single control element can be temporarily positioned within a 
group by pressing “Alt” and operating the element. 

Double click on numbers: Opens the entry box to allow manual entry of 
numeric values. 

Double clicking on buttons: Resets the control element to its preset (initial) 
value. Double clicking again sets the value back to the changed value. 
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Left clicking on value displays, below the faders, or on the left button corners 
decreases the values. If the key is kept depressed, the value is automatically 
reduced until the key is released, or until the end of the scale has been 
reached. ("Page down"). 

Right clicking on value displays, below faders, or on the right button corners 
increases the values. If the key is kept depressed, the value is automatically 
increased until the key is released, or until the end of the scale has been 
reached. ("Page up"). 

Right clicking on buttons (e.g. compressor) opens the corresponding window 
(“End”). 

The level faders can be adjusted very precisely. Click on a fader, keep the 
mouse button pressed, move the mouse pointer away from the fader to the left 
or right. You can then adjust the settings by moving the mouse in a vertical 
direction. The steps of the settings become smaller as the mouse button is 
moved further away from the selected fader. 

The step size of the fader movement also becomes smaller if you keep “Shift” 
depressed while moving a fader. 

There are two ways to change knob settings. After clicking on a knob you can 
either move the mouse around the knob this is the standard method, or move 
it up and down similar to moving the faders. You can reduce the step size of 
the value settings by keeping the “Shift” key depressed. 

 

Channel strips 

Each track in the VIP is sent through a specific mixer channel, i.e. the sound 
settings of the respective mixer channel are applied to the objects on the track. 

Each channel strip provides the following setting options. Each individual 
section can be opened and closed by clicking on the corresponding arrow 
symbol. 
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Input: Specifies the audio input for the recording. 
Gain: Controls the ratio of signal input to signal output of each 
channel. 
Aux: AUX parts for various AUX busses can be set using these 
buttons. Right clicking opens the AUX routing dialog. 
Ins:  In addition to the mixer effects , more effects can freely be 
assigned to the channel strips. The selection includes "Sound FX" 
(the real-time effects "Equalizer", "Compressor", "Reverb", "Echo", 
and "AmpSimulation"), "Dynamics" (compressor), and (top slot only) 
an insert for external plug-ins.  
EQ: This section allows you to change the sound pattern of the track 
signal using a 4-band parametric equalizer. The knobs change the 
volume of the frequency range.  
You can edit the volume and frequency width of each band in the 
number fields. 
Right click on one of the knobs for fine tuning. Samplitude 11.5 
Producer shows the EQ dialog in which you can specify exact 
settings. 
Panorama: This adjusts the signal alignment in the stereo panorama. 
The settings of the knob have a different effect on mono and stereo 
tracks. When set to the center position, the track signal is held in the 
center of the stereo picture irrespective of whether the track is mono 
or stereo. If the knob is moved away from the center position, the 
mono signal is moved within the stereo picture (to the left or right). 
For a stereo track, the alignment between the left and right channels 
within the track signal is changed. 
Track number: Right clicking the track number opens a context menu 
to make adjustments to the track settings or to insert a new track or 
aux/submix bus. 
Stereo link: This button to the right of the track number connects the 
current channel with the one to the right of it. All settings and 
adjustments affect both channel strips. 
"RD/T" (Automation): Use this function to record controller 
movements of the volume fader, panorama controller and AUX 
controller as Vol/Pan/Surround or AUX curves during playback. 
Curves that already exist are shown in the mixer by movements of the 
AUX bars, the panorama controller, and volume fader. 

"S" (Solo): The solo button mutes all tracks with the exception of the selected 
one. Right clicking enables the selection of the output device for the track. 

REC: Arms the track and starts the recording. 

"M" (Mute): The mute button mutes the track. Right-clicking enables the 
selection of the output device for the track. 
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Volume fader: Controls the levels of the tracks. 

Monitoring: Click the loudspeaker button to activate the monitoring function. 
This means that audio material can always be passed through the inputs of the 
sound card and forwarded to the outputs. 

If "Hybrid Engine" is set in the options for monitoring, all mixer channel effects 
for the feeds can be used. This requires working ASIO drivers for the sound 
card. This way, Samplitude 11.5 Producer can be used as a live effect device. 

More details about monitoring can be found in the chapter "System settings > 
Global audio options > Monitoring settings". 

Track name: Shows the name of the VIP track. Clicking opens the track 
settings dialog where you can change the track name, among other things. 

FX: This key activates each track's VST or DirectX extra effects used to 
configure and edit any number of effect sequences. This specifies the 
sequence in which the effects are used. 

Further information can be found in the chapter "Effects and effects plug-ins -> 
Sequence of effects calculations". 

Right clicking on the button opens the control dialog. This lets you add or 
delete effects and makes the individual track effect settings dialogs accessible. 
You can copy, insert, reset, save, or load track effect settings. Specify your 
personal track effect settings in the program directory in "FX Presets > Track 
FX". Of course, you can also create new subfolders as well as "instruments" or 
"Mid Side Processing". 

Out: Sets the audio output for the channel. This can either be a submix bus in 
the mixer or a wave out device. 

 

Master section 

The master section can be found to the right of the channel strips. 
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Plug-ins: Set the "Vintage Effects Suite" as well as external VST 
or DirectX plug-ins for the master output signal here. 
SoundFX: Provides access to the real-time effects "Equalizer", 
"Compressor", "Reverb", "Echo", and "AmpSimulation". 
Mastering Suite: Provides access to the real-time effects 
"4-band equalizer", "Stereo FX", "Multimax", and the "Digital 
Audiometer" analysis device. 
FFT filter: The FFT filter enables the complete signal to be 
filtered. 
Vocoder: The vocoder for the complete signal can be found 
here.  
Limiter: Distortions in the master signal are prevented by the 
limiter. 
Master equalizer: Provides access to the 4-band equalizer for 
the master signal. 
Stereo Enhancer (StE): This "Stereo FX" lets you modify the 
stereo picture of the complete signal. 
Normalize: This is the master normalization. If you click on this 
button, the output faders are customized in such a way that the 
loudest sections reach 0 dB. This function requires that the 
loudest sections in the VIP be found and played. After clicking 
the "Normalize" button, the program sets the peak value of the 
complete signal to 0 dB. 
To display the maximum values after having made changes, 
please use the "Peak reset" button. This deletes the peak 
display. Clicking the numerical display of the peak value when 
stopped sets the playback marker to the VIP position of this 
value. 
Link: This button above the faders connects both faders. Use 
this function to change the left and right faders simultaneously. 

Faders: These faders adjust the left and right master signal. Double clicking on 
a fader resets the fader to 0 dB. 

FX: Opens the effects/routing dialog for editing and configuring any number of 
effects chains. This specifies the sequence in which the effects are used. More 
information can be found in the chapter "Effects and effects plug-ins -> 
Sequence of effects calculations". 
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Mix to file: The entire VIP including all settings is calculated into a file. More 
information on this can be found in "Tools -> Track bouncing". 

On: This function lets you mix the complete signal into a stereo WAV file during 
each playback. This is especially useful if you wish to use the processed output 
signal of the mixer,  for example, when monitoring. Make sure that the "On" 
button is deactivated if you don't wish to mix the master signal into a new file. 
Otherwise, the system creates a WAV file every time the file is played. 

Note: You don't need to use the "Mix to file" function to record dynamic mixer 
movements during playback. It's usually better to control effects movements 
via AUX busses, to record volume and panorama curves, and then use  the 
mixdown function. 

Device / master out: Enter the playback device for the entire signal here; this 
can also be set in the system/options dialog under "Audio devices". 

 

Global settings 

Some additional buttons for adjusting the global settings of the mixer window 
and mixer handling can be found at the right side of the mixer window. 

This includes (clockwise from bottom left): 

Start track: If the VIP has many tracks, then only a section of the 
corresponding mixer channels is generally displayed in the mixer window. The 
visible section can be moved using the scroll bar at the bottom of the mixer. 

Hold “Shift” down and click on one of the “Start track” buttons to save the 
current view (a left click is sufficient the first time). 

You can recall the previously saved section by clicking again on the “Start 
track” button. 

Preset: By clicking on the preset menu you can select various mixer setups. 

In the "Options" menu reference, please read the section "Project properties -> 
Mixer setup" 

Setup: A click on the setup button opens the mixer setup dialog.  
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Show functions: Right of the master volume fader, individual sections of the 
mixer window can be switched on and off. Particularly the single tracks, master 
section, input pad, AUX section, inserts, EQ, and visualization display. 

+ buttons: The "Aux" category also contains a function for increasing and 
decreasing the amount of aux routes and insert slots. 

Solo/Mute: All solo and mute functions can be globally activated and 
deactivated using this button. 

Bypass FX: Bypasses all mixer effects to compare the settings. 

Auto rec: This display indicates automation data recording such as volume and 
panorama. Automation has to be enabled on at least one track. 

Play/Stop: VIP playback can be started and stopped using this button. A right 
click opens the transport controller. 

Group selected controls: These two buttons are used to group mixer elements 
and ungroup them when they are no longer needed. If you want to create a 
group, select the desired elements by holding down "Ctrl" and then clicking 
"Group controls". To ungroup, choose one of the elements in the group and 
press "Ungroup controls". 

Snapshots:The "snapshot" function is particularly useful to compare various 
setups. You can easily switch between the setups. Naming snapshots is 
possible by double clicking the name field. The two buttons at the bottom of 
the last name field enable you to save and load snapshots. 

A right click on a snapshot opens a context menu from which snapshots can 
be saved, loaded, and deleted or switched between the banks of snapshots. 
This allows up to 32 mixer snapshots to be saved. 

In this menu, mixer settings can also be stored to a separate file. 

When loading a snapshot, the current mixer settings are temporarily saved and 
can be restored by clicking on “Load last mixer”. This also allows an A-B 
comparison between the snapshot and the current settings. 

Reset (mono): Resets all mixer settings to the default settings for mono tracks 
(when using mono or LR wave projects). 

Reset (stereo): Resets all mixer settings to the default settings for stereo 
tracks (when working with stereo wave projects). 
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Reset aux: Resets all aux shares of the channel strips to their default values (= 
no aux share). 

Reset EQ: Resets all equalizer settings. 

Reset peaks: Resets the LED peak meters (peak hold display). 

Reset FX: Resets all effect parameters to the default settings so that effects 
can no longer be processed. 

 

Buses and routing 

AUX buses 

An AUX bus is a collecting bus combining all signals of the corresponding 
"AUX sends" of the individual channels. AUX buses are usually used for 
controlling real-time effects via the volume curve. For this purpose, part of the 
signal of the desired mixer channel is sent to the AUX bus ("AUX send") and 
effects are added. The AUX bus fader represents the "AUX return". This means 
that the higher the volume of the AUX bus, the more effects in the mix will be 
audible. 

Hint: The AUX tracks contained in the VIP tracks are usually not objects. They 
only provide dynamic effects to other tracks. 

 

Submix buses 

A submix bus combines several tracks. It controls the volume, panorama, and 
effects settings of all tracks that are “routed” to the submix bus. For example, 
all drum tracks (hi-hat track, bass drum track, etc.) can be combined to one 
submix bus so that the entire drum kit can be controlled via the volume 
controller of the submix bus. 

 

Working method 

 An AUX/a submix bus can be created in the mixer at any time. To insert a 
submix bus after all channels, right click on the number of the last channel 
shown in the mixer. In the appearing context menu, select "Insert Tracks -> 
New submix bus". If the output of several previous channels is now routed 
through this bus, the volume of all of these can be controlled centrally through 
the new bus. If you have created an AUX bus with "Insert Tracks -> New AUX 
bus", you can channel the signals of the previously created AUX sections into 
the the newly created AUX bus. AUX buses are also the target for AUX sends 
with a lower channel number. 
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 Right clicking the number of a channel allows the option to select between the 
properties "AUX bus", "Submix bus", or even both for the according channel 
strip. 

 Submix or AUX buses are always stereo buses. 
 Submix buses can be fed from tracks with a lower channel number just as a 

physical output device. 
 Submix and AUX buses can be used for all channel effects, including volume, 

panorama automation, and AUX send. You can align your output to output 
devices or submix buses with a higher channel number the same way as any 
other channel. 

 Automation of volume and panning for AUX and submix buses are the same 
as for all other channels. 

 

Embedding external effects devices 

In order to include external effects devices you require an audio interface with 
several in- and outputs, whereas one input/output pair is reserved for the 
external effects device. 

 

Routing the signal 

 You can loop the signal either as an effect or insert. 
 Insert send: Route the channel output directly to the physical output of the 

card that is to feed your external device. 
 Insert return: Select a mixer channel (insert return channel) which the effects 

signal should be sent back to. In the input section of the channel, select the 
sound card input connected to the output of the device you want to loop in. 

 External send effect: Create an AUX bus that is fed from the corresponding 
AUX send from different channels. The output of the AUX bus has to be routed 
to a physical output of the sound card. Connect the output of the effects 
device to the desired input of the sound card. The sound card input is 
connected to the mixer channel by selecting the corresponding input section 
of the sound card in the dialog window of the input section of the AUX return 
channel. 

 

Tips and tricks 

 Master normalization is a mixer feature which allows you to quickly set the 
output level to 0 dB. If the limiter in the master section is active, then the 
output level is also monitored, thus preventing level clipping. 
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 Clicking on the displayed top peak level numbers of the master sets the cursor 
to the VIP peak position. This can be controlled with the function "Play over 
cut". 

 The mixer function "Mix in file" (to the right below the mixer) writes the master 
output of the mixer to a wave file (or HD wave project). If parameters are 
changed during playback, the sound that was changed live can be recorded. If 
you use the live input of Samplitude 11.5 Producer, then all mixer effects can 
be used in the mix file while recording. Warning: the mix file is overwritten at 
every play start. Therefore, if you want to keep the result, you have to rename 
this file or save it under a different name. 
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MIDI in Samplitude 11.5 Producer 

What is MIDI? 

A few words about MIDI: MIDI files do not contain the actual sound like audio 
files, but only the note control information. This data is interpreted and played 
back by the VST instrument or synthesizer.  MIDI is thus a kind of remote 
control for synthesizers. This has some advantages: 

 MIDI files need a lot less memory than wave files. 
 MIDI files can be adapted to any tempo (BPM) without affecting the sound. 

The playback tempo is simply changed. 
 Transposition of MIDI files to other pitches is also easy. As a result, a section 

in a song does not have to be saved in several different keys. The version in C 
major is perfectly sufficient. It can then be transposed to any key easily. 

The disadvantage of MIDI files: The audio is not yet determined and is only 
produced during playback. 

 

Connect external equipment 

Interface connection 

Please consult your sound card or MIDI interface manual for information about 
the correct connection. The most common ways to add MIDI functionality to 
computers are: 

 Multi-port MIDI interfaces, including separate devices. 
 Sound card with built-in MIDI interface. 
 General MIDI module or keyboard-integrated interface, usually labeled “To 

host”. 

 

MIDI cabling 

MIDI inputs/outputs: If your computer has an internal or external MIDI port, or 
has a MIDI-capable sound card installed, connect your MIDI keyboard’s “MIDI 
out” to the computer’s “MIDI in” (on the interface, sound card, and so on).  

If your MIDI keyboard can generate its own sounds, connect the computer’s 
“MIDI out” to the keyboard’s “MIDI in”. If your computer (or the MIDI device) 
offers more than one MIDI output, connect any other sound synthesizers to 
these. If the computer only has one MIDI output, you need to connect the 
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second sound synthesizer’s "MIDI in" to the keyboard’s "MIDI thru" port. A 
third device can be connected to the second’s "MIDI thru", and so on. The 
"MIDI thru" port always delivers a copy of the signals coming into the device’s 
"MIDI in". It is preferable, however, to use a direct connection from a 
computer’s "MIDI out" to a device, rather than chaining too many devices one 
after the other. Timing problems may occur in the chain if a lot of MIDI 
commands are sent in a short space of time. This is due to the slight delays 
introduced by each "MIDI in" to "MIDI thru" transaction. If your computer also 
features several MIDI inputs, they can be used for the connection of MIDI 
expanders.  

MIDI local off: If your keyboard features an internal sound source, it is 
important that you stop the keyboard from generating sounds directly from its 
own keyboard. If you buy a new keyboard that is to be used without a 
sequencer and connect it straight to an amplifier, you would expect the device 
to make a sound when you press its keys. In other words, the keyboard is 
internally connected to the sound synthesizer. This behavior, however, is not 
what you want to happen when using your keyboard with Samplitude 11.5 
Producer. In this scenario, the keyboard is used as the computer’s input 
device, and Samplitude 11.5 Producer is sending (i.e. playing) MIDI information 
to any connected sound synthesizer, be they the keyboard’s own sound 
generator, a sound card, or any other connected sound module. 

If you wanted to control and record another sound module using your 
keyboard as the input device, its own sounds would play alongside those of 
the other sound synthesizer, which is why the keyboard must be separated 
from its own internal synthesizer. This function is known as “Local OFF”, and is 
set directly on your keyboard. Refer to your keyboard’s manual for information 
on how to do this. Don’t worry about “breaking” the link between the keyboard 
and its internal sound generator – Samplitude 11.5 Producer will act as the 
“missing link” in this scenario. 

 

Convert MIDI objects into audio files 

If you use VST instruments, then you won't have to convert these MIDI objects 
into audio data before exporting your entire arrangement, since the sound is 
created on your computer and can be processed there. 

If you still wish to do so (to free up processing power on your PC, for example), 
then switch the desired MIDI track to "Solo" and export the arrangement. Then 
add the exported file back into your arrangement and delete the MIDI objects 
in the exported track. 
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All MIDI objects which open external synthesizers via a MIDI interface will have 
to be converted into audio objects if you want them to be exported as well. 
They only contain control information for sound reproduction. 

For this to happen, the output of the MIDI synthesizer (e.g. the sound card) 
must be connected to the input of the sound card. The MIDI data can then be 
played and recorded simultaneously via the record function. The result is an 
audio file that can be edited and exported together with the multimedia files. 

 

MIDI settings 

Here you can specify which MIDI devices (view page 474) to use in Samplitude 
11.5 Producer. 

 

MIDI: Import, record, edit 

Recording MIDI tracks 

Just as with the routing settings of audio tracks, you can also tell the program 
which MIDI input to use. 

Open the track settings dialog by right clicking on the field that contains the 
track name (track info box). In the "MIDI" section of the track settings, select 
the "MIDI recording device" which your keyboard or external sequencer is 
connected to. Select the MIDI playback device you use as the "Playback 
device" or MIDI output device, e.g. "MIDI out" of your sound card or a VST 
instrument. In the same dialog, activate the "MIDI" button in the "Recording" 
section. 

Note: You can activate the MIDI section of the track editor ("Menu window -> 
Track editor") by clicking the "MIDI" button in the track box.  Now right click 
"Rec" to select the MIDI input device as well as the instrument outputs of each 
selected playback device. You should also check the instrument outputs if the 
MIDI signal in the level display can be seen but no sound can be heard, and 
then adjust this to the MIDI output device (VST instrument). 
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The following MIDI record modes are available: "Normal", "Overdub", 
"Multi-overdub", and "Replace". These decide which of the newly recorded 
MIDI files will be added to the VIP. 

You can specify the settings for MIDI record modes in the transport control. 
Click on the arrow on the left beside the "Close" button in the transport control 
to display this section. 

You can also select the MIDI recording modes from "MIDI record mode" in the 
"MIDI" menu. 

Normal: This recording mode corresponds to that of the audio recording, i.e. 
for each recording process a new MIDI object is created over the existing 
object. The old object remains intact. This way you can record multiple takes 
of a passage and then compare them in the take manager later on. 

Overdub: The data is recorded into an already existing object; available and 
newly recorded MIDI data is mixed together. If you record over several objects, 
then these are combined into a single new object. 

Multi-overdub: The data is recorded into an already existing object; available 
and newly recorded MIDI data are mixed together, but existing objects remain 
the same. This mode makes sense for recording MIDI controller changes over 
several objects sequentially. 

Replace: The data is recorded to an existing object, and any MIDI data is 
overwritten. Several existing objects are combined into a single object. 

After selecting the mode, make sure that the recording is activated for the 
track. The record button, which is set to standby, changes to violet to signal 
that this MIDI track should record MIDI data. 

Now you can start the MIDI recording by pressing "R". After recording, you will 
be asked whether you want to keep or delete the recording. You also have the 
chance to change the record mode for the recorded MIDI data. After 
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confirming this with "OK", your newly recorded material will appear as a "MIDI 
take" in the VIP. 

 

Importing MIDI data 

Existing MIDI files can be imported into a Samplitude 11.5 Producer project as 
objects. However, you can also load a MIDI file as a separate object the same 
way as a wave, HDP, or RAP project. 

Menu: File/Open/MIDI (*.MID) … 
Shortcut: Shift + M 
Mouse: Drag & drop from file browser or Windows Explorer. 

If you import MIDI files, please note that only type 0 or 1 MIDI data is 
compatible with the import function. Each file should end with *.MID so that it 
can be recognized as a valid format. 

MIDI files are generally imported like a wave file, irrespective of whether they 
are imported in a VIP window or a MIDI project window. For a VIP you can 
specify at which position you want to insert the new MIDI object. Set the play 
cursor at this position, select a range in the desired track or drag the file from 
the internal explorer or Windows Explorer directly into the track position via 
drag & drop. 

Hint: The following dialog is automatically displayed if a VIP is already open as 
an active window. If you want to open the MIDI file in a separate MIDI project 
window without inserting the content into a VIP, please ensure that no VIP 
project window is active. Samplitude 11.5 Producer will also display the MIDI 
import dialog if only one range of a MIDI project window is dragged into a VIP 
track. 
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The import dialog contains status information on the MIDI file you want to load: 

Each standard MIDI file also contains temp information. Samplitude 11.5 
Producer displays this information in a separate section of the dialog. At this 
position of the import you can decide whether you want to adjust the VIP 
tempo to the tempo of the imported MIDI file. If necessary, a tempo marker is 
displayed in the VIP. 

If you select the option "All MIDI channels into one track", Samplitude 11.5 
Producer inserts the MIDI object into the currently selected VIP track. The 
created MIDI object then contains all MIDI channels of the MIDI file. 

 

Editing MIDI objects 

Editing MIDI objects in Samplitude 11.5 Producer follows the same principle as 
editing audio objects: MIDI objects can be copied, split, and trimmed, have 
fade handles for fading in or out, and a volume handle that scales the MIDI 
velocity. MIDI objects refer to the MIDI data you have recorded while playing or 
importing, but are not saved on the hard drive as a MIDI file but are saved as a 
project file instead. 

You can edit MIDI object in the MIDI object editor as well as in the different 
MIDI editors, i.e. piano roll, drum editor, controller editor, listen editor and 
score editor. 
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MIDI object editor 

Object: Menu / Object editor 
Shortcut: "Ctrl + O" 
Mouse: "Shift + double click" 

The MIDI object editors (designed similar to the audio object editor) allow you to 
easily edit the MIDI object parameters. You can adjust sound, length, volume, 
and program changes individually for each MIDI object.  
A Samplitude 11.5 Producer MIDI object may contain up to 16 channels and up 
to 16 MIDI SMF tracks (initial track number in imported standard MIDI file). For 
instance, you can use a single object to control a multi-output VST instrument 
via several MIDI channels. Within this object you can edit the notes in the 
corresponding MIDI editor in all channels or only in a selected channel. You can 
use the max mode of the object editor to get an overview of which MIDI tracks or 
channels are within one MIDI object which may have been created from a 
general MIDI file (“Max” checkbox). 

 

If there is only a single track in the MIDI object, then the settings are only 
available for this MIDI track. 
You can use the MIDI object editor to quantize MIDI data in the MIDI object. 
Please note that these settings affect the MIDI object non-destructively in real 
time so that you don't see the changes in the MIDI key or drum editor. 
Important functions and settings in the MIDI object editor: 
Velocity 
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The velocity fader is comparable to the volume fader in the wave object editor. 
Normally, each MIDI note has a velocity value which determines how “hard” the 
note is played. Changing the velocity value in the object editor scales the volume 
of the notes in the MIDI object from its physical maximum or minimum values (0 
to 127), and is therefore included in the actual velocity note values. Changing the 
fader is identical to changing the middle handle of the MIDI object in the VIP 
track. 
Position/Length 
This sets the starting position of the MIDI object as well as the length of the 
object. The settings correspond to moving the object in the VIP track or 
changing the length using the length handle at the bottom left and right of the 
object. 
Crossfades (max mode) 
You can set the global fade settings in the menus "Fade in/Fade range". 
The crossfade editor allows you to make global settings for MIDI crossfades. 
However, this corresponds with the basic setting for all crossfades of the 
project. Crossfades between MIDI and audio objects are possible. Create a 
crossfade between two objects and press “Set” to save the crossfade. If the 
crossfade is set, you can use it for other objects anytime by clicking on “Get”. 
Fade in/out (max mode) 
These settings determine the fade in and fade out effects of an object. If you add 
a fade effect to a MIDI object, the changes are interpreted as a change to the 
velocity values of the affected notes. The fade lengths can be changed directly in 
the object by using the upper left and right object handles. In max mode the 
object editor provides a selection of different curves. 
Object name 
Enter the name of the object. 
MIDI real-time effects 
All 16 possible MIDI channels are displayed in max mode. If the MIDI object does 
not contain data for a channel, this is displayed in grey. Only settings for one 
MIDI channel can be found in the preset, reduced mode. 
MIDI IN channel (max mode only): Mutes the channel of the MIDI object. 
MIDI OUT channel: Routes the MIDI data of a channel to a different channel. 
Transp.: Transposes all MIDI notes of this channel. 
Program and bank change: The values entered here are always transmitted if 
the object is played back. Use these settings if different objects of a MIDI track 
are to use different programs of a synthesizer. 
Quantization 
This is a virtual quick quantization without further options, while the quantization 
settings changed in the MIDI editor immediately affect the notes and adjust their 
starting positions. 
Track selection 
Use this if you want to split a multitrack MIDI file into separate VIP tracks but still 
would like to change all MIDI objects as a group. Bear in mind that this function 
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is only activated if several MIDI objects are active in the VIP. Selecting several 
objects with the object lasso or using "Shift + mouse click" can also achieve this. 
Mute controllers 
Deactivates MIDI controller 
Mute SysEx 
Prevents control via SysEx data 
Bypass effects 
Deactivates all real-time effects for this MIDI object. 
Link all channels 
The settings are changed for all channels simultaneously. 
Background color 
Changes the background color of the MIDI object. 
Reload object 
It may be necessary to reload the MIDI data from the file used to create the 
object at some point. Note: All previous changes are overwritten. 
Bar definitions 
This allows you to make your own bar settings for the MIDI object. The settings 
can differ from the rest of the project or other MIDI objects. The four values in 
the settings window (numerator, denominator, tempo, and PPQ) can help you if 
you would like to increase the quality of the MIDI notes and data. For example, 
you can specify a different resolution (PPQ) to enable a finer quantization. 
MIDI editor 
Opens the MIDI editor (piano roll), where you can easily set, edit, and quantize 
MIDI events. 
Play/Stop 
Starts and stops playback at the current position. 
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MIDI editor 

Notation display, movement, zoom 

The MIDI editor features five main areas for editing: 

 Matrix editor (piano roll) 
 Drum editor (toggle between the drum editor and piano roll optional) 
 Controller editor (for example, velocity, MIDI volume…) 
 List editor (event list) 
 Score editor 

Various tools are available, e.g. the pencil or eraser. Exact values for each MIDI 
event can also be set in the edit fields via the piano roll. 

Fundamentally, changes like moving or deleting notes always refer to all 
selected MIDI events (red) with only a few exceptions. Changes to the selection 
in a range always apply to every other range as well. For example, you can 
select a group of notes in the piano roll and then change the velocity of these 
note groups which modifies all selected notes simultaneously. 

 

Notation display in piano roll and controller editor (with velocity curves) 

Notes which are not selected within the editor are displayed in blue. The 
intensity of the color symbolizes the velocity, and the velocity increases as the 
color gets darker/stronger. 

Selected notes: Multiple selected notes are displayed in red, and a more 
intense color symbolizes increased velocity. 

Current event: Appears in bright red with a red border. The properties of the 
currently selected events are displayed in the edit fields above the piano roll. If 
an event is selected with the mouse, it turns into the current event. 

Display of filtered events: You can filter specific events for the display to get a 
better overview of the events of a MIDI object. 

Example: The MIDI object as notes in the MIDI channels 1, 2, and 5. You can 
now make all notes in channels 2 and 5 accessible for the selection and editing 
tools via the selection of the MIDI channels in the channel filter by selecting the 
two channels from the menu. All unselected filtered notes in channel 1 are 
displayed in gray in the piano roll and the list editor. 
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Events in the filtered channels can be completely hidden using "Hide filtered 
MIDI data" option in the menu. 

The list editor provides additional display filters that only function within the list. 
The display filters are initiated with the settings of the playback filters (mute 
settings), but the filters can be set independently of one another. 

Display of muted events: MIDI object settings (in the MIDI object editor, "Ctrl + 
O") can be used to mute notes and filter other MIDI events. This type of 
"muted" event is displayed lighter or paler in the piano roll and list editor. 

Events in front of or behind the beginning/end of the object (recognizable by 
the blue lines in the editor or when the display is active and transparent as 
grayed-out ranges) appear similarly pale as non-muted events within the object 
borders. 

Events above and below the current picture section: Two small red displays 
above and below the vertical scroll bar to the right-hand side of the MIDI editor 
screen show in red if there are notes outside the screen's display. 

 

Moving and zooming 

The vertical and horizontal view or zoom are adjusted with the scroll bars just 
like in the project window. 

Mouse wheel: Scroll horizontally 
Shift + mouse wheel: Zoom vertically 
Shift + Ctrl + mouse wheel: Scroll vertically 
Ctrl + mouse wheel: Zoom horizontally 

 

Synchronized MIDI editor and VIP screen view 

If you change the horizontal display or zoom using the scroll bars, holding 
"Shift" changes the corresponding VIP window. 

Play/Play solo 
“Play solo” only plays the MIDI object that is currently opened in the MIDI editor 
(corresponding with the filter settings in the “Options” menu). “Play” plays the 
entire arrangement. 
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Multi-object editing (MO editing) 

You can also load several MIDI objects simultaneously in the MIDI editor. All 
MIDI objects selected in the arranger are added to the MIDI editor by clicking 
the "MIDI editor" button in the arranger. 

 

If the MIDI editor is already open, you may include additional MIDI objects by 
clicking them while holding down the "Shift" key. 

The MIDI editor always shows the current MIDI object and the current arranger 
track where the object is located. The plug-in activated for this track is 
displayed in the field to the right. 

 

New MIDI events will always be placed into the current object, i.e. the 
displayed object. The current line of notes will be included when in "Score" 
mode.  

Click the arrow next to the object or track indicator, and all MIDI objects or 
MIDI tracks contained in "MO editing" mode will be listed one below the other. 
The current object or track will feature a check mark next to it. 

The corresponding object becomes the current object by selecting notes or 
MIDI events or by clicking it with the pencil tool. The current staff in the score 
editor will be reset automatically. 

You may also copy and insert MIDI notes between multiple objects. 

The current object area may be highlighted by clicking the button behind the 
object selection field. Areas outside of the current object will be grayed-out 
and the notes of other objects will be paler, but they may still be selected. 

 

A display filter for the current track may be activated while in MO editing 
mode. Data from other tracks is then grayed out or made invisible. If the option 
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"Hide filtered MIDI data" in the "Options" menu is activated, then MIDI events 
that are not current will be made invisible. 

 

Note: If the score editor is activated at the same time, only the velocity values 
of the current staff will be displayed in the controller editor. 

The staff of the current track is highlighted with blue lines. 

 

Using the MIDI editor: Selecting events 

 Select event: Left click on event 
 Add/Remove event (selection): Ctrl + left click on event 
 Change/Set current event within multiple selection: Left click on selected event 
 Set current event, deselect all other events: Double click on event 
 Selection of events within a line or range: Click while holding down "Shift" 
 Selection of all notes of a pitch: Double click on the assigned key on the left 

keyboard 
 Selection of all notes: Ctrl + A (functions for pitches selected with a key on 

notes with this pitch) 
 Select next or preceding note: Cursor left, right 

 

Selection of MIDI events (piano roll, drum editor, controller editor, list 
editor, score editor) 

Special selection options in the piano roll 

In order to directly select all notes of a certain pitch, double click on a free 
section with this pitch in the piano roll editor or in the keyboard. Hold down the 
"Alt" key to select notes with this pitch only from this click position. 

Holding "Shift" and double clicking on a free area selects all notes (all pitches) 
from the click position onwards. 

Note: If you press "Ctrl" as well during any of these selection methods, the new 
selection is added to the current one (i. e. the previous selection is not 
canceled). 
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Editing events: Piano roll 

 

Editing tools 
There are several editing possibilities for notes within the piano roll, i.e. the 
so-called "Mouse" modes. The same functions for editing notes (except delete) 
apply in all modes, so that these modes only differ by their reaction to clicking 
in empty spaces. 

Selection (1) 
Lasso: You can draw a selection frame by holding down the mouse button. 

A click in an empty space removes a selection. 

Draw pencil (2) 
Left clicking draws a note. The beginning and the length are determined 
according to the current quantization settings (Toolbar editor). 

Drum pencil (3) 
A sequence of notes is drawn. The length of the notes and the note intervals 
are determined by the current quantization settings. 

When holding Alt: The pitch of the first note is also maintained for all notes 
drawn subsequently. Moving the mouse backwards (to the left) while 
depressing the mouse button removes drawn notes. 
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Pattern pencil (4) 
Draws a freely definable note pattern (Ctrl + P). 

When holding Alt: The pitch of the first note is also maintained for all notes 
drawn subsequently. Moving the mouse backward (to the left) deletes just 
added notes again. 

Velocity change (5) 
If you hold the mouse key and drag the mouse vertically, the velocity values of 
the selected events are increased or decreased relatively to each other: The 
velocity values are changed absolutely, i.e. all changed events have the same 
velocity values after editing. In the graphic velocity display mode you can 
change several velocity values at once by clicking + dragging the mouse over 
the notes. 

Delete (6) 
Clicking on a selected note deletes all selected notes. Dragging the mouse 
deletes all notes underneath the eraser. 

Magnifying glass (7) 
Left mouse button: Zoom in 

Right mouse button: Zoom out 

Left mouse button + drag: The sketched area is always zoomed. The zoom 
mode can be temporarily accessed by holding "Z". After releasing the key the 
mouse mode is active again. 

Glue notes (8)  
Glues the note with the next note of the same pitch. 

Split notes (9)  
A notation bar is split in the matrix at the next grid position by clicking. 

Mute (M) 
Individual notes or selected note groups can be deactivated or activated by 
clicking on them. Also available as a command in the "MIDI functions" menu. 

Hints: 
 You can freely define the shortcut for switching the mouse mode (tool). 

"Delete" mode can be activated anytime by clicking/dragging with the right 
mouse button. For instance, you can use the pen to insert new notes when left 
clicking and remove already inserted notes with a right click without having to 
change tools. 
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 Notes created in "Draw" mode contain the MIDI channel and velocity of the 
edit boxes of the "New" section above the piano roll. 

 You can select the previous/next note with the cursor left/cursor right keys. 
With the cursor up/down keys you can adjust the note pitch step by step. 

 

Editing notes with the mouse 

If you move the mouse over a note, then the mouse cursor will change and, 
depending on the part of the note, the following options will be available: 

 Change note start time (Grab note bar at the beginning, note end remains) 
 Change note length (Grab note length at end) 
 Shift + set fixed note length (for multi-selection hold "Shift" and drag current 

reference note longer/shorter – all notes will have the same length) 
 Ctrl + scale note length (for multi-selection hold "Ctrl" and drag current 

reference note longer/shorter – changes the note length relatively, i.e. the 
reference note will become twice as long and thus all other notes will be 
double length) 

 Move note freely (pitch and start time is changed) 
 Move note horizontally only, retain pitch (in free move mode, hold "Alt") 
 Move notes vertically, keep position (hold "Shift" in move mode) 

 

MIDI functions 

Extensive quantization (More Informationen can be found in the section 
"Quantization settings" on page 212) and editing functions for MIDI notes can 
be found here. 

The commands in the "MIDI functions" menu always affect all of the selected 
notes. If no notes have been selected, the functions are applied to all notes. 

Legato: If necessary, notes may be prolonged until the next note to be played 
in legato. 

Notes quantize (start and length): Selected notes will be quantized according 
to the set grid and length quantization values. If no notes are selected, all 
events will be quantized. This function can be accessed via the "Quantization" 
button in the MIDI editor. Hard quantization always occurs at 100%.  

Start quantization: Selected notes will be quantized corresponding to the set 
grid quantization value. Note lengths remain unaffected. 

Quantization approximation (soft): This command considers the current level 
value in the quantization options. The simple quantization command always 
occurs at 100%. In this manner, you can always select between approximation 
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(soft) and hard quantization without having to adjust the quantization options 
every time. 

Length quantization: Selected notes will be quantized according to the set 
length quantization value. The start time remains unaffected. 

Quantize note ends to grid: The end of selected notes will be quantized 
according to the set grid quantization value. The start time remains unaffected, 
but the note lengths will change. 

Reverse quantization: With this command, you can reverse all completed 
quantization steps. This works even after the arrangement has been saved. 

Quantization settings: Opens the dialog for the Quantization settings (view 
page 212). 

Quantize controller events: Allows you to quantize controller events (view 
page 191) in order to reduce their number. 

Mute notes (Mute): Mutes and unmutes notes. 

Remove overlaps (polyphonic): Notes may be shortened so that there no 
longer are any overlaps. Chords (simultaneously played notes) are recognized 
and not corrected, i. e. chords are not split up. 

Remove overlaps (monophonic): Notes may be shortened so that there no 
longer are any overlaps. Forces monophonic voice leading. 

Convert sustain pedal to note lengths: This function converts sustain pedal 
controller events (controller 64) into note lengths. All notes which were started 
after a "Pedal pressed" event (CC64 > 64) will be extended to the "Pedal 
released" event (CC64 < 64), and the pedal events removed. 

 

Editing selected events (edit fields) 

The properties of each event in the piano roll, controller, and list editor can be 
edited by clicking the edit fields below the editing tools. The following buttons 
are available for each note: 

 Channel 
 Byte 1 (or pitch) 
 Byte 2 (or velocity) 
 (Start) time in bars: beats: ticks 
 Length in bars: beats: ticks 
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The display of the ticks has a resolution of 384 PPQ (i.e. 384 ticks correspond 
to a quarter note). 

Used to edit, click, and drag the displayed value. Hold down the left mouse 
button and drag up or down to increase or decrease the value. 

Note: The value adjustments are greater if you press "Ctrl". 

You can also edit the value numerically via the keyboard by clicking on the 
figure. 

Multi-selecting events leads to a few special features:  

You can change the values relatively by dragging the mouse, using the mouse 
wheel, or entering numeric values and then confirming by pressing "Enter" (for 
pitch and velocity). 

You can make absolute changes by simultaneously holding "Shift" while 
dragging & dropping or by completing your entry with "Shift + Enter". 

Note: MIDI channel changes are always absolute. 

 

Controller editor 

Open: The controller editor is located below the piano roll and can be hidden. 
It can display and edit up to 4 MIDI controller types or velocity values 
simultaneously. 

Open it by clicking either the -Button below the keyboard or with the 
shortcut "ALT + V". 

The values of existing events are displayed as colored bars in the controller 
editor, whereby darker and higher bars symbolize higher values. The bars are 
located vertically directly below the notes. 

 

Selection 

Combo tool, also used for value changes as well as freehand and line drawing. 
Select the controller bar by clicking and dragging or by single clicking in the 
range within a bar. 
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Click on the bar end: The controller value can be adjusted by dragging 
vertically: 

Shift + drag: Set all bars to the same value. 

Ctrl + drag: Scale (relative value change) 

Shift: Draw lines (envelope) 

Alt: Draw freehand (envelope) 

Freehand drawing: Click and drag to draw a controller curve, drag backwards 
to correct the curve while drawing. 

Single click: Creates a single controller event. 

Shift + click: Draw line 

Draw lines: Click and drag to draw a controller ramp. 

Note: If you edit velocity, no new notes are generated; only existing velocity 
values are modified. 

 

Tools 

The Controller Editor has its own tools for editing curves and values. 

 Controller selection: A click on the menu area of the button opens a 
selection menu in which the MIDI controller for editing can be selected. 

 Selection: This is a combi tool used for value changes as well as 
freehand and line drawing. 

Click in the upper range of a controller bar to modify the controller value 
immediately by dragging. Clicking in the lower two thirds of the bar selects the 
corresponding note which is then highlighted in red in the editors. 

Select multiple controller bars by clicking and dragging a range in the 
Controller Editor; individual values can be selected by single-clicking within the 
bar. Selected controller events will be highlighted red. 

Combi tool editing options: 

 Click on the bar end + drag: The controller value can now be adjusted by 
dragging vertically. If you hold the "Shift" key down while dragging, all of the 
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selected events will be set to the same value. If you also hold down "Ctrl", 
then the values of multiple selected controllers will be changed relative to one 
another.  

 Alt + Drag: This activates freehand drawing; the mouse pointer becomes a 
pencil. By dragging in the corresponding controller area, you can draw in any 
number of controller curves. 

 Shift + Drag: This activates line drawing and the mouse pointer becomes a 
cross hairs. By dragging horizontally, you can draw in linear value curves 
(ramps). 

 Freehand drawing: Draws new controller value curves or 
individual values by single-clicking without dragging. 

By dragging backwards, you can delete your curve during drawing. Shift + 
Drag with the cross hairs to draw a line. 

 Draw lines: Use the line function to insert a transition 
between two different controller values. 

Hint: If you edit velocity with the draw tools, no new notes are generated; only 
existing velocity values are modified. 

 

Quantize controller events 

MIDI controller events can be quantized and thinned out; select the "MIDI 
functions" menu and the "Quantize/Thin out controller" command to do this. 
Quantization occurs according to the quantization settings (view page 212). 

 

Multi-view 

The four multi-buttons are used to display or hide the view of all possible 
controller curves. Clicking on the menu area of the buttons opens a menu 
which allows you to choose a MIDI controller for this controller slot. 

Selecting and processing notes: By clicking in the upper range of a controller 
column, the controller value can be changed immediately by dragging the 
mouse. Clicking in the lower two thirds of the column selects the 
corresponding note (displayed in the editor in red). 

Tips:  

The size of the controller editor can be determined by the dragging the mouse 
to the top edge (directly below the horizontal scroll bar). 

Several controller events can be shifted simultaneously. First select all values 
you want to move (if necessary, hold "Ctrl" to select different controller types 
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together). You can now move the selection in the time box by entering a value 
and confirming with "Enter", or by dragging the mouse.  

Use the display filter function for velocity values. 

In polyphonic events especially the columns are located above each other, 
making it difficult to select the respective note. To edit only notes of a certain 
pitch, e.g. all C1 notes in the controller editor, click on the respective key on 
the keyboard. The key and the background of the selected pitch are 
highlighted. Only notes of this pitch are displayed in the controller editor. 

Notes of different pitches, e.g. all C1, D1, and A1 notes can be displayed with 
"Ctrl + Click" (or "Shift + Click" for the area between the clicks, respectively). 
These are simply display options of the controller editor. Multiple note selection 
by double clicking is not possible. 

A further possibility is to selectively edit controller bars located on top of each 
other, which is based on the fact that the bar of the currently selected note is 
selected/edited using the mouse. Therefore, first click on the note within the 
piano roll, or click on the columns located on top of each other and then select 
the required note using the cursor keys. Then change the controller value by 
clicking in the upper third of the red (current) area of the column. 

Besides directly changing the velocity values of a selected note you can 
change several velocity values at once by clicking in a free space and dragging 
the mouse over several velocity values while holding down the key. You can 
then also create sequences by moving the mouse in a curve. A previous 
(multi)selection is ignored. For example, you can easily create a crescendo or 
decrescendo effect. 

 

List editor (midi event list) 

Open list editor 

The MIDI editor has an integrated display of all events in list format. This list 
editor can be opened with the button above the keyboard or by using the “Alt 
+ L” keyboard shortcut. 

When the list editor is opened and activated for editing it has a narrow red 
border. This is to make clear that certain functions, e.g. select next/previous 
event (cursor keys) or the “Select all” command, refer only to the list. 

Working with the list editor 
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The list editor does not only display note events, but also MIDI controller and 
SysEx data. This controller and the data can be hidden and can even be 
filtered during playback (“mute”). 

Double clicking on a SysEx entry in the list opens a simple editor for viewing 
and editing the SysEx information. 

A note always has a "Note on" and "Note off" event. These are always selected 
and edited in pairs (note off events are not displayed by default, but can be 
displayed by checking the box below the editor). 

New events can be created directly in the list editor by using the “Insert" 
button. The current values of the edit fields in the upper frame of the piano roll 
always apply. Therefore, before editing these fields please ensure that no event 
in the piano roll is selected. 

Tip: If no current event has been selected, you can determine the insert 
position by setting the play cursor. 

 

For editing certain events only, the list editor has a view filter for each column. 
These are small check boxes above the list editor columns. 

Select a representative format, e.g. a note of a certain pitch. Then click on the 
display filter of a specific column to display only events of this type, e.g. of the 
selected pitch. All other events are now hidden. 

View filters can be combined. For example, you can use the “Select all” 
command ("Ctrl + A") to select and edit all type 10 control change events 
(volume) of MIDI channel 6. 



 
 

 194 MIDI editor  

www.magix.com

MIDI editor tips & tricks 
You can copy & paste MIDI data within the editor and between different MIDI 
objects. MIDI data is always inserted at the current position of the play cursor. 

Duplicating: If the grid is activated (“Options -> Quantization grid active"), the 
selected notes are copied and inserted from the next grid point following the 
selection. They are otherwise inserted immediately after the selection. 

 

Drum editor 

After opening the MIDI editor (double click on the MIDI object), open its 
"Options" menu and select the "Drum editor" entry. Instead of the piano keys 
to the left, you now see a list of drum instruments. 

 

Note: If a drum map is active in a track (recognizable by the cross beneath 
"Drum" in the trackbox), the Drum editor is loaded automatically when the MIDI 
editor is loaded. 

Drum editor: In the trackboxes of the drum editor you can individually adjust 
MIDI channel, grid, quantization length, display width in cell mode, and velocity 
scaling for each drum instrument. 
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Velocity scaling: The velocity value of each note is multiplied by the V 
value/100 entered here and adjusted to the MIDI velocity between 1 and 127. 
Scaling is audible but is not visualized further. 

 Cell mode: When the drum editor opens, "Cell" mode activates by default. This 
is solely a view mode which permits an alternative view of the MIDI events. 

 Notes are displayed as cells, i.e. the note length is not displayed, but rather a 
specific display width can be set. In the drum editor's cell mode the display 
width for each instrument can be set individually in each trackbox. (In the 
piano roll's cell mode the length value sets the width). 

 Cell mode serves to improve the overview especially when editing MIDI drums 
and permits a structured and efficient workflow. This is because the display 
can be limited to the most important information, starting note positions, and 
velocity. 

 

Mouse modes 

The following modes are available for editing events, just like in the piano roll: 

Selection mode (1): You can use this mode to select drum events, move, or 
change the length of one or several events simultaneously. 

Draw pencil (2): In this mode you can draw drum events. If quantization is also 
activated, they snap to the grid immediately when you enter them. 

Drum pencil (3): This mode also entails a draw function. However, the 
quantization length is also taken into account when the events are drawn. 

Pattern pencil (4): This mode allows you to draw entire drum patterns (or 
melody patterns). If you want to create a new pattern, you have to select it first 
in "Selection" mode and press "Ctrl + P" simultaneously (or go to "Edit" in the 
MIDI/Drum editor, then "Create pattern from selection"). If you have created a 
preset pattern, then you can start drawing at any position. The lowest note in 
the pattern is the pitch you will draw. 

Velocity tool (5): This mode allows you to mark events and change the velocity 
values of all selected events in relation to each other. Absolute values are 
entered when you hold "Shift", i.e. all changed events receive the same velocity 
value. 

Eraser (6): This tool lets you delete events with a single mouse click. 

Zoom mode/magnifying glass (7): Sketch a rectangle to zoom in. The left 
mouse button is used to zoom in, the right one is used to zoom out. 
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Velocity 

If this button is active, the bar height is used when displaying the velocity value 
of the note. In all mouse modes (except for "Delete") the velocity can be 
changed by directly clicking on a note without have to switch to the controller 
editor. 

 

Quantization 

The global quantization settings can be found in the menu "Options -> 
Quantization options". Press "Q" to trigger global quantization. Each drum 
instrument can have its own quantization. To make the necessary settings, 
select the arrow next to the track name of the instrument you want to edit and 
open the quantization options. 

 

Drum maps 

Drum maps specify individual instruments, e.g. bass, drum, hi-hat, snare, etc. 
Individual output notes, MIDI channel, and velocity scaling can be set for each 
of these instruments. To split the drum names a "general" MIDI map is used by 
default. 

The drum map can be set in the track info (should the track be set to MIDI 
recording), via the "Drum" field and via the drum editor itself by clicking on the 
"Map" field. 

It may be the case that your synthesizer (regardless if real or virtual) uses a 
different mapping setup. 

This means that when you play the drum event, the sound you wish to hear 
may not be heard (for example, instead of a bass drum, you might get a high 
tom). In this case you will have to sort out your mapping setup. 

 

Drum map editor 

This editor lets you route each played note to a different one and give them 
their own individual names. It's also possible to assign each individual 
instrument its own quantization and a new (MIDI) output channel. 

Pitch: This is the incoming MIDI note. 

Instrument: Here is where you can find the name of the drum instrument, e.g. 
"Bassdrum 1". 

Grid: If you wish, you can set up a grid for the starting point of the drum event. 
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Length: In this field you can set the grid for the note length. 

Output note: This is the note value to which the drum instrument (the incoming 
MIDI note in the "Pitch" field) should be routed or mapped. 

Channel: You can set up an individual channel for each instrument here. 
Furthermore, you can select swing, window, and near quantization for each 
instrument in the drum editor. 

 

Score editor 

The score editor displays the MIDI data of a MIDI object as a score sheet. It 
"interprets" the available MIDI data into real time. If you move or change the 
MIDI data, such changes are immediately reflected in the score image. If you 
insert a new note in the score editor, a corresponding MIDI "Note on" event is 
created immediately. Therefore, do not view the score editor as a score 
painting program, but more as an interpreter for MIDI data. 

For instance, it is not possible to insert or delete rest symbols directly. 
Samplitude 11.5 Producer automatically "registers" rests in the gaps between 
the MIDI notes. You will therefore always have a valid score sheet and 
"complete" bars, even if the MIDI object should only contain a single MIDI note: 
the necessary rests are automatically inserted into the bars. 

The common controllers of the MIDI editor in the score editor operate as usual, 
e.g. the eraser is used for deleting notes or the pen for creating, copying, and 
inserting new notes. In this chapter you will learn how you can edit your MIDI 
objects within the regular score. While the event editor contains specific editing 
options for certain details (dynamics, note length), it is better to make MIDI 
changes directly in the score sheet as it guarantees a better overview. 

 

Opening the score editor 

The score editor is integrated into the MIDI editor window. If the MIDI editor is 
opened, then you can activate the linear score view by pressing the "Score 
editor (linear)" button. 

 
Score editor (linear) button 

Navigation: You can adjust the play cursor directly in the score by holding shift 
and clicking the desired position. You can set the playback range by holding 
the "Shift" key and left clicking the left border and right clicking the right border 
of the range. 
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Score editor modes 

Samplitude 11.5 Producer offers two alternatives for viewing the score: linear 
display and page mode.  

The linear note display can be combined with the matrix display to offer ideal 
MIDI editing conditions, since the detail in depth of the matrix editor and 
overview can be supplemented by several score systems. You can select the 
score in the score sheet and perform fine adjustments in the piano roll. 
Selection and zooms in all editor views (linear score, piano roll, event list, 
velocity editor) are always synchronized. 

 

Linear view 

 
Score editor (linear) button 

For detailed editing of the MIDI data in the score you should preferably select 
linear view mode as both matrix and velocity display are available. All 
parameters such as pitch, note length, and velocity are displayed. 

Please note: Only the notes of the currently active system are displayed in the 
velocity editor if notes and velocity are parallel. The red bar mark indicates the 
currently active system. 

 

Notation view in "Linear" mode (move bar between score and matrix) 

The horizontal zoom above the scroll bar zooms parallel to the matrix view. 
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In linear mode details can no longer be displayed correctly if you zoom out 
horizontally, since the note symbols overlap. It may then be necessary to 
reduce the size of the notation symbols (+ & - buttons on the right). Despite 
the no longer correctly displayed details, zooming out can still provide you with 
a good overview, particularly in large scores. Samplitude 11.5 Producer can 
adjust the notation symbols automatically. To do this, please select "Automatic 
zoom" in the score menu. 

 

Page view 

This page mode displays the notes just like on a musical score sheet, which 
also serves as a print preview. Here you can select notes and allocate them to 
voices/staves and delete them, although you cannot move them with the 
mouse or pen. 

 
Score editor page mode 

Page view is not only useful for preparing a score sheet (e.g. for titles, 
borders), but also for editing longer sequences. The stave break allows you to 
display considerably more bars than with the linear display. 

Scrolling in full view mode: Use the vertical scroll bar to scroll from page to 
page. 
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Page mode as print preview: You should first change the page format (in the 
score properties dialog) to the paper format of your printer before setting up 
the page for printing as the display depends on the page format. You will then 
see your score exactly as it will be printed. 

 

Score sheet 

The automatic conversion of MIDI data into score material is usually sufficient 
for editing MIDI data; in this case, efficiency is required instead of a perfect, 
ready-to-print display. However, it may still be necessary to adjust some of the 
display options for the musical material during editing. These display options 
can be found in the "MIDI score properties" dialog, which you can open by 
clicking the corresponding button. 

 Open score settings dialog for notation system and page properties 

Presets are available here, too. These are pre-programmed standard settings 
for certain instruments or groups such as "strings" or "orchestra". Selecting a 
preset improves the score display and its readability. 

 

Violin clef view (preset) 

 

Changing the score by selecting the piano presets 

More information about the score is available below. 

 

Editing MIDI data in the score sheet 

Selection 

As usual you can select notes by clicking them. You can select a group of 
notes (e.g. a chord) by sketching a frame over them while holding down the 
mouse button. Select multiple single notes by pressing "Ctrl". 
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Note parameters 

The parameters pitch, velocity, and length can be changed for one or several 
selected notes. If you have selected one or several notes the data of the 
current note will appear in the info bar above the score view. Changing a 
parameter may have a comparable effect on all selected notes, just like in the 
matrix editor. 

 

Move and transpose 

To move notes, first select and then drag them to the desired position. Here 
the info box can help you keep track of the pitch or position. The step size 
when moving is determined by the selected quantization raster in the MIDI 
editor. 

 

Copy 

Select the desired notes and copy them by holding down "Ctrl" and dragging 
the mouse. Alternatively, you can also use the copy function of the edit menu. 

 

Insert new notes 

You can also insert new notes in the score editor by using the pen. Click on 
the desired position with the pen, hold down the mouse button and, if 
necessary, correct the position and pitch. If you let go of the mouse key, 
Samplitude 11.5 Producer will add a new note of the same length as the 
selected length quantization value. You can only insert new notes into the 
active stave. For instance, to insert a note in the lower part of a piano system, 
first click on the lower staff in the system on the left.  

Only notes are inserted that correspond with the current pitch. Non-scale 
notes or chromatic intermediate steps are skipped. When you enter 
conventional music material with the mouse, diatonic insert mode increases 
the chances of hitting the correct note. If a new prefix is to be added to the 
note, you can move the note chromatically with the arrow key. This way an 
inserted F in C major can be transformed into an F# by pressing "Page up".  

 

Delete notes 

You can delete notes by: 

 selecting them and pressing "Del" or 
 by clicking on them with the eraser (or the right mouse button) 

 

Insert notation symbols 
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Clef symbols can be inserted at the current cursor position by pressing the 
corresponding clef symbol in the active system. 

 

Delete notation symbol 

Notation symbols such as clef and pitch cannot be selected, since they are 
meta information for the notation display and no MIDI events have been 
allocated to them. They can also be deleted by clicking them with the eraser 
(or the right mouse button). 

 

Adjusting and optimizing the score 

Samplitude 11.5 Producer automatically generates a notation display from the 
MIDI events contained in the MIDI object. This is always correct with regard to 
pitch and position. However, this does not mean that the notation can be read 
optimally, since displaying note lengths also plays an important role in this 
context. In this case, the notation permits more interpretation flexibility so that 
the user usually has to intervene. The illustration shows a typical example of 
how poor a readable transformation of a sixteenth note piano sequence would 
look in notation.  

This representation may be correct, but it is not readable. Why is that? The 
MIDI events contain very precise information on the start of a note, i.e. its 
length and pitch, which has to be taken into account during playback. It may 
influence the groove of a song if the notes are always slightly shorter than 
sixteenth notes. If this were to be displayed correctly in the notation, then the 
score would be unreadable as in the example above. The MIDI events also do 
not contain information on whether the gap between two notes is a real rest, 
its harmonic correlations (pitch), and the characteristics of the dynamic 
sequences. This is why automatic processing of notation always differs from 
what would be ideal. Samplitude 11.5 Producer includes a number of 
automatically and manually controllable functions for making it easier to read 
the notation. The reworked version of the the above score illustration shows 
how big the difference can be. 

 

Note allocation in multiple staves 

The term "Stave" refers to an individual line within a stave as well as all staves 
of a score. In cases where it is important to be able to differentiate a score and 
a staff from one another, we use the term "Stave" for the score and "staff" for a 
single system. 

What is meant by a "Stave" can often be interpreted from this relation, for 
example, in a two-handed piano piece, "upper" or "lower" systems are 
referenced. 
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Samplitude 11.5 Producer provides multiple systems, e.g. for piano notation, 
or entire scores which can possibly be comprised of up to 16 individual 
systems. 

To manually assign notes to a system, click 

 

to move the selected notes one line on a stave higher. Click 

 

to move them one line lower. This results in the note being connected to the 
line (independent of the MIDI channel or pitch). This manually set allocation can 
be undone by clicking on  

 "Automatic staff allocation"  

When transcribing a MIDI piano recording, splitting the notes into a two-line 
piano system using the split point is recommended. The points where 
individual notes are placed incorrectly in a line can be corrected easily by 
assigning the notes manually with a click to the desired stave. 

The automatic allocation of the score to a specific line is flexible. Either the 
MIDI channel of the note event, the pitch, or even a combination of the two 
can make up the criteria. This permits simpler and faster distribution of MIDI 
notes in the score line.  

For example, it's often the case with some standard MIDI files that a particular 
piano piece's lower system notes have a different MIDI channel than that of the 
notes of the upper stave. Let's assume the notes for the right hand are on 
channel 1 and the notes for the left hand are on channel 2. In this case you 
should set up two staves for the stave in the note stave settings. The easiest 
way to do this is with the "Piano" preset. For the first staff, set the MIDI 
channel allocation to "Ch. 1" in the "Channel" selection box and "Ch. 2" for the 
second staff. Deactivate allocation according to pitch by setting the split point 
to 0 (see MIDI score settings dialog). 

The rules for allocation are as follows: 

If the (preset) option "Automatic stave allocation" is set for the note, then the 
staves will be played through until the MIDI channel corresponds with it and 
the pitch is over or equal to the split point. 
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Note: It may happen that some notes are not shown at all as they are not yet 
allocated to a stave. 

 

Multi-voice notation 

Up to two independent voices can be annotated for each staff. The voices 
differ in the direction of the note stems: the first voice is always with the stem 
pointing upwards, the second with the stem pointing downwards. Rests are 
displayed individually for each voice. 

Multi-voice notation can simplify the score considerably and enable multiple 
instruments or parts to be displayed in one staff together.  

 

You can set the voice by selecting the notes and clicking on the button or 
menu command "Assign first voice" or "Assign second voice". 

 

This sets the stem direction of the notes, and therefore the voice itself. 

This assignment can be undone by clicking on 

 "Automatic staff assignment for notes". 

For automatic voice assignment, the note's MIDI channel has to be analyzed. 

To do this, set up a MIDI channel for the second voice in the stave properties 
dialog. This can be set individually for each staff. All notes of a stave whose 
MIDI channel has not yet been assigned to a second voice, are added to the 
first voice. 



 
 

MIDI editor 205  

 

www.magix.com

Voice assignment via the MIDI channel can be practical when displaying 
standard MIDI files with multi-voice piano pieces if the voices of the right hand 
are set to the first and second MIDI channels and the voices of the left hand 
are set to MIDI channels three and four. In this case, apply the following 
settings: 

 

Note: If there is no MIDI channel selected for voice assignment, only one voice 
will be annotated (if manual voice assignment does not occur). 

 

MIDI score settings dialog 

 Open score settings dialog for stave and page properties 

Note stave and page format settings can be set here. None of the settings 
have any influence on the MIDI data itself, but rather only on the display of the 
score. 
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Note: The affected stave settings are always applied to all MIDI objects 
situated on the current track. The page format settings are global and valid for 
every VIP. 

 

Stave settings 

All settings for the stave and display parameters/options can be accessed via 
this dialog page. Here you can enter the clef.  

Samplitude 11.5 Producer provides MIDI files with up to 16 staves on one 
track. For each staff, the clef, display transposition (for instruments that 
transpose, for example, a saxophone), and display quantization can be 
specified individually. 

Furthermore, an instrument's prefix ("Name") can be set as well as the MIDI 
channel for automatic stave/voice assignment. 

Similarly, the split point serves automatic stave assignment: Notes above the 
split point are added to the upper stave, while those under the split point are 
added to the stave beneath it (as long as the MIDI channel matches). 

The active staff is recognizable via the index marked in red. The list of 16 
staves can be scrolled vertically using the arrow buttons (up/down). In the 
lower range the display options of the active staff are shown. 

Optionally, all changes to settings, display options, clef, and display 
quantization are always transferred equally to all staves. 

 

Note display: Interpretation options 

None of the options have any influence on the MIDI files or playback. 

Simplify note lengths (interpretation) 

Displays rests and slurred notes in such a way that the score is as legible as 
possible without influencing playback. 

Automatic staccato articulations 
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A staccato symbol is added to a note whose value is considerably longer than 
the "real MIDI note". This is practical when working with simplified length 
display. 

 

Option: "Simplify note lengths (interpretation)" selected.  

Additional option: "Automatic staccato articulations". 

Hide note overlaps 

Prevents the overlapping of sequential notes which, for example, arises as a 
result of playing legato: 

Recognize triplets 

Activate this option if triplets are present in the MIDI object. 

Please note: The display quantization value always has to be one step finer 
than the smallest discernible triplet value. To recognize one eighth triplets, 
display quantization has to be set to at least one sixteenth (or to 1/64 for 1/32 
triplets). 

Strict measure/pulse division 

There are no note or rest values longer than a beat subgroup (pulse). Longer 
notes are displayed as multiple slurred notes. This can simplify the legibility of 
the score. 

Larger beam groups 

Beam groups are partially compiled across beat subgroups. This can simplify 
the legibility of the score. 

Recognize grace notes 
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Note values which are much shorter than the display quantization value are 
annotated as flam notes as long as a base note is present. 

 

Notation symbols 

Clef 

 

There are four clefs available in Samplitude 11.5 Producer: violin, bass, tenor, 
and alto clef. Samplitude 11.5 Producer differentiates between base clef and 
clef change. The base clef can be set up for every stave in "Score settings" 
(and applies to all MIDI objects on the current track). A clef inserted from the 
tool bar, will be interpreted as a clef change. Clef changes are possible any 
number of times in a song and also within beats. 

Insert: Activate the staff into which the clef should be inserted (by clicking on 
the staff signature to the left). 

Position the play cursor at the desired insert point and click on the desired clef 
in the toolbar. Move the playback cursor to the desired insert position and click 
on the desired clef in the toolbar. The clef will be inserted musically, not 
graphically, with a clef change at position 10:01:000 (the beginning of the tenth 
beat) the clef symbol at the end of the ninth beat will be displayed according to 
note set rules. 

Clef changes can also be deleted by clicking on clef symbol with the eraser (or 
the right mouse button). 

 

Beat signature 

The metric and beat signature symbols are created automatically from the 
tempo markers of the VIP project. 

Beat changes are possible at every full beat border. In addition, you might 
want to create a beat count measure marker with the new signature (for 
example, 6/8) at the desired position. If there are no beat count measure 
changes, then it's enough to set the bar type of the piece (for example, 3/4) in 
the transport control. 

 

Accidental 

 Enharmonic change 

Samplitude 11.5 Producer sets the sharps and flats according to the clef 
description you selected. It is often the case, however, that enharmonic 
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change can considerably optimize the legibility of certain passages. In this 
case you can work manually. To change one or more selected notes 
enharmonically, click on the corresponding button. The function transforms 
flats into sharps and vice versa. 

 

Page format settings 

You can select the page format independent of the printer settings so that it 
always has the same note layout regardless of workplace and independent of 
the printers installed in Windows. 

 

In the score/page format setting, texts for tempo description, composer, and 
an additional text can be entered. Similarly, you can choose which layout 
elements should appear on the page (check boxes for beat numbers, page 
numbers, and texts). 

 

Printing score 

Samplitude 11.5 Producer automatically creates the layout of the score and 
allows optimal division of staves and staves on the page. You only need to 
specify the page size, orientation, and page borders. 

 Note size: Here you can scale the size of the note symbols and the printout. 
This is actually irrelevant when working using the monitor's display, since you 
can zoom whenever you want anyway. However, the size of the notes does 
influence at which position a line or page break occurs. 

 Set a value smaller than 100% to get more beats/staves onto one piece of 
paper. 



 
 

 210 MIDI editor  

www.magix.com

 Set higher values than 100% in order to keep larger note symbols on the 
printout. 

 

Print notes 

Activate the print process in the "Score -> Print notes" menu or via the print 
button. Furthermore, a printer dialog window appears which appears differently 
for each printer or printer driver. Depending on the printer there are various 
options, e.g. the selection of pages you wish to print and the number of 
copies. Make sure that you have set up the same paper format for the printer 
as for the page mode, otherwise the printout may be scaled and the page ratio 
changed. 

The following won't be printed, it's only visible on the monitor. 

 The lines which highlight the page borders on the monitor 
 Mouse pointers 
 The color display of the currently selected notes and playback areas. 

When printing a file (e.g. as a PDF file with a special printer driver) please note 
that you have to activate the option "Save fonts in document" in the printer 
driver so that the notation symbols will be displayed correctly in the document. 

 

Quantize 

Small irregularities when playing to record can be smoothened with the 
quantization function. In contrast to this, mechanical sounding sequences can 
be made a little more groovy by applying the Swing function. 

 
Clicking on the Quantize button shifts all selected notes to a 
customizable quantization grid.  

All notes are quantized without previous selection. 

 

 

1/4, 1/8, 1/16, and 1/32 notes and 
corresponding triplets can be selected as 
starting points (grid) and lengths.  

The Quantize button always performs standard quantization (the note's start 
point and length are preset). MIDI functions -> Advanced quantization provides 
other quantization modes (e.g. length only or Soft Q). 
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The quantization options enable the type and scope of the quantization to be 
set more precisely. 

 

Quantization grid ("Snap") 

 
If snap is activated, the notes "snap" to the quantization values 
when they are created or edited. 

The quantization values are also considered. For instance, the notes snap to 
the corresponding positions within the quantization window.  

The snap positions are displayed within the piano roll as a matrix. A swing 
quantization is displayed by the different intervals of the vertical partitions in the 
piano roll. The grid can be hidden with the "Show quantization grid" command 
in the options menu ("Alt + G"). 

You can deactivate the snap function while creating or editing notes by holding 
down "Alt" as you draw them. 

Move relatively on grid ("Options" menu): If this option is active, then notes 
keep their original intervals  relative to the grid and not to the note start when 
they are moved; the distance moved snaps to the quantization value. Use this 
option if you want to move unquantized notes a certain distance without 
disturbing the timing. 

Keyboard shortcut:  Shift + G 
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Quantization settings 

The quantization settings can be found in the MIDI editor menu under "MIDI 
functions -> Extended quantization" or in Samplitude 11.5 Producer's main 
menu under "MIDI -> MIDI quantization settings". 
The dialog with the settings is not "modal", i.e. you can leave it open if you 
wish, and test certain passages with different settings. 

 

The selected quantization settings may be visualized in the top of the dialog. 
The blue lines indicate the target positions for the quantized notes, i.e. the 
snap points. The gray area around this show the quantization window i.e. the 
target positions that are affected by the quantization. 

Q-grid/length: The quantization grid and length at which target points within 
the beat on which the note start points or lengths move (see above).  

Q threshold/ Q window: This parameter may be used to slightly vary 
quantization by excluding notes from quantization that are very close to the 
next quantization value. "Q window" refers to the interval to the left and right of 
a grid point; events will be quantized within this range. Quantization does not 
take place outside of this window. This means that events with distance less 
than the "threshold" or more then the "window" from the grid point will not be 
quantized. The affected target range will be indicated in gray in the dialog 
graphic. 



 
 

MIDI editor 213  

 

www.magix.com

Swing: Starts swinging, groovy playback (for example, triplet). Specifies the 
division for uneven grid points. 

 50 ... “50-50” division: The odd eighths are exactly half way between the even 
eighth notes (“even” playing method) 

 67... triplet playing method, 3-2 division 

Offset: The value range in this parameter stretches from -100 to +100. By 
changing the offset values, you move the whole quantization grid. Negative 
values move the quantization to the left, i.e. forward in time; positive values 
move to the right i.e. further in time. The maximum of 100 corresponds with an 
offset of half the grid width. 

Presentation of blue grid points in the dialog and the grid in the MIDI editor 
directly reflects changes to these values. 

Humanize: The "Humanize" parameter creates another variation option, i.e. 
notes are able to be assigned according to the randomization principle up to a 
specific interval to positions around the exact quantization value. The setting 
occurs in % of a 16th note. The value specified therefore determines the 
possible interval between the quantized notes and the exact quantization 
value. 

Soft Q: This value sets the strength or "Soft Q" value of the quantization. 

 "100" moves the event precisely to the quantize grid point, 
 "50" shifts the event to the middle between the current position and the 

quantization grid point, 
 "0" means no movement -> Quantization off 

The command "Soft Q" command considers the current level value in the 
quantization options. The simple quantization command always occurs at 
100%. In this manner, you can always select between approximation (soft) and 
a harder quantization without having to adjust the quantization options every 
time. 

Standard quantization settings: Select from a list of quantization actions (see 
MIDI functions) that are listed by clicking the "Quantization" button. 

Reset quantization: All notes are rest to there original positions. 

Standard settings: Restores the default values. 
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MIDI editor shortcuts 

Apart from a few exceptions, like using the space bar for stop/playback, the 
keyboard shortcuts can be defined freely with the keyboard shortcut, menu, 
and mouse editor. For some basic functions such as scrolling and zooming, all 
keyboard shortcuts from the VIP are applied. You can explicitly define 
shortcuts for all commands that are available in the MIDI editor menu. 

Hint: The mouse wheel settings are also applied from the VIP, as is the switch 
for the temporary zoom mode (special) which is defined with "Z" 

Playback/Stop Space bar 
Close MIDI editor (apply changes) Return 
Close MIDI editor (discard changes) Esc 
 
File 
Import MIDI Ctrl + I 
Export MIDI Ctrl + E 
 
Edit 
Undo Ctrl + Z 
Redo Ctrl + Y 
Cut Ctrl + X 
Copy tracks Ctrl + C 
Insert Ctrl + V 
Duplicate Ctrl + D 
Select all Ctrl + A 
Create pattern from selection Ctrl + P 
Delete selected MIDI data Back, Del 
Delete all MIDI data Ctrl + back, Ctrl + Del 
Select next event Arrow right 
Select previous event Arrow left 
 
MIDI functions 
Legato Ctrl + L 
Quantize notes Ctrl + Q 
 
Options 
Scroll mode F 
Show event list  Alt + L 
Show velocity/Controller editor Alt + V 
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Play clicked notes Alt + P 
Quantization grid active Ctrl + G 
Show quantization grid Alt + G 
Quantization options Alt + Q 
MIDI object editor editor Ctrl + O 
Audition Panic-End played edit notes Ctrl + F 
 
Mouse mode 
Selection 1 
Draw 2 
Drum (draw) 3 
Pattern (draw) 4 
Change velocity  5 
Delete 6 
Magnifying glass 7 
Glue note mode 8 
Split note mode 9 
Mute notes (Mute) mode M 
Select next event Arrow right 
Select previous event Arrow left 
Event pitch higher Arrow up 
Event pitch lower Arrow down 
Select next grid quantization value Alt + Arrow down 
Select previous grid quantization value Alt + Arrow up 
Select next length quantization value Alt + Arrow right 
Select previous length quantization value Alt + Arrow left 
Move play cursor forward Page down 
Move play cursor forward (fast) Ctrl + Page down 
Move play cursor backward  Page up 
Move play cursor backward (fast)  Ctrl + Page up 
Velocity/controller selection Ctrl+1 
Velocity/controller draw freehand Ctrl+2 
Velocity/controller draw freehand Ctrl+3 
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Software / VST instruments 

Samplitude 11.5 Producer provides the option of integrating software 
instruments as well as MAGIX synths (e.g. Robota Pro) into a virtual project 
according to VSTi standards (e.g. Sample Tank) and can be controlled via the 
internal MIDI functions and editors. All instruments as well as their multiple 
outputs are seamlessly integrated into the audio engine with all of their effects 
and routing options. The maximum number of instruments is limited by the 
performance power of your processor. You can increase this number by using 
the integrated freeze function. 

 

Software instrument "Robota Pro" 

 

Installing VST plug-ins 

Install VST plug-ins according to the manufacturer's instructions. VST 
instruments and VST effects are not entered into the Windows registry, but 
must be saved in a certain directory. 

Samplitude 11.5 Producer searches for installed VST instruments in the "VST 
Plug-ins" program subfolder. VST instruments may be installed either in this 
folder or another path may be specified. If a VST plug-ins folder is already 
installed on the system, then please use the existing folder. The existing path 
must be specified in the system settings (keyboard shortcut: "Y" key) via 
"Effects > VST/DirectX/ReWire" (multiple paths may be specified). Simply 
enter one path after the other; each path will be scanned. Samplitude 11.5 
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Producer will automatically find new plug-ins that have been installed if they 
are present in the specified folders. If you add VST plug-in subfolders into the 
main VST folder (e.g. "Equalizers", "Filters", "Modulation", etc.), then these will 
be displayed as submenus when VST plug-ins are loaded. 

 

The first time the program is launched, a search for existing instruments and 
plug-ins is executed (when the track settings are opened). Here, not only are 
all the plug-ins imported, but they are also checked for their usability within the 
program. This search is only required once; the next time it is opened, the 
track settings will be opened immediately. 

Tip: For problems with your current configuration, you can reset all paths and 
installed instruments or plug-ins. To do this, delete the "VSTPlug-Ins.ini" file in 
the Samplitude 11.5 Producer folder. All paths will have to be newly entered. 
Plug-ins which were removed from the program prior to this will still be shown 
again.  

 

Load instruments 

These are managed in Samplitude 11.5 Producer under "Track menu -> VST 
instrument editor". You can also assign an instrument to each track; the 
instrument is selected as a MIDI playback device. 

Selected instruments or their individual outputs are shown directly in the first 
VSTi plug-in/insert slot of the track box and mixer track and can also be muted 
(left click) and opened (right click) from there. 
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 Load an instrument by selecting a "New instrument" in the project window as 
a track output. This can happen at various points: 

 Playback device menu (right click the "Mute" button -> MIDI -> New 
instrument) 

 Plug-ins slot -> VSTi in the track editor 
 "Insert effect slot of the mixer -> VSTi": You will only find this option in the top 

insert slot of the individual mixer channels. 
 "Out" slot -> New instrument in the MIDI section of the track editor. 

 "Out" slot -> MIDI -> New instrument in the audio section of the track editor. 

 

Loading routing settings with software instruments 

An instrument may also be assigned  to each track as a MIDI output device. 

Additionally, you can route audio output channels from software instruments to 
any tracks of the VIP. MIDI (send) and audio (return) signals from a software 
instrument may be present together on one track (but this is not absolutely 
necessary). Samplitude 11.5 Producer is fully flexible in terms of individual 
routing configurations. 

When installing a software instrument, the "Routing for multi-channel 
instruments" dialog opens up. Here you may specify new tracks for single 
audio outputs. 
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Simple: Audio and MIDI together in a single track: Now all audio signals will 
be routed to the current track where the instrument has been opened. Multiple 
outputs will be mixed together before the mixer effects. Simple mono or stereo 
software instruments may be installed completely in the current track. In this 
case, the track sends MIDI to the instrument and receives the audio signal 
from the instrument. 

Multi-timbral audio on your own track separated from MIDI routes: Choose 
this setting if you would like to control the VSTi from several MIDI tracks. 

Multi channel: Create multiple new tracks for instrument outputs: Choose this 
option to automatically create new tracks for all VSTi audio outputs. The newly 
created tracks are configured and named automatically. The mono/stereo 
configuration is assumed from Samplitude 11.5 Producer (Standard). 

Individual outputs can also be routed subsequently to separate tracks. To 
display hidden tracks in the Arranger window again, please use the Track 
Manager. 

 

Advanced options 

Stereo/Mono (standard): Information delivered from the plug-in is used for 
routing. 

All as stereo/mono: Several plug-ins deliver incorrect information about 
whether the outputs are in mono or stereo. These options force individual 
outputs to be treated as stereo or mono outputs. 

Combine audio/MIDI: Activate this check box to automatically route the MIDI 
output of each individual track to this instrument. 
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Hide instrument output tracks in arrangement: All newly created output tracks 
of this instrument are hidden in the arranger but still appear in the mixer 
window. This setting should be used if an instrument's individual outputs are 
controlled by a single MIDI file, and therefore do not contain objects or 
information in the arranger window. 

Hint: Please note that a virtual synthesizer's audio output can usually be 
created, edited, and mixed in the same track as the MIDI data the instrument is 
receiving. Among other things, this results in a double use of the volume fader 
which, on the one hand, controls velocity or MIDI volume (CC7), and on the 
other the audio level. These are not identical parameters. For instance, you can 
include a MIDI instrument played with high velocity quietly in the mix and vice 
versa. You can, therefore, optionally assign the volume fader differently. To do 
this, right click on the track's volume fader. 

 

Load effects plug-ins 

Effects plug-ins can be used at track, object, and master level. 

 

Apply plug-ins at wave level 

The menu "Offline effects -> DirectX/VST plug-ins (view page 358)" lets you 
calculate the plug-in effects directly into the audio material. During virtual wave 
editing, the plug-ins will be loaded into the mixer's master area (view page 
222). 

Note! Destructive editing of audio material can not be undone! It's better to 
use the real-time effects via the object editor or the mixer. 

 

Load plug-ins at object level 

You can apply effects plug-ins at object level via "Real-time effects -> Object 
DirectX/VST plug-ins" menu or via the object editor. 

Object editor 

 Double click an audio object and select the "Object effects" view. 
 Under "Plug-ins", click on a plug-in slot's little arrow. 
 The plug-ins in the menu are now available to you. 

"Real-time effects" menu 
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 Select an audio object in the arrangement by clicking it 
 Next, open the "Real-time effects" menu and select the entry "Object 

DirectX/VST plug-ins" 
 In the dialog, you can load the desired plug-ins for the selected object one 

after the other 
 Right clicking on the loaded plug-in opens its interface 

 

Load plug-ins at track level 

At track level you can load plug-ins in the mixer as well as in the track editor. 

Track editor 

 Select the track for which you wish to load the effect. 
 Open up "Plug-ins" if it is not yet visible. 
 Now click on the little arrow next to the plug-in slot. 
 You can select any plug-in from the menu. 

 

Mixer 

 Open the mixer by pressing "M" or via the mixer button. 
 Click on the small arrow next to the insertion slot of the desired track. 
 Now select a plug-in from the corresponding submenu. 
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Note: Send effects will also be embedded. Add an AUX track and apply the 
effects to it. Bear in mind that the effects will be mixed, i.e. the effect in the 
AUX track should not contain the original signal anymore. 

 

Load plug-ins at master level 

In the mixer's master section, you 
can load plug-ins just like in the 
mixer tracks. Click on the arrow to 
the right beside one of the plug-in 
slots and select the desired 
plug-in from the menu. 

 

Route MIDI instrument inputs 

Nearly all software instruments require MIDI data in order to be heard. To route 
the MIDI input onto a specific track which contains the MIDI data, click on the 
VSTi button in the track editor of the corresponding track and select the 
instrument from the "Out" slot which you wish to activate. Already loaded 
instruments are mentioned in this list. 

To open a completely new instance of an instrument which works 
independently of already existing instruments within the project, select its name 
from the "New instrument" submenu. 

 



 
 

Software / VST instruments 223  

 

www.magix.com

Instruments with multi-channel outputs 

The number of available individual outputs generally depends on the 
instrument, and this may be adjusted via the instrument's settings. Outputs 
may be available in stereo or mono. 

 

Distributing sounds on multiple single tracks 

This approach, for example, is ideal for all drum samplers if you want to 
address an entire drum set, but prefer to mix and edit the drum sounds 
individually. 

 

Addressing an instriment on several MIDI channels 

Several MIDI tracks are typically used for so-called "multi-timbral" synthesizers 
which can play several sounds on different MIDI channels simultaneously, 
whereby each addresses a specific sound program (part) on a specified MIDI 
channel. This also has the advantage that such instruments only require one 
instance of the plug-in for several sounds. Multi-timbral software instruments 
often have separate audio outputs. Please remember to route the individual 
parts to the desired outputs within the VST instrument (panel). 

 

Adjust instrument parameters 

The instruments editor (panel) is then opened when an instrument is loaded 
and can be opened again at any later date by right clicking on the VSTi slot in 
which the instrument name is displayed. Alternately, the VSTi editor can also 
be opened by right clicking on the record button on the track -> Instrument 
output -> VSTi editor. 

The graphical interface opens by default. If the selected instrument (or plug-in) 
does not have its own interface, the parameters dialog will open. This display 
mode is limited to just a few control elements and can only be opened via the 
menu of the instrument window. Use this mode if you find the panel of the 
plug-in too unclear or if it takes up too much space on the screen. In this 
dialog eight freely selectable parameters of the instrument are clearly and 
numerically displayed. Bar controls can be used to adjust the parameter 
values. 

Alongside the combi-boxes for the selection of all instrument parameters, the 
"Auto" checkbox is also of importance. Once activated, the automatic 
processes of the selected parameters are started. The automation curve is 
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shown in the project track and can be edited. The parameter can be 
automated using the fader. 

Activate automation parameters by checking the "Auto" control box. 

The parameter selection is saved for each plug-in so that the next time you use 
the same plug-in in a different project, the same parameters are used. This 
way you have the advantage that every frequently used parameter of the 
corresponding instrument is available immediately after it has been opened. 

 

Instrument panel and parameter dialog 

The instruments editor (panel) is opened when an instrument is loaded and can 
be opened again at any later time by right clicking the VSTi slot displaying the 
instrument name. Alternatively, the VSTi editor can also be opened by right 
clicking the record button on the track -> Instrument output -> VSTi editor. 

The graphical interface opens by default. If the selected instrument (or plug-in) 
does not have its own interface, the parameters dialog will open. This display 
mode is limited to just a few control elements and can only be opened via the 
menu of the instrument window. Use this mode if you find the panel of the 
plug-in too unclear or if it takes up too much space on the screen. In this 
dialog eight freely selectable parameters of the instrument are clearly and 
numerically displayed. Bar controls can be used to adjust the parameter 
values. 

The parameter selection is saved for each plug-in so that the next time you use 
the same plug-in in a different project, the same parameters are used. This 
way you have the advantage that every frequently used parameter of the 
corresponding instrument is available immediately after it has been opened. 

 

Dialog menu 

Further options can be found in the menu of the instrument window: 

Bypass: Deactivates the instrument and mutes it. Note that some instruments 
use up processing power if bypass is switched on but are still located in the 
insert slot. In such cases, the instrument should be removed completely from 
the insert if it is no longer required. 

Monitoring: This option must be switched on if you wish to be able to hear the 
instrument when it is being played or recorded. If you wish to always have 
monitoring active when the track's record button is pressed, then please select 
the "Tape monitoring" option in the system/global audio options ("Y", "Audio 
setup" tab) dialog. 
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Loading/Save patches/banks: Here you can save an instrument's settings and 
sounds. The standard formats for this are: *.fxp for patches or *.fxb for whole 
banks. Some instruments have their own patch/bank format, settings are then 
loaded and saved directly via the instrument's interface. 

Set parameters randomly: Use this function to set all parameters of an 
instrument to a random value. This option can lead to surprising results and 
provides interesting ideas for sound design, thanks to the random generation 
of a new sound. However, you should note that parameters can only be set 
when they are accessible via the interface. For some very complex virtual 
synthesizers (e.g. modular systems), some parameters may not be modifiable 
using this option. Please note that thanks to the random placement of various 
parameters, very extreme sounds can be generated. This may lead to no 
sound being produced at all or extremely loud volumes and frequency ranges 
being reached. For this reason you should keep an eye on the preview volume 
when experimenting with this function. 

 

Play and monitor instruments live 

Requirements for playing live 

In order to play virtual software instruments, you will require a MIDI device to 
enter the data. This is typically a MIDI keyboard. Of course, you can also use 
any other PC that transmits MIDI data or a hardware synthesizer. 

For direct monitoring while playing you will in any case require an audio 
interface with ASIO drivers. Simply playing instruments, however, is also 
possible with MME or WDM drivers. 

 

Monitoring 

In order to play virtual software instruments you require a device to enter the 
data. Typically this would be a MIDI keyboard. Of course you can also use any 
other PC that transmits MIDI data or a hardware synthesizer. 

For direct monitoring while playing you will in any case require an audio 
interface with ASIO drivers. Simply playing instruments, however, is also 
possible with MME or WDM drivers. 

 For live monitoring you also have to make the following settings: 
 ASIO drivers (System/Options -> System/Devices -> Global audio options -> 

Playback devices -> Driver system) 
 Activate global record monitoring in the transport control ("Rec M" button) 
 Activate the track monitoring button (loudspeaker symbol) 
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 Software monitoring or Hybrid Engine (Options -> System/Global audio 
options -> Audio setup) 

Tip: You can also select monitoring mode by right clicking on the "Record 
monitoring" button on the transport control. 

Latency: Please note that a system-dependent delay between pressing the key 
and the instrument sound occurs when you play virtual software instruments. 
This so-called latency time is mainly determined by the buffer size set for the 
ASIO drivers. For playing in an acceptable manner we recommend a buffer size 
of 1024 samples max. This corresponds with 23ms at 44.1 kHz. For many 
users, however, a latency of 3ms, i.e. 128 samples, is optimum. Please note 
that the CPU load also increases at a lower buffer size. The "live" delay only 
occurs when an instrument is played, playback latency of an already recorded 
MIDI track over a virtual instrument is compensated later. 

As software instruments are fully integrated into the audio engine of the 
program, the signals can be routed, mixed and equipped with plug-ins any way 
you like. There may be some restrictions when playing, but all functions are 
fully available during playback. 

Hint: Please note that "Track FX monitoring" mode or "Mixer FX 
monitoring/Hybrid Engine" have to be activated. 

 

Latency 

Please note that a system-dependent delay between pressing the key and the 
instrumental sound occurs as you play virtual software instruments. This 
so-called "latency" time is mainly determined by the buffer size set for the ASIO 
drivers. To play in an acceptable manner, we recommend a buffer size of max. 
1024 samples. This corresponds with 23ms at 44.1 kHz. For many users, 
however, a latency of 3ms, i.e. 128 samples, is optimum. Please note that the 
CPU load also increases at a lower buffer size. The "live" delay only occurs 
when an instrument is played, playback latency of an already recorded MIDI 
track over a virtual instrument is compensated later. 

 

Recording and playback of an instrument 

An instrument is recorded much in the same way as a normal MIDI track. Make 
sure that the MIDI recording is active in the desired track and then press the 
record button in the transport control. The recording begins immediately. 
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When playing already recorded MIDI tracks, track monitoring should be 
switched off. 

 

Routing VST instruments using the VSTi manager 

There are many flexible methods for signal routing of instruments. 

As described in the previous paragraph, an instrument may be fed from several 
MIDI tracks, and the outputs of an instrument may also be sent to several 
tracks. 

 

Routing instrument outputs 

Instrument outputs may be easily routed by using the VSTi manager. Simply 
open the VST instrument to view the individual outputs, and then right click 
the "Output routing" column. 

 

Now search for the track to be fed the corresponding individual output. The 
assigned output now appears in the target track's plug-in slot. 

Alternatively, you may also route directly to the track box of the arranger:  

To play the output of an already loaded (or instantiated) instrument on a 
specific track, right click the record button for the track, go to "Instrument 
outputs", and select the instrument output available in the project by placing a 
check mark. Several instrument outputs may be used simultaneously in one 
track. The outputs of several different instruments may even be combined into 
one track. 

Deactivating the instrument outputs works the same way. Remove the 
instrument output by removing the check in front of the corresponding output 
in the "Instrument outputs" submenu. 

Moreover, the routing options of the mix engine may also be used. A track 
containing the audio return of any instrument may be routed to any bus, AUX 
bus, or master. 
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Routing MIDI instrument inputs 

Nearly all software instruments require MIDI data to be audible. To route the 
MIDI input to a specific track that contains the MIDI data, click the VSTi button 
in the track editor for the corresponding track, and then select the instrument 
in the "Out" slot that you want to activate. Previously loaded instruments are 
a,so featured in this list. 

To open a completely new instance of an instrument which works 
independently of already existing instruments within the project, select its name 
from the "New instrument" submenu. Multiple instances of the same VST 
plug-in are indicated by the number (index) in front of the name of the software 
instrument. 

 

Solo playback of VSTi instrument outputs 

To preview solo instrument outputs, switch the track that is receiving the signal 
from the instrument to solo. Even if the MIDI objects, which in effect are 
responsible for the sound, are not present in the track, you will still hear the 
selected track solo. Samplitude 11.5 Producer automatically recognizes the 
MIDI track that is sending the signal to the output and allows the instrument 
continue to receive MIDI data from the assigned tracks. 

 

Preset management 

If an instrument has presets, these are displayed in the “Program Slot” (“Prg”) 
with their internal name (if MIDI mode is activated). 

This drop-down menu can be used to easily “step through” the presets of your 
instrument. These presets can also be selected using the “Program” menu of 
the instrument window. 

If your MIDI input device can send “Program change” commands, then you can 
also directly select programs of this instrument. The program slot is 
automatically updated in the track, so you have an overview of the program all 
the time. 

 

Freezing instruments (freeze) 

Software instruments require CPU power for playback, which at some point 
can be quite considerable and is required during every playback. Therefore, 
please use the "Freeze" function to release the CPU power for VSTi tracks 
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temporarily. You retain full control over the MIDI objects of this track, which 
can be restored (“de-frozen”) at any time. 

To “freeze” an instrument, select the “Track freeze” option in the track menu 
(Ctrl + Shift + F). After a short processing time, all MIDI and audio objects are 
replaced by a single, resource-friendly, 32-bit stereo audio object, which is 
now played back instead of the original object and the instrument. The existing 
automation data and track effects are already included in this freeze object. 

The actual instrument of this track is no longer addressed by MIDI files of this 
track and can even be deactivated, provided that it is not used by other MIDI 
tracks. 

Select “Track unfreeze” (Ctrl + Shift + U) to change the original MIDI data at a 
later point in time that was "frozen”. The track is now returned to the state in 
which it was "frozen", but again requires the initial CPU power for processing 
the instrument. 

Alternatively, you can use the feature “Edit track freeze”. In this case, a new 
single-track VIP is opened with the original track. This track cannot be played 
together with your arrangement. As soon as you save this project, a new 
freeze object is processed and included in the original project. 

Freeze also works with single outputs in different tracks than the main output 
track (instrument outputs 1+2). You can also freeze these tracks if they do not 
contain MIDI information and do not hold objects. The MIDI data that has been 
routed to the track or to the individual output of the instrument automatically 
creates an audio file that is now played instead of the original instrument. In 
order to prevent double playback of the data, deactivate the single output of 
the instrument manually in the frozen track. 

To edit freeze data you cannot only use the "Track freeze edit" function, since 
there is no MIDI data available on this track that could be edited. Therefore, 
“unfreeze” the track and edit the MIDI data of the send track. You can then 
refreeze the track. 

Note: As long as the instrument is not entirely unloaded from the track it 
remains loaded into the RAM memory of the system. Samplers or instruments 
that require considerable amounts of memory also require this when their insert 
tracks have been frozen. 
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Tips on handling virtual instruments 

 You can realize so-called stack sounds (i.e. sounds that use several 
synthesizers and play these in unison) by opening several instruments and 
activating monitoring for all channels. 

 To program beats, you can create and save individual drum maps in the MIDI 
editor that match the respective instruments. 

 If an instrument can limit the amount of voices, then you can use this option to 
save CPU power if you do not require the full number of voices. 

 Some instruments use sound sets according to the "General MIDI" standard. 
You can use these instruments for playing back MIDI files according to the GM 
standard. Please import the entire MIDI file to a single track including all 
channels. Make sure that virtual instruments can also receive program change 
commands that are also saved in such a file, so that the correct sounds are 
played back. 

 

ReWire 

If this option is activated, ReWire-compatible client applications (e.g. 
Propellerheads Reason) can be integrated into Samplitude 11.5 Producer as 
synthesizers.  

Activate ReWire functionality in the program settings ("Y"). Afterwards, installed 
ReWire applications can be loaded as instruments into a MIDI slot. All ReWire 
client applications appear as individual sections in the selection menu of the 
plug-in slot of the track and are loaded as software instruments (VSTi). The 
client application should always be launched after Samplitude and should be 
closed before exiting Samplitude. Some client applications can be opened 
automatically by right clicking on their name in the MIDI slot (red) – just as you 
can open the plug-in window for VST instruments by right clicking. 

The ReWire application can then be accessed like a software instrument via 
MIDI, the audio output signal of the ReWire client can be routed to the 
Samplitude 11.5 Producer tracks. The client application runs, starts, and stops 
synchronous to the time position of Samplitude. 

ReWire supports up to 4096 MIDI buses. A ReWire client only registers the 
MIDI buses that are actually available with the host (Samplitude 11.5 
Producer). You can therefore select the bus within the track in the MIDI 
channel menu (e.g. the receiving instrument for Reason): 
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The "classic" MIDI channel of MIDI 
notes and events is not important, 
it is replaced by the ReWire MIDI 
bus system. For each track a MIDI 
object is able to control a ReWire 
MIDI BUS. This means that all 
events of a MIDI object apply to 
the track for this ReWire bus, 
independent of the channel 
number the events originally had. 
Multi-timbral MIDI objects, like 
those created in the MIDI file 
import, cannot be played correctly 
with ReWire. You can, however, 
access the ReWire client across 
multiple tracks on various ReWire 
MIDI buses. 

Only a few ReWire clients support direct opening of the client application via 
the host application (Samplitude 11.5 Producer). In this case, you will have to 
start the client application manually. You can do this by starting your client 
application as you would normally. It then automatically recognizes the host 
and starts in a special client mode. 
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Surround sound 

Surround panorama module 

In the "Surround Panorama" module the panning of a track or an object is set 
and edited on the Surround bus. 

 

Open the dialog 

 Right click on the Surround pan display of the relevant channel line in the 
mixer (this is only possible if the twin-channel Surround mode is already 
active), or 

 Right click on the button or regulator in the relevant track in the VIP, or 
 Open the track menu of the VIP in the track information with a mouse right 

click and select “Pan / Surround editor”, or 
 Select the required track in the VIP and select “Track -> Surround panorama 

module” 

In the title line of the Surround panorama module the track is stated that it is 
currently being edited. 

Example: “Surround panorama module: Track 4” 

 

Display elements 
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In the panorama display the loudspeaker channels of the Surround setup are 
shown as blue dots. Activating the options underneath the panorama display 
allows the following information to be displayed in addition: 

 

Name 

The loudspeakers are designated with defined abbreviations: “L” (left), “C” 
(center), “R” (right), “Ls” (left Surround), and “Rs” (right Surround). 

 

Volume 

A level indicator appears next to each loudspeaker and shows the value of the 
level share that the sound source is transmitting on this Surround bus. For the 
stereo modes the total of the level of both sources is always shown. If "Shift" is 
held down and the mouse is clicked on a source, only the value for this source 
will be shown briefly.  

 

Sound field 

The input signal is presented as a field made of concentric circles. Each red 
line corresponds to a level-gradient of 3 dB in the sound field. The 
loudspeakers are arranged in such a way that the distance between each 
loudspeaker and its neighbor is constant. This arrangement makes a uniform 
distribution of the sound source possible to all channels. Level relationships 
are created between the channels that cannot be achieved in other modes. 

 

Settings 

Surround active 

Activates the twin-channel Surround mode.  

In the deactivated state the stereo position can only be determined via the 
control elements in the track box or the mixer. 

Pan L/R 

This determines the way in which the left-hand or the right-hand channel is 
placed in the Surround field. For the individual cases, please read the section 
on “Stereo and mono signal processing with twin-channel Surround”. 

Width 

Affects the extension range of the loudspeakers. 
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Center 

The parameter controls the share of the center in the distribution of the sound 
source to the front channels. In certain working ranges (e.g. film sound) it is 
customary to reserve the center channel for dialog and to mix music and 
noises without share in the center. A signal positioned exactly in the middle is 
reproduced in the 5.1 format with Center = 100% exclusively through the 
center channel, or with 0% exclusively as a phantom sound source through the 
channels L and R. This parameter is often also described as divergence. 

Automating Surround 

This section of the dialog is described in the section on “Automation of 
twin-channel Surround”. 

 

Stereo and mono signal processing with 
twin-channel Surround 

Mono 

The following applies to stereo signals: A mono total is formed from the signal 
that is positioned as a single mono sound source in the panorama. 

The following applies to mono signals: The signal is positioned as a single 
mono sound source in the panorama. 

 

X-Sym. 

The following applies to stereo signals: The left-hand and right-hand channels 
are aligned symmetrically on the x-axis. This enables a stereo signal to be 
panned very easily from front L to Surround L.  

The following applies to mono signals: In addition to the original mono source 
a second (mono) mirror sound of this signal is positioned. 

The mirror axis is the x-axis. 

 

Y-Sym 

The following applies to stereo signals: The left-hand and right-hand channels 
are directed symmetrically on the y-axis. This enables a stereo signal to be 
panned very easily from front L to R. 

The following applies to mono signals: In addition to the original mono source 
a second (mono) mirror sound source of this signal is positioned. 
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The mirror axis is the y-axis. 

 

XY-Sym. 

The following applies to stereo signals: The left-hand and right-hand channels 
are aligned symmetrically to the x and the y-axes. This enables a stereo signal 
to be panned very easily from to front L / Surround R.  

The following applies to mono signals: In addition to the original mono source 
a second (mono) mirror sound source of this signal is positioned. This is 
mirror-symmetrical to the original course with regard to the x and y-axes. 

 

Parallel 

The following applies to stereo signals: The left-hand and right-hand channels 
are kept at a constant distance to one another and shifted parallel to one 
another during movements. If "Ctrl" is held down the distance between the two 
sound sources can be altered.  

The following applies to mono signals: The original and the mirror sound 
sources are kept at a constant distance to one another and shifted parallel to 
one another during movements. If "Ctrl" is held down the distance between the 
two sound sources can be altered. 

 

Stereo thru 

The following applies to stereo signals: The same level shares as with a mono 
source are sent to the various channels, depending on the position of the 
sound source. However, for all left-hand channels only the left-hand signal is 
used, for the right-hand channels only the right-hand signal, and for the center 
and LFE channels the mono proportion.  

The following applies to mono signals: No special function, identical with 
mono mode. 

 

Automation of twin-channel Surround 

Surround panorama module 

Panning movements in track-related Surround panning can be automated. For 
this purpose, first the automation is switched on in the Surround panorama 
module. This can also be done by pressing the button of the relevant track in 
the VIP window. If the sound source is moved during the playing process, this 
movement is recorded and shown in the VIP as a curve. Later editing of this 
curve is possible with the Panorama drawing mode of the mouse in the VIP. 
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Drawing 

For this automation mode a range first has to be marked in the VIP within 
which the change is to take place. The drawing mode is now switched on in 
the Surround panorama module. Now, any required series of movements of 
the sound source can be drawn in the Surround panorama. This series of 
movements is carried out in the previously marked time range the next time the 
VIP is played. Later editing of the curve is possible with the curve editing mode 
in the VIP. 

 

Processing the Surround Sound automation 

Possibility 2: Drawing mode in the Surround panning dialog 

In order to prepare the drawing and movement for a Surround sound 
placement of the source signal, a range first has to be selected in the VIP track 
in which the automation is to take place. Then the “Drawing mode” function 
likewise has to be switched on in the Surround panning dialog. After that you 
can simply put the source signal in the panning dialog into a new position. 
Samplitude 11.5 Producer generates the automation events automatically in 
order to generate this movement for the automation curves. 

 

Possibility 3: Drawing automation curves in the VIP track 

Samplitude 11.5 Producer allows you to draw new Surround sound automation 
curves in a VIP track or to change existing curves. Make sure that the button 
for the corresponding VIP track is activated. In the Surround panning dialog 
the “Automation on” function can also be switched on. As the next step the 
panorama drawing mode has to be selected from the toolbar. You can draw 
new curve events with it in the VIP track. Place the mouse pointer close to an 
existing curve and click the left-hand mouse button. While this button is held 
down you can create new events for this curve. 
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Synchronization 

Synchronization is very important to an audio system, since it is necessary to 
align playback and recording speeds of different system components. 
Synchronization enables studio equipment such as tape machines, drum 
computers, video recorders, or sequencers to be linked with different formats 
like MIDI clock, MIDI timecode, or SMPTE timecode so that all of the devices 
run at precisely the same time. 

Samplitude 11.5 Producer can be configured to as the master or slave within a 
synchronization system. As a master program, it generates the necessary 
timing information required for other system components; as slave. Samplitude 
11.5 Producer receives the timecode data to follow during playback or 
recording. 

Clock on digital systems 

In case digital signal flows are processed, e.g. via ADAT, SPDIF, or MADI, it is 
important to define a clock reference within the overall system. The clock 
signal is transferred via Blackburst, World Clock, or the digital input, and it may 
be received by the receiving or playback computer. External devices such as 
converters or mixers may also provide a clock reference. For these systems, 
there can be only one master but several slaves. 

Note: Don't confuse (Word) clock with timecode. The clock signal is only a 
digital pulse for comparison of the timing between the connected devices and 
to keep the bit rate constant. This enables transmission errors to be prevented. 
Professional digital audio devices normally feature a word clock input and are 
able to generate and receive a clock signal. 

Time-related synchronization of projects 

For more complicated configurations, it is usually necessary to connect various 
audio and video systems via absolute time references. This enables them to 
operate according to the behavior of the master, and the timecode information 
(transport and progress) is implemented correspondingly. 

 

Synchronization formats 

There are different types of synchronization formats. In the synchronization 
format you will find slave device information about the start position, start and 
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stop signals and, in extended formats, the precise timing information, which 
are continuously transmitted. 

Samplitude 11.5 Producer understands and transmits the synchronization 
formats MIDI-Clock (MC) and MIDI timecode (MTC). 

MIDI Clock 

MIDI Clock only contains the SPP (song position pointer) and the start/stop 
signals. There is no continuous timing information embedded in the MIDI clock 
signal, nor is this transmitted. This type of synchronization is principally 
therefore only suitable for starting and stopping. The greatest drawback of this 
type of synchronization is the fact that Samplitude 11.5 Producer can verify 
though whether the audio tracks are played back in full sync, but MIDI Clock 
does not provide further continuous time information to allow the internal 
position to be compared with the external signal. 

You can use this type of synchronization if your system combination shows no 
timing changes. 

MIDI Time Code (MTC) 

If you require a reliable integration of the MIDI tracks of an internal sequencer 
into Samplitude 11.5 Producer's audio tracks, use of the MTC format is 
recommended. 

MIDI Time Code or “MTC” includes so-called time information in addition to the 
MIDI Clock signals, although only start synchronization occurs in Samplitude 
11.5 Producer.   It is therefore important that both systems have a word 
clock or are connected to any other type of digital audio clock. This helps to 
successfully avoid drifting. 

Chase Lock Sync 

If fluctuations in speed occur, Samplitude 11.5 Producer can make 
adjustments in slave mode that ensure exact temporal synchronization. This 
function is called "chase lock". The settings can be changed in the 
Synchronization dialog. This option should always be used if a part of the 
synchronization cannot be clocked centrally via black burst, word clock, or the 
digital input, and Samplitude 11.5 Producer is the "slave". This is the case if 
the timecode is located on a track featuring a multitrack machine. If the 
systems are coupled via a central digital audio clock, then chase lock should 
not be activated. Please note that resampling to the recording in real time 
according to the timecode fluctuations will be applied if "Chase Lock" is active. 
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This causes increased CPU load and may result in unwanted changes to the 
audio material, if this is played later with other timecode references.  

Samplitude 11.5 Producer supports real "Chase Lock" synchronization, i.e. 
audio playback can be controlled precisely by a received timecode signal (MC 
or MTC). In this case not only the starting point of audio playback is controlled 
externally, but sync also controls playback speed if "Chase Lock" is activated. 
Samplitude 11.5 Producer is therefore capable of following analog tape 
devices or VCRs that always have some slip for longer periods. 

 

Synchronization / Synchronization settings 

 

Master synchronization: Samplitude 11.5 Producer will slave to 
SMPTE/MTC/MC and can act as the master for MIDI clock and MIDI time 
code. 

Sync output is directly linked to audio playback so that no delays occur 
between Samplitude 11.5 Producer and external devices, even with long 
tracks. This new synchronization technology was specially developed for 
connecting Samplitude 11.5 Producer with MIDI sequencers such as 
Cakewalk, Cubase, Logic, Evolution Audio, MIDI Connections, etc. which can 
run on the same PC in multitasking mode. 
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In this case you should use a virtual MIDI router for internally linking the 
programs like "Hubis MIDI Loopback" from the Samplitude 11.5 Producer 
studio CD-ROM. 

Wherever possible, please use MTC -25 frames/sec., since unlike the MIDI 
clock, no tempo changes have to be taken into account. 

If Samplitude 11.5 Producer is running as master, please set the FX factor to 
1.0. 

Slave synchronization with real "chase lock": Samplitude 11.5 Producer 
supports real "chase lock" synchronization, i.e. audio playback can be 
controlled precisely by a received time code signal (MC or MTC). In this case 
not only the starting point of audio playback is controlled externally, but sync 
also controls playback speed if "chase lock" is activated. This way Samplitude 
11.5 Producer can follow the sync of analog tape machines or VCRs for quite 
some time, which always have a certain slip, without delay. 

This is a very powerful feature which many "professional" systems only offer at 
a high price! 

By entering the "sync velocity", you can influence the speed of the tempo 
adjustment. The greater the sync velocity, the faster Samplitude 11.5 Producer 
will follow a tempo change of the sync master; however, this also means that 
the pitch fluctuation in the audio material is greater. 

Only use values greater than 100 if Samplitude 11.5 Producer does not 
synchronize precisely in standard cases. 

The "chase lock" synchronization uses a real-time resampling routine requiring 
a certain CPU power. Anything as fast as a Pentium 90 processor should 
suffice. 

When using the hardware pitching feature, the chase lock synchronization uses 
direct access to the sample rate of the sound card in 1 Hz steps. This achieves 
particularly precise synchronization without additional CPU load. However, the 
sound card has to support this feature, as is currently the case with the ARC44 
and ARC88 4 or 8 channel. 

MIDI clock input device: Here the driver must be selected from which 
Samplitude 11.5 Producer will receive MIDI clocks for the synchronization. 

BPM: Here you have to enter the tempo at which you want to receive MIDI 
clocks. 
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MIDI clock output device: Here you have to select the driver via which 
Samplitude 11.5 Producer should send MIDI clocks for synchronization. 

BPM: Here you have to enter the tempo you want to send MIDI clocks. 

SMPTE/MTC input device: Here you have to select the driver via which 
Samplitude 11.5 Producer should receive MIDI timecode for synchronization. 

Sync velocity: The greater the sync velocity, the faster Samplitude 11.5 
Producer will follow a tempo change of the sync master; however, this also 
means that the pitch fluctuation in the audio material is greater. Only use 
values greater than 100 if Samplitude 11.5 Producer does not synchronize 
precisely in standard cases. 

MTC output device: Here you have to select the driver via which Samplitude 
11.5 Producer should send MIDI timecode for synchronization. 

Type: Select the proper frame rate. Use 24 frames for cinematic 
synchronization, 25 frames for PAL video, and audio synchronization, 30 
frames for NTSC video. 

Pre-roll-frames: You can specify, how many frames Samplitude 11.5 Producer 
is to ignore before the synchronization starts. Here you can account for the 
fact, that certain analog instruments need time to reach the correct speed. In 
order to have Samplitude 11.5 Producer link up to the proper time values, a 
certain pre-roll frame count can be specified. 

SMPTE offset: The SMPTE offset is indicated in milliseconds and in SMPTE 
frames. The offset is removed from the incoming SMPTE time code signal to 
line up differences between tape material and recorded samples in Samplitude 
11.5 Producer. With an offset of “60:00:00” milliseconds (1 hour) a tape that 
was previously stripped can be synchronized, if the start point for the 
recording/playback starts at 1 hour. Samplitude 11.5 Producer will, however, 
start at the correct beginning position. 

FX: With this parameter, possible inaccuracies during the positioning of long 
samples can be equalized. Requirement is a flawless synchronization at the 
sample beginning. Follow the instructions in the chapter “problem solutions”. 

Key:  G 
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Burning CDs 

Burning Red Book-compatible audio CDs is a vital feature of Samplitude 11.5 
Producer. You won't require any other software for writing a CD. You can also 
write CDs "on the fly", and all processing is performed in real time during the 
write process. Since trackbouncing was not performed first and no image is 
created, no extra space is required on the hard disk. 

However, sufficient system resources must be available for processing while 
writing. If your PC is too slow and writing is interrupted, then you can of course 
revert to the conventional trackbouncing method. 

 

Red Book 

To standardize the data structure of CDs and to make them compatible with 
the CD drives, Sony and Philips laid down individual standards for the various 
types of CDs. The names simply arose from the color of the books in which 
these standards were recorded. The term "Red Book" is common language for 
the Compact Disc Audio Standard. The requirements listed here have to be 
observed for industrial CD production. Audio CD players only read CDs 
created according to the Red Book format. It is therefore necessary to first 
convert PC files into this format before writing them onto an audio disc 
compatible with any audio CD player. 

 

Writing 

Some years ago, there was only a small number of select studios which were 
able to do CD mastering. Today, writing audio CDs is nothing exceptional and 
continuously dropping prices for CD-R burners and media make them available 
to nearly everyone. 

The audio material is stored digitally on the CD, this data is read by the CD 
player, and then it is transformed back to the analog plane. While in action, 
track indexes indicate to the CD player which songs start at which position. 

Samplitude 11.5 Producer can also write an audio CD from the program 
directly. Before the write process starts, the track indexes are directly set in 
the VIP window, and then Samplitude 11.5 Producer converts stereo sum and 
indexes into a data stream which is fed to the CD burner. 
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The CD-R drive modifies an assigned layer of the medium by means of a laser 
so that an audio CD player can read this information as digital audio data later 
on. 

 

Burning CDs in  Samplitude 11.5 Producer 

1. In order to write an audio CD, the VIP window must first contain audio 
material. You may either record it new or import existing wave files into the 
virtual project. 

2. Mix your recordings by means of the VIP window's real-time functions and 
the mixer window. The CD will later sound exactly like the playback via a 
stereo sound card. All settings for the playback will be audible on the CD, too. 

3. Set the track indexes to mark the starting position of each song. If the VIP 
window contains only one stereo track (each song is created as separate 
object), then you may create indexes in Samplitude 11.5 Producer with the 
”automatic indexes” button. This will cause an index to be positioned at the 
beginning of each object. Tracks and indexes may be arranged in Samplitude 
11.5 Producer as you wish. Pause intervals may be continuously adjusted, and 
indexes may be set without any pause. Samplitude 11.5 Producer is one of the 
few audio programs which features this. 

4. When you have made all settings you can write the CD in real time, or you 
can use the offline function if your PC is not powerful enough. Now click 
”create CD” in the toolbar or select ”CD -> Create CD” in the menu. This dialog 
offers two options:  

Write using ”on the fly” mode: all effects are calculated in real time. 

Create complete, new files. Samplitude 11.5 Producer creates a new stereo 
file that contains all information on the multiple-track project.  

5. One click on ”OK” to start the writing process, and Samplitude 11.5 
Producer starts searching for available CD-R drives. If several drives are 
connected to the system, then you will be prompted to select the correct drive. 
Before burning, the process can be simulated. You can check using the 
simulation whether the computer's capacity is sufficient for the writing process.  

Once started, the burn process cannot be stopped. 
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DSP display 

System capacity is essential to the real time CD writing process. Once the 
writing process started, it cannot be stopped. The CD will be unusable if the 
the process is interrupted. When ”on the fly” is selected, the computer must 
calculate the playback with all real-time functions and simultaneously write the 
data onto the CD. 

The DSP display is a useful tool to assess possible problems when writing to 
the CD. The table below gives you a clue to the maximum possible writing 
speed. Individual deviations may result due to the configuration of your system 
and the speed of its components. 

 

DSP display and writing speed 

Nearly 100 percent  single speed 

Up to 50 percent  double speed 

Up to 25 percent  fourfold speed 

In particular, when first using a new and unknown computer system it is 
recommended to simulate the writing process first to check the system's 
performance limits. If the system becomes overloaded, reducing the number of 
tracks or real-time effects will help by combining parts of the VIP window 
(trackbouncing). 

The offline writing process variation offers another possibility. It creates a new 
stereo file first as the basis for the writing process. 
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Tools and wizards 

Load audio CD track(s) 

This option is also located in the “CD” menu. 

This function allows you to import audio data from most CD-ROM drives and 
CD burners without any quality loss. Please contact our technical support for 
the latest list of supported drives if you require it. 

The HD wave projects are recorded as wave files and can therefore be edited 
with other audio editing programs without having to convert them first. 

To do this, please follow these steps: 

1. Open the drive list dialog and select the CD-ROM drive you desire if you 
have more than one drive 

2. Click on the “Track list” button 
3. Select one or more tracks in the CD track list dialog list box 
4. Click on “Copy selected track(s)...” 
5. Select a file name for the new wave file or HD wave project and click "OK". 
6. Now the audio data is copied from the CD-ROM to your hard disk as a new 

wave file. 
7. Close the track list and drive list dialogs; one or more new objects appear in 

your VIP which contain the audio data from your CD. 

 

Features of the track list dialog 

Copy selected track(s): This button starts the audio data copy process; all 
selected tracks from the list are copied into one wave file. 

Play: Starts audio playback of the first selected track in the list. 

Stop: Stops audio playback. 

Pause: Stops audio playback (to be resumed later). 

Resume: Resumes playback (if previously paused). 

Select all tracks: Selects all tracks of the CD for copying the complete volume. 
You can select multiple tracks with "Ctrl + mouse click" or with "Shift/Alt + 
cursor". 
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Unselect tracks: Closes the drive door of the CD-ROM drive 

 

Features of the drive list dialog 

Track list: This button opens the track list dialog for selecting several audio 
tracks on a CD. 

Configuration: This button opens the drive configuration dialog to select 
special copy modes and SCSI IDs. 

Reset: Restores the standard drive settings. 

Add drive: Creates a new drive entry in the list for editing configuration data. 

Delete: Deletes the selected drive entry from the drive list. 

Save setup: Saves the drive list and all configuration data in a *.cfg file. 

Load setup: Loads the drive list and all configuration data from a *.cfg file. 

 

Features of the CD-ROM drive configuration dialog 

Drive name: Edits the name of the drive in the list. This is useful if you create 
more than one entry which access the same physical drive. 

Host adapter number: Specifies the number of your SCSI adapter (normally 0). 

SCSI-ID: Sets your CD-ROM drive's ID. Make sure you set the correct ID, 
there is no error checking! 

SCSI-LUN: Selects the SCSI LUN parameter (normally 0). 

Alias: Selects your CD ROM drive's manufacturer. 

Normal copy mode: Copies the audio data without any software correction. 

Sector synchronization copy mode: Copies the audio data using a software 
correction algorithm. Some CD-ROM drives cannot seek exactly to the same 
position between two read accesses, but Samplitude 11.5 Producer can 
correct these differences using this algorithm. 

Burst copy mode: Optimizes the copy process speed (no software correction). 

Sectors per read: Defines the number of audio sectors per read cycle; the 
higher the number, the faster the copy process will be. Not all SCSI adapters 
support more than 27 sectors. 
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Sync sectors: Defines the number of audio sectors used for sector 
synchronization. A higher number results in a better synchronization, but also 
in a slower copy process. 

 

Batch processing 

Batch-processing lets you automate work processes. You can stretch out a 
specific editing function of a wave project in the same way onto a file list of any 
size (the "batch"). The files can then executed automatically over night, for 
instance. 

Possible editing processes include: 

 Normalization 
 Linear fade in and out 
 All real-time effects available in the mixer master 
 Format conversions: Word width (16/24/32 float), sample rate, 

stereo/mono/left/right 
 Save in all available export formats. 

For example, you can normalize an entire folder of 24-bit wave files to 96%, 
add 5ms fade to the beginning and end of each, compress with the multi-band 
compressor, convert to 16-bit, resample at 22kHz, and save as MP3. 

 

Source files 
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Create a list of the files to be edited by selecting “Add file”. Multiple selection is 
also possible. "Load folder" adds all audio files in a folder as well as all 
subfolders to the list. All importable audio formats can be loaded in Samplitude 
11.5 Producer. “Save list” creates a Playlist (in the common *.m3u format) for 
using your selection of files later. “Remove” deletes all selected list entries. 
“Remove all” deletes the complete list. 

 

Effects 

 

Amplitude: You can normalize to a specific maximum value in %/dB or 
sink/raise the level by a certain value. Read more on this in the chapter "Effects 
menu -> Amplitude/Normalize". 

Effects presets – Mixer master channel: So that you don't have to list out 
innumerable effects settings in the batch processing dialog again, the effects 
can be integrated using mixer preset files. 

In the mixer it's possible to export all settings of the mixer in a mixer preset 
(*.mix). This happens via the "Save mixer preset" button in the mixer. 

When you load the *.mix file into the batch-processing function ("Load preset"), 
all effect settings of the master channel will be calculated into the file batch (all 
other data from the mixer preset, e.g. channel strips, groups, etc. will be 
ignored). With "Edit preset", you can open a special FX routing dialog from 
which you have access to all effect parameters.  

Mixer presets which were saved in the "/fxpresets/batch" folder can be 
selected directly from the preset selection box. 
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Effects: Beside the master effects of the mixer preset, the non real-time effects 
"Resampling/Timestretching", "Remove DC offset", and "Remove modulation" 
(DeClipping) can also be used. "Settings" opens the corresponding effects 
dialog. 

Fades at the beginning and end of projects: Linear fades of any length can be 
added to the beginning and/or end of files. 

 

Target format 

 

All settings on this page can be saved as presets. You can freely choose the 
bit resolution (16/24/32-bit), the sample rate, stereo/mono/left/right as well as 
the save format with the corresponding format options. You can find out more 
about the sample rate in the "Offline effects menu -> Adjust sample rate". 

Read more about export formats under "File menu -> Export". 
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Destination files 

 

There are several ways to save edited files: 

 Replace files: The original file is replaced with the edited one. If the file is used 
in a VIP, the VIP is closed first. 

 Save files in source directory with changed name " / " Save files in following 
directory": The edited file is saved in the source directory or in any chosen 
directory. The specified suffix/prefix is added to the file name. Optionally, you 
can "Delete source files after editing". 

 Keep source directory structure: This option saves all files including the source 
path. This allows you to keep folder structures of CDs. 
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Crossfade Editor 

In the Crossfade Editor you can conveniently and efficiently edit all aspects of a 
crossfade. All changes are non-destructive and can be undone via "Undo". 

 

Crossfade Length: The length of the crossfade can be set in varyingly large 
steps. A click on the "+" / "-" buttons increases/decreases the length in small 
steps, the "++" / "--" buttons in larger steps. Use the button "-?+" to 
customize these step effects to your needs. The crossfade length can also be 
defined by a selected range in the VIP by clicking on "Get Range Length". This 
range has to be selected before opening the Crossfade Editor. 

Fade In / Fade Out: There are lots of different curve types available for the 
crossfade: 

 Linear (0) 
 Exponential 
 Logarithmic 
 Cosine 
 Sine/Cosine 
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The faders can be used to change the curves in the corresponding available 
range. Linear curves require less computer power than non-linear ones. 

Note: The settings for fade in/out in the Crossfade Editor are also applied to 
the selected object if it does not overlap any other object. 

Global Settings: Set: The current settings are defined as preset. This is useful, 
for example, when an object is split with the "T" key and you wish to create a 
crossfade between the two objects. When opening the Crossfade Editor, the 
specified settings are set as default. 

Global Settings: Get: Use this button to get the presets of the Crossfade 
Editor. 

Get Range Length: The range length of the range selected in the VIP is set as 
the crossfade length. 

Crossfade off: Deactivates the crossfade of the selected object. The fade out 
time of the first object is set to 0.  

Play / Stop: Starts or stops playback in the selected range or at the cursor 
position. 

Move Crossfade Position: The end of the first object and the end of the 
second object are moved equally. The ++/--/+/- buttons are used to set the 
crossfade length. 

Shortcut:  Ctrl + F 

 

Remix Agent 

The Remix Agent is a powerful tool for determining the BPM (beats per minute) 
and the time positions of quarter note beats of any song. This is important, for 
example, when a track on an audio CD has been imported into Samplitude 
11.5 Producer and other sounds like drum loops, effects, or synthesizer voices 
are to be mixed in. 
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Remix agent - Tempo and beat assignment 

 

The Tempo and beat recognition is a powerful tool that determines the tempo 
(measured in beats per minute, or BPM) as well as the timing of the beats for a 
song’s quarter notes. This is important if an audio CD title is imported into 
Samplitude 11.5 Producer, and you want to mix in sounds like drum loops, 
effects, or synthesizer voices. 

When to use the Auto Remix Assistant: 

 When the tempo of the arrangement must be adapted to the tempo of the 
song.  

 When the tempo of the song must be adapted to the tempo of an existing 
arrangement. 

 When the song is to be cut up precisely to create a remix object which can 
then be rearranged as desired. 

 

Requirements 

 The song must be longer than 15 seconds. 
 The songs have to contain "rhythmic" music. 
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 The song must be in stereo. 

 

Preparation - Setting the start marker and object end 

Before opening the Auto Remix Assistant, you should set the start marker at 
the position in the song object in the arranger where you want detection to 
start. If the song contains a long intro without beats, set the start marker after 
the intro. As a rule of thumb, the Auto Remix Assistant should always be "fed" 
dance music.  

 The start marker should be set before a quarter note beat or, better still, briefly 
before a beat at the start of a bar. 

 If the start marker lies before the song object, the object is examined from the 
beginning.  

 If detection is not performed by the end of the song, the object can be 
shortened accordingly with the object handle at the end of the object.  

 

Checking the automatic tempo and bar recognition 

After Tempo and beat recognition opens, the selected track object will be 
analyzed. Following the analysis, the track will be played, and during playback 
a metronome corresponding with the computed result will sound; vertical tick 
marks visualize the quarter note positions in the wave form display. 

The following is indicated: 

 Position of the start of the measure (one): red lines 
 Position of the other quarter notes (two, three or four): green lines 
 Reliably recognized positions: thick lines 
 Unreliably recognized positions: thin lines 
 Tapping is indicated by additional blue lines 

If the tempo and beat information is already available, then dots above the 
display at the corresponding positions will appear. To the left underneath the 
waveform display the metronome volume can be adjusted. To the right the 
calculated BMP value will appear. If the BPM value is valid, the display will be 
green. 

If the metronome clicks match the rhythm of the music, the bar starts will then 
be determined. If not, you can correct the tempo manually. 

 

Corrections: Manual tempo and onbeat / offbeat setting 

If the result is incorrect, you can help the Auto Remix Assistant with a few 
mouse clicks on the correction buttons.  
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There are two possibilities: On the one hand, the “Tempo correction” list offers 
alternative BPM numbers which could also fit with the music. The adjustable 
BPM values are detected automatically, and the total number of BPM can 
deviate from song to song. 

Tap tempo: With difficult audio material we recommend the using tapping 
input mode. Either "T" must be pressed, or the "Tap tempo" button must be 
clicked in time with the music. While repeatedly tapping the tempo correction 
button, one should keep an eye on the color in the BPM display. In the 
“unlocked” condition (red) the tapping is not in time with the music. One should 
tap until the “locked” condition is displayed. After a short time one hears if the 
result is correct via the metronome.  

Subsequently, offbeat correction takes place if required. If the detected quarter 
notes beats lie around the length of an eighth note (transferred behind the real 
positions of the quarter note beats), then one or more alternatives can be 
selected from the on beat/off beat correction list.  

 

Set the start of the bar 

Start bar correction takes place next. The beat at the start of the bar should 
coincide with the high sound of the metronome, or the red line in the wave 
form display. 

Correction is achieved in one step: If the start of the beat can be heard, then 
click on "Tap one" once, or press "T". Alternatively, you can also choose how 
many quarter notes the "One" is to be moved back by. 

If the start marker is set right before the first beat of a bar, then no correction 
is necessary. 

Hint: After every adjustment, the metronome and tick mark visualization reacts 
with a delay. 

 

Step 3: Use of the BPM and beat recognition 

With this last step you determine what is to be done with the material currently 
being analyzed. There are three possibilities:  

1. You want to generate remix objects from the song (the analyzed material), 

2. You want to bring your project tempo into line with the tempo of the song or 
vice versa, 
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3. You initially only want to save the tempo and beat information in the audio 
file to edit them later. 

 

Generating remix objects 

The song is cut up beat by beat into individual objects which can then be used 
and re-edited in any required way in the VIP.  

Some usage examples: 

 Generate loops out of complete songs that you can use with your own 
material. 

 Remix songs, i.e. change the sequence of the remix object, cut and duplicate 
the individual parts or beats of the songs, or enhance the song with any other 
loops, samples, etc. 

Caution! The “Generate remix objects” option can only be selected if the remix 
agent was opened from a VIP. 

Audio quantizing: The new objects are fitted exactly into the beat grid of the 
arrangement. 

In the case of manually produced music there are always slight tempo 
fluctuations which result in different bar lengths. In order to ensure that the 
objects still fit into the rigid beat grid of the arrangement, the "Object 
timestretching" option is activated and used in such a way that the differences 
in lengths are corrected. 

For small corrections, use resampling. If the necessary corrections are very 
small, the higher-quality resampling technique can be used instead of 
timestretching.  

Note: If you decide to alter the tempo of your multi-track object later and to 
adjust the audio object in the VIP to the new tempo value, clearly audible pitch 
changes will appear in the remix. 

Remix objects in loop mode: The new objects are put into loop mode. When 
the objects are lengthened with the right-hand object mouse handle, the object 
will continue to be played at its original length. 

Setting arrangement tempo at object tempo: The arrangement (VIP) takes 
over the BPM value it has found. If you want to use the dissected song as the 
basis for a new composition (remixing), this option should be active.  
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Note: the time correction is allocated to the objects by setting the object 
real-time timestretching and can therefore be corrected in the object editor. 
Conversely, timestretching settings that have already been set can be 
over-written. 

Grouping: The remix objects are grouped. 

Use crossfades: The remix objects are superimposed. The parameters of the 
superimposition can be set in the crossfade editor. 

Exit: The dialog is closed without the changes being saved. 

Adjust tempo: This option offers you the possibility of adjusting the song 
tempo to your project speed or the project speed to your song tempo. 

Caution! The “Adjust tempo” option can only be selected if the remix agent has 
been opened from a VIP. 

Set object tempo to arrangement tempo: This adjusts the object length to the 
existing arrangement. Three different procedures are possible: 

Timestretching: The song's pitch remains constant, but under certain 
circumstances the sound quality may suffer.  

Resampling: Resampling changes the pitch, in the same way as changing the 
speed on a turntable, but significantly retains the sound quality of the song. 

Note: If you decide to alter the tempo of your multi-track object later and to 
adjust the audio object in the VIP to the new tempo value, clearly audible pitch 
changes will appear in the remix with objects edited with resampling. 

Audio quantizing: Audio quantizing calculates the tempo adjustments into the 
audio file. This is done in such a way as if initial remix objects (see below) were 
being produced and immediately compiled into a new audio file. If the 
recognition is uncertain, the result can include extreme tempo fluctuations. It is 
particularly important to set the start marker before calling up the remix agent 
in such a way that the tempo is recognized with certainty. 

The advantage of audio quantizing is that small tempo fluctuations are evened 
out in the music. The bar starts of the music always match the bar starts of the 
arrangement and therefore do not tend to wander away from one another. 
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Set arrangement tempo at object tempo: The arrangement (VIP) takes over 
the BPM value it has found. If you want to use the dissected song as the basis 
for a new composition, as with remixing, this option should be active.   

Change global setting: The BPM value of the arrangements (VIP) is set at the 
calculated value. 

Adjust tempo map: From the position of the play cursor to the final position of 
the remix object, a tempo marker is set for each bar in the arrangement (VIP). 

Generate bar marker in the current range: This option enables markers to be 
set at start of each bar in the song (the positions of the lines marked in red in 
the wave form display). 

Generate quaver markers in the current range: Select this option in order to 
set markers at the positions of the starts of the quaver-bars (the positions of all 
lines presented in the wave form display). 

One example of the use in both cases: 

Mixing two songs:  

1. First, adjust the project tempo to the song over which you intend to dub in 
the second song (“Set arrangement tempo to object tempo”, “Alter global 
setting”). 

2. Then, adjust the tempo of the second song to the project tempo (“Set 
object tempo to arrangement tempo”). 

3. Since the project tempo and the tempo of both songs now match exactly, it 
will be possible to fade from one song to the other without any problem. 

Save only tempo and beat information: If this option is selected the tempo 
and beat information is transferred to the audio file. The objects in the VIP and 
the VIP itself remain unchanged. 

Generate beat markers in the current range: With this option markers are set 
at the start of each bar in the song (the positions of the lines marked in red in 
the wave form display). 

Generate quaver markers in the current range: Select this option in order to 
set markers at the positions at the start of each quaver-bar (the positions of all 
the lines marked in red in the wave form display). 
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Harmony Agent 

 

The Harmony Agent is designed to analyze harmonies. 

The music track is analyzed first when you open the Harmony Agent. The 
Harmony Agent tries to automatically identify the harmonies for each quarter 
beat of the music. The correct beat information is an important prerequisite for 
a properly-functioning Harmony Agent. 

During subsequent playback, the detected harmony is played as a chord by an 
internal generator for verification purposes. You can adjust the volume with 
"Volume Generator". "Mute" deactivates the generator. 

The transport control controls playback of the music track. The position slider 
below lets you quickly move to a certain passage. 
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Check and correct the automatic harmony recognition 

After the analysis, you can manually correct harmonies which were not 
correctly identified. Note that major chords are written with capital letters and 
minor chords with lower-case letters. 

Left click on the respective harmony symbol in the wave display. Hold the key 
if you want to mark several subsequent harmonies. If you right click on 
selected harmony symbols, a menu containing alternatives will be displayed. 
The initially recognized harmony is marked with an *. 

If there are no alternatives available, you can select the correct "Keytone" or 
"Chord" from the menu in the "Correction" section. Use the option "Replace 
selected harmony in the entire song" if you are sure that the incorrectly 
recognized harmony is not included in the entire song. Usually, major and 
minor keys have been mixed up. 

Once you are sure that all harmonies are set correctly, click on "Continue". 

 

Use harmony recognition 

You can apply the information from the Harmony Agent here. There are 
different ways to output harmonies: 

 You can create VIP markers in the arrangement that display harmonies 
graphically in the video monitor as guitar tabs in sync to the music. 

 The information may be saved as an audio file. This also ensures that the 
harmonies are available later. For instance, if you'd like to display the harmony 
information in the time bar (Edit -> Show object marker -> Harmony marker). 

 You can choose between different displays of the harmony symbols. You can 
choose between German, English or Roman symbols to "name" the tones. 
Furthermore, you can set "Predraw" to force single harmony interpretation. 
"#" shows all notes as "sharps" (C#, D#, F#,...), and "b" displays them as 
flats. 

 

Track settings 

Audio 

Output: Specifies the audio output device. This can either be a  bus (submix 
bus) in the audio studio mixer or a wave out device. This parameter can can 
adjusted in the VIP window, in the mixer, as well as in the track settings. 

Surround mode: Activates Surround mode. 
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All tracks: Sets the current settings for all other tracks in the VIP. 

Track type: Displays whether the track is set to AUX send and/or a 
submix-bus. 

Color: The track color set here is displayed in the track editor as well as in the 
track box in front of the track name. If the track is a track folder, then the color 
will be used for the border and all tracks in this track folder. 

Audio recording options 

Audio device: Defines the audio recording device. This setting can be made in 
the VIP window, in the  mixer, or in the track settings. 

Recording file: Specifies the name for the recorded wave file. As a default, the 
following mask is applied: [VIP][tracknumber].wav. If you move tracks, then the 
track number in the file name will no longer match. 

Track name: Change the track names here as they are shown in the track box. 

Track recording options 

Stereo: Records a stereo wave file. 

Mono: Mono recording uses an input device for recording. 

Mono (Mix): Mono recording records a signal which mixes both input devices. 

Record in RAM only: This creates a RAM wave project. The difference from a 
HD wave project is that it opens a VIP in the computer's RAM. This enables a 
significantly better playback performance, but is only suitable for short 
recordings. 

 

MIDI 

Recording device: Set up the MIDI interface to be recorded. 

Playback device: Set up the MIDI interface on which the track's MIDI 
information will be output. 

All tracks: Applies the settings to every track. 

Play/Thru parameters 
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In Channel: If a MIDI channel is set here, then ONLY this will be used for 
recording. 

Out channel: If the MIDI object includes multiple MIDI channels, then you can 
use this option to filter out other MIDI channels than the one set. Only events 
for the MIDI channel set here will be output via the MIDI interface. 

Transp.: Transposes the played pitch in semitones up or down. Set the value 
here to 2 and play C2, for example: D2 will be played or recorded. The value 
12 transposes an entire octave up; -12 correspondingly transposes down. 

Program: Sets the MIDI program for the current track.  

Bank Hi (MSB):  According to MIDI specification, "Bank Hi" is required if a 
bank number should be addressed which exceeds the 7-bit MIDI range (0-127 
or 1-128). 

Bank Lo (LSB): Enter a bank number. If it exceeds 127/128, remove 128 and 
enter 1 in the "Bank Hi"-field; if higher than 255/256 enter a 2, and so on. 

Note: If you need to switch banks and programs within a track, it's 
recommended that you set this in the MIDI object editor (view page 178), and 
that you separate (view page 364) the objects at the corresponding positions. 

MIDI Thru active: The incoming signal is immediately forwarded to the set 
output device. 

 

Managers 

The managers combine frequently needed administrative and control functions 
together inside one window, including those of markers, grooves, and tracks. 
This also includes a file browser to find, sample, and load media data.  

The managers can be opened inside or outside of the main window and do not 
block it. The managers window has a multi-monitor capability and remembers 
its last position when it is closed. A number of managers can be opened 
simultaneously in various different views and independently of one another. 

The managers integrate the following sub-windows, including keyboard 
shortcuts: 
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 File browser (view page 263)  
 Objects (view page 267)  
 Tracks  
 markers (view page 270)  
 Ranges 
 VSTi 

To open the managers, click on the “Manager” entry in the toolbar or select the 
entry “Open new manager” in the “Tool" menu. With this menu entry you can 
also open further manager windows in addition to the one already open. 

Click on the window tab at the bottom edge of the managers window in order 
to open the corresponding sub-window.  

 

File manager 

Samplitude 11.5 Producer contains a file browser in the manager where files 
can be previewed and loaded directly into projects. The browser can be used 
to create favorites folders and provides access to all recently opened folders. 

To view the file browser, click on the "Manager" button in the toolbar and then 
select the "File browser" tab at the bottom of the manager window. The file 
manager can also be opened via the menu (view page 451). 

Menu: Tools/Manager/File browser 

 
 

Navigation / Favorites 

The file manager works in a similar way to Windows Explorer; directories and 
files are displayed with directory and file symbols in list form. 

Navigation is achieved with the mouse or keyboard. A drive selection menu 
found in the toolbar lets you quickly switch between all data storage devices 
connected to the workstation. 

A display filter located in the toolbar lets you limit the display to certain media 
types, e.g. .wave, MIDI, or project files, only. "All media files" is the default 
display. 
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The "Search" option lets you search the current window for directories or files. 
Enter a search item into the input box and click “Enter”. Found directories or 
files are highlighted. You can find and highlight several entries that meet your 
search criterion by entering one or several first letters. 

The file browser opens as a tiled window by default. The right box hosts the 
favorites list, which you can fade out using the “Options” toolbar. Use “Add” or 
“Remove” to add and remove directories from the list of favorites. 

There is a combo box below the favorite list displaying the last used paths and 
which lets you change the current project directory. 

 

Preview audio files 

You can use the "Play" icon in the toolbar to preview a marked audio file, and 
every highlighted audio file is played immediately if the “Autoplay” box is 
checked. This way you can listen to a complete list using the cursor keys only. 
Clicking on the play button again stops continuous playback again. 

Hint: During playback the transport console controls are allocated to the media 
file. Playback and positioning functions are fully available. 

Playback is not routed through the mixer or internal effects. In contrast to the 
playback features of the “Load” window, which uses routines of the operating 
system, playback uses the audio device selected in the "Play" parameters 
(“P”), usually an MME, WDM, or ASIO device. If no playback occurs, first check 
that the settings and routing of this device is correct. 

Note: To preview certain media data, e.g. in WMA format, you have to convert 
these files to wave format. Conversion is done automatically in the 
background. 

 

Load files from the browser into projects 

Some media files can be inserted from the browser into an opened project at 
the desired time position via drag & drop. If the file browser list is in the 
foreground, pressing “Enter” has the same result. 

If an audio file is dragged from the clip list and dropped into an empty space or 
into the title bar of the program window, it is opened in wave editing mode. 

If several files are selected in the list, all files will be inserted at the current 
cursor position as new objects, and loading options ("Options") will be applied. 
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This way you can specify whether all files should be inserted into the current 
project one after the other, one underneath the other, alphabetically, or 
according to their time stamp positions. The load option settings are valid also 
for files loaded via the load dialog of the program. 

There are further options in the context menu of a media file (right click): 

 Load file 
 Delete file: Physically removes file from storage device. This process cannot be 

reversed! 
 Highlight all files 
 Open via standard link: The file is opened in the Windows application that is 

linked to this file type. This can be an MP3 player or some other wave editor. 
 Open in Windows™ Explorer: Opens the current directory as a new Windows 

Explorer™ window. 

 

Soundpool 

This setting can be used to access Soundpools. Access to the supplied 
Soundpools is via a new, more clearly laid out database overview that enables 
the display of loops, multiple styles and instrument categories, e.g. all bass 
loops of every installed style or every loop of a style. 

If you did not install the Soundpools on your hard drive during installation, then 
insert the Samplitude 11.5 Producer installation DVD into the DVD drive. The 
contents of the Soundpools will now be imported into the database. Other 
Soundpool media are automatically recognized and added to the database. 

We recommend copying media to the hard 
drive and then importing it with "Add style". 

This menu provides several additional options for maintenance and display of 
your Soundpool database: 

Normally, loops can be previewed just by clicking them, even during project 
playback. If "Automatic playback" is deactivated, then use the playback button 
in the manager. 

The option "Hide instruments without available loops" completely hides 
instrument groups in the Soundpool manager for which there are no loops 
present in a certain style (instead of being grayed out). 
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Every detected Soundpool (on CD/DVD or on the hard drive) is added to the 
database and displayed there, even if the corresponding medium is currently 
not in the drive or if the Soundpool has been deleted or moved. The option 
"Clean up Soundpool" removes these entries from the database. "Reset 
Soundpool" will reset the Soundpool database so you can re-import the 
Soundpools later. 

A Soundpool consists of one or more Styles. Styles are sound libraries that 
belong together and cover a certain musical style. The sounds (sample or MIDI 
loops) of one style all have a certain tempo. You can mix loops from different 
styles, and the tempos will be adjusted accordingly. Within a style, loops are 
ordered according to instruments, and one instrument folder contains different 
sounds. Each sound can have a different pitch (except for drums and effects 
sounds). 

 

The Soundpool display consists of several columns: First, all styles available in 
the database are shown. The second column lists the instruments. The third 
column, "Name", contains the list of the sounds found. The respective name, 
tempo, length in bars (1, 2, or 4 beats), and type is listed for them. The 
different pitches are displayed above that (if available). 

The list of samples found is created based on the entry selection in the first 
two columns. With "Ctrl + click" you can reduce or expand selection. No 
selection ("Ctrl + click" on a single selected element) shows all entries from this 
category.  

If you select an instrument, e.g. "Drums" and "Percussion" and no style, then 
all drums and percussion samples in the whole database will be displayed. 

In the search field, you can search the list of 
the sounds found for a certain sound file 
name. 

There is one principle difference between the types of loops: While audio loops 
(.wav or .ogg) are normal (looped) audio objects that can be applied anywhere 
in the arranger, MIDI loops (MIDI takes) consist of MIDI data + the controlled 
synthesizer (Vita or Revolta). This is automatically loaded to the track where 
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you place the MIDI loop. This means that you will need to use a new track for 
each additional MIDI loop which controls a different sound. However, the same 
loop in another pitch is possible. 

Loops can be loaded by double clicking, drag & drop, or by double clicking the 
corresponding pitch. The objects will be inserted directly behind one another 
so that complete accompanying tracks can be compiled quickly.  

Tip: If you want to search in multiple lists at the same time, open a new 
manager via "Tools -> Open new manager..." and switch to "Soundpool" in the 
new window. A separate search query can be set for each list. 

 

Object manager 

The object manager integrated in the manager lists all objects contained in the 
current project and makes it possible to edit selected object parameters. 

To view the object manager, click the "Manager" button in the toolbar, and 
then select "Objects" at the bottom of the manager window. 

Menu: Tools -> Manager -> Object manager 

Keyboard shortcut:  Ctrl + Shift + O 

You can export object manager information as a text file. To do this, click the 
"Export text" button in the toolbar. The Windows™ text editor opens with an 
excerpt from the object manager list. The following information will be saved:  

 Project name and path 
 Track and object name 
 Start position in the project 
 Source file path 

Afterwards, you can find this file in the project folder (Projectname.txt). 
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Object view and selection 

Objects are displayed in a tree structure and sorted according to tracks, 
whereby only tracks are listed that actually contain objects. As an option you 
can choose to display objects of the current tracks only (Toolbar: “Options”). 

You can use the +/- keys of the toolbar to open and close the track object 
display in the entire window. Click on the “+” symbol left of the track number to 
explode the view of a single track. 

Selecting objects: A square check box next to the object name lets you select 
single or multiple objects. These will then appear in the project window as 
“selected”. If an object is selected that is part of an object group, then the 
other objects of the selection are also selected in the project window and 
object manager. You can recognize grouped objects by the number of the 
object groups in the object manager group bar. 

Search for objects: As in other manager windows, the object manager also 
provides a search option that allows you to search for objects in the current 
window. Enter a search item into the box and press “Return”. Found objects 
are highlighted, but are not selected in the project window. 

 

Deleting, renaming and editing objects 

You can delete objects directly in the object manager by selecting one or 
several objects simultaneously and pressing “Del”. Alternatively, you can delete 
an object via its context menu. 

You can rename objects by double clicking on the object name and entering a 
new name. The procedure of changing a marker position directly in the list is 
the same. 

To edit an object directly from the object manager, right click on the object you 
want to edit and start the object editor. 

 

Edit object parameters 

The following objects may be edited via the object editor: 

 Object start 
 Object length 
 Object end 
 Volume 
 Lock 
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To edit a parameter, double click the respective entry and enter a different 
value. Numeric values may be changed via drag & drop, in which case "Ctrl + 
Shift" provides larger or smaller value changes. "Tab" moves to the next 
editable value. "Arrow up/down" navigates vertically within a text column. 

 

Track manager 

All tracks of the current project are displayed in the track manager and it 
enables direct access to solo, mute, and record. 

To view the track manager, click the "Manager" button in the toolbar, and then 
select the "Tracks" tab at the top of the manager window. 

Menu: Tools > Manager > Track manager 

 
 

Track view and selection 

The track manager contains all of the current project's tracks. You can double 
click on the track number to select a track. The track will be displayed in the 
project window. If the track is outside of the visible display, the project window 
will scroll to this vertical position. 

Search for tracks: As in other manager windows the track manager also 
provides a search option that allows you to search for tracks in the current 
window. Enter a search item into the box and press “Return”. Found tracks are 
highlighted. 

 

Rename, delete, and insert tracks 

You can delete tracks via the manager by selecting one or several of these 
tracks and pressing “Del”. Alternatively, you can also use the context menu to 
delete a track. 

You can rename tracks by double clicking on the track names and entering a 
new name. The procedure of changing a marker position directly in the list is 
the same. “Tab” moves on to the next editable value. “Cursor up/down” 
navigates you vertically within a column if this is a text column. 
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To edit an object directly from the object manager, right click on the object you 
want to edit and start the object manager. All functions are present in the 
same way as they would be if you opened the object manager from the project 
window. 

You can also insert new tracks directly in the track manager. Right click on a 
track entry and select “Insert track” from the context menu. A new track is 
added after the final track of the project. 

 

Marker manager 

The marker manager displays all markers contained in the current project, 
regardless of type and makes it possible to jump to them directly from the list 
or to play them. 

To view the marker manager, click the "Manager" button in the toolbar and 
then select the "Marker" tab at the top of the manager window. 

Menu: Tools -> Managers -> Marker manager 

 You can export marker manager information as a text file. To 
do this, click the "Export text" button in the toolbar. 

The Windows text editor opens with an excerpt from the marker manager list. 
The following information will be saved:  

 Project name 
 Marker type 
 Marker name 
 Marker position in project 

You can find the file in the project file (Projectname.txt). 

 
 

Marker view and selection 

In the marker manager you can display all of the current project's markers. 



 
 

Tools and wizards 271  

 

www.magix.com

Searching for markers: As in other manager windows, the marker manager 
also provides a search option which allows you to search for markers in the 
current window. Enter a search item into the box and “Enter”. Found markers 
are highlighted. 

 

Jump to and play from marker position 

Double click on a marker in the type column to position a playback marker on 
a different marker position. 

Playing markers: Select a marker and click on the “Play marker” button in the 
toolbar. A range surrounding the selected marker is created and playback is 
started. 

 

Deleting markers, changing marker name, position, and type 

You can delete objects directly in the object manager by selecting one or 
several objects simultaneously and pressing “Del”, or you can also use the 
context menu to delete a track. 

You can rename markers by double clicking on the marker names and entering 
a new name, or you can use the context menu. The procedure for changing a 
marker position directly in the list is the same. Please use the same method to 
change a marker position directly from the list. “Tab” moves on to the next 
editable value. “Cursor up/down” navigates vertically within columns if these 
are name columns. 

Tip: You can change the type in the context menu of the respective marker 
anytime, e.g. if you want to change a position marker into a CD track marker. 

 

Range manager 

 

The range manager represents all ranges contained in the current project and 
makes it possible to select them directly from the list.  
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In order to display the range manager click on the “Manager” button in the 
toolbar and then select the “Ranges” tab on the bottom row of the manager 
window.  

Menu: "Tools -> Managers -> Range manager" 

 

Defining and search for ranges 

Defining ranges: To save a range in the manager, you first have to define a 
range in the project window. Next, click on the “Define new range” button in 
the toolbar of the range manager. 

Ranges that are saved using the program's “Save range” feature ("Alt + F2", 
"Alt + F3", etc.) appear in the list with "F2", "F3", etc., as indicators. 

Searching for ranges: As in other manager windows, the range manager also 
features a search option that lets you search for ranges in the current window. 
Enter a search item into the box and press “Enter”. Found ranges are 
highlighted. 

 

Edit range parameters 

You can edit the following parameters in the range manager: 

 Name 
 Start 
 Length 
 End 

To edit a parameter, double click on the respective entry and enter a different 
value. Numeric values can be changed by drag & drop, and "Ctrl + Shift" 
allows for larger or smaller value changes. “Tab” moves on to the next editable 
value. “Cursor up/down” navigates vertically within a column if these are name 
text boxes. 

 

VSTi manager 

The VSTi manager enables easy display, inserting and deleting of VST, MAGIX, 
and Rewire instruments in the current project. If the instruments are opened, 
the single outputs to the assigned tracks are displayed. Right clicking on the 
selected instrument opens the plug-in dialog of the selected VSTi. Instrument 
outputs are routed in the VSTi manager in "Routing setup". Specify how the 
outputs should be routed in the dialog that appears. Either route all outputs to 
the current track or create new mono or stereo tracks for each output. 
Pressing the Del key removes a selected instrument completely from the 
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project. If only individual output signals are selected, routing to a track is 
canceled by pressing the Del key. 

 

Detailed information about instrument routing settings and about managing 
single outputs can be found in the chapter "Software/VST instruments -> 
"Routing instruments". 

 

SMPTE Generator 

 

If you don't have any external MTC to SMPTE Converter for synchronization 
with analog equipment, this dialog allows you to create audio files containing 
SMPTE audio signals. Place the generated SMPTE signal onto an empty track 
and route its output to the SMPTE synch input of the analog recording device. 

You can choose from the following specifications as SMPTE frames per 
second: 24, 25, 29.97, 29.97 drop frame, 30, 30 drop frame. 

The SMPTE start value can be entered in hours, minutes, seconds, and 
frames. 

You can specify the length in samples, milliseconds or SMPTE code. 

You can choose from the following sample rates: 44,1kHz and 48kHz. 
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Solo JamSession 

The Solo JamSession lets you create complete songs single-handedly. Begin 
with a simple idea, a small riff, or a chord progression. This is then recorded 
and put straight into an endless loop after the recording. 

Now, you can record a melody on a different track. The program simulates 
working with hardware "Looping delays", like, for example, the Gibson 
Echoplex. The difference is that Samplitude 11.5 Producer creates an 
arrangement during "looping" which can later be edited and compiled into a 
complete song, because Solo JamSession records everything you do. 

 

Open 

  Start Samplitude 11.5 Producer and select "New Solo Jam Session" from the 
start selection or 

  create a new arrangement. 

You can start your Solo Jam Session via the Menu (view 
page 406) or the "Recording" button in the tab toolbar. 

Shortcut:  J 

Note: Solo JamSession simultaneously serves as a simple recording in the 
"Easy" workspace. Please read more on this in the quick start manual under 
"Recording" (view page 28). 

 
 

Operation 

If you cannot use a MIDI input device or joystick, you should control your Solo 
JamSession entirely via your keyboard.  

The spacebar (or the sustain pedal or joystick button) will trigger different 
actions depending on which mode you selected. 
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If you are recording multiple tracks (up to 8 tracks are possible), you may mute 
individual tracks during the session using the keys 1-8. These actions are also 
recorded in the arrangement, so that a complex arrangement is created, even 
while recording. 

By clicking on "Stop", playback/recording is stopped immediately. 

 

Modes 

There are different recording modes in the Solo JamSession. 

 

Normal 

All material is recorded in the same track. The recording restarts from the 
beginning each time the spacebar is pressed. Old audio material is overwritten. 

The aim of this mode is to record multiple takes at a certain section in the 
arrangement, which can then be interchanged easily in the Take Manager. 

 

Overdub 

New audio material is always placed in a new track. Each time the spacebar is 
pressed, a new track is created where the recording restarts from the 
beginning. 

The aim of this mode is to record objects one below the other in multiple 
tracks that can then be arranged freely. 

 

Loop recording 

This mode records in an endless loop; therefore, a range has to be selected 
first. Otherwise the total length of the arrangement is defined as the range. 

After each repetition, Samplitude 11.5 Producer creates a new track in which 
the program records. The material that has already been recorded remains in 
tact, but is set to mute. 

The aim of this mode is to create multiple recordings in a set range, without 
listening to material of the same session that has already been recorded. 

 

Loop Overdub 

This mode records in an endless loop; therefore, a range has to be selected 
first. Otherwise the total length of the arrangement is defined as the range. 
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After each repetition, Samplitude 11.5 Producer creates a new track in which 
the program records. The material that has already been recorded remains in 
tact and is played back during recording of other tracks. 

The aim of this mode is to create multiple recordings in a set range, while 
simultaneously listening to material that has already been recorded. 

 

Solo JamSession 

This mode largely corresponds to the behavior of the "old" Auto JamSession. 
The aim of this mode is to create an arrangement even while playing that can 
serve as a basis for a new song. 

By pressing the spacebar several times in a row, the following actions will be 
triggered: 

1. Playback begins. Nothing is recorded yet. 
2. The first recording starts. Record your first beat(s). As a sign that the 

program is recording, the action button turns red. 
3. The recording ends. The recorded section is then inserted into the 

arrangement as a loop and begins playing repeatedly. This serves as a grid 
for the next loops. 

4. The next recording starts. You'll continue to hear the previously recorded 
loop. Now you can add an additional voice to it. 

5. The recording ends, playback of the first and the newly recorded loop 
continues. 

The next times start and end other recordings (4 and 5 repeat each other). 
Every time the recording is restarted, it's recorded in a new track. All loops 
recorded up until now are played. 

Double-clicking on the record button stops the last loop recorded. Clicking 
three times ends all running loops. You can use it to separate various sections 
in the arrangement from one another. 

 

Accompaniment 

There are many ways to record a song: 

 Record everything by yourself. Here, the loop that was recorded first is set as 
a measure for the speed of the song in BPM (beats per minute). The buttons 
1-8 function as mute or solo buttons depending on their set modes (see 
below). 

 You can choose from one of the accompaniments provided. The tempo of the 
song will be determined by the template. 

 



 
 

Tools and wizards 277  

 

www.magix.com

Metronome 

The metronome is useful for users who might need some help, so they don't 
"lose the beat". 

You can select the tempo from the list. "--" means that the speed adapts to 
that of the first recorded loop or to that of the accompaniment (if selected). 

 

Practice speed 

Speed is divided in half or quartered if you activate this button. In the list box, 
you can select whether you want to play and record with 50% or 25%. 

 

Monitor 

If the button is activated, the incoming signal is output immediately. 

"Sound FX" enables you to add extra effects to your material. The effects are 
applied to all tracks. 

Technically, these effects are on the track. Activation or deactivation of these 
effects is therefore not recorded. 

 

Options 

The following options are only available in "Solo JamSession" mode. 

Quantization guarantees that newly recorded loops fit into the existing 
arrangement by recording loops whose lengths are exactly multiple times that 
of the first recorded loop or that the loops begin or end on the bar or loop 
borders. 

There are multiple options for quantization: 

Quantize Length to next whole loop: The new loop is recorded with the same 
length or a whole-numbered multiple (2x, 3x, 4x...) of the original loop length. 
The loops always remain synchronous, but mustn't have the same starting 
point. This is the preset quantization mode. 

Quantize Start + length to next full loop: It's only after the next loop border 
that recording starts. The length is quantized like in "Length to next full loop". 
The starting points of the loops are all at the same time positions. 

Quantize Length to previous loop: The loop end is shortened to the last 
exceeded loop border. This is useful should you always only get around to 
clicking on the action button (spacebar) after the next loop when recording. 
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Quantize Start + length to next bar (standard): The starting point of the 
recording and the loop length are adapted to the bar. This is useful if you have 
recorded the first loop over multiple bars. 

Quantize Start + length to the next beat: The starting point of the recording 
and the loop length adapt to quarter beats. This is useful if you want to record 
very short or uneven loops (for example, only ¾ bar). 

Note: The options "Start + length to next bar/beat" are only useful if the speed 
has been set (specified in "Metronome" or by the accompaniment). 

Freestyle: Quantization is deactivated. No more loop starts or lengths are 
adapted when recording. It's only recommended if you want to create chaos or 
are very "precise". 

Mute/solo effects quantization: This option also quantizes the control of solo, 
mute, and other effects (double speed, half speed, reverse). 

Apply loop effects to last track only: The loop effects are always used on the 
last track only. 

 

MIDI / Joystick setup 

This menu entry opens the dialog "Edit keyboard shortcuts, Menu and Mouse" 
with the Solo JamSession page (view page 491). Here, you can also "learn" 
MIDI commands. 

Synth objects 

Samplitude 11.5 Producer supplies several synthesizer plug-ins to create your 
own drum pattern, bass, or melody lines. The synthesizers produce "synth 
objects" which are arranged on the tracks together with the other objects. 

 

Working method 

Opening the synthesizers 

The software synthesizers can be found in a special folder which is copied to 
your hard disk on installation. To open it, click on the synth button. 

You can find all available synthesizer plug-ins in the selection box. 

 

Object synths and track synths 
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In Samplitude 11.5 Producer there are two different types of software 
synthesizers: 

Object synths: These synths build up individual synth objects in Samplitude 
11.5 Producer. A corresponding synth object can be moved onto any track 
without anything changing on the synthesizer settings. Object synths are the 
Drum & Bass machine, BeatBox 2, Atmos, Vita, LiViD, and Robota. 

Note: Object synths can also use object effects. Open the object editor (view 
page 75) via the corresponding object's context menu. 

Track synths: These synths do not form any individual synth objects in 
Samplitude 11.5 Producer, but"normal" MIDI objects instead. They correspond 
to the function of external hardware synthesizers or VSTi plug-ins, which are 
also controlled via MIDI. Like all MIDI objects, they are dependent on the track, 
that is, the corresponding track synth is specified in the MIDI track settings. 
Correspondingly, the track synths can also be selected in the track editor and 
modified. Vita and Revolta belong to this type of software synthesizer. 

 

Programming the synth object 

Depending on the plug-in, various functions to create and control sound can 
be applied via the operating console. Please read the following chapters 
pertaining to the individual synthesizers in this regard.  

To monitor programming, playback can be started and stopped at any time 
with the space bar while the operating console is open. If the synth plug-in has 
its own play button (e.g. the beat box), then it will start the plug-in solo without 
playing the other tracks of the arrangement as well. 

 

Arranging the synth object 

Once you have finished programming the melodies or rhythms of the synth 
object, you can close the operating console and arrange the synth objects on 
the tracks. They can be stretched or compressed, faded in and out, turned 
down or up, etc. with the help of handles: These steps are the same for all 
objects.  

The operating console of every synth object can be reopened at a later stage 
by double clicking or via the synth button if you would like to reprogram the 
object. In addition, you can drag as many other synth objects of the same 
software synthesizer as you like onto the tracks and program them separately. 
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Note for users of older versions of Samplitude Producer oder Music Studio 

This version of MAGIX Samplitude Producer has replaced older technically 
outmoded synthesizers with newer, significantly improved solutions. Other 
synths were replaced by newer, non downward-compatible versions. 

Arrangements created using older versions of SamplitudeProducer or Music 
Studio may not function properly Samplitude 11.5 Producer for this reason. 
MAGIX provides the removed synthesizers as an extra download. 

To download... http://rdir.magix.net/?page=DEPBU7N8R5E2 

Note: Downloads require registration. 

 

Atmos 

Atmos is a synthesizer which can be used to easily create realistic nature 
sounds in no time. From thunder and lightning to animal sounds and traffic 
noise, Atmos helps you design natural-sounding atmospheric noises for your 
projects. 

 

 In the upper border window, select the top category "Scenario". You can 
select a desired nature sounds category (for example, "Thunder and 
Lightning"). 

 In the middle of the window, a collection of control elements appears for 
designing the desired "Ambience". Each element has its own description (e.g. 
"Thunder") and two faders, i.e. "Volume" and "Intensity". The "volume" control 
adjusts the loudness portion of the element. The "Intensity" fader controls the 
behavior of the sound, depending on controller element. For example, with 

http://rdir.magix.net/?page=DEPBU7N8R5E2�
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"Thunder", you can set how often thunder and lightning should sound; with 
"Rain", the strength of the rain can be regulated (if moved to the far left, light 
rain can be heard, while if moved to the far right, a downpour with loud 
splashing noises is audible). 

 At the bottom right border you will find a master volume fader with which the 
master volume of the synthesizer can be set. Furthermore, the "Randomize" 
setting is also located here. This way you can change the settings of the 
control elements by yourself. 

 

BeatBox 2 plus 

Note: BeatBox 2 replaces the older BeatBox from previous versions and is not 
compatible with them. Please read the notes for users of older Samplitude 
11.5 Producer versions. 

BeatBox 2 is a 16-voice drum computer with hybrid sound synthesis and a 
step sequencer. The proven handling concepts of the "old" BeatBox like matrix 
programming with auto copy have been expanded with comfortable editing of 
velocities and significantly improved sound synthesis, including a multi-effects 
section (one effect per drum instrument). 

A drum sound is created in BeatBox 2 using a sample (analogously to the old 
BeatBox) which is combined with a synthetic sound that can be created using 
up to three different synthesis models (hybrid sound synthesis). BeatBox 2 plus 
enables detailed editing and automation of all sound parameters. 

There are two styles of interface in BeatBox 2. While closed, you can listen to 
included sounds or those you've made in BeatBox 2 without using too much 
window space. 

 

Only the most important control elements are displayed when the program 
window is minimized. 

 Volume controller: Controls the volume. 

 Peakmeter and preset name: The peakmeter lets you visually control 
BeatBox 2. Click on the triangle beside the preset name to open the 
preset list. 

 Next/Previous preset 
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 Save preset: The preset includes the drum kit in use, the pattern, and any 
possible automations (view page 286). 

 Play/Stop: The playback controller in BeatBox 2 starts BeatBox without 
playing the arrangement, too.  

 Edit button: The edit button opens BeatBox 2 for you to program your 
own beats and sounds. 

 

Maximized BeatBox 2 plus window 

 Drum kit: This section loads drum kits (collections of different drum 
instruments) and the individual drum instruments. 

 Selected drum instrument: The settings in the synthesis section (6) and 
velocity/automation (5) always affect the selected drum instrument. 

 Pattern editor: Programs the beat sequence. In the top part, different 
patterns (sequences) can be loaded and saved as well as different settings 
for the view and function of the pattern editor. The matrix is where the 
beat is programmed: One line corresponds to a drum instrument, and a 
column matches a specific time position within 1-4 beats. If a cell is 
clicked on, then the respective drum instrument will be triggered at this 
position. 

 Velocity/Control: This section has two modes: Velocity and Automation. 
The setting Velocity displays the velocity levels for the selected 
instrument's beats as a column. The Automation set up allows automation 
to be set for sound parameters in the synthesis section (6). 
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 Synthesis: The selected sound parameters and effects settings for the 
selected drum instrument can be edited here. 

In the following, the sections of BeatBox 2 will be discussed individually: 
 

Drum kit 

This section loads drum kits (collections of different 
drum instruments) and the individual drum 
instruments. You can also try out an already 
programmed pattern with different kits or exchange 
individual drum instruments. 

 

 Select drum kit: Use the <> buttons to switch through the different drum 
kits. A drum kit is a collection of percussion instruments with matching 
sounds, e.g. rock kit or electronic drums à la TR 808. By changing the 
drum kit, you can add an entirely different sound to the rhythm you have 
already created. 

 Save drum kit: Use this button to save the current collection of drum 
instruments as a kit. 

 Drum kit list: Click on the arrow right of the name to open a complete list 
of available drum kits. 

 Select drum kit: The arrow buttons function analogously to those of the 
drum kit. The sequence of drum instruments in the kit can be resorted via 
drag & drop. 

 Mute/Solo: The "solo" button switches a drum instrument solo, i.e. all 
other instruments which are not "solo" will be muted. The "mute" button 
mutes a drum instrument. 

 

New drum or effect sounds can by added to the current drum kit by drag & 
drop from Windows Explorer. Drag a wave file to a drum instrument to create a 
new drum sound based on this sample. BeatBox 2 copies the sample into the 
sample folder to make sure that the instrument or kit created can be used 
again later. You can drag a complete folder with wave files to the drum kit to 
create a kit based on those samples. 

 

Context menu 

Right clicking a drum instrument always opens a context menu: 

 Copy/Paste: Copy an instrument from a track and paste it to another one. 
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 Empty instrument: An empty instrument is added. No sound is played, it has 
no name, and is used to clean up an unused track. 

 Default instrument: The standard instrument is added. It has the standard 
parameter for all synthesis shapes and serves as the starting point for your 
own sounds. 

 Reset automation: BeatBox 2's own presets contain automations. These are 
dynamic sound parameters like filter curves or pitch changes. This command 
allows you to completely remove these for the selected instruments. 

 

Pattern editor buttons 

 

 Pattern: Use the <> buttons to switch through the different patterns. 
The arrow to the right opens a list of all available patterns, and the save 
button stores the current pattern. 

 Clear track/all: All events for the selected instrument (track) or all events 
for the pattern (all) are removed by clicking this button. 

 Bar selection: The bar you wish to edit can be selected via the 
corresponding number button. Use the “Follow” button to select follow 
mode, i.e. the step display follows the steps of the currently played beat. 
All shows all bars of the pattern. 

 "1>2-4" Auto copy: If more than one bar is set as the pattern length, 
"Auto copy" mode makes sure that the drum notes set in the first bar 
are automatically placed into the next bars. This also makes it easy to 
create a continuous beat, even with a loop length of four bars. Notes set 
in the bars further back are not affected by the "Auto draw" function, 
which, for example, makes faint variations detectable only in the fourth 
bar. 

 Bars: The maximum length of a drum pattern is four beats. The length 
can be selected via the small scroll bar. 

 Shuffle: This controller changes BeatBox 2's timing. If the fader is 
turned to the right, the eighth of a rhythm is played more and more like a 
triplet. If that sounds a bit too abstract – simply try it out, ideally with a 
pure 1/16 hi hat figure; you'll soon see what the shuffle fader is capable 
of. 

 Grid: Here you can set the time resolution of the BeatBox. You can 
choose from 1/8 notes (only for very simple rhythms), 1/16 (default), 
1/32 (for more refined constructions). 
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Pattern editor - matrix 

 

This is the heart of BeatBox. A click on any position in the drum matrix creates 
or deletes drum notes (events). Clicking and dragging draws in a series of 
notes. Together with the velocity editing options (view page 287) (velocity), you 
can easily create drum rolls. 

If "Shift" is held when you click on notes in the range, a rectangle can be 
drawn out which selects the notes contained within this rectangle (lasso 
selection). Selected notes can be copied by dragging them to a new position. 
If "Ctrl" is also held down, then existing notes will remain at the target position. 
Delete all selected notes by right clicking. 

Two special commands are available for selection: 

Shift + double click Select everything in the bar clicked on. 
Shift + Ctrl + double click Select all 

A simple mouse click cancels the selection. The selection is automatically 
canceled after copying. If you want to keep your selection, hold down "Ctrl" 
while copying. 

 

Keyboard shortcuts 

Many functions in BeatBox 2 can be controlled with the keyboard, for example 
a beat can be triggered with the "Enter" key live in a running pattern. Here's a 
complete list of the keyboard commands: 

General Key command 
Open/Close editor e 

Pattern editor - options 
"1>2-4" Auto copy a 
Follow f 
Display bar 1... 4 1... 4 
Show all bars 0 
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Grid finer/rougher +/- 

Selected drum instrument 
Previous/Next Cursor up/down 
Preview p 
Live input Enter 
Mute on/off m 
Solo on/off sec 

 

Velocity 

The velocity mode serves for editing the velocity/automation of the individual 
drum notes for the selected drum instrument. 

 

 Reset: Sets all velocity levels to 100% 

 Mode switcher: Switches the section between velocity control and 
Automation (view page 286). 

 Random: The random parameter adds random variations to the set 
velocities. This helps make your beats sound more natural. 

 Amount: No function in velocity mode. 

 Velocity level: Every set note for the selected instrument is displayed as 
a column and can be edited. Multiple columns can be edited at once; 
see Editing velocity values and automations (view page 287). 

 

Automation 

Every parameter for a drum sound, including effects, can be automated, i.e. 
can change during a pattern. For example, you can make your snare drums 
more lively by adding higher voices to loud hits or  by setting accents on 
individual hits with reverb effects. 

 

The synthesizer section below enables the selection of a 
parameter for automation via the small blue LEDs above a 
parameter controller. More about the parameter controllers in 
the Synthesizer (view page 288) section. 
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 Reset: Sets all automation values for the selected parameter. 0. 

 Mode switcher: Switches the section between velocity control (view 
page 286) and automation switched. This happens automatically 
during selection of parameters. 

 Random: The random parameter adds random variations to the set 
automation. This helps make your beats sound more natural because 
each programmed hit will sound slightly different. The level of the 
random parameter is also influenced by the amount controller (see 
below), i.e. if the amount is at "0", then the randomness will have no 
effect. 

 Amount: The amount parameter regulates the complete influence of 
the automation values and of the random factor on the selected 
parameter. An amount of "0" does not have any effect at all on the 
automation; maximum level has the greatest effect. The effects of the 
amount controller on the automation values is made visible by a 
slightly lighter line in the value columns. 

 Automation values: The selected parameters can be drawn in as a 
column with the mouse. Automation values can also be drawn 
between the set notes; the sound of the drum instrument changes 
during playback. 

Automation values are added to the original value of the parameters. 

 

 

Editing velocities and automation values 

Hold down "Shift" and select any number of columns for velocity or automation 
with the mouse. Two special commands are available for selection: 

Shift + double click Select everything in the bar clicked on. 
Shift + Ctrl + double click Select all 
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The "Copy" button copies the selection to the clipboard. If you select this or 
that track in another editor, then you can paste the notes there now from the 
clipboard. If the target selection is larger than the contents of the clipboard, 
then it will be inserted again. This lets you quickly add a short section 
throughout the complete length of the pattern.  

The three handles allow the velocity or automation values to be edited 
together. 

 

The middle handle increases or lowers the values together. 

 

An object can be faded in or out with the handles to the left and right upper 
corners of the object. 

 

If you move the handles horizontally you can change the curve shape of the 
transition. 

A single click in the automation section cancels the selection again. 

Note: A selection of velocity values matches the selection of corresponding 
notes in the matrix editor. 

 

Synthesizer 

In the lower section of BeatBox, you can set the sound for the selected drum 
instrument. 
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The synthesis in BeatBox 2 consists of a combination of a simple drum 
sampler and a synthesizer. There are three different synthesis models possible 
for the synthesizer: "Phase Distortion Synth" (FM synthesis), "Filtered Noise", 
and "Physical Modeling". The mixed signal of both components is then 
processed by a multi-mode filter. An envelope curve ("envelope generator") 
time-dependently controls modulations of in all components.The details of the 
synthesis models can be read in the section Synthesis models (view page 293). 

 

 Preview drum istrument 

 Save drum instrument 

 Select sample: A click on the arrow selects samples from the 
categories like kick, snare, etc. 

 Select synthesis mode: Switches between the three synthesis 
models. 

 Mix: Mix relationship between drum sampler and synthesizer. 

 Parameter controllers: All six sound parameters for a drum sound can 
be directly set and automated via the parameter controller. The 
parameters in question depend on the drum sound currently loaded. 
By clicking the name of a sound parameter, a menu opens for you to 
add parameter controllers to each drum sound's synthesis 
parameters. 

 Automation: This selects the controller's parameter for the automation 
(view page 286). 

 

Effects section 

Each of BeatBox 2's drum instruments includes an effects unit which is fed in 
after the actual sound synthesis and editing. Each of these effects units 
includes a series of high-quality algorithms to add "audio polish" or to place 
the sound in a production-typical context. 
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 FX on/off 

 Parameter controller: An effects module includes four adjustable 
parameters. The fourth, "Mix", is always available and the remainder 
possess a function dependent upon the selected algorithm. 

 Automation: This selects the controller's parameter for the automation 
(view page 286). 

 Effects algorithm: Click the arrow to select an effects algorithm. 

The available effects algorithms per unit are described in the following. 

 

Mono delay (tempo sync / millisec.) 

Simple, monophonic delay effect 

Parameters 

 Time:  Delay time controlled by musical measure (sync) or free running 
 Feedback:  Repetition 
 Damping:  High damping of the repetition 

 

Stereo delay (tempo sync / millisec.) 

Stereophonic repetition, adjustable separately per side 

Parameters 

 Left / Right: Delay times, synced or free running 
 Feedback: In contrast to mono delay, no repetition takes place in the middle 

position of the feedback controller. When turned to the left the type of delay is 
that of the so-called "ping-pong" variety, i.e. the signal is alternately sent so 
that is jumps from one channel to the other. When turned to the right the delay 
effect is "dual mono", in which case left and right sides act as two 
independent time-delay units. 
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Chorus 

Produces a typical "floating/shimmering sound" by modulated detuning of a 
signal  to "thicken up" its sound or spread it across the stereo field. Detuning 
is achieved by a short delay, the length of which can be varied by the 
modulation. This produces the so-called "Doppler" effect. 

Parameters 

 Time: Delay time in milliseconds. This can be understood as the "base" 
modulation which is stretched or compressed by the modulator. 

 Rate: Modulation speed 
 Depth: Modulation amplitude. Low values modulate only a little, higher values 

lead to a clear vibrato. 

 

Flanger 

Algorithmically similar to chorus, but different in that the delay time is 
significantly lower and delay works with repetitions (feedback). A flanger 
sounds more "cutting" and up-front than a chorus. 

Parameters 

 Rate: Modulation speed 
 Feedback: Delay feedback 
 Depth: Modulation amplitude 

 

Phaser 

A modulation effect just like chorus & flanger, but in this case no detuning 
takes placed. Filter components periodically alter the signal's "phase 
response" (principle of the "phase shifter"). Characteristic notches are 
produced in the frequency spectrum response to create so-called "comb filter 
effects". The phaser effect is suitable for pads and "psychedelic" sounds. 

Parameters 

 Rate: Modulation speed 
 Feedback: Feedback of filter steps 
 Depth: Modulation amplitude 

 

Room reverb / Hall reverb 

In the case of reverb there are two realistic simulations of natural reverberation. 
Sounds receive "atmosphere" and thereby appear lively and "authentic". Room 



 
 

 292 Tools and wizards  

www.magix.com

reverb simulates a small space with high echo density. Hall reverb mimics the 
typical reverb of large concert halls. 

Since natural spaces never sound "static" because air molecules are 
constantly moving and due to the complexity of reflection processes, both 
algorithms include a modulation parameter which varies the delay time of 
individual echoes and thereby affects the liveliness of the reverb impression 
depending on strength. 

Parameters 

 Decay: Reverberation length 
 Damp: Damping of highs, simulates absorbtion via air, wall materials, and 

objects 
 Mod: Modulation strength. 

 

Lo-fi 

This algorithm gives the sound a little bit of "grit", or a certain measure of 
signal destruction depending on its setting. An ideal partner for creative sound 
design. The simulation of early digital synthesizes or samplers is equally 
possible since their AD/DA converters were anything but "true" in the character 
of their sound. The sample rate from the output of the lo-fi effect can be 
continuously reduced and a generous measure of "aliasing" distortion can be 
produced alongside the unavoidable loss of highs which results from "down 
sampling". Bit resolution is clearly changeable, too. 

Parameters 

 Rate: Sample rate 
 Crush: Number of bits 
 Low-pass: Low-pass filter at the output to smooth out induced noise 

 

Distortion 

This overdrive effect works similarly to common guitarist effect pedals. 
Everything is possible, from light, bluesy signal saturation to hard "metal shred 
boards". Here a dual-band EQ works on the in and output signals and 
therefore provides a rich palette of sounds. 

Parameters 

 Drive: Controls the internal level and thereby the overdrive 
 Low: Bass portion. 
 High:High portion. 
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Analog filter 12/24db 

Vintage compressor 

Synthesis models 

The sound synthesis in BeatBox 2 consists of a simple sampler and a 
synthesizer which includes three different synthesis modules. 

Sampler 
The sampler plays short sound recordings ("samples") in different pitches. The 
sampler is intended for creating all kinds of drum sounds; the sounds are static 
and unnatural if the pitch is not altered. This is why the sampler is combined 
with on of the three synthesis models. 

Filtered noise 
White noise is filtered by two band-pass filters with separately setup 
frequencies and resonance. This algorithm is suitable for creating synthetic 
snares and high hat sounds. 

Phase distortion synth 
Two oscillators with regulated phase distortion and thoroughly variable 
frequency modulate each other (FM/cross-modulation/ring-modulation). 
Depending on the setting, this algorithm can be used to create kick, tom, or 
metallic percussion sounds; higher values for frequency and modulation level 
produce noisier sounds for high hats or shaker sounds. Since the oscillator 
frequency can be set exactly according to the musical pitch, this model can be 
used to produce mass lines or melodies. 

Physical modeling 
This is a simple physical model of an "abstract" percussion instrument. A 
fed-back network of delays is caused to oscillate by an impulse of filtered 
white noise (exciter). Depending on the setting of the exciter, the size of the 
model (surface), and the damping, a wide spectrum of natural sounding 
percussion instruments like cymbals, claves, gongs, or triangles can be 
created. 

Multimode filter/Envelope generator 
Following the samplers and synthesizers, an inverse filter (multi-mode filter) is 
added to add the last bit of polish to the drum sound. The envelope generator 
controls all time-dependent processes in the synthesizer and sampler.  

 

Drum & Bass machine 2.0 

The Drum & Bass machine is a dual synthesizer, uniting both distinct styles of 
drum’n’bass in one piece of equipment to produce fast beat crashes and 
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rumbling bass lines. With the Drum & Bass machine you need no special skills 
to create authentic sounds for your drum’n’bass songs. 

A tip: The typical speed for Drum’n’Bass is usually around 160-180 BPM. The 
Drum & Bass machine also fits in perfectly with other music styles, e.g. bigbeat 
(120 BPM) or trip hop (80-90 BPM). 

 

Setup 

 

The top half of the synthesizer controls the rhythm section, the bottom half 
controls the bass section. Between the two, on the left side you will see a 
symbol where both sections can be turned on and off individually. You can turn 
off the bass section, for example, so that you take only the drum section break 
beat into the arrangement. The Samplitude 11.5 Producer arrangement mix will 
then only include the drum section in the mix file. 

The volume control is on the right border, controlling the volume for both 
sections. The play and stop buttons allow you to listen to your drum’n’bass 
creations up front in Samplitude 11.5 Producer. 

The "Drum‘n’Bass" label covers a menu containing functions to load and save 
drum’n’bass patterns (Load machine state/Save machine state), and functions 
to delete or generate patterns (Clear all/Random all). The submenu "Velocity 
presets" contains some help functions for programming of the velocity row. 

 

The rhythm section (top half) 

You can easily create complex and authentic jungle break beat sounds. In a 
professional recording studio, jungle break beats are created by dividing any 
given drum loop into several small "bits" and putting them back together in a 
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different order. This lengthy process is significantly simplified by the Drum & 
Bass machine. You just have to design your own new play sequence.  

You set up the new sequence in the top ("steps") row. The blue cells indicate 
the individual sections ("notes") for the subdivision of the loop. 

A left mouse click on one of the blue cells allows you to select one of six 
possible symbols. Each symbol represents a different note or other way of 
playing the note. Every time you click on one of the blue cells, the next symbol 
is chosen. 

Rely on your own intuition and creativity when programming your beats. It is 
not absolutely necessary to know the exact meaning of each individual symbol 
in order to create cool and authentic beats. 

Summary symbol description: 

1: Play drum loop from beginning 

2: Play drum loop from the second note 

3: Play drum loop from the third note 

4: Play drum loop from the fourth note 

Backward symbol: Play backwards from this point 

Stop symbol: Stops play 

The right mouse button allows you to delete the step cells individually. The 
"Clear" button on the right deletes all step cells; the drum loop is played in its 
original sequence. The "Random rhythm" button generates a random 
sequence. You can then alter the rhythm as you wish. 

By clicking on the blue field in the bottom part of the rhythm section you open 
a pop-up menu where you can select the drum loop sound. If you select a 
different drum loop, it will be loaded and played as programmed by you. 

In the "Flame" row you can set the note to be played twice quickly in 
succession instead of only once, allowing you to program rolls and fill-ins. 

The "Velocity" row allows you to set intensity values between 0 and 16 with the 
mouse (left mouse click increases value, right mouse click decreases value). 
Use the three buttons under the "Velocity" row to determine how these values 
will affect the sound of your loop. If you select "Volume", the velocity value 
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alters the volume for this cell (16 = loud, 0 = quiet). If you select "Filter", the 
velocity value alters the filter strength for this cell (16 = sharp, 0 = muffled). The 
"None" button blocks use of the velocity values. 

 

The bass section (bottom half) 

The bass section allows you to create the right bass lines for your rhythm 
quickly. As in the rhythm row, there are two-step rows.  

 With the first "Notes" row, you determine the sequence of the notes, i.e. the 
sound sequence.  

 By clicking on a cell with the left mouse button, you open a pop-up window, 
where you can select the notes.  

 By clicking with the right mouse button, you delete a cell.  
 If you click on an empty cell with the right mouse button, you will see a "Stop" 

symbol. This function is similar to that in the rhythm section, i.e. it stops the 
bass sound at this point. 

 In the "Octave" row you can determine the bass octave sound. Octave 1 
creates a deep tone, Octave 3 a high tone. You can only set the octave values 
if there is a note in the row above. 

 As in the rhythm section, there are also buttons for "Clear", "Random notes", 
and a red selection field at the top border of the bass section. The red 
selection field allows you to set the bass sound. 

 Underneath the step rows, you will also find two sliding controls for sound 
adjustment. You can use the "Vibrato" control to make the bass tone "swing" 
at its pitch. If the control is pushed all the way to the right, the swing will be 
stronger; all the way to the left will have no effect on the pitch. 

 With the "Delay" controller you can set a time for the sound to completely fade 
out. All the way to the right makes the sound fade out quickly (after approx. ¼ 
second); all the way to the left means ongoing sound. 

 

LiViD - Little Virtual Drummer 

MAGIX LiViD helps you to turn your ideas into songs. Enter a few basic details 
and LiViD will play a full drum track, complete with intro, verses, choruses, fills, 
bridges etc.; the entire song structure is laid out for your convenience. Brilliant 
stereo drum samples recorded by professional studio musicians and a freely 
adjustable “Humanize“ function will  create an authentic drum feel with perfect 
sound quality. 

LiViD features four styles (pop, rock, funk, latin), each of which is subdivided 
into four further substyles, as well as six song sections for each substyle (intro, 
verse, bridge, chorus, outro, fill-in). 
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Scramble: A random sequence of four one-bar patterns is generated internally 
for each style/substyle/song section. “Scramble” generates a new pattern 
order. 

Shuffle: Shifts the second and fourth 16th note of a beat back by a freely 
definable amount (100% = triplet rhythm). 

Humanize: Randomly shifts all events backwards or forwards, or leaves them 
unaffected. Note: these shifts are very subtle and not always immediately 
perceptible! 

Snare: Sets the snare stick style to “normal”, “side stick” (stick hits the rim 
while resting on the skin) or “rim shot” (sticks hits the rim and skin 
simultaneously). Exception: the snare’s quietest velocity level ( the "ghost 
notes") is always “normal”. 

Hi-hat: Sets the hi-hat sound to “soft” (fully closed) or to “hard” (half-open). 
Exception: completely opened hi-hat (pop, type1, verse). 

Ride: Sets the ride cymbal sound to “ride” (cymbal is hit on the rim) or “ride 
bell” (cymbal is hit on the bell at the center). 

 

Robota 

The Robota is a four-part drum computer with virtual analog and 
sample-based sound production. Virtual analog sound production means that 
the sounds are synthesized in real-time, i.e. produced with a synthesizer to 
recreate the typical analog sounds of classical drum computers, such as the 
Roland Tr-808 and Tr-909, or more recent devices such as the Korg Electribe 
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or the Jomox x-cousin. Sample sound production uses drum sound recordings 
(or even other recordings) as the basis for sound production.  

After selecting the elementary sound production technique, the sounds of each 
of the 4 parts (or instruments) can be edited using modulators.  

The step sequencer programmed with incident lighting helps Robota to play. 4 
beats in sixteenths (or 2 beats in thirty-seconds) are processed as a loop. At 
each beat position, the playing positions can be set by clicking a button. In 
"Event" mode, the instruments are distributed within the beat pattern. In 
"Snapshot" mode you can adjust additional instrument sound settings.  

 

Sound synthesis 

The four instruments of the Robota are built identically. Each instrument can 
create all kinds of drum sounds –  from hissing hi-hats to phat bass drums.  

During elementary sound production, you can choose between an oscillator 
with selectable wave shapes (sine, triangle or saw tooth) or a sample. In 
addition, you can add a noise generator can be added. The oscillator has a 
pitch envelope (pitch env.) and a volume envelope (attack/decay). It can also 
be frequency and ring-modulated. The depth of the modulation can be 
controlled via an envelope parameter (Fm/rng dcy). There’s also a “Lo-fi” 
section consisting of distortion (Rectify), bit rate reduction (Crush) and 
sampling rate reduction (down sample). 

Temporal control via an envelope (lofi dcy) will get the best out of the lo-fi 
effects. A multi-mode filter (low-pass/band-pass filter/high-pass) with 12/24 dB 
steep-side. A comb filter can be inserted. The filter frequency can be likewise 
modulated via an envelope. For extra pressure, an adjustable compressor 
(compressor, comp resp) is included, as well as tube amplifier simulation 
(tube).  
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Parameter (1) To simplify matters, not all 
parameters can be changed on a sound - only 
those that are meaningful for the selected drum 
sound may be changed (snare, kick, high etc.). 
There are four selected variable parameters 
coordinated exactly with the selected preset sound. 
Oscillator waveform (2): The fundamental 
waveform of the Oscillators is selected here. You 
can choose from  sinus/triangle/sawtooth/sample. 
If you have selected "Smpl" you can use the rotary 
knob to select a sample, i.e. a previously recorded 
drum sound. These samples are saved in the folder 
/synth/robota/samples/. If select custom samples, 
they will appear in the selection list. 
(3):For each part you can regulate: Filter Cutoff, 
Resonance, Tube, Volume and Panorama (view 
page 300). 

 

 With select choose the instrument for editing in the step 
sequencer.  

 “M” mutes the instrument, “S” makes it solo   

 The loudspeaker button allows you to hear a preview. 

Master Section 
Volume regulates the total volume of the Robota. Distortion adds an 
adjustable tube distortion to make the sound “dirtier” and more powerful. The 
peak meter helps control the output level – when it enters the red area, reduce 
the total volume.  
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Schematic illustration of the Robota synthesis 

 

Here is a detailed circuit diagram of a Robota voice with a description of all 
control parameters.  

Pitch envelope (pitch env) 
Controls the pitch envelope level. 
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Tune 
Tunes the instrument. 

Oscillator shape (osc shape) 
The shaper adds additional frequency shares to the basic sound of the 
oscillator by artificially reshaping the wave shape. A sine wave (shape = 0) can 
be reshaped up to a square curve (shape = max). 

Oscillator waveform 
The fundamental waveform of the oscillators is selected here. You can choose 
from sine/triangle/sawtooth/sample. If "Sample" is selected, you can use the 
controller to select a sample, i.e. a previously recorded drum sound. These 
samples are saved in the folder /Synth/robota/samples/. If you select custom 
samples, they will appear in the selection list. If you are playing your own 
samples, they will appear in the selection list. 

Noise 
Adjust the ratio between the oscillator sound and the noise generator. 

Attack 
Adjusts the attack time. The greater the set value, the softer the attack of the 
sound. The attack rate is also applied to the lo-fi and filter envelope curves. 

Decay 
Adjusts the decay curve. The greater the value, the slower the instrument will 
decay. 

FM/Ring modulation frequency (Fm/rng frq) 
The fundamental frequency of the frequency or ring modulation.  

FM level (fm lvl) 
At a low frequency FM first adds vibration to the sound, at high frequencies 
and low levels it creates bell-like sounds, as the level increases metal sounds, 
and finally noise. 

Ring modulation level (rng lvl) 
Ring modulation creates typical auxiliary frequencies. 

FM/Ring modulation decay (Fm/rng dcy) 
Time constant of  FM/ring modulation by-product. Only the beginning of the 
drum sound is affected by the modulation.  

Rectify 
Distorts the audio signal. 
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Crush 
Bit rate reduction. Digital artifacts become audible with higher settings.   

Down sample (dwnsmple) 
Sample rate reduction. Ideal for creating the "old school sound" of older digital 
drum machines. As it is increased, the result becomes darker. 

Lo-fi decay (lofi dcy) 
Time constant of the by-product of the three lo-fi effects which makes the 
sound "dirty". Only the beginning of the drum sound of the lo-fi effects is 
affected if the decay is low. For instance, this makes the kick of a kick drum 
sound more interesting. 

Filter modes (flt mode)  
Filter mode: High cut – sound portions above the cut-off frequency are filtered 
out. Band pass (BP) – Sound portions above and below the cut-off frequency 
are filtered out. Low cut - All sound portions below the cut-off frequency are 
filtered out. This mode is set as a preset and can not be changed. 

Filter frequency (flt freq) 
The cut-off frequency of the filter. 

Filter resonance (flt reso) 
Filter resonance which increases the sound portions at the cut-off frequency of 
the filter. If the resonance is high, the filter itself can also be used as an 
oscillator. 

Filter modulation -/+ (flt mod -+) 

Regulates how much and in which direction the filter envelope curve moves the 
filter frequency in which direction. 

Filter-Modulation decay (flt mod dcy) 
Decay time of the filter curve. Smaller values with high resonance create a 
"zapping" sound of the filter, greater values create the typical sweep sound. 

Filter modulation velocity (flt mod vel) 
Specifies how much the filter modulation depth depends on the velocity. If this 
value is increased, louder beats will generate higher filter curves than quieter 
ones. 

24 dB 
The filter can operate with a slope of 12 dB or 24 dB. This mode is set as a 
preset and cannot be changed. 
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Comb filter (comb filt on) 
You can activate a comb filter, a feedback delay that creates resonance-like 
sounds comparable to a plucked string. The delay time and feedback levels 
are permanently linked fo the filter parameters (frequency and resonance). This 
comb filter is set as a preset and can not be changed. 

Compressor 
Controls the compressor strength. This lets you increase the "power" of the 
drum sound. 

Compressor response (comp resp) 
Controls the compressor time. The lower the value, the faster the compressor 
follows the volume. 

Tube 
Controls the level of the tube amp simulation. It "saturates" the output signal of 
the voice and adds warmth to the sound if the settings are moderate. 
Increasing the settings makes the sound "dirtier". 

Volume/Pan 
Controls the volume and panorama position of the drum instruments. 

 

Sequencer 

  

Incident lighting is used to control the drum patterns just like in all classical 
drum computers and groove boxes. The step sequencer consists of 16 
individual step buttons with LEDs corresponding to the appropriate partitioning 
of a beat:  

16ths or 32nds (a half beat is in each case displayed). A button lights up to 
indicate the releasing of the instrument at this point in the beat (= step).  

A left click turns on the step, a further left click deletes the step again.  

 

A pattern can be a maximum of 4 beats long. The length can 
be modified using the fader on the button bar. 
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The beat to be edited can be selected with the applicable “edit” button. The 
“Follow” button specifies whether the step of a beat is in time. 

"1 > 2-4" auto draw: If more than 1 beat is activated as the loop length, the 
"Auto draw" mode ensures that the drum note set in the first beat is set 
automatically for the following beats. This makes it very simple to produce a 
continuous beat from a loop length of 4 beats. Notes set in the rear beats are 
not affected by auto draw.  

How to program a drum pattern: 

 Select the pattern length with the fader. 
 

 Select “Event” mode. 

 

 If you edit during playback, turn off “Follow”. Select the beat with the “Edit” 
buttons.  

 
 

   Use “Select” to choose an instrument to edit.  

  Use the “Clear bar” button to delete all steps in the 
selected instrument. 

 

 

 Turn on the appropriate step buttons, and use the 
“Velocity” controller to adjust the beat velocity.  

 

 Repeat the procedure with the other instruments  

Snapshots 

In addition, you can automate programming of the editable sound parameter of 
a drum sound via so-called "snapshots". You can thereby save the sound 
parameters of a drum instrument on the step buttons of the sequencers. 

Automating the drum instrument with snapshots.: 

 

 Set the edit mode to “Snap”.  
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 If you edit during playback, turn off “Follow”. Select the beat with the “Edit” 
buttons.  

 Select an instrument and edit the sound. You can control the sound of an 
instrument even when playback has stopped by using the loudspeaker button. 

 Save the sound as a snapshot to one of the step buttons. 
 Change the sound of an instrument and save the settings to other step button 

Warning: The parameters are not changed abruptly but are faded internally 
instead, in order to avoid crackling. If two snapshots with extreme parameter 
differences are too close together, the drum sounds will sound differently when 
the pattern is played. 

 

 Using the arrow keys, you can jump between the individual 
snapshots during stopped playback.   

 Press “on” to activate snapshot automation.  

Groove Control 
The secret behind “groove” beats lies in delay. That is, individual beats are 
either anticipated or delayed according to patterns. For example house beats 
use the “shuffle” whereby straight 1/16s are delayed at certain times. 

 

In the Robota there are groove velocity and groove swing presets. Groove 
velocity presets contain for each step of a beat a certain offset to increase or 
reduce the original beat velocity. Groove swing presets contain for each step a 
time alignment that is either anticipated or delayed. The result is a 
livelier-sounding sequence. The strength of the effect can be adjusted with the 
% regulator.   

 

Setups, drum kits, presets, and patterns 

  

A single instrument sound is saved 
as a preset.   

 

Presets containing all four 
instruments are saved as drum kits.  
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All note information plus the 
snapshots are saved as a pattern.  

 

Together (drum kit + pattern) they are 
know as a setup.  

Load/Save 

Presets, drum kits, patterns and setups can be selected with the continuous 
rotary regulators next to the display area. For storing, click on the  “Save” 
button. Then specify a new name in the input field. To store, press “Enter”.  

Note: A drum kit stores only the names of the presets, not the actual 
parameters. If you want to store your own drum sounds that were created by 
changing existing presets, you must first store them as new presets and then 
as a new drum kit! The same applies to the setups, which contain only the 
pattern and drum kit names. 

If necessary, always store in this order: preset -> drum kit -> pattern -> 
setup. This applies only when creating your own “templates”. If you store your 
arrangement normally, the complete current status (synthesizer + sequencer) 
of the Robota is always stored and correctly loaded later with the arrangement. 

 

Vita 

The MAGIX Vita synthesizer specializes in playback of "real" instruments using 
sampling technology. This means that short samples of real instruments in 
different pitches, playing techniques and volumes are used, combined, and 
played again at the correct pitch. 

The VITA synthesizer is controlled via the MIDI objects. If you load Vita via the 
Media Pool, a preset MIDI object will appear first. You can then load different 
Vita sounds via the "Output" menu at the top of the MIDI editor. 

You can adjust Vita's sounds via the instrument menu of the 
trackbox. 
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The Vita interface 

 

1. Layer selection/Peak meter: The Vita sounds, also known as layers, can be 
selected here using the arrows. Right clicking on the display opens the layer 
menu. 

2. Main parameter: Sets the volume, panorama position, pitch characteristics 
("transpose") and the fundamental frequency ("master tune"). 

3. Amp: This is the volume envelope. Here you can influence the temporal 
progression of a track's volume. A(ttack) stands for the volume increase at the 
start, D(ecay) for the length of time the decrease in volume takes on a section 
set with S(ustain) at the maximum volume. R(elease) is the length of time it 
takes for the sound to ring out. 
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4. Filter: Switches on a filter which influences the sound. "Filter type" allows 
you to select a filter type. "Cut-off" regulates the filter frequency, "Resonance" 
controls the strength of the amplification of the filter frequency. "Velocity" 
specifies how strongly beat should influence the filter frequency, and the 
volume can be balanced using the "Gain" controller. The filter envelope (ADSR 
slider) influences the filter frequency depending on the time. 

5. Delay: Switches on an echo effect, "Time" controls the delay time, "Level" 
controls the strength of the echo sound. 

6. Reverb: Switches on a reverb effect, "Time" controls the delay time, "Level" 
controls the strength of the echo sound. 

7. Value display: The value display shows the exact value of the parameter 
which was just modified. 

8. Dynamic range: Usually, the relationship between the created volume and 
MIDI velocity is proportional. Since some MIDI keyboards produce a velocity 
which is too hard for loud sounds or the other way around, this behavior can 
be balanced out with the "MIDI input curve". The dynamics of the sound can 
be influenced with "dynamic" and "dynamic curve", i.e. the relationship 
between the quietest and loudest sounds. 

9. Voices: Here you can control the amount of voices played simultaneously. If 
notes are no longer played during fast passages, you can increase the amount 
of voices here (performance will not be as good). 

10. Keyboard: Here you can preview the Vita sounds. This only works during 
playback or recording. 

 

Revolta 2 

Revolta 2 is a further development of Revolta. It is polyphonic and playable 
with up to 12 tones, including an additional noise generator, a step sequencer, 
and an extra-flexible modulations matrix. An effects section with 9 different 
effects and presets (created by a professional designer) make it a full-fledged 
synthesizer for all kinds of lead, sequence, and pad sounds. 

REVOLTA 2 has a whole array of presets. The sounds have been created by 
professional sound engineers and demonstrate the huge potential of this 
instrument from the word start. First off, however, we would like to encourage 
you to try out the various control functions and to experiment as much as you 
like. The sky's the limit to your creativity. 
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Revolta 2 interface 

Note: The following is only a short description of the Revolta 2 interface. 

 

 

For a comprehensive documentation of this complex synthesizer please 
click the help button on the Revolta 2 interface!   

The Revolta 2 interface can be displayed in two sizes. In "Rack" mode only the 
elements necessary for preset loading are visible: 

 

 
By clicking the edit button you can open the complete 
interface. 

 

1. Main parameter: Sets the volume, panorama position, pitch characteristics 
("Transpose"), and play modes ("Poly", "Mono", "Legato"). "Glide" regulates the 
portamento time. 

2. Oscillator section: Two oscillators are available with smoothly adjustable 
curve forms and a noise generator. Both oscillators can be tuned to each other 
and used to modulate frequencies. 
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3. Amp: This is the volume envelope. Here you can influence the temporal 
progression of a track's volume. A(ttack) stands for the volume increase at the 
start, D(ecay) for the length of time the decrease in volume takes on a section 
set with S(ustain) at the maximum volume. R(elease) is the length of time it 
takes for the sound to ring out. "Vel" specifies how much the envelope curve 
depends on the velocity. 

4. Filter: Here you can switch on different filters to influence the sound. "Filter 
type" selects a filter type. "Cut-off" regulates the filter frequency, "Resonance" 
controls the strength of the amplification of the filter frequency. VEL" indicates 
how much the velocity influences filter frequency, and "Key" changes the filter 
frequency depending on the note pitch ("Key tracking"). The filter envelope 
(ADSR slider) influences the filter frequency depending on the time. "Env mod" 
controls the strength of the filter envelope curve, and with "drive" the filter can 
be overmodulated. 

5. FX1/FX2: Here you can mix in 2 different effects out of a total of 9 available 
effects. 

6. LFO1/LFO2/Step sequencer: Two LFOS and the step sequencer can be 
used to modulate single parameters of Revolta 2. 

7. Options and modulations matrix: The two buttons open the Revolta options 
page for general and preset-specific settings and modulation matrix. In the 
modulation matrix modulation sources are connected with modulation targets. 
Simple modulations like the oscillator (the pitch will be modulated via an LFO) 
can be set quicker directly on the interface. Much more complex modulations 
are possible in the matrix because the matrix offers more modulation sources 
(e.g. MIDI controller, oscillators) and the modulation source can influence more 
targets.   

8. Value display: The value display shows the exact value of the parameter 
which was just modified. In addition, you can find out the load of the twelve 
voices. 

9. Preset section: Here you can select Revolta presets. Every sound can be 
listened to, and an A-B comparison between two sounds is also possible (for 
example, an edited and an unedited sound). 
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Timestretch patcher 

This tool enables wave files used in Samplitude 11.5 Producer and other 
MAGIX programs (e.g. MAGIX Music Maker) to be patched.  

Additional information and settings are written into the wave project to make 
them easier to find, thus ensuring better timestretching and pitchshifting 
results.  

The following can be patched: 

 Algorithms for timestretching/ pitchshifting 
 BPMs 
 Beat markers 

 

Overview 

Algorithms for timestretching / pitchshifting 

Different algorithms (besides the standard algorithm) can be used for real-time 
timestretching and/or pitchshifting for better results. Check 
resampling/timestretching/pitchshifting for more details. With the patcher you 
can store the optimal timestretching algorithm in the wave project. This 
ensures that the "correct" algorithm is used automatically when 
timestretching/pitchshifting is used on these projects as object effects (e.g. 
with the timestretch mouse mode).  

 

Beat markers 

Beat markers are also saved in the wave project when using beat 
marker-based algorithms. 

In contrast to the timestretching dialog, the patcher is non-modal, meaning 
that if the patcher is open, you can move beat markers in a wave project while 
checking out the timestretching result. 

 

BPM value 

Patches the BPM value (beats per minute). This is useful for when the 
timestretching factor must be determined later in order to adapt the wave 
project to the tempo of an existing arrangement. 

 

Patches in brief 

Patches only work if you have opened the wave project in destructive wave 
editing mode and if it is not open in a VIP simultaneously. 
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On the right of the dialog (patch) you can select the algorithm to be used and 
specify the wave file tempo. On the left side (test) is the control element from 
the timestretching/pitchshifting dialog. 

It allows you to test the selected algorithm in connection with the "Play/Stop" 
and "Play original" buttons. Patch saves the information in the wave file.  

 

Make CD 

Use this dialog to start the CD burn dialog. Samplitude 11.5 Producer contains 
high-quality and constantly updated CD burn routines which are licensed from 
"Point Software & Systems". 

Before the CD burning process starts, Samplitude 11.5 Producer creates a 
so-called TOC file (Table of Contents) with the name of the current VIP and the 
extension TCX. This file is saved with the same path as the VIP itself. For this 
reason, it's necessary for the VIP to be saved to the hard disk at least once 
before the CD is created. 

The "Make CD" dialog in detail: 

 
 



 
 

Tools and wizards 313  

 

www.magix.com

Burn “on the fly” 

Use this extremely powerful mode if you want to create the CD directly from 
within the VIP. All necessary calculations are performed in real time during the 
burning process. The following real-time tasks are calculated during the 
process: 

 Volume and panorama settings 
 Fades and crossfades 
 Mixing of tracks 
 Mixer track effects 
 Mixer master section effects 

To get a good idea whether your system is able to sustain the real-time 
processing needed for this functionality, try this: 

Play back the VIP sections that contain the largest number of tracks and/or 
where the most real-time effects are used. Watch the DSP meter (bottom 
left-hand). Below are the expected performances at the different DSP values: 

 Below 25%: CD creation with up to 4x mode 
 Below 50%: CD creation with up to 2x mode 
 Below 90%: CD creation with up to 1x mode 
 Above 90%: Real-time creation is not possible, use the second mode 

(Bouncing) 

 

Generate a complete new file 

Use this option if your system is not fast enough to sustain the real-time 
creation of the CD (see above). This mode calculates all wave files, including 
fades, crossfades, and volume automation into a new audio file. Any other 
real-time processing is also part of the newly created audio file. Make sure that 
you have sufficient hard disk space prior to starting the process (approx. 700 
MB for a complete CD). 

The original wave files used in the VIP remain unchanged. This makes this 
procedure non-destructive! 

 

Print TOC 

This starts the external TOC printer application. This convenient tool allows you 
to print the contents information of the current CD. You may choose between 
a text style format to print the production documentation and a formatted 
printout for the CD jewel case. Please refer to the online help for the TOC 
printer for more specific information! 
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Show TOC 

This button opens a text window which shows the contents of the current 
TOC. The “Copy” function can be used to copy the contents to the Windows 
clipboard for use with other text editing applications. 
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File menu 

The File menu contains broad functions for generating, managing, loading, and 
saving projects. 

 

New Virtual Project (VIP) 

 

A new virtual project is created and presented in a new window on the screen.  

New project 

Arranger view: Samplitude 11.5 Producer opens a new virtual project in the 
normal arranger view. 

Multi-track recorder (MR-64): This opens the MR-64 for quick and easy 
recording. Please also read the chapter "Recording with the multi-track 
recorder". 

Open project: Opens a dialog for accessing virtual projects. 

Most recently opened projects: This is a list of the virtual projects that were 
recently opened; click a project to open it. 
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Project settings 

Left clicking opens a dialog to view more options. 

Project name: The name of the new VIP should be entered here. A subfolder 
with the name of the project is added automatically in the standard folder 
selected via the "file path". 

Target path: Select the folder where you want to save your project here. 

Project template: You can choose between previously saved project templates 
in this list field. They include all project settings such as track number, device 
assignment, etc. You can create new project templates with the command 
"File -> Save project as template". 

Sample rate: Presets the sample rate of the virtual project. 

Note: Regardless of the project sample rate, you can load objects with 
different sample rates, audio formats, and codings. 

Track number: The track number of the virtual project is defined here. With the 
"Track > Insert new tracks...", commands you can add tracks afterwards at 
any time. 

A right mouse click opens the dialog with the project options. All settings (e.g. 
to the grid, BPM, CD arrange mode, autosave, etc.) made here apply to every 
new VIP you create! They will be saved in a separate VIP 
(Templates\Template.VIP). This file, template.vip, can also be edited directly, 
and you can also use the following additional settings as a default for each 
project: 

 Record arming setting of the first track 
 Some mixer setup settings 
 Playback mode 
 Track and master effects settings (e.g. compressor mode, effects sequence) 
 Grid offsets. These can be very important for linking to the timecode. 

Samplitude 11.5 Producer projects can include a timecode range of 12h. 

Don't show this window again: If this option is active, Samplitude 11.5 
Producer will create a new project with the standard settings. This may be 
reset via program settings. 

Keyboard shortcut:  E 
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Open 

You can open various file types and load them into Samplitude 11.5 Producer. 

Key:  "L" (RAM wave projects) 
Key:  "Shift + L" (HD wave projects) 
Key:  "O" (Virtual projects) 
Key:  "W" (wave files) 
Key:  "ALT + S" (Sessions) 

 

Virtual project 

Virtual projects are multitrack projects in Samplitude 11.5 Producer which 
make use of wave projects. When loading a virtual project, all associated wave 
projects (RAM and HD wave projects) are opened if they were not open prior 
to loading the VIP. The windows of the individual wave projects remain 
minimized to prevent cluttering of the screen. They are initially only visible as 
icons. 

Once the wave projects are loaded, the VIP project window is displayed. 

 

RAM wave project 

RAM wave projects contain audio data in Samplitude 11.5 Producer’s 
proprietary format. These files are loaded into the RAM memory of your 
computer, including their associated graphic files, marker position information, 
etc. 

 

HD wave project 

HD wave projects contain audio data which is directly loaded from the hard 
disk together with the graphical information, marker position information, etc. 
The audio format used for these files is the wave format. 

 

Object 

Contains playback instructions (link to a wave project, track, time position, 
parameters, etc.) for audio data. Objects are used in virtual projects. 

 

Session 

A previously saved Samplitude 11.5 Producer session can be loaded with this 
command. All projects and their related windows are arranged on the screen 
the way they were saved to the session. 
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Load / Import 

Load audio file 

Opens a dialog for loading audio files. Several files can be loaded 
simultaneously. Just like with Windows Explorer, you can extend your selection 
with "Ctrl" + click and select a series of files with "Shift + click". 

Note: Due to peculiarities of the Windows Explorer, the line in the file selection 
dialog is created from back to front. Therefore, if you click, for example, Track 
1, Track 2, Track 3 (with Ctrl) one after the other, you will see "Track 3", "Track 
2" and "Track 1" in the input line and they will also be loaded in this sequence. 
Therefore, if you want to load several individual titles, you should select them in 
the opposite order of how you want them to be arranged later in the project. If 
you want to select multiple files in Explorer (via "Shift + click"), you should 
proceed as follows: First, mark the last track of the list, then press "Shift" and 
mark the first track of the list. If you click "Open", all tracks are in the correct 
order in the VIP. 

If a VIP is opened, new objects are created simultaneously on the selected 
track in the VIP which refer to loaded audio files. If no area has been selected 
in the VIP, the files are positioned after the last object with a pause of 2 
seconds, otherwise to the start of the range. The pause can be changed in the 
CD/DVD menu under "Automatic pause settings".  

Each audio file can be previewed before it is loaded. 

Attention: The preview function uses the standard output device of the 
Windows multimedia system (as well as the system sounds). Many audio cards 
mute the standard Windows MME sound system when the ASIO driver is in 
use; in this case, an error message will be issued for the preview function. For 
this reason, the preview function is by default deactivated during ASIO driver 
use. However, it can be re-activated (options for loading audio files if you 
select another audio device for your PC's multimedia functions, e.g. the 
onboard sound available on all modern computers). 

Options 

(the button at the very bottom right of the dialog opens the options) 

Always deactivate preview: Always deactivates the file preview. 
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Deactivate preview during use of ASIO: To prevent driver problems the 
preview function is deactivated when using ASIO. 

Tip: Files can be found, organized, previewed, and loaded much easier using 
the File Manager (view page 263). 

 

Loading options 

If you load a file, a dialog will open first. 

Copy file(s) into the project folder: This copies the file into the folder where the 
project is located. This is useful for loading items from storage devices like 
external hard drives, memory cards, or CDs/DVDs, since these storage devices 
always need to be inserted/connected without this option. 
Activation of this option is also useful if offline effects (view page 411) are 
applied. 
Activate this option to edit wave files on CD-ROMs directly. 

Convert other file formats into wave: Decoding compressed audio formats 
requires significantly more computer power than playing simple wave files. 
Thus, this option is advantageous if computer power is being used for 
real-time effects or for playing multiple tracks at the same time. 

 

Load MIDI file 

Load MIDI files via this item. In comparison to the "Load audio file" option, only 
MIDI files are displayed.  

Tip: Files can be searched for, organized, previewed, and loaded much easier 
using the File Manager (view page 263). 

 

Load audio CD track(s) 

This option is also located in the “CD” menu. 

This function allows you to import audio data from most CD-ROM drives and 
CD burners without any quality loss. Please contact our technical support for 
the latest list of supported drives if you require it. 

The HD wave projects are recorded as wave files and can therefore be edited 
with other audio editing programs without having to convert them first. 

To do this, please follow these steps: 
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1. Open the drive list dialog and select the CD-ROM drive you desire if you 
have more than one drive 

2. Click on the “Track list” button 
3. Select one or more tracks in the CD track list dialog list box 
4. Click on “Copy selected track(s)...” 
5. Select a file name for the new wave file or HD wave project and click "OK". 
6. Now the audio data is copied from the CD-ROM to your hard disk as a new 

wave file. 
7. Close the track list and drive list dialogs; one or more new objects appear in 

your VIP which contain the audio data from your CD. 

 

Features of the track list dialog 

Copy selected track(s): This button starts the audio data copy process; all 
selected tracks from the list are copied into one wave file. 

Play: Starts audio playback of the first selected track in the list. 

Stop: Stops audio playback. 

Pause: Stops audio playback (to be resumed later). 

Resume: Resumes playback (if previously paused). 

Select all tracks: Selects all tracks of the CD for copying the complete volume. 
You can select multiple tracks with "Ctrl + mouse click" or with "Shift/Alt + 
cursor". 

Unselect tracks: Closes the drive door of the CD-ROM drive 

 

Features of the drive list dialog 

Track list: This button opens the track list dialog for selecting several audio 
tracks on a CD. 

Configuration: This button opens the drive configuration dialog to select 
special copy modes and SCSI IDs. 

Reset: Restores the standard drive settings. 

Add drive: Creates a new drive entry in the list for editing configuration data. 

Delete: Deletes the selected drive entry from the drive list. 

Save setup: Saves the drive list and all configuration data in a *.cfg file. 



 
 

File menu 321  

 

www.magix.com

Load setup: Loads the drive list and all configuration data from a *.cfg file. 

 

Features of the CD-ROM drive configuration dialog 

Drive name: Edits the name of the drive in the list. This is useful if you create 
more than one entry which access the same physical drive. 

Host adapter number: Specifies the number of your SCSI adapter (normally 0). 

SCSI-ID: Sets your CD-ROM drive's ID. Make sure you set the correct ID, 
there is no error checking! 

SCSI-LUN: Selects the SCSI LUN parameter (normally 0). 

Alias: Selects your CD ROM drive's manufacturer. 

Normal copy mode: Copies the audio data without any software correction. 

Sector synchronization copy mode: Copies the audio data using a software 
correction algorithm. Some CD-ROM drives cannot seek exactly to the same 
position between two read accesses, but Samplitude 11.5 Producer can 
correct these differences using this algorithm. 

Burst copy mode: Optimizes the copy process speed (no software correction). 

Sectors per read: Defines the number of audio sectors per read cycle; the 
higher the number, the faster the copy process will be. Not all SCSI adapters 
support more than 27 sectors. 

Sync sectors: Defines the number of audio sectors used for sector 
synchronization. A higher number results in a better synchronization, but also 
in a slower copy process. 

 

Save project 

The current project is saved with the name displayed in the project window. If 
you previously have not specified a name for your project, Samplitude 11.5 
Producer will ask you to do so. 

Keys:  S 
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Save project as 

You can define the path and name of the new project you want to save your 
work as. RAM projects and virtual projects will be saved with the new names 
(the source file remains untouched). HD wave projects are renamed on the 
hard disk. Samplitude 11.5 Producer will not generate a copy of it for reasons 
of conserving space on your hard drive. 

Keys:  Shift + S 

 

Save project as template 

This option allows you to create project patterns where all project settings 
(number of tracks, etc.) are maintained and saved without the objects and 
HDPs. These patterns can be loaded when you are creating a new multitrack 
project ("File -> New multitrack project"). 

 

Save object 

Save your project. This file only contains real-time data (wave files, fades, 
names, etc.), and not the actual audio data. The wave project referenced by 
the object also has to be available if you want to reload the object. 

 

Save session 

Saves a complete Samplitude 11.5 Producer session. if a session is saved with 
the name „startup.sam“, then it will automatically be loaded by Samplitude 
11.5 Producer the next time the program is started. 

 

Export 

Here you can export VIPs, HD wave, or RAM wave projects in the formats 
WAV, MPEG (1:10), Dump, MS-Audio, AIFF with Quicktime, 16-bit AIFF and 
Real Audio or MP3. 

Note: The audio data from HD Wave projects can be further processed or 
imported directly as WAV files by other applications. The use of the "Export 
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sample" function is only necessary when the data is to be copied. The storage 
space required on the hard drive is increased; of course, copying also requires 
considerably more time. 

 

WAV 

Here you can export Wave files. 

Format settings: A dialog window featuring a list of all compression codecs 
appears here. Please select the desired codec and compression rate. If you 
click the "Dithering" button, the dithering settings dialog will open. Detailed 
information about this is available in "Program settings -> Dithering settings". 

 

MP3 

Exports the project as MPEG Layer 3 with the included encoder. By clicking on 
the format settings, a new window opens where encoder options can be 
defined. Set output format, encoder quality, padding mode, stereo coding, 
content options, VBR (variable bit rate) options, and MP3 ID editor labeling. 

 

Windows Media 

Exports the project in Window Media Format. 

This format is an optimized audio/video format for the Internet from 
Microsoft™. This format also enables streaming playback of audio files over 
the Internet. Select a profile for the Windows Media file in the "format settings" 
dialog. Enter the track and artist names, copyright details, and descriptions. 

 

FLAC 

FLAC is the abbreviation for "Free Lossless Audio Codec". This is a freely 
savable format that can be used to compress your audio data to 50% of their 
original size. Unlike lossy compression methods like MP3 or OGG, the full 
sound quality is kept intact with FLAC. 

 

OGG Vorbis 

Exports the project in OGG Vorbis format. 

The "Format settings" button opens an additional dialog to select the desired 
bit rate. The scale of compression ranges from 46 kBit/s to 500 kBit/s (for MP3 
from 32 kBit/s to 320 kBit/s). In the stereo options, choose between "Stereo" 
and "Mono" and also select the "Variable bit rate" mode. 
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AIFF 

The project will be exported in AIFF format. In the advanced dialog, select the 
bit resolution, stereo format, sample rate, and quality level of sample rate 
adjustments. 

 

AIFF with QuickTime 

Exports the project in AIFF format. In this case, QuickTime is used as the 
encoder. This format also enables streaming playback of audio and video files 
over the Internet. 

Like with Real Media exports, the corresponding video size, frame rate, and 
codec settings may be adjusted for "AIFF with QuickTime" export as well. This 
function requires the installation of QuickTime on your computer. 

The following export options are available: Format (linear PCM, A-Law 2:1, IMA 
4:1, MACE 3:1, MACE 6:1, QDesign Music 2, Quallcomm PureVoice™, µ-Law 
2:1), channels (mono, stereo, quadrophonic, 5.0, 5.1 ), sample rate, sampling 
rate conversion quality as well as linear PCM settings in 8, 16, 24, 32 and 
64-bit file format. 

 

Convert audio 

Stereo wave -> Mono 

A stereo wave project is copied and converted into a left mono wave project 
and a right mono wave project . 

 

2 mono -> Stereo / LR wave 

Two mono projects are linked to one L&R wave project. This is a convenient 
way of editing joined mono samples with the same operations. 

Here you can connect two mono wave projects to one L&R wave project. You 
can then perform common operations and apply them to all samples. 

After applying the command you will be prompted to activate the second mono 
wave project that you want to connect to the active mono wave project. To do 
this, click on the title bar of the corresponding window. Please note that only 
mono projects can be linked to mono wave projects of the same bit and 
sample rate. The lengths of both projects are adapted to each other. 

 

L&R wave > 2 mono 

L& R wave projects can be split into two independent mono projects using this 
function. This way you can break the fixed connection of the samples to one 
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another and edit them individually. If you wish to edit them together again, then 
select the "2 mono -> L&R wave" function. 

 

LR wave > 1 mono 

The current L&R wave project is converted into a mono mode. If it was a 
stereo project before, then both channels will be mixed. The previous samples 
are first added with 100% of their image and then divided by two to prevent 
overmodulation (distortion). This is equivalent to reducing the volume by 6 dB. 

 

1 mono > LR wave 

The original mono wave project is duplicated and converted into a single L&R 
wave project with the same sample in both channels.  

 

2 mono -> LR wave 

Here you can connect two mono wave projects to one L&R wave project. You 
can then perform common operations and apply them to all samples. 

After applying the command you will be prompted to activate the second mono 
wave project that you want to connect to the active mono wave project. To do 
this, click on the title bar of the corresponding window. Please note that only 
mono projects can be linked to mono wave projects of the same bit and 
sample rate. The lengths of both projects are adapted to each other. 

 

Save in format 

Use this function to convert wave projects between the various Samplitude 
11.5 Producer formats for wave projects. 

This can be useful if you want to convert RAM wave projects to HD wave 
projects, or L&R wave projects (2 connected mono samples) into stereo wave 
projects. 

 

Export video sound... 

After successfully editing the video sound in Sequoia, you can write the sound 
back into the video file. Here you can either replace the original sound of the 
video or create a new video file. 

Set the source file first under "Video source". 

Replace audio in the original AVI file: This option carries out trackbouncing on 
the current VIP. This creates a temporary WAV file which can then be 
integrated into the selected AVI file. It's necessary that the AVI contains an 
audio track of the same format (sample rate and bit resolution). 
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Save AVI file as: This option carries out trackbouncing on the current VIP. This 
creates a temporary WAV file which can be copied with the selected AVI file 
into a new AVI file. This process contains the original AVI file. 

Note: If the lengths of the audio and video files are different from one another, 
a warning dialog opens. After the export, the longer component is cut off – an 
attempt to automatically synchronize the data is not carried out. If you should 
receive such a warning, try to resample the soundtrack to the correct length. 

 

Trackbouncing (internal mixdown) 

This command can be applied to compile a project, a sought range or selected 
objects and tracks of a virtual multi-track project (VIP) into one audio file and 
save it under a new name. All real-time editing (cuts, crossfades, mixer settings 
including mixer effects and plug-ins, volume and panorama curves, real-time 
effects in the object editor, etc.) can be integrated into the new project. 

 

Normalize your project before bouncing using the master normalization 
function in the mixer ("N" button) in order to get a precisely calibrated file. All 
settings in this dialog can be saved as presets at any time. 

 

MIDI bouncing 

An additional dialog allows you to select whether or not to mix the entire 
project with all MIDI objects or just the selected MIDI objects within the current 
range into a single MIDI object. In this case, the MIDI track and object effects 
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like timestretching, track MIDI transpose, program change, etc. are bounced 
into the resulting MIDI object. 

Note: Don't confuse MIDI bouncing with the "MIDI object freeze (Object -> 
Object freeze)" function, which replaces the MIDI objects with audio objects in 
the software instrument's audio return signal. 

 

Range trackbouncing 

Use this function to convert the objects within the currently selected range to a 
new WAV file or a HD Wave project. The objects are then replaced in the 
Arranger. This is useful if you wish to combine multiple objects into a single 
object which can then be further edited easily. 

To create performance room, you can render object effects using the range 
trackbouncing feature. 

 

Rename project 

The “Rename project” command allows you to rename a project file rather than 
save it to a different file. For RAM wave projects, only the internal names are 
changed (without being saved), but all corresponding files are renamed 
immediately in the case of HD wave projects. 

RAM wave projects need to be saved after the project is renamed. 

 

Clean up 

Save complete VIP in 

This function in menu “Project” allows saving a VIP with all needed wave 
projects (*.RAP., *.HDP) into a specified directory. This makes it easy to copy 
all files of a VIP to a backup disk, etc. 

 

Delete virtual projects 

With the "Delete virtual projects" command you can comfortably delete VIPs 
and all wave projects used in the VIP. All files which belong to a multitrack 
project (the wave file containing the audio files, files with the graphics data, and 
the HDP file with the project information) will be lost. 



 
 

 328 File menu  

www.magix.com

Warning: There will be no further security query. The data will be deleted 
immediately after pressing "OK". 

 

Burn project backup on CD 

This option lets you easily create data CD backups of the whole project. For 
this purpose, the external CD burning software is started. 

 

Delete HD wave project 

HD wave projects are deleted from the hard disk. Use this command 
cautiously, since all corresponding files are lost. 

If you wanted to delete a HD wave project (HDP) from a file manager (e.g. 
Windows Explorer), then it would also be necessary to delete the graphic files 
related to the project files. 

 

Delete unused samples 

This function lets you edit all wave projects belonging to the current virtual 
project in such a way that all ranges that aren't used are deleted. It basically 
deals with the part of the audio data to which the objects in the Arranger do 
not refer and don't get played at any point. The objects in the virtual project 
are customized automatically so that nothing changes in the Arranger view. 

This function deletes physical data and does not have an "Undo" option. You 
should therefore use this command with care. 

If multiple virtual projects refer to the same wave files, all of these projects 
should be open as well. Only this way will you able to keep track and prevent 
data loss. 

With the "Remove unused samples" function you can save lots of storage 
space, but corrections to the objects' lengths are limited as all audio data 
outside the object borders are removed. For this reason, you can specify 
security reserves with "Rescue additional samples for each object". This 
number of samples are left in front and behind the object borders in the audio 
material. The default value is 22050 samples – this corresponds to 500ms at 
44100 kHz sample rate. 

The dialog lists all of the wave projects used in the virtual project. Here, you 
can see the total memory space used by the Wave projects in the "Size" 
column and beside it, and the free space in the "Unused" column. In the "Edit" 
column you'll find a checkbox for each file which can be used to add the files 
to the process. Only those files that contain unused sections of audio data are 
pre-selected. To keep these, remove the check. 
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Note: The list can also contain files not actually referenced by the VIP, but 
referenced by the VIP's undo chain. These files are 100% unused samples and 
will be deleted completely when checked. 

If you have discarded, for example, an entire recording session, you can delete 
the unused files as well. If, however, you had opened audio material from other 
sessions or your private sample library and didn't use them any more after 
that, you should uncheck these files so that they don't get deleted. 

We recommend that before using the function you should delete the "Undo" 
chain and close all unused wave projects. 

Tip: If the relevant audio files are required later on for additional production 
work, the following procedure is recommended for archiving the finished 
production: 

Save your entire project in a new folder ("File menu -> Save complete VIP 
in..."). In the save dialog, select the command "Copy only Samples used in 
VIP". Now only those audio files / samples that are actually required by your 
archiving project will be found in the few folder. You can now save the content 
of this folder to a backup medium (for example, CD-ROM or DVD). 

 

Delete freeze data 

Use this function to delete unused data that was created when freezing but is 
no longer needed after "unfreezing". 

 

Close project 

Closes the arrangement. 

 

Project properties 

Mixer setup 

Here you can open the mixer setup (view page 499) dialog. Use this to set the 
number of tracks, AUX buses and submix buses as well as the routing presets 
for the most frequent use cases. 
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Playback options 

The play parameters window which appears after selecting this menu option is 
designed to quickly enter playback parameters. 

 

Sample rate: The sample rate can be changed here as long as the sound card 
supports the new rate (some sound cards even support changing the rate 
while playing the sample). This is especially useful for hearing notes in a 
sample range played in a different octave. When selecting half the sample rate, 
the pitch should be the same. It would be played one octave lower. 

Device: Use this dialog box to specify the sound card's driver. This is 
necessary if playback takes place through a single sound card device, and is 
especially important if multiple output devices are located in the computer. 

Autoscroll: This you to activate the "Autoscroll" feature. This is especially 
useful when working with large disk files. The HD wave project window will 
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follow the play cursor during playback. When working in “2” or “3” section 
display mode, the autoscroll feature causes the individual sections to follow the 
play cursor as well. If you have zoomed into one of the sections, the play 
cursor will move through the section faster, resulting in more screen re-draws. 

You can choose between page and soft scrolling, but be careful: Scrolling 
requires CPU power (depending on the processor, graphics adaptor, and 
resolution), and the CPU may be overloaded in critical situations which may 
result in playback dropouts. Deactivate autoscroll mode if this happens. 

Scrubbing: If you "Insert" ("Insert", or "0" on the number pad), Samplitude 11.5 
Producer will switch to "Scrubbing" mode, and playback speed can be 
controlled directly by the mouse. The further to the right the mouse goes, the 
faster Samplitude 11.5 Producer plays. 

In comparison to many HD recording systems, this even works in a virtual 
multitrack project. 

Use scrubbing mode to find passages, crackling, etc. in material. The older 
generation of sound engineers are, no doubt, very familiar with this method 
from analog tape editing. 

There are two scrubbing modes ("P"): 

Relative: The relative distance between the play cursor (positions bar) and the 
mouse position can be used to control the speed. The play cursor follows the 
movement of the mouse. 

Absolute: You can also use the absolute position of the mouse in the window 
to control the speed: 

Left border = Double speed backwards 

Center = No movement 

Right border = Double speed forwards 

Tip for scrubbing: For buffer sizes (4000, 2000 samples) scrolling is "softer".  
Test if your computer functions at this buffer size without any playback errors. 

Combined with "Soft scroll", editing becomes very convenient on faster 
computers. 
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Project information 

A simple text editor can be used to enter comments for the current project. 
This text can be displayed every time the project is opened so that important 
information about project can be preserved together with the audio material. 

 

Project status 

This dialog displays various, project specific information such as name, path, 
the number of ranges as well as marker changes, and time of creation, number 
of objects count and file size. 

You will also find a list of all audio files used in the project. 

Keyboard shortcut:  Alt + I 

 

CD arrange mode 

If you activate this menu feature, Samplitude 11.5 Producer will arrange the 
next objects introducing a Red Book-standard pause between them.  

The following procedure highly recommended: 

 Open a new VIP with 4 tracks (for example), so that you may reedit it later on 
 Activate the "Special CD arrange" mode in the CD menu 
 Load wave files, audio tracks, or make a recording using the microphone 

You will notice gaps in the VIP between the individual objects; these represent 
the inserted breaks. You can adjust the length of the included pauses in the 
adjust pause length dialog, if you want. 

 

Destructive wave edit mode 

Wave projects can be edited destructively as well as virtually. Please also read 
the corresponding descriptions in the first chapter of the handbook. You can 
select the desired editing method from the list. 

 

Program settings 

System / Audio 

This menu item opens the system/options (view page 469) dialog where most 
general project settings can be made for Samplitude 11.5 Producer. 

Keyboard shortcut: Y 
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MIDI settings 

Here you can specify which MIDI devices (view page 474) to use in Samplitude 
11.5 Producer. 

 

Synchronization 

Opens the synchronisation dialog (view page 239). Here you can specify 
whether Samplitude 11.5 Producer should operate as master or slave, which 
protocol to use, and which interface should be used to send or receive 
synchronization data. 

 

Editing keyboard shortcuts and menus 

Here you can open the dialog for Editing keyboard shortcuts, menu entries and 
mouse functions (view page 489). 

 

Edit toolbars 

With this command you open the tool bar editor for the according toolbar. The 
same function can be called by right clicking on the tool bar. All tool bars are 
customizable. You can customize any toolbar by adding or removing any 
command, which is available as a toolbar icon.  

Inside the toolbar editor there is a context-sensitive popup help dialog. 

 

Reset toolbars 

This menu lets you reset several toolbars. 

 

Video height 

If the option to display the AVI frames in the VIP window, the height of the AVI 
pictures is determined with this setting. This selection can also be reached by 
clicking on the video track. 

 

Font selection 

Samplitude 11.5 Producer will also let you specify the font used for text display 
in the various objects. 

 

Font for time display 

This option lets you select the display font for the time display (Menu "Window" 
> "Time display"). 
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Metronome settings 

This menu item opens the metronome settings (view page 481). 

 

Display mode 

Please read the explanations in the "View" menu. 

 

Color setup 

Here you can adjust the foreground and background color for displaying 
samples in wave projects, the colors of the volume and panorama curve, the 
grid, the oscillograph and the time display. 

 

Color selector 

The standard Windows color selector has its own integrated online help which 
can be accessed with "F1" or "?" in the dialog. 

In addition to the mentioned function attributes, the sets of the user-defined 
colors can be saved onto a file and reloaded again. 

Right click in the color selector dialog to access a menu with all the saved 
user-defined color palettes. With "Current user-defined save as..." you can 
save the current palette onto a new file which will then appear under "Color 
palettes" in the menu. 

 

Undo settings 

This menu entry opens the basic Settings for the "Undo" function (view page 
487). 

 

Object lock definitions... 

Here you can select which functions should not be permitted by locking the 
objects. 

The choice consists of: 

Moving: The objects cannot be moved unintentionally (default). This is 
especially useful for multi-track recordings to prevent inadvertent offset 
between each track from the beginning. 

Volume changes: Deactivates the volume handles of the objects. 
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Exit 

Closes Samplitude 11.5 Producer. 

 

Recently opened files 

This feature provides a selection of recently opened projects. 
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Edit menu 

This menu contains all editing functions (similar to cutting on a tape machine).  

In virtual projects, you can select track sensitive ranges, so only the selected 
tracks are manipulated. 

Activate cutting and copy also activates a project clip. The window for this 
project will appear if the icon is double clicked. 

Some of the functions are only available for wave projects, some only for virtual 
projects (VIP), and others will work in all types of projects. 

When working with a virtual project (VIP) a selected range is always required 
for the cut functions. The beginning and end of the selected range determine 
the start and end of a cut. The vertical position indicates which tracks are 
affected by the edit. 

It is recommended to use the "auto crossfade" function to make smooth 
transitions between the edit points. This will automatically create fades at the 
object edges. 

Please note that these functions are processed for both channels when 
working with stereo and L&R wave projects (if only one channel edited, then 
you will need to convert the wave project into two mono wave projects).  

 

VIP mouse mode 

All mouse modes available in the VIP are listed here. Detailed information can 
be found in the chapter Mouse Functions and Mouse Modes. 

 

Wave Project mouse mode 

Object mode 

Detailed information about object modes is available in "Screen elements -> 
Toolbars - overview -> Object modes". 
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Undo 

Samplitude 11.5 Producer offers you a comfortable way of tracking changes in 
virtual projects. Up to 100 changes can be kept in memory and traced 
backwards. That means virtual processes can be reversed (undone). Range 
and marker manipulations can also be undone using the “Undo” feature. 
Thanks to this extremely efficient feature, critical operations can simply be tried 
and then reversed to the original status if the results are not satisfactory. 
Samplitude 11.5 Producer offers a convenient undo option for VIP objects. A 
maximum of 100 undo steps can be retraced. This number can be configured 
in "File -> Preferences -> Undo definition". 

Keys:  Ctrl + Z 

 

Redo 

Redo revokes the latest undo command. 

Keys:  Ctrl + A 

 

Undo History 

 

A list box with recent undo commands opens. 
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You can return to any work stage. This list can be removed in the "Edit" menu 
via "Delete Undo Levels". 

 

Delete undo levels 

This feature deletes a virtual project's undo levels. This is useful if certain wave 
projects are left in the undo chain, but they do not exist in the VIP anymore. 
You won’t be able to process or delete the wave project if the undo chain still 
contains a reference. After deleting the undo levels, these projects are available 
again.  

 

Copy 

Copy 

The current range is copied into the clip, but is not deleted from the project. 
The sample or track length remains unchanged. Please note that any previous 
clip contents are deleted. The properties of the project will be applied to the 
clip. 

Shortcuts: C 
 Ctrl + C  
 Ctrl + Ins 

 

Copy to... 

This function copies the selected range form a wave project  into a new file.   

Shortcut:  Shift + C 

 

More > Copy and silence 

Copies the current range to the clipboard (clip), removes it from the project, 
and replaces it with silence. 

Shortcut:  Ctrl + Alt + C 

 

Cut 

Cut 

Wave projects 
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The audio data in the selected range are copied from the current wave project 
into the clip. The material behind the removed range is merged with the 
material in front of the removed range to close the gap. The complete wave 
project becomes shorter. 

Please keep in mind that the clip always contains the same attributes as the 
wave project the material was copied or removed from. 

If you cut material from a mono wave project, the clip becomes a mono wave 
project. If material from a stereo wave project is cut or copied to the clip, the 
clip becomes a stereo wave project. Another attribute adopted is the bit 
resolution and the sample rate of the originating wave project.  

The previous contents of the clip are deleted. 

After a successful removal of the selected material, Samplitude 11.5 Producer 
drops a marker at the position the removed range previously started. This 
allows you to insert the contents of the clip into the wave project at the exact 
same spot if you accidentally removed the material. Use the function "Edit -> 
Paste/Insert clip" to insert the clip contents. 

 

Virtual projects (VIP) 

In virtual projects the selected range is copied to the VirtClip and is removed 
from the current VIP. The VirtClip does not contain actual audio information, 
only the links to the audio files. The VirtClip also contains as many tracks as 
the removed range. 

The material behind the removed range is appended to the material in front of 
the removed range. The VIP project becomes shorter if the selected range did 
cover all tracks. This way you can shorten VIPs which contain empty space 
behind the last object. 

As with the wave projects, a successful removal of the selected range drops a 
marker at the position the removed range previously started. This allows you to 
insert the removed material with "Edit -> Paste/Insert clip". 

Keys: Ctrl + X, or X 
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Split 

Split objects 

Use this option to split all selected objects at the cursor position and separate 
them into individual objects. 

If the range is selected, the cut will be made at each border. Ensure that the 
object that is to be edited is contained within the active range. If necessary, all 
objects may be activated by double clicking on the range selected in the range 
bar. In this case, it is not necessary to select the objects beforehand.  

Shortcut:  T 

 

Split objects at the project marker position 

The selected objects are spilt at the positions of the project markers. The 
newly created objects will be named after the previous markers. 

 

Split objects at the track marker position 

The selected objects are split into separate objects at the positions of the track 
markers. The newly created objects will be named after the previous markers. 

Shortcut:  Ctrl + T 

 

Insert 

Paste from clip 

The contents of the clip are inserted into the current project behind the 
position of the play cursor or the beginning of the currently selected range. The 
data or objects that are located behind the insert position are moved out of the 
way to make room for the clip contents. The samples or audio tracks become 
longer. The clip remains unchanged during the procedure. If the clip was 
empty, an error message is displayed. 

After inserting the contents, the program selects a range over the inserted 
area. If you select "Edit -> Delete", the inserted contents are removed and the 
project is returned to the original state. 

In virtual projects using selected ranges, the program utilizes the beginning 
position and relative track position as the insert point for the VirtClip or clip 
contents. 
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Clip Project Clip Channel Project Channel 

Mono 
Stereo 
 
Mono 
 
Stereo 

Mono 
Stereo 
 
Stereo 
 
Mono 

Channel 1 
Channel 1 
Channel 2 
Channel 1 
Channel 1 
Channel 1 

Channel 1 
Channel 1 
Channel 2  
Channel 1 
Channel 2 
Channel 1 

Keys:  Ctrl + V, or V 

 

Overwrite with clip 

The current range is replaced with the clip contents. The overall sample length 
remains unchanged. The data that occupied this position before cannot be 
recalled. The clip contents are not changed. The assignment of the clip 
channels follows the table mentioned above. 

In virtual projects, the selected range determines the position and track in 
which the clip is inserted. 

Keys:   Alt + V, or Insert 

 

Mix with clip 

The range contents and the clip contents are mixed. Similarly to the "Insert" 
function, the rules for channel assignment between project and clip also apply; 
the clip itself remains unaffected. Please note that with this function both 
components (i.e. the sum of both) are entered into the mix at 100%. On the 
one hand, the volume of the project sample is guaranteed not to drop 
suddenly, but on the other hand, overmodulation my occur. You may have to 
adjust the project's amplitude prior to this ("Edit" menu). 

 

Crossfade with clip 

The content of the range is crossfaded with the content of the clip. 

 

Delete 

Delete 

The data in the current range is deleted. The sample data after the deleted 
range is added at the position the deleted range started. The sample length 
becomes shorter. 
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Please note that this command will not save the deleted data to the clip. If you 
want to preserve the deleted sample data, use the “Cut” command. Using this 
the “Delete” command will delete the data from the current sample and 
preserve the contents of the clip. 

Key:  Del 

 

Extract 

This function is the counter part of the "Cut" function. 

wave projects: The current range is retained, the data before and after the 
range is deleted and cannot be recovered. The length of the sample is reduced 
and the content of the clip remains. 

Virtual projects (VIP): All tracks of the VIP keep the length of the selected 
range, irrespective of the position of the range. 

This function does not work track-specifically. The objects before and after the 
range are deleted. This function does not influence the VirtClip. 

 

Silence 

Insert silence 

The "Insert silence" option will insert blank data at the current play cursor 
position or the starting position of the currently selected range. 

 

Set silence 

Copies the selected VIP range into the clip and clears it in the VIP project. The 
project length is not changed. Please note that the previous clip contents are 
deleted. 

This is a good way to remove a section of a VIP for use elsewhere without 
affecting the length of the track(s) from which the material was removed. 

Keys:  Alt + Del 
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Tempo 

Tempo / Time signature 

Tempo and bar changes are an important expression criteria of all music. 
Samplitude 11.5 Producer offers comprehensive creation possibilities. 

In this case the definition of tempo and time changes is done entirely by means 
of markers within the project window. Special tempo and bar markers can be 
defined using linear or immediate tempo or bar changes. The resulting tempo 
curves are calculated automatically. The display in the transport window serves 
as a visual control of the current tempo or time which displays the current 
values when playing back or repositioning the current respective value. 

The musical grid can also be adjusted by placing support points at certain time 
positions or already available audio and MIDI events, e.g. a reference drum 
track (so-called "advanced tempo mapping"). 

There are three types of markers: 

 Tempo 
 Time signature (musical signature) 
 Bar position 

Of course, tempo information can also be adopted when importing MIDI files 
into the current project. Samplitude 11.5 Producer creates the required tempo 
markers automatically. 

If required, MIDI/audio events can be coupled with the musical grid and 
positioned precisely for tempo changes. 

 

Set new tempo marker 

A new project first has a single “master” tempo which can be defined in the 
transport control or in the project settings (“I”). 

You can define unlimited tempo changes directly in the project window at 
anytime. The tempo marker is the most important tool as it can be used to 
define a tempo change at a precise position, which can also be interpolated 
linearly to a previous tempo definition. 

 



 
 

 344 Edit menu  

www.magix.com

Set new beat marker 

The time signature marker changes the type of beat after the marker position, 
e.g. from a 4/4 beat to a 3/4 beat. A new project first has a uniform 4/4 beat 
that can be defined in the transport control or in the project settings (“I”). 

Bar markers can only be inserted at the beginning of a bar. If an imported MIDI 
file contains bar changes, bar position markers are automatically generated. 

 

Set new beat position marker 

Beat position markers assign a specific musical position to a specific time 
position. This way, the bar frame/grid and MIDI events can be easily 
synchronized with existing audio material. 

 

Ignore all tempo markers, use project tempo only 

All tempo markers are ignored, only the project tempo is used. 

 

Metronome active 

Activates/deactivated the metronome. This function can also be activated via 
the "Click" button of the transport console. 

 

Metronome settings 

This menu item opens the metronome settings (view page 481). 

 

Range 

Range all 

The range will cover the complete sample. This command comes in handy if 
you want to apply changes to the entire sample with functions that normally 
only address certain ranges. 

Keys:  A 

 

Edit range 

In this submenu you will find options and keyboard shortcuts for adjusting the 
play and edit range in the VIP. 

 

Range start to left/right 

Moves the start of the range to the left/right 
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Shortcut: Alt + Arrow left/right 

        

 

Move range end to left/right 

Moves the end of the range. 

Keyboard shortcut:  

Left:  Alt + "-", or Shift + Arrow left 

    

Right:  Alt + "+", or Shift + Arrow right 

    

 

Range to beginning 

The beginning of the range will be extended toward to the beginning of the 
project. 

Keys: Shift + Home 

 

Range to end 

The end of the range will be extended toward the end of the project. 

Keys: Shift + End 

 

Flip range left 

The current range is shifted left by the length of the range and the end will be 
the former beginning position. If there is not enough room to place the range, 
the command will not be executed. 

Keys:  Ctrl + Shift + Arrow left 

 

Flip range right 

The current range is shifted right by the length of the range, and the beginning 
will be the former end position. Keep in mind that if there is not enough room 
to place the range, the command will not be executed. 

Keys: Ctrl + Shift + Arrow right 
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Beginning of range > 0 

This function shifts the beginning of range to the right of the next zero position. 

Keys:  Page up 

 

Beginning of range < 0 

This function shifts the beginning of the range to the left of the next zero 
position. 

Keys:  Shift + Page up 

 

End of range > 0 

This function shifts the end of the range to the right of the next zero position 
(change in polarity). “Zero position” is the next sample value with zero value or 
the boundary between a positive and a negative sample value (or vice versa). 
This is particular useful for searching for loop points. 

Keys:  Ctrl + Page down 

 

End of range < 0 

This function shifts the end of the range to the left of the next zero position. 

Taste:  Shift + Page down 

 

0 > Range < 0 

This function shifts the beginning of the range to the left and the end of the 
range to the right of the next zero position.  

Taste:  Shift + Page down 

 

Set range start to left marker 

Moves the range start to the next marker on the left, i.e. the range will be 
expanded. 

Keyboard shortcut: Shift + F2 

 

Start of range to left object edge 

Moves the range start to the next marker on the left, i.e. the range will be 
extended up to the end of the next object on the left. 

 

Set range start to right marker 
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Moves the range start to the next marker on the left, i.e. the range will be 
extended. 

Shortcut:  Shift + F3 

 

Set the end of the range to the right object edge 

Moves the end of the range to the next marker on the left, i.e. the range will be 
extended up to next object on the right. 

 

Area above all selected items 

A range is opened above all previously selected objects. Read the topics 
"Selecting objects with the mouse (view page 73)" and "Ranges". 

 

Range length 

This command lets you set the range length to 1, 2, 4, 8, and 16 bars. You 
can set the tempo in BPM with "View -> Snap setup". 

 

Split range 

This function is particularly useful for working with loops. If not already 
displaying in split range mode, the project is switched to this mode first to 
display three sections on the screen. 

The upper section displays the whole sample, the section located at the 
bottom left displays the data near the beginning of the range, and the section 
at the bottom right displays the data near the end of the range. 

The boundaries of the range can be positioned exactly in the lower sections, 
while the upper section will display the location of the entire range. You can 
also define ranges across several sections. 

In order to revert splitting, the display setting has to be changed to a section 
again using "View -> Sections -> 1", or "Shift + B". 

Key: B 

Deactivate: Shift+B 

 

Split range for video 

This function is in particular useful for working with AVI videos.  
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The upper section displays the whole sample. The section located at the 
bottom left displays the data near the beginning of the range. The section at 
the bottom right displays the data near the end of the range. 

Both lower sections are zoomed down to single frame accuracy. 

The boundaries of the range can be exactly positioned in the lower sections, 
while the upper section will display the location of the entire range. You can 
also define ranges across several sections. 

To undo the split, the display has to be returned to a 1 section display with 
"Shift + B", or "View -> Sections -> 1". 

 

Store range 

Another powerful feature of Samplitude 11.5 Producer is the option to define 
and save different ranges for future retrieval. An unlimited number of ranges 
can be defined. You can, for example, specify different loops and compare 
them while you recall their ranges.  

All ranges of a project can be accessed via "Tools -> Range manager". All 
ranges can be renamed or played. 

When selecting this menu option, the selected range needs to be stored by 
entering a numerical value the range is associated with. 

Keys:  Shift + F2 ... F10 

 

Get range 

Select this option to select one of the defined ranges as the current range. 

Samplitude 11.5 Producer even lets you choose a range while playing, and the 
specified range becomes the current one and is audible. Using this method, 
you can change between two ranges to compare them with each other. 
Ranges can also be named and recalled with the range manager ("Tools" 
menu). 

Keys:  F2 ... F10 

 

Get range length 

By selecting this option you can select the length of one of the defined ranges 
to be the current range. 

Keys:  Ctrl + Shift + F2 ... F10 
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Set markers 

An indefinite number of positions can be saved at the start position of the 
playback marker (position line). This enables you to set markers. 

Shortcuts: 

1 - 10 

Marker with name... 

Marker with automatic numbering 

Place marker at recording position 

Shift + 1 ... 0 

' 

Alt+? 

 

Range manager 

All saved ranges of the current project are displayed in the range manager. 

A colored bar highlights the current range. 

By selecting a range name, the corresponding range in the project is 
selected/activated. 

In the lower line you can enter/modify the range name. You can also delete 
ranges and save new ranges in the range manager. 

With the "Play once" button you can play the selected range once, "Play loop" 
activates looped playback. This makes the range manager particularly useful 
as a jingle player. 

 

Recall last range 

Restores the last selected range (useful if the adjacent marker was accidentally 
deleted). 

 

Crossfade 

Crossfade Editor 

This menu entry opens the Crossfade Editor (view page 251) that allows you to 
easily set and edit crossfades. 
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Auto crossfade active 

If this option is turned on, then all newly recorded or cut material in a VIP or 
material copied from a wave project into a VIP track has an automatic 
crossfade applied to it. 

Global settings for fade-in and fade-out parameters are assigned to the object. 
These settings can be changed with the crossfade editor via "Edit -> 
Crossfade editor". 

If two objects which had an automatic crossfade applied to them are 
overlapped, a real-time crossfade is the result. 

Auto crossfade mode is an excellent tool to easily perform a linear cut of a 
spoken voice track, jingle, etc. requiring a soft passage without unwanted 
sounds. If needed, each crossfade can be edited using the editor or by 
manually manipulating the handles.  

 

Track menu 

Insert new tracks 

Add one track 

The virtual project is expanded by one empty track. 

 

Add several tracks 

The virtual project is expanded by one empty track (inserted below the 
selected track). 

 

Insert empty track 

The virtual project is expanded by one empty track (inserted below the 
selected track). 

 

New MIDI track 

A track is added to the project which is already set for MIDI recording. 
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New track folder 

Inserts a new folder track in front of the marked track. If a range across several 
tracks was highlighted before creating the folder track, then each of these 
tracks will be added to the folder. 

Tracks can be moved into the folder with drag & drop by clicking on a free area 
in the track box. The mouse pointer turns into a hand. Similarly, tracks can be 
removed from the folder via drag & drop and out of the track box. 

Certain actions can also be grouped. This means an action performed on a 
folder track affects all contained tracks. Tracks in a folder can be: 

 Faded out with the "Reduce track" button. All tracks included in the folder 
track are displayed in reduced size. 

 Switched to mute, lock, monitoring, and solo. 
 Volume controlled. The individual volume faders of the tracks are scaled 

relative to another, independent of the current function of the track volume 
fader (MIDI, CC, or audio level) 

 Activated (the displayed condition corresponds to the first track of the folder, 
joint switching is only possible with different/multi-track recording devices) 

If the folder track display is enlarged (opened up), all included tracks are 
displayed as well with a frame in the color of the folder track. The track color 
can be selected in the track settings. If the folder track is minimized, the tracks 
included in the VIP are hidden. They continue to be available in the mixer. They 
are also available in the mixer. 

Normally, all the tracks can be seen with the objects they contain in the folder 
in a smaller display. Section marking in the folder track is carried out across all 
tracks. Use this view mode for section-based cut operations across all tracks 
of the folder track. 

By right clicking on the track box of the folder track, the contained track can 
be used as a reference track. The objects of this track are displayed in the 
folder and can be used for simultaneous object-based cutting operations for all 
objects of the other tracks in the folder track that are grouped with these 
objects. Object groups like these typically originate from multi-track 
recordings. 

The usual method of working with folder tracks would be as follows: 

1. Initiate a multi-track recording. This creates several grouped objects, one 
below the other. 
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2. Select an area over all the objects that you wish to edit together. You can 
now create a folder track. 

3. Minimize the folder track and choose one of the contained tracks as a 
reference. 

4. The object of the reference track now appears in the folder track instead of 
the symbolic display of all contained tracks. All object editing, cuts, fades, 
and object editor effects of this object are now applied to all objects of the 
folder tracks (changes in the object editor take effect only after "Apply/OK" 
is clicked). 

Folder tracks are not visible in the mixer. 

 

New submix / AUX bus 

In the "New submix bus" menu item you can add a new submix bus as a new 
track. The "New AUX bus" option is identical. The new bus is always inserted 
after the active track. 

 

Copy track(s) 

All selected tracks in the VIP are copied into the VirtClip. 

 

Insert track(s) 

The clip is inserted from the track with the current range setting. New tracks 
are created in the VIP. 

 

Delete track(s) 

All selected tracks are deleted from the actual VIP.  

 

Track type 

Displays whether the track is set to AUX send and/or a submix-bus. 

 

AUX bus 

An AUX bus is a track featuring all the abilities of a normal track, i.e.  it can 
include track effects, and panorama and level can be automated. It has one 
input and one output. The most important difference is that you can branch off 
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the audio signal to this bus of any track with a lower number than that of the 
AUX bus. This is done by using the AUX send faders in the mixer. 

AUX busses are typically used for effects such as reverb or echo, that may be 
equally required for various tracks, but in different shares. In Samplitude 11.5 
Producer, Objects can be routed to AUX busses as well. You can also send to 
AUX buses. 

 

Submix bus 

A submix bus is a track featuring all abilities of a normal track. This means that 
it can include track effects, and the panorama and level can be automated. 
The important difference is that you can route the output signal of every track 
with a lower track number than the submix bus to this bus (instead of routing 
to the master or an output device). 

AUX busses are typically used for effects such as reverb or echo, that may be 
equally required for various tracks, but in different shares. In Samplitude 11.5 
Producer, Objects can be routed to AUX busses as well. 

 

Input 

Stereo: Records a stereo wave file. 

Mono: Mono recording uses only one input device for recording. 

Mono (Mix): Mono recording records a signal which mixes both input devices. 

MIDI recording: The set MIDI input is recorded. 

 

Track size 

Minimize none 

This option maximizes all tracks. 

 

Maximize track 

This option minimizes all tracks except the selected track. 
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Track Freeze 

Track freeze 

The selected track is rendered into a wave file which replaces all objects on the 
active track. Object and track effects are added to reduce the PC's processor 
strain of having to process effects and plug-ins. 

The advantage of track freeze is that the frozen track is saved in a separate 
VIP and can be edited/recalled at any time. This way it's also possible to work 
flexibly and to keep resource usage at a minimum even when working with less 
powerful computers. 

Track freeze for AUX buses/submix buses 

Bus/Aux bus tracks can be frozen just like regular tracks. This enables a 
complete group of tracks to release the required CPU load including all effects, 
fades, crossfades, and automation settings in one step. 

Submix bus 

 Tracks routed onto the submix bus are not changed but remain instead. 
 The submix bus is muted ("Track -> Track options -> Mute bus input"). 
 The file created while freezing is inserted into the AUX track as an audio 

object. 
 Changes made to the tracks after freezing which are routed to the submix bus 

have no effect on the signal output while playing. 

AUX bus 

 Only AUX send settings in tracks are taken into account (not in objects). 
 Tracks routed onto the frozen AUX bus are not changed but remain 

unchanged instead. 
 The AUX bus input is muted ("Track -> Track properties -> Mute bus input"). 
 The color of the AUX send fader (mixer) in the affected tracks is blue. 
 An asterisk is added before the name above the AUX send faders (mixer). 
 The file created while freezing is inserted into the submix track as an audio 

object. 
 Changes made after freezing to the tracks transmitting to the AUX bus are not 

updated in the file created while freezing. Therefore, if objects are moved into 
tracks transmitting to an AUX bus, the audio signal on the corresponding AUX 
will remain the same. 
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Track unfreeze 

This menu item removes the wave file created during "Track freeze" and brings 
back the track that was saved in the temporary trackbouncing VIP. 

Changes made in this project are applied to the track as well. 

Note: If tracks were added in the reference project (the project created while 
freezing), "Track unfreeze" is not possible. 

 

Track effect settings 

Copy / Paste track effects settings 

With this command you can copy the complete effects settings of the active 
track into the clipboard. 

 

Copy / Paste track effects settings 

With this command you can copy the complete effects settings of the active 
track into the clipboard (to paste it on another track). 

 

Reset track effects settings 

Reset all track effects settings to its defaults, i.e. no effects are applied at all.  

 

Track information 

Please refer to “Track” menu! 

 

More 

Cut track(s) 

Cuts out the complete tracks that have been selected by the range. 

 

Track effects 

Please read the chapter “Menu effects”. 

 

Dynamics 
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Dynamics 

This menu entry opens the Track Dynamics (view page 121). This is a 
dynamics tool that requires little CPU power and can be used in different 
modes. 

 

Frequency/Filter 

Parametric EQ 

This menu item opens the Parametric Equalizer (view page 98). 

 

Delay / Reverb 

Reverb/Delay 

 

The reverb effect device offers newly developed and very realistic reverb 
algorithms to add more room depth to your recording. 

 

Reverb 

Reverb gives you a high-quality reverb which can be specified further using the 
“Room Size”, “Time” and “Color” and mixed into the original sound with “Mix”. 

Room size: This controller controls a room simulator, which calculates the 
reverb effect according to the room size. If the controller is turned all the way 
to the left, then it sounds as if the audio object was recorded in a very small 
room. If it is turned all the way to the right, it sounds as if the audio object was 
recorded in a cathedral. 

Time: This is where you set the reverb tail's length, i.e. the sound's "sustain" 
level. 

Color: Control the sound of the reverb here,  dampen or brighten it. 

Mix: This controller determines how much of the unprocessed original sound 
(dry signal) is subjected to reverb (wet signal). Application of this effect in an 
AUX bus requires the controller to be set to 100% (all the way to the right). 

 

Delay 
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This effect is like an echo which delays the signal and repeats it. 

Delay: This sets the period of time between the individual echoes. The more 
the control is turned to the left, the faster the echoes will follow each other. 

Feedback: This adjusts the number of echoes. Turn the dial completely to the 
left, there is no echo at all; turn it completely to the right and there are 
seemingly endless repetitions. 

Mix: This fader determines how much of the unprocessed original sound (dry 
signal) is subjected to the echo (wet signal). Application of this effect in an AUX 
bus requires the controller to be set to 100% (all the way to the right). 

 

Delay 

This opens the Analog Delay (view page 103) feature in the Vintage Effect 
Suite. 

 

 

Stereo / Phase 

Surround editor 

Please read the chapter "Surround". 

 

Modulation / Special 

Chorus 

This opens Chorus (on page 109) in the Vintage Effect Suite. Chorus is one of 
the most familiar and popular effects. 
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Plug-ins 

 

This dialog allows you to use Microsoft DirectX and VST-compatible plug-ins 
for effects calculation in Samplitude 11.5 Producer. This allows you to use 
almost any effect algorithms of third parties in addition to the effects integrated 
in Samplitude 11.5 Producer.  

Samplitude 11.5 Producer's mixer enables plug-ins to be integrated as 
real-time effects. The plug-ins must be able to process audio data blocks 
instantly and completely without changing the length. This is normally the case 
for most plug-ins (e.g. reverb, echo, dynamic compressors, etc.). Other 
algorithms are excluded here (e.g. timestretching plug-ins because of the 
resulting length-changing effect). 

 

MAGIX Plug-ins 

Chorus 

This opens Chorus (on page 109) in the Vintage Effect Suite. Chorus is one of 
the most familiar and popular effects. 
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Delay 

This opens the Analog Delay (view page 103) feature in the Vintage Effect 
Suite. 

 

 

Filter 

Opens the Vintage Effect Suite's Filter (view page 107). 

 

 

Flanger 

Flanger (view page 105) is less known, but is a indispensable effect for many 
applications and is also available in the Vintage Effect Suite. 

 

Tape simulation 

The Tape Simulation adds a feeling of "warmth" to digital recordings that 
sound "cold"; something that used to be created by the tape saturation effect 
of analog equipment. 

 

Distortion 

The Distortion effect (view page 111) in the Vintage Effect Suite opens. 

 

 

BitMachine 

This opens the BitMachine (view page 112). 

 

Track properties 

Here you can edit the properties of the active track. These are: 

Mute: The mute button mutes the active track. 

Solo: Switches the active track to solo mode. 

Solo exclusively: This setting switches the active tack to solo exclusive mode, 
i. e. you will only hear the activated track. All other tracks are muted, unlike 
solo mode. 
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Record: Activates record mode. 

Lock: Locks the activated track. 

Volume/Pan-curve active: Displays the volume or pan curve of the activated 
track. 

Submix/AUX bus: If the activate track is a bus, it can be defined as a submix 
and/or AUX bus. 

 

Surround editor 

Please read the chapter "Surround". 

 

DirectX plug-Ins 

Please read the corresponding explanations in the "Effects" chapter. 

 

Activate next / Previous track 

The next (lower) or previous (upper) track in the VIP from the view of the 
currently activated track is activated. With the cursor keys you can 
conveniently scroll up or down. 

Key: 

Activate next track   Cursor down 

Activate previous track  Cursor up 

 

Object menu 

In contrast to the "Edit" menu, all functions in this menu exclusively manipulate 
selected objects in virtual projects. Selected ranges have no effect with these 
functions.  

Ranges are used to determine insertion points or cut positions of objects. 
When inserting material into a virtual project, the range beginning has the same 
function as the play cursor. 
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Object editor 

Use the object editor for object-oriented editing. This way you can quickly and 
easily edit each selected object independent of your general settings. 

Shortcut:   Ctrl + O 

 

MIDI editor 

This menu point opens the MIDI editor. Here, the content of the MIDI object 
selected in the VIP can be displayed and edited. Here, you can choose from 
the matrix editor, drum editor, score editor, event list, and velocity/controller 
editor. 

If a MIDI object is not selected, you will be asked if you wish to create one. If 
you confirm this with "YES", a MIDI object in the current track is created at the 
cursor position/start of the range. 

Read more about the MIDI editor in the "MIDI editor" chapter. 

 

Wave editing 

Opens the wave project (contains audio files) belonging to an object and 
displays it in the wave window. 

The range corresponds precisely to the part of the audio data which the object 
accesses. 

You can carry out destructive (offline) editing In the wave window. 

Cut and copy functions are available for destructive editing ("Edit" menu) as 
well as complex effects ("Effects" menu). 

Destructive editing is not necessarily recommended. 

If you have duplicated objects, i.e. several objects are using the same audio 
data, then all of these objects will have changed when you change the wave 
project. 
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Please note that the cut and copy processes, fades, crossfades, etc. can be 
performed much more elegantly and more quickly as non-destructive virtual 
projects. 

Almost every effect can be used on objects directly in the virtual project. 

Please also note that it is better to work in single-track virtual projects even if 
you only want to edit wave files in Samplitude 11.5 Producer. You can quickly 
and conveniently perform all editing operations here. If you have to use longer 
wave files, you have to wait after each editing sequence until the audio data 
has been copied to the hard drive. However, you can work considerably faster 
if you use virtual projects. 

With the "Trackbouncing" function ("Tools" menu), you can create a new wave 
file from the virtual project. 

 

Edit 

New MIDI object 

A new MIDI object is created on the selected track. After choosing the 
command, you can select a prefabricated MIDI template (from the subdirectory 
“Templates” in the Samplitude 11.5 Producer directory) from a small pop-up 
menu. It deals with normal standard MIDI files which can be copied into this 
directory or directly exported from Samplitude 11.5 Producer as a template. If 
only one file is in the template listing, no menu appears the object is created 
immediately. 

 

New synth object 

Please read the "Synth objects" chapter! 

 

Cut objects 

The currently selected object is replaced with empty space and copied to the 
VirtClip. The length of the current project remains and all other non-selected 
objects remain in their positions. The previous contents of the VirtClip are 
replaced with the cut object. 

 

Copy objects 

To place a copy of the currently selected object into the VirtClip select this 
option. The contents of the VirtClip can then be inserted into the project using 
the “Insert objects” option (see below). The previous contents of the VirtClip 
are replaced. 
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Insert objects 

Objects in the VirtClip can be inserted in the project at the current play cursor 
position. The other objects in the project maintain their positions. Please note 
that the newly inserted object might cover portions of existing objects. 

 

Delete objects 

The selected objects are deleted from the current project. The length of the 
current project however remains the same. Previously unselected objects keep 
their positions. The contents of the VirtClip remain unchanged. 

Keys:  Ctrl + Del 

 

Duplicate and move 

Duplicates all selected objects, that is, a copy is created in the original project 
at the same point. The original object is underneath (covered). The duplicate 
can be moved to the new desired position using the mouse (in 
Object/Universal Mode). Duplication is also possible using drag & drop (in 
Object/Universal Mode): 

If multiple objects were selected before duplication, the Ctrl key should be 
pressed before moving so that all objects remain selected and are moved 
together. 

This way, you can quickly duplicate objects. 

 

Duplicate objects multiple 

This function duplicates multiple objects and places them in a sequence. 
Another dialog is displayed which allows you to determine how many copies of 
the selected objects are to be duplicated, the separating distance, and the 
overall length of the duplication. 

This is also another way to build loop objects. 

The following parameters are available: 

Number of objects: Determines the number of objects created. 

Group created objects: All created objects are grouped together when 
checked. 

Delta time: This determines the relative position of each created object to the 
next (from the beginning of one object to the beginning of the next). The 
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default setting is the length of the selected object. The default setting  lines 
up the duplicated objects without any gaps between them to create a 
seamless loop. 

Duration: Alternatively, the duration can be specified, i.e. the combination of 
the time difference and the number of duplicated objects. 

 

Build loop object 

A loop can be defined within an object with this function. An area which 
indicates the loop length must be selected in the object first.  

The object becomes the loop object, and the number of loops can simply be 
“raised” using the “length handles” at the bottom of the object.  

Loop objects generated like this are ideal for generating long drum sequences 
from only one drum loop! Loop objects also help to save memory, since in the 
VIP only one object is handled rather than multiple objects or copies of the 
same material or very long samples! 

 

Split objects 

This function splits or separates selected objects so that individual object 
sections can be manipulated further. All selected objects are separated at the 
current play cursor position, resulting in two independent objects. 

If a range is selected, the cut occurs on both range boundaries. It is not 
necessary to select objects prior to choosing the range and using the "Split 
objects" function. If an underlying object is separated, then the newly created 
object covers the original underlying object. 

Keys:  T 

 

Split objects on marker position 

This function splits or separates selected objects so that individual object 
sections can be manipulated further. All selected objects are separated at the 
current marker position, resulting in two independent objects. 

 

Split objects on marker position 

This function splits or separates selected objects so that individual object 
sections can be manipulated further. All selected objects are separated at the 
current marker position, resulting in two independent objects. 
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Trim objects 

This function trims the object borders to the currently selected range borders. 
The selected range needs to be located within the confinements of the object 
you want to trim. 

Keys:  Ctrl + T 

 

Trim MIDI objects 

This function moves the object borders of a selected object to the edges of the 
current range. For this to occur, the range must be fully within the object's 
borders. 

 

Group objects 

Builds a new object from those selected using trackbouncing. 

 

Mute objects 

The selected objects will be muted. 

 

Lock objects 

Use this option to protect objects from accidental shifting. First, select the 
objects you want to “lock” in place and activate the lock function. A diagonal 
line is placed across the locked object. 

In the "Options" menu you can specify the functions you want to lock. 

 

Unlock objects 

An object can be unlocked so that it can be moved again. All of the objects 
selected will be unlocked. 

 

Locking options 

The dialog opens displaying the Locking options (view page 487). 

 

Separate MIDI objects according to channels 

If a MIDI object contains several channels, you can use this menu item to split 
it up into several MIDI objects. 

Hint: Please note that the created tracks have to be allocated to the 
corresponding instrument/MIDI device. 
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Quantization 

MIDI quantization (standard) 

This command quantizes the ends of the MIDI notes of all selected MIDI 
objects according to the MIDI quantization settings. 

Detailed information about quantization can be found in the chapter "MIDI 
editors -> Quantization". 

 

MIDI Humanize Q 

This command considers the current Humanize value in the quantization 
options. 

Detailed information about quantization can be found in the chapter "MIDI 
editors -> Quantization". 

 

Advanced 

Start Q/MIDI quantization 

This command quantizes the start positions of the MIDI notes for all selected 
MIDI objects according to the MIDI quantization settings. The grid view 
corresponds to the set start quantization value. 

Detailed information about quantization can be found in the chapter "MIDI 
editors -> Quantization". 

 

Q/MIDI quantization start and length (start and length) 

This command conducts quantization of the start and length of the MIDI notes 
of all selected MIDI objects according to the MIDI quantization settings. 

Detailed information about quantization can be found in the chapter "MIDI 
editors -> Quantization". 

 

Q/MIDI length quantization 

This command conducts quantization of the lengths of the MIDI notes of all 
selected MIDI objects according to the MIDI quantization settings. 
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Detailed information about quantization can be found in the chapter "MIDI 
editors -> Quantization". 

 

Quantize note ends 

This command quantizes the ends of the MIDI notes of all selected MIDI 
objects according to the MIDI quantization settings. 

Detailed information about quantization can be found in the chapter "MIDI 
editors -> Quantization". 

 

Reset MIDI quantization 

This command resets the original offset in relation to the grid of the start and 
length values of MIDI notes of all selected MIDI objects. This allows 
quantization to be undone at any time – even after the VIP has been saved. 

Detailed information about quantization can be found in the chapter "MIDI 
editors -> Quantization". 

 

MIDI input Q (global) 

Use this option to quantize the MIDI recording destructively. The original 
position may be restored via the menu item "MIDI -> Extended MIDI quantize 
-> Reset quantization". 

 

Object effects 

Dynamics 

Dynamics 

Fundamentally, the compressor is an automated, dynamic volume controller. 
The dynamics of a piece are limited, loud sequences remain loud, quiet 
sequences become louder. Compression is often used to add power to audio 
material or to increase the loudness. The level of compression is adjusted by 
the ratio controller, while the activation threshold is determined by the 
threshold. You can also influence the attack and release. 
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Editing is carried out using a “look-ahead” method, similar to high-quality 
studio appliances. There are no peak over-modulations or other artifacts, as 
the algorithm can never be ‘surprised’ by sudden level peaks. 

 

Sensor field: You can intuitively influence  the sensor field  of the 
compressor with mouse movements. The graphics  color and the respective 
effect settings change in response to each other. 

Ratio: This parameter controls the amount of compression. 

Threshold: Set the threshold, above which compression is applied. 

Attack: Sets the algorithm's reaction speed to increasing sound levels. Short 
attack times can create an undesirable "pumping" sound, as the volume is 
quickly reduced or increased correspondingly. 

Release: Sets the algorithm's reaction speed to falling sound levels. 

A/B: If you have selected a preset for the effect and make manual changes to 
it later, you can compare the original preset sound with the new settings by 
using the A/B-button. 

Reset: This resets the effect device to its original neutral starting point where 
minimal processing power is required and no effect is added to the sound. 

Load/Save: Here you can save the current settings as an effect file so that they 
can be used on other projects as well. 

 

Frequency/Filter 

10-Band EQ 

The 10-band equalizer subdivides the frequency spectrum into ten areas 
(‘bands’) and equips them with separate volume controls. This way it is 
possible to create many impressive effects, from a simple boosting of the bass 
to complete elimination of a certain range of frequencies. Note: If low 
frequencies are boosted too much, the overall sound level is heavily increased 
which may lead to distortion. In this event, adjust the overall volume downward 
by using the "master volume" control situated in the main screen. 
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Slider controls: Each of the ten frequency ranges can be separately boosted 
or turned down with the ten volume controls. 

Link bands: Using this button flexibly combines the frequency ranges with 
each other to avoid artificial-sounding overemphasis of an individual frequency 
range. 

A/B: If you have selected a preset for the effect and make manual changes to 
it later, you can compare the original preset sound with the new settings by 
using the A/B-button. 

Reset: This resets the effect device to its original neutral starting point where 
minimal processing power is required and no effect is added to the sound. 

Touch screen (right EQ section): This is the "sensor field" of the EQ. Here you 
can draw any type of curve with the mouse. This will be immediately translated 
into a corresponding control setting on the left side of the EQ. 

 

Parametric EQ 

This menu item opens the Parametric Equalizer (view page 98). 
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FFT Filter 

The FFT filter enables the wildest filter effects to be drawn simply with the 
mouse. 

 

A red line can be drawn in the graphic field using the mouse. The left side of 
the graphic is for the lower frequencies of the sound, the right for the higher. A 
"mountain" in the left part of the graphic creates a large increase in bass, a 
"mountain" in the right increases the highs noticeably. Often, interesting effects 
can be achieved when the filter curve is deleted for the entire range (i.e. set 
completely to the lowest value in the display). This practically deletes the 
sound. Now a pair of mouse clicks in the upper display area will only make 
individual frequency ranges audible, this way a normal drum loop is quickly 
turned into into a "science fiction" sound. 

Freehand drawing: With this pencil you can draw "freehand". Draw or rotate a 
straight line by pressing and holding the "Shift" key. 

Quantized drawing: This activates a quantization function to draw straight lines 
and angled figures. The farther away from the curve you are, the wider the 
bulge in the range. This effect can be increased with the "Ctrl" key. 

Reshape tool: This drawing tool lets you bend existing curves. Deformation 
can be achieved by pressing the mouse button repeatedly. 

Navigation tool: This lets you move the displayed area. 
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Zoom tool: With the left mouse button you can zoom into the display; zoom 
back out with the right. Keep the left mouse button pressed to drag out zoom 
areas. 

Reset: The Reset button quickly allows you to place the filter curve into the 
initial state again.   

Preset: Access the presets for certain applications here. 

Level: The "Level" slider allows you to enhance or diminish the differences in 
the curve movement. The result is a stronger or weaker modulation. 

Vol: The "Volume" controller controls the volume of the material. 

Sound cloner: With the sound cloner you can determine the sound 
characteristic of a song and transfer it to others. This way you can, for 
example, create a Pat Metheny song in the style of Madonna's producers. 
Load a track you really like, set the song's playback position and press the 
"Learn" button.  

Scale options: Accesses a settings dialog with options for scaling FFT curves 
(view page 371). 

 

Scaling options (FFT filter) 

Freq: This switch lets you choose between a logarithmic ("log") or a linear ("lin") 
frequency scale. The logarithmic display corresponds to the human perception 
of pitch. Like on the keyboard of a key instrument, the (graphic) spacing of the 
intervals, i.e. halftones, is uniform across the entire range. 

Freq.log: The upper labeling of the graphic can be switched between output in 
"Hz" or "Notes". Note output is only possible via logarithmic frequency display 
("log"). 

Value display: Here you can set a logarithmic or linear display as well as an 
enlargement of the filter curve. 

Value range: Here you can set the displayed value range in dB. 

Curve display: Here you can switch between a bar and a curved display. 

 

Filter 

Opens the Vintage Effect Suite's Filter (view page 107). 
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Delay / Reverb 

Room Simulator 

This function lets you add a high-quality room simulator to the audio material. 

 

Reverb type: Here you can choose between a short, medium and long sustain. 

Reverb share: Here you can set the balance between the original signal 
(without reverb) and the actual reverb. 

Preview: This button activates the preview function. A short reverb section is 
calculated and then played so that you get an impression of the settings. 

 

Reverb/Delay 

 

The reverb effect device offers newly developed and very realistic reverb 
algorithms to add more room depth to your recording. 
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Reverb 

Reverb gives you a high-quality reverb which can be specified further using the 
“Room Size”, “Time” and “Color” and mixed into the original sound with “Mix”. 

Room size: This controller controls a room simulator, which calculates the 
reverb effect according to the room size. If the controller is turned all the way 
to the left, then it sounds as if the audio object was recorded in a very small 
room. If it is turned all the way to the right, it sounds as if the audio object was 
recorded in a cathedral. 

Time: This is where you set the reverb tail's length, i.e. the sound's "sustain" 
level. 

Color: Control the sound of the reverb here,  dampen or brighten it. 

Mix: This controller determines how much of the unprocessed original sound 
(dry signal) is subjected to reverb (wet signal). Application of this effect in an 
AUX bus requires the controller to be set to 100% (all the way to the right). 

 

Delay 

This effect is like an echo which delays the signal and repeats it. 

Delay: This sets the period of time between the individual echoes. The more 
the control is turned to the left, the faster the echoes will follow each other. 

Feedback: This adjusts the number of echoes. Turn the dial completely to the 
left, there is no echo at all; turn it completely to the right and there are 
seemingly endless repetitions. 

Mix: This fader determines how much of the unprocessed original sound (dry 
signal) is subjected to the echo (wet signal). Application of this effect in an AUX 
bus requires the controller to be set to 100% (all the way to the right). 

 

efx_StereoDelay 

Opens the Stereo Delay (view page 117) in the essential FX (view page 117). 

 

Delay 

This opens the Analog Delay (view page 103) feature in the Vintage Effect 
Suite. 
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Time / Pitch 

Resample / Timestretching 

Opens the timestretching/resampling/pitchshifting editor. 

Note: If you only want to change the sample rate of an audio file, then use the 
"Adjust sample rate" option from the "Effects" menu. 

 

All algorithms in this dialog use the time factor parameter and pitch as input 
parameter.  

The time factor calculation (from the original length/original speed and the 
length required/speed required) can be comfortably activated on the right side 
of the dialog. 

 

Resampling 

Samplers and PCM synthesizers transpose samples during this procedure. 
Time factor and pitch are dependent upon each other; the shorter the audio 
material, the higher the pitch. This effect is comparable with changing the play 
back speed of record players or tape recorders.  

The effect is relatively loss-free, and the sound loss is less than all 
timestretching/pitchshifting procedures. If pitch change is justified by changing 
the speed (and vice versa), use this algorithm. 

When lengthening the audio material by resampling, very small aliasing effects 
may occur. The anti-aliasing filter helps correct this. Alternatively, since this 
filter creates additional CPU load, it can be activated for computation and 
real-time previewing. The filter is also available for the other algorithms that use 
internal resampling during pitchshifting.  
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Default 

"Standard" applies an algorithm which usually delivers very good results, 
including factors from 0.9 to 1.1, and operates in phase-locked mode to 
maintain the room effect of stereo signals. For drum loops or other "beat 
heavy" material, this algorithm is only partially suitable, since it can change the 
groove and even fade out or double beats in rare cases. 

Time compression (sample length is reduced) is more successful with this 
algorithm than timestretching, i.e. it is better to reduce the longer sample than 
vice versa when adjusting two samples to another. 

 

Smoothed 

A considerably more complex algorithm is used which requires more 
processing time. The material can now also be used on very large factors (0.2 - 
50) without bringing about strong artifacts. The material is "smoothed", making 
the sound softer and emitting it at an adjusted phase level. This smoothing is 
hardly audible with speech, singing, or solo instrumentation. Problems may 
arise with more complex spectra (sound mixes from various instruments or 
finished mixes). This algorithm is not very well suited to drum loops and other 
material with strong transients. The groove remains intact, but the attacks are 
slurred because of phase shifting. With small corrections (factor ca. 0.9 - 1.1) 
the setting of the smallest possible smoothing value should be used.   

Recommended for: 

 Orchestra instruments: String instruments, wind instruments, etc. 
 Speech, single voice, and multi-voice sections 
 Speech with background noise like video sound, etc. 
 Synthesizer areas, guitars, etc. 

Not suited for: 

 Stereo mix 
 Drum loops, percussion 

CPU strain: very high 

 

Beat marker slicing 

This mode focuses on customizing drum loops, but can also be used on other 
material like monophonic bass runs or sequencer lines. The algorithm splits the 
material into individual components, individual notes, or beats, which are then 
selected via the beat marker. 
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These "snippets" are then compiled into the new temporal measure. If the 
tempo is increased, then individual beats begin overlapping; if it is slowed 
down, then short pauses between the beats become audible. 

If this algorithm can be used, then it should be, since the time change occurs 
without any loss of quality at low CPU strain. 

Recommended for: 

 Samples which can be split into individual notes or beats. 
 Drum loops, if the beats do not overlap and there is not much reverb. 

Definitely not suited for: 

 Everything else where beat markers do not exist; the algorithm fails completely 
and silence is the result. 

CPU strain: minimal 

 

Beat marker stretching 

This algorithm functions similarly to the standard algorithm. Unlike the previous 
algorithm, this one synchronizes the stretched material with the beat markers. 
The groove remains perfectly intact, and duplicated or faded-out beats do not 
occur. Unlike the "Beat marker based slicing" algorithm, this algorithm doesn't 
fail fully when there are no markers, or when the markers are placed 
incorrectly, but the synchronization quality may be reduced or contain errors. 
In practice, automatic marker generation is usually enough for good results. 
You should avoid having beat markers which follow one another very closely 
(<1000 samples). 

 

Monophone voice 

This is a special timestretching and pitchshifting function for vocal solos, 
speech, or solo instruments. The material cannot contain background noise, 
and excessive reverb may also be detrimental to its effects. With suitable 
material the audio quality is very high. 

With the "Use formant correction" option the formants remain the same when 
pitchshifting, i.e. the "Mickey Mouse effect" does not occur. This way, realistic 
background choirs can be "composed" from just one solo voice. However, the 
formants can be shifted by +/- 12 half tones, and vocal distortions can result.  

Typical usage of this algorithm: 
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 Intonation correction: The note with the imprecise pitch should be cut out as 
an object, so that it can be manipulated independently of the other notes. 

 Harmonizer effects: An object with vocals can be copied and moved down. If 
the pitch is changed, then the second voice will be changed, etc.  

 Generating background vocals from existing vocal samples 
 Timestretch/Distortion of a speech sample, to make a "grandfather" voice. 

Recommended for speech, single voice vocals, single voice instruments 
without overlapping, with low reverb and low background noise. 

 

Elastic Audio easy 

Opens the Elastic Audio Easy dialog (view page 141) to edit monophonic 
material and to create harmonic voices. 

 

Stereo / Phase 

Switch channels 

This function switches the left and right stereo channels.  

This is useful for correcting recordings with switched channels. This function 
can be reversed if you don't re-select the range; opening it again will bring 
back the original material.  

 

Stereo FX 

The "Stereo FX" enhancer lets you edit the justification of the audio material in 
the stereo panorama. If stereo recordings sound unfocused and 
undifferentiated, an extension of the stereo base-width can often provide a 
better transparency. 

 

Base width controller: Adjusts the base width between mono (on the extreme 
left), unchanged base width (center), and maximum base width (”wide”, on the 
extreme right). Reducing the base width can produce a rise in the level. In 
extreme cases – when the left and right channels include identical material and 
the base width controller is pushed to the left on ”mono” – the result can be a 
level rise of 3 decibels.  
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Raising the base width (values over 100) diminishes the mono compatibility. 
This means that recordings edited this way sound hollow when listened to in 
mono. 

Volume controller: Adjusts the volume of every single channel, thereby 
adjusting the entire panorama. The damping of left and right levels is displayed 
in dB underneath the controllers. A centered recording can later be moved to 
the left or right of the stereo picture.  

Stereo meter: This provides a graphical display of the phase relation of the 
audio signal. You can use it to review the justification of the signal in the stereo 
panorama and the effect of the stereo enhancer.  

In order to achieve the greatest possible compatibility with mono, the display 
should come closest to a diagonal line. Otherwise some frequency ranges may 
cancel each other out if the stereo signal is played on a mono device. 

Karaoke preset: This preset opens a special karaoke effect that more or less 
eliminates vocals. It deletes middle frequencies typical for human vocals during 
playback so that someone else can do the singing.  

 

Invert phase 

The sample data is inverted along the amplitude axis, which means that 
negative values become positive and vice versa. This function allows you to 
adjust recordings with different phases to one another. 

An incorrect phase occurs if during an analog recording parallel cables are 
switched. To correct such errors, some mixers have a switch that can be used 
to invert the phase of an input. If you press the switch by mistake, errors might 
occur as well. 

This function is reversible, so if you repeat it, the original signal is restored. 

 

Modulation / Special 

Vocoder 

The vocoder principle: Carrier material (e.g. a surface sound or a synth chord) 
is affected by a modulator (e.g. language or singing) so that one gets the 
impression that it is speaking or singing. Rhythmic surface sounds can also be 
developed if modulated with a drum loop.  

This is done via the transmission of the frequency characteristics of the 
modulator (speech) on the carrier (chord).  
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Carrier input 

Here you have to select the desired carrier sample. Some special carrier 
samples that have been loaded automatically from the "Vocoder" directory are 
listed. 

 
Use the "Carrier sample" check box to load any number of samples of the 
current project or predefined carrier sample. 

 Here you can play the carrier on its own for test purposes. 

Noise: This controller lets you add noise to the carrier sample. This makes 
sense if the carrier material can not be modulated sufficiently or is irregular. It's 
good for "filling" drum loops which have too many pauses between the beats. 

Material containing all frequencies in equal amounts are particularly suitable, 
such as strings, orchestra chords, broad synthesizer pads, hissing, or wind 
noise. 

 

Filter 

Dynam: Influences the dynamics of the modulator signal to reduce the 
modulation depth of the vocoder. 

This prevents two often undesired side effects of modulation. On the one hand, 
the volume change of the modulator signal is added to the output signal in a 
slightly more moderate form which may improve the power of the vocoder 
voice. On the other, the low-level share of the modulator signal is ignored in 
order to prevent modulation of the carrier by breathing or noise. 

Smooth: Affects the speed at which the vocoder adjusts to the modulator 
spectrum. The greater the value, the "lazier" the vocoder follows the modulator 
and the "smoother" the sound changes in the carrier sound.  

 

Filter graphic 

Any frequency characteristic can be drawn in to optimize the results of the 
vocoder. For example, simple disturbing bass frequencies can be eliminated as 
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the curve is corrected downwards to the left. Similarly, weak highs can be 
strengthened as the curve is raised to the right. 

 

Mixer 

In the mixer you can also mix parts of the carrier and modulator signal to the 
vocoder output signal ("Out").  

If the output signal of a track is used as a carrier in the vocoder, this track will 
be muted first, and then you can make it audible again in the vocoder mixer. 

 

Presets 

You can select predefined vocoder settings in the"Preset" list window. The 
presets all contain vocoder settings, except the selected carrier signal. "Reset" 
restores the vocoder default settings. 

 

efx_ChorusFlanger 

This opens the Chorus/Flanger effect in the essential FX. 

 

efx_Phaser 

Opens the Phaser in the essential FX. 

 

Chorus 

This opens Chorus (on page 109) in the Vintage Effect Suite. Chorus is one of 
the most familiar and popular effects. 

 

Flanger 

Flanger (view page 105) is less known, but is a indispensable effect for many 
applications and is also available in the Vintage Effect Suite. 

 

Tape simulation 

The Tape Simulation adds a feeling of "warmth" to digital recordings that 
sound "cold"; something that used to be created by the tape saturation effect 
of analog equipment. 
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Plug-ins 

 

This dialog allows you to use Microsoft DirectX and VST-compatible plug-ins 
for effects calculation in Samplitude 11.5 Producer. This allows you to use 
almost any effect algorithms of third parties in addition to the effects integrated 
in Samplitude 11.5 Producer.  

Samplitude 11.5 Producer's mixer enables plug-ins to be integrated as 
real-time effects. The plug-ins must be able to process audio data blocks 
instantly and completely without changing the length. This is normally the case 
for most plug-ins (e.g. reverb, echo, dynamic compressors, etc.). Other 
algorithms are excluded here (e.g. timestretching plug-ins because of the 
resulting length-changing effect). 

 

MAGIX Plug-ins 

Chorus 

This opens Chorus (on page 109) in the Vintage Effect Suite. Chorus is one of 
the most familiar and popular effects. 
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Delay 

This opens the Analog Delay (view page 103) feature in the Vintage Effect 
Suite. 

 

Flanger 

Flanger (view page 105) is less known, but is a indispensable effect for many 
applications and is also available in the Vintage Effect Suite. 

 

Select objects 

Select all objects 

Selects all objects in the arranger window. 

Shortcut:  Ctrl + A 

 

Select objects 

Selects all objects located partially or entirely in the selected range, or at the 
current play cursor position.  

 

Object lasso 

The normal way to select several objects at once is to click on the free space 
to the right of the object in the lower area of the track and drag a window out 
around the selected objects. 

Sometimes, however, there is not enough space between the objects. The 
object lasso solves this problem. 

Once activated, you can click on an object and pull up a selection frame 
without moving the object you clicked on. 

Once you selected the objects you want, the mouse returns to the standard 
mode, and that you will have to reactivate the object lasso each time you want 
to use it. 

 

Select previous object 

Use this command to select the previous object on the same track. 

Shortcut:  Ctrl + Alt + Q, < 
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Select next object 

Use this command to select the next object on the same track. 

Shortcut:  Ctrl + Alt + W, > 

 

Select objects > Switch selection 

Selects all objects located partially or entirely in the selected range, or at the 
current play cursor position. 

 

Unselect objects 

Unselects the object selection. 

Shortcut:  Ctrl + Shift + A 

 

Groups 

Group objects 

All selected objects are grouped together. All operations are applied to the 
whole group.  

 

Ungroup objects 

Selected objects are ungrouped. Individual objects are available for processing 
after that. 

 

Move object 

This menu contains functions for moving the objects themselves and also for 
moving the wave project within the object. There are also other functions for 
moving a crosswire between two objects and for changing the loudness of the 
object.  

This menu mainly exists for issuing keyboard commands (visible next to the 
entries themselves in the menu) and can be changed using the “Keyboard 
shortcuts and menu editing” function. 

In the picture shown here the menu contains the standard settings for the 
keyboard commands. 
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Commands for moving objects can also be found in the lower toolbar (range 
bar). 

 

Object to play cursor position 

This moves the selected object to the actual play cursor position. 

 

Object to original time position 

This moves the selected object to the original position where the material was 
originally recorded. This is often helpful if an object was accidentally moved. 

 

Set new original time position 

The current object position is used to reset the original position attribute for the 
object. This is also used in the take manager. 

 

Move objects step-by-step 

Samplitude 11.5 Producer contains a complete set of functions for object and 
crossfade editing. Simply select two overlapping objects; only select the 
corresponding object for object editing. Use the "Ctrl" key to select the left 
object and the "Alt" key to select the right object. 

Object(s) to the left Ctrl + Alt + 1 
Object(s) to the right Ctrl + Alt + 2 
Object start to the left Ctrl + 3 
Object start to the right Ctrl + 4 
Object end to the left Alt + 3 
Object end to the right Alt + 4 
Crossfade to the left Ctrl + Alt + 3 
Crossfade to the right Ctrl + Alt + 4 
Increase volume Ctrl + Alt + 8 
Reduce volume Ctrl + Alt + 7  
Object content(s) to the left Ctrl + Alt + 9 
Object content(s) to the right Ctrl + Alt + 0 

Please note the useful "Object content to the left/right" functions. Here, object 
length and object position are kept, the assigned audio material from the 
corresponding wave project is moved into it. 
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Snap point (Hotspot) 

Hotspot 

The current play cursor position is turned into a reference point for the snap 
function. Instead of the object’s beginning, the hot spot is now used when the 
object is snapped to the grid. Stroked vertical lines illustrate hot spots, and hot 
spots may stand outside an object (in front of or behind the object). This 
function is very useful for a case where the portion of an object to be 
synchronized does not line up with its beginning.  

 

Delete hotspot 

The set hotspot is removed, the object snaps again to the object start when 
the object grid is switched on. 

 

Object color / name 

Object foreground color 

After selecting the desired color, all selected objects in the project will have the 
same foreground color. 

 

Object background color 

The background color selected in the color grid is applied to all objects. 

 

Object name 

The selected new name is applied to all selected objects. 

 

Tempo and beat recognition 

This menu entry opens the Tempo and beat recognition (view page 253, view 
page 252). Tempo and beat recognition is a powerful tool for determining the 
BPMs (beats per minute) and the time position of quarter note beats of any 
song. This is important, for example, when a track on an audio CD has been 
imported into Samplitude 11.5 Producer and other sounds like drum loops, 
effects, or synthesizer voices are to be mixed in. 

 



 
 

 386 Object menu  

www.magix.com

Harmony Agent 

The Harmony Agent provides harmony recognition automatically and 
determines the key and chord of any music title. See the guitar tablature of 
your favorite song in real time for the arrangement! 

 

Harmony display 

After successful analysis with the Harmony agent, this menu entry enables you 
to show/hide the harmony display. 

 

Audio ID 

It's possible to identify audio files with this function. In contrast to 
Freedb-Suche (view page 444), the audio file does not need to be a part of an 
album or CD, and it doesn't even need to be played back completely. 

Samplitude 11.5 Producer analyzes typical sound characteristics of a song or 
part of a song and sends this data as a query to the Internet server. The server 
compares this "acoustic  fingerprint“ with saved information about already 
known songs and then provides the required song information. 

 

Timestretch/pitchshift patcher 

 
 

Timestretch/Pitchshift Patcher - Overview 

Use this tool to patch wave files for use in Samplitude 11.5 Producer.  Here, 
additional information and settings can be written into the wave project. These 
enable the processing of timestretching and pitchshifting algorithms at 
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optimum quality. Without the patcher you would have to search and set the 
settings and additional information for each wave file you wish to edit. 

The following can be patched: 

 Algorithms for timestretching/pitchshifting 
 Time factor/Pitch 
 Time factor processing (new length/new BPM) 

 

Timestretch/Pitchshift Patcher – Patching 

Patches only work if you have opened the Wave Project in destructive Wave 
Editing mode and if it is not open in a VIP simultaneously. Moreover, it must 
not be open in a virtual project at the same time. 

Choose the algorithm you wish to use in the dialog. You can also specify the 
tempo of the wave file using the "Time factor" controller. 

You can now test the chosen algorithm in conjunction with the "Play/Stop" and 
"Play Original" buttons. By clicking on the "Patch" button, Samplitude 11.5 
Producer writes the information permanently to the wave file. 

 

Algorithms for timestretching/pitchshifting 

In Samplitude 11.5 Producer you can use the "Beat Marker Stretching 
(smoothed)", "Smoothed", "Beat Marker Slicing", "Beat Marker Stretching" as 
well as "Monophonic Voice" algorithms as well as the "Standard" algorithm for 
real-time timestretching. 

Detailed information about this is available in "Menu Effects -> 
Resampling/Timestretching/Pitchshifting". Use the patcher to save the most 
suitable timestretch algorithm for your needs in the wave project so that the 
chosen algorithm is used automatically on your wave projects when using 
timestretching/pitchshifting. 

 

Beat markers 

With beat markers the audio material is synchronized in such a way that the 
groove remains perfectly intact.  When using the beat marker-based 
algorithms, the beat markers are also saved in the wave project. 

Hint: Unlike in the timestretching dialog in the "Effects" menu, the patcher is 
non-modal, meaning that you can move the beat markers in the wave project 
and simultaneously control the result of the timestretching. 
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BPM value 

The desired BPM value (beats per minute) can be patched here. This is useful 
for when the Timestretching factor must be determined later in order to adjust 
the wave project to the tempo of an existing arrangement. Should the "New 
BPM" field in the dialog be grayed out, you can change the value using the 
"Time factor" controller. 
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Playback / Record menu 

Play once 

The project or the range is played once. 

Key:  Space bar 

 

Play loop 

The project or the range is played in a loop. 

Key:  Space bar 

 

Play in range 

If you have specified a range, selecting this menu option (or button) will start 
playback of the sample from the beginning; enter the range and continue to 
loop through the range until you press stop. This mode is very useful for testing 
loops for instrument samples. 

Key:  Space bar 

 

Play with preload 

All buffers are loaded and the playback is ready to be started. Another window 
will appear with which playback can be started at your convenience. No delays 
will occur. This function is useful on slower systems and if synchronization 
must be started in manual mode and an exact start has to be performed. 

Keys: Shift + Space bar 

 

Play only selected objects 

Play only selected objects 
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Only selected objects will be played. All unselected objects will be muted 
temporarily. If the play cursor is not at the first selected object’s time position, 
it will be reset. 

Key:  Alt + Ctrl + P / Alt Gr + P 

 

Restart play 

Playback will start at the beginning even during the actual playback. 

Keys:  Backspace 

 

Stop 

The playback is stopped for all projects types. 

 

Stop and go to current position 

The playback is stopped; the play cursor goes to the current position. 

 

Playback mode 

Change play direction 

The playback direction can be changed even during the actual playback. 

 

Loop mode 

In this mode, selected ranges are played in a loop. This corresponds to 
switching on the "Loop" button in the transport control. 
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Playback options 

The play parameters window which appears after selecting this menu option is 
designed to quickly enter playback parameters. 

 

Sample rate: The sample rate can be changed here as long as the sound card 
supports the new rate (some sound cards even support changing the rate 
while playing the sample). This is especially useful for hearing notes in a 
sample range played in a different octave. When selecting half the sample rate, 
the pitch should be the same. It would be played one octave lower. 

Device: Use this dialog box to specify the sound card's driver. This is 
necessary if playback takes place through a single sound card device, and is 
especially important if multiple output devices are located in the computer. 
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Autoscroll: This you to activate the "Autoscroll" feature. This is especially 
useful when working with large disk files. The HD wave project window will 
follow the play cursor during playback. When working in “2” or “3” section 
display mode, the autoscroll feature causes the individual sections to follow the 
play cursor as well. If you have zoomed into one of the sections, the play 
cursor will move through the section faster, resulting in more screen re-draws. 

You can choose between page and soft scrolling, but be careful: Scrolling 
requires CPU power (depending on the processor, graphics adaptor, and 
resolution), and the CPU may be overloaded in critical situations which may 
result in playback dropouts. Deactivate autoscroll mode if this happens. 

Scrubbing: If you "Insert" ("Insert", or "0" on the number pad), Samplitude 11.5 
Producer will switch to "Scrubbing" mode, and playback speed can be 
controlled directly by the mouse. The further to the right the mouse goes, the 
faster Samplitude 11.5 Producer plays. 

In comparison to many HD recording systems, this even works in a virtual 
multitrack project. 

Use scrubbing mode to find passages, crackling, etc. in material. The older 
generation of sound engineers are, no doubt, very familiar with this method 
from analog tape editing. 

There are two scrubbing modes ("P"): 

Relative: The relative distance between the play cursor (positions bar) and the 
mouse position can be used to control the speed. The play cursor follows the 
movement of the mouse. 

Absolute: You can also use the absolute position of the mouse in the window 
to control the speed: 

Left border = Double speed backwards 

Center = No movement 

Right border = Double speed forwards 

Tip for scrubbing: For buffer sizes (4000, 2000 samples) scrolling is "softer".  
Test if your computer functions at this buffer size without any playback errors. 

Combined with "Soft scroll", editing becomes very convenient on faster 
computers. 
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Record 

Starts recording. 

 

Record mode / Punch in 

Play while recording 

This option corresponds to the option in the recording options with the same 
name. 

 

Record without playback 

Use this option to record without playing the VIP. 

 

Punch in mode active 

This option activates the punch mode. Punch in and punch out are processes 
for automating the recording start and end of an audio segment. Once punch 
mode is active, the punch in record feature can be used to record audio 
segments without stopping playback. 

The requirement for this mode is an armed record track. Use the “Rec” button 
on each track to select it for punch recording! 

Punch recording can be done in two ways: 

1. Punch in/ out “On-the-fly”: This allows you to start the recording (punch in) 
at any time during the playback. Once the recording commences, it can be 
stopped at any time (punch-out), while the playback continues. 

This is very similar to tape based multi-track recorders, which allow you to 
correct mistakes during previous recording takes by overwriting segments of 
the tape. 

Simply start the playback with the space bar. Punch-in recording can be 
started by clicking "Punch record" in the toolbar. 

2. Punch in/ out with markers: The second method is to punch in and out of 
recording using special markers. This is a more automated way of dealing with 
punch-in/-out recording. This is useful when specific punch in and punch out 
points are determined and you don’t want to take any risks in possible 
punching in or out of the recording. "Punch in and out with markers" lets you 
specify the exact points where the recording should start and stop. To operate 
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in this mode, a range has to be selected which defines the beginning and end 
of the recording. The "Set punch-in marker" and "Set punch-out marker" 
functions are used to tell Samplitude 11.5 Producer where to punch in and 
where to punch out. Next, set the play cursor to an appropriate position prior 
to the punch-in point and start playback/recording with the "Punch record" 
button in the "Punch" toolbar. 

Important: When working with the punch in/out functionality, make sure that 
"Auto crossfade" mode is activated by clicking on the corresponding button in 
the toolbar. The auto crossfade will create smooth transitions between the 
takes. This helps to prevent little pops and clicks! 

There is also a way to perform looped punch-in recording. Simply select a 
range over the desired punch region. The range is played back until you stop 
the playback with the space bar. Each time the program loops through the 
range, new takes are recorded at the punch markers. To find the best take 
after the recording is completed, use the take manager! 

 

Record options 

This menu option opens the "Record" window. All necessary settings for 
recording can be entered here. If you don’t need to open the dialog again once 
it is set, just start recording using the record button on the transport control, or 
by clicking the toolbar icon  

 

Record mode: Select between stereo and mono and if you want to record the 
audio into a RAM wave project or to the hard disk as an HD wave project. 
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Preload: The "Preload" option allows you to load all the buffers before 
recording actually begins. This enables an immediate recording once you click 
the record button. Otherwise, Samplitude 11.5 Producer will load the buffers, 
and depending on the size of the buffers and the overall computer speed, this 
may take some time. 

Sample rate: Select the audio file's sample rate. Make sure that your sound 
card supports the selected sample rate.  

Resampling to 44.1 kHz: Some Samplitude 11.5 Producer versions can 
perform a real-time sample rate conversion to 44.1 kHz, if you are recording 
with a different sample rate. For example, a DAT tape is often recorded at 48 
kHz, but the tape needs to mastered and prepared for Red Book audio CD 
processing (44.1 kHz). Samplitude 11.5 Producer allows you to automatically 
convert the audio during the recording, eliminating the additional sample rate 
conversion step after the recording. 

Device: This selects the desired device driver you want to use for the 
recording. If you have more than one sound card installed in your system, this 
window will let you specify which card to use. Make sure the sound card is 
properly installed in Windows and is operational. If you do not see an entry in 
this window, check whether a device driver has been installed for your sound 
card. This usually is done during the software installation for your sound card. 

? (Device): By clicking the “?” button, you can check the recording capabilities 
of the selected sound card, i.e. information about the sound card driver and its 
capabilities. 

Info: Dialog for detailing sound card properties. If your sound card supports 
24-bit recording, you can activate this recording mode via the info dialog. 

Playback while recording: Simultaneous recording and playback is especially 
important when wanting to monitor existing tracks while recording a new track. 
This option allows you to turn the feature on. To conserve system resources 
and keep the recording error free on slower systems, you may need to turn this 
feature off. 

File name / Browse: The name of the audio file to be produced and the pre-set 
index path are displayed at the bottom of the recording window; both can be 
changed by clicking  "File" button. 

Set CD track marker: While the recording is running, you can set track 
markers by clicking "Set CD track marker" in the recording dialog. 
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Automatic recording stop: When this field is activated, recording stops 
automatically after approximately 16 seconds of silence. This allows you to 
make a recording without having to worry about stopping it at the end. 

Automatic CD track recognition: When this field is activated, track markers will 
be set automatically at the end of pauses between songs. 

Create VIP object with name: Samplitude 11.5 Producer allows you to choose 
whether you want to automatically create objects in a VIP once you are done 
with the recording. 

Monitor: This check box activates the VU meters. Please note that the correct 
recording device must be selected prior to beginning this. While recording, the 
LED control displays move slower, do, however, show each maximum level. 

Recording level: This display indicates that the signal level to be digitized is 
correctly set. Play the loudest part of the material to be recorded and watch 
the display. 

Low-level recording leads to a loss in sound quality, while high-level recording 
can produce unpleasant ”clipping” sounds. 

You can adjust the record level either on the sound source or with the mixer of 
your sound card. 

Osc / Correl: Opens the oscillograph or phase correlator. The oscillograph 
displays the wave form at the input in a scalable window. 

The phase correlator displays the phase level of a stereo signal. A vertical line 
corresponds to a mono signal, and a horizontal line corresponds to a 180° 
phase-inverted signal which usually indicates an incorrect cable connection. 

Tuner: For “tuning” guitars and other string instruments. A calibrating line 
appears when the A0 note is played. If deviating tones are played, the 
deviation can be read on the basis of the calibration line and the numerically 
indicated pitch is corrected accordingly. 

Record offset: This option allows you to specify an offset, which is calculated 
in samples. Sometimes it is necessary to compensate for any delays due to 
processing speed and other factors, such as your sound card’s ability to 
switch between playback and recording mode. Delays can occur between the 
recording and the playback of audio if the "Playback while recording" feature is 
turned on. This option allows adjustments if this occurs. Good values to start 
with are in the 20-2000 sample range. You can determine this value by playing 
a project with a distinct start in a multitrack VIP and recording it 
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simultaneously. You can then measure the offset precisely using the zoom 
functions. 

Set marker 1: You can drop markers into the project. The current position of 
the play cursor is used to drop a marker at positions you want to select for 
later clean-up or similar tasks. 

Record: Starts recording by activating this button.  

Stop: Stops the recording process. Samplitude 11.5 Producer will ask you 
whether you wish to keep the recording or delete it. 

Should the computer become overloaded due to swapping data or hard disk 
access for example, simply interrupt the recording with a click of the right 
mouse button or the space key. 

OK: Closes the record parameter dialog. 

Shortcut: "R" (second "R" starts recording) 

 

Monitoring 

New, more flexible input signal monitoring is now available via ASIO driver 
support. 

 

Monitoring > Input monitoring on/off 

This function activates/deactivates the input monitoring (corresponds with “Rec 
M” button on the transport control). When actively monitoring, the input signal 
of the tracks for active monitoring (loudspeaker button in the VIP or mixer is 
activated) are played according to the selected monitoring type at the output. 
Furthermore, the LED peak meters in the VIP and mixers react according to 
the input signal. 

Note: If the "Rec" button is activated on a track, then the loudspeaker button is 
activated simultaneously in order to switch on monitoring. 

 

Monitoring > Tape player monitoring 

The preset method for monitoring, similar to tape players and familiar from 
earlier versions of Samplitude 11.5 Producer:  
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When "Stop" is displayed, the input signal is rendered, "Play" renders the track 
contents, "Record" renders the input signal. If the option is deactivated, the 
user has to choose whether the input signal is shown or not. Use the "Force 
monitoring" button (small loudspeaker symbol beside/above the peak meter in 
the VIP/mixer).  

 

Monitoring > Peak meter monitoring 

This corresponds with the normal characteristics of the VIP, i.e. the track's 
peak meter displays the sound card input level. 

 

Monitoring > Software monitoring / Software FX monitoring 

Software monitoring for cards with ASIO drivers is also possible if the card 
does not support hardware monitoring (ASIO direct monitoring). 

Software FX monitoring also calculates the track effects into the monitoring 
signal with the exception of all high latency-affected FX inserts (e.g. FFT filters, 
dehisser, or vocoder). The amp simulator, however, is applicable. Samplitude 
11.5 Producer can therefore also be used as an effects device to play live 
directly. 

If you need all of the mixer effects, then use the conventional live input mode 
(functions without ASIO, but is afflicted with higher latencies). 

Furthermore, software or software FX monitoring must be active to be able to 
play VST instruments live using the "MIDI in" port. 

 

Move play cursor 

to beginning 

This option positions the play cursor at the beginning of the project. 

Shortcut:  Home 

 

to end 

This option positions the play cursor at the end of the project. 

Shortcut:  End 

 

to range start 

Sets the start position of the play cursor at the beginning of the currently 
selected range. 
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to end of range 

Positions the start position of the play cursor at the end of the currently 
selected range. 

 

To start of section 

This option positions the play cursor at the beginning of the visible section. 

 

Left/right movement in page/scroll mode 

Use these commands to move the play cursor to the right or left. 

In "Page" mode, the play cursor moves across the screen to the end of the 
visible section; at that point, the window view shifts to the start of the following 
section. 

In "Scroll" mode, the play cursor jumps to the middle of the section and 
remains there as the project moves through it. 

Shortcuts: 
Movement in "Page" mode:  Right arrow/left arrow  
Movement in "Scroll" mode:  Alt + left/right arrow 

Note: Once a range open is open, use the "left/right arrow" keys to control the 
beginning of the range. 

 

Object border left 

The play cursor jumps to the left to the next object edge in the selected track. 

Shortcut:  Ctrl + Q 

 

Object edge right 

The play cursor jumps forward to the right to the next object edge in the 
selected track. 

Shortcut:  Ctrl + W 

 

Marker left 

The play cursor jumps to the left to the next marker in the arranger window. 

Shortcut:  Alt + Q 
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Marker right 

The play cursor jumps forward to the right to the next marker in the arranger 
window. 

Shortcut:  Alt + W 

 

Section to play cursor/last stop position 

If you have not selected the option "Stop at current position" in "System 
options > Playback", then the play cursor may be set to the last stop position 
with this command. 

Shortcut:  Ctrl + Alt + , 

 

Marker 

Set markers 

An indefinite number of positions can be saved at the start position of the 
playback marker (position line). This enables you to set markers. 

Shortcuts: 

1 - 10 

Marker with name... 

Marker with automatic numbering 

Place marker at recording position 

Shift + 1 ... 0 

' 

Alt+? 

 

Jump to marker 

The new start position of the playback marker (position line) is set at the saved 
position of the corresponding marker number. Playback continues from the 
new start position. Please note that the range between the new start position 
and the end of the sample is played back. 

Shortcut:  1 ... 10 (via the alpha keyboard) 

 

Markers on range borders 

This function sets two markers to the beginning (S) and the end (E) of a 
selected range. 
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Set markers on silence 

This function sets markers on silent regions in the sample (only in wave 
projects, i.e. HDP or RAP). You can choose the minimal length of the pause, a 
threshold level, the start number, and a prefix for the marker name. 

This is very useful to select the regions of sample CDs, etc. 

Min. time (ms): This is the minimum length in ms of a ”silent” area.  

Threshold (dB): This is the maximum volume of a ”silent” area. The level of the 
area in the project will be set on the level of the threshold in the graphic 
display!   

Starting number: The markers will start to count from the number you type in 
this dialog box. 

Prefix: This allows you to insert additional symbols (letters would be 
appropriate), which will be placed in front of the marker-numbers. By doing 
this, you will able to distinguish between new and older markers.  

 

Delete marker 

The selected marker will be deleted. 

 

Delete all markers 

All markers of the project will be deleted. 

 

Set start marker 

This function/button sets the punch-in marker 

 

Set end marker 

This function/button sets the punch-out marker. 

 

Remove punch markers 

This function/button deletes the punch-in and punch-out markers. 

 

Set new tempo marker 

A new project first has a single “master” tempo which can be defined in the 
transport control or in the project settings (“I”). 

You can define unlimited tempo changes directly in the project window at 
anytime. The tempo marker is the most important tool as it can be used to 
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define a tempo change at a precise position, which can also be interpolated 
linearly to a previous tempo definition. 

 

Set new beat marker 

The time signature marker changes the type of beat after the marker position, 
e.g. from a 4/4 beat to a 3/4 beat. A new project first has a uniform 4/4 beat 
that can be defined in the transport control or in the project settings (“I”). 

Bar markers can only be inserted at the beginning of a bar. If an imported MIDI 
file contains bar changes, bar position markers are automatically generated. 

 

Set new beat position marker 

Beat position markers assign a specific musical position to a specific time 
position. This way, the bar frame/grid and MIDI events can be easily 
synchronized with existing audio material. 

 

Bar position markers (Advanced Tempo Mapping) 

The tempo of a piece of music is usually defined when it's composed. If you 
want to increase the tempo at a certain bar position, simply define a tempo 
marker, with tempo interpolation referring to the previous marker. 

However, recorded audio material often does not correspond with the project 
tempo, e.g. a drummer's reference track to indicate the tempo of further 
recordings or additionally composed material with many timing nuances. 
Instead of placing tempo makers or even having to adapt the reference 
material using time-stretching, you can create the musical grid at certain time 
positions in the linear course of playback of the project using support points; 
so-called bar position markers. This way you can synchronize the bar grid, 
musical grid, and the corresponding MIDI data with available audio material. 

Example: The drummer has recorded a track using a metronome, but has 
deliberately not hit important beginnings of a bar precisely. The musical grid is 
adapted to keep the groove within this performance. By placing a bar position 
marker, the project beat of “20”, including the beginning of the chorus, is 
moved exactly to the first beat of the 20th bar played by the drummer. 

This practical example shows that the bar position markers are used to 
combine the audio-based sample/time position (or SMPTE) with the musical 
bar position by means of defined support points. This allows for easy editing of 
projects with changing musical tempo when the musical grid is edited in the 
actual time course (e.g. bar 20 should begin a this point in time!). 
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A tempo marker is different in that it defines a clear command: Faster (or 
slower) from here. A bar position marker, however, defines the tempo indirectly 
by adjusting the tempo before the marker in such a manner that the desired 
musical position (“beat 20”) is met precisely at the marker position. 

The grid, the grid display, the metronome and the events in the MIDI editor are 
automatically adjusted according to the changed musical tempo. 

Note: Bar position markers immediately following a tempo marker always 
create a tempo run. Instead of a tempo jump, a bar position marker is used to 
set a tempo run if there is a bar position marker immediately before the tempo 
marker. As the tempo before the bar position marker has already been defined, 
the adjustment of the musical position has to be carried out by decreasing or 
increasing the tempo to such an extent that the required bar position meets 
the required time position at the bar position marker. 

 

Working with tempo and bar markers 

Creating tempo markers 
Tempo and bar changes in Samplitude 11.5 Producer are set directly in the 
project window using project markers. 

So, you have to create a marker to insert a tempo change at a certain 
playback position. There are several ways to do this: 

1. Tempo/beat marker window 
Set the playback cursor to the position where you would like the tempo or bar 
change to be. The option “Snap to grid” is very useful for placing the cursor 
directly on a bar or 1/4 bar. Click on the "Snap" button in the transport control 
("Tempo" section). Open the tempo/bar marker window from the marker menu 
(right click on time bar), or from the MIDI menu. 

Click on the “New marker” button in the window. A marker is inserted at the 
current position. You can now use the marker option to set the properties of 
this marker. For a new tempo marker, enter the required tempo in BPM or the 
new bar for the bar marker. 

Please observe that the settings are only valid for the markers currently 
selected in the marker list. For example, you cannot set the marker properties 
such as type or tempo after it has been created. 

Please also observe that a beat marker only makes sense at the start of a new 
beat. If the play cursor is at a different position, the marker position is 
automatically moved to the beginning of the next bar. 
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2. Marker menu 
Tempo and bar markers can also be created using the marker menu context 
menu and the MIDI menu of the program. You can of course assign shortcuts. 

3. Timestretch mouse mode: Click on the time border 
In "Timestretch mouse" mode you can create markers directly with one click 
on the required playback position. 

Tempo-marker: "Shift + Click" 

Bar position marker: "Alt + Click" 

Edit marker/ tempo/bar marker window 
If a tempo marker is changed or a bar position marker is moved, this influences 
the following markers and audio/ MIDI projects in the VIP. 

There are principally two possibilities: The time position either remains 
constant, or the musical position remains and the time position is adjusted 
(tempo/bar marker window). 

Illustration: The time position in the VIP is the absolute position within the VIP. 
The musical position is flexible, which is made clear by the grid. Maintaining 
the musical position therefore means that the objects or markers are adapted 
to the newly created grid and that their time position in the VIP therefore 
changes. If the time position is maintained, the musical position changes 
accordingly. 

When tempo markers are manipulated, the behavior of the markers, audio and 
MIDI objects can be controlled separately. With each presetting the musical 
(grid) positions are maintained for MIDI objects and tempo markers, as is the 
time position for markers and audio objects. The time position is always 
maintained if “Alt” is pressed while manipulating with the mouse. 

The time position, however, is always maintained for fixed tracks (preset). This 
can be changed in the tempo marker window. 
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In this example the first tempo marker in the second image has been changed. 
The MIDI object and the second tempo marker were moved correspondingly 
so that the musical positions (3:01:000 and 4:01:000) are retained. The time 
position of the audio object was not changed, so that its musical position has 
moved forwards (from 2:2:000 to 2:01:181). 

Further options: 
Each tempo and bar position marker can be ignored using the “Bypass” 
option. This occurs automatically for bar position markers if absurd bar 
positions are created while moving, e.g. if bar position markers are exchanged 
(bar 20 before bar 19) or are moved to a position within the project so that 
these bar positions that originate from a previous tempo marker cannot be met 
by tempo interpolation. 

Ignore all tempo markers: In the beat marker window there is an option for 
ignoring all tempo markers. In this case only the set project tempo is used (“I”). 

Manipulating the tempo marker in timestretch mouse mode. 

The timestretch mouse mode simplifies working with tempo markers. 

You can easily create tempo markers using "Shift + click". markers are then 
initialized according to the tempo. You can, however, adapt this tempo 
immediately by moving the mouse vertically holding "Shift" and clicking. 

Bar position markers are created with "Alt + click" and can be moved by "Alt + 
horizontal mouse movement" (without adjusting the time position), e.g. to 
manipulate the bar grid and to adapt it to available audio events. 

Tips, examples of use 

Loading MIDI files that include tempo changes: The tempo changes are 
adopted by the current project and are accounted for during subsequent 
editing and in the MIDI editor. 

Tempo markers can be placed when composing in the MIDI editor (these then 
apply to all tracks). Subsequent MIDI objects and tempo markers retain their 
musical position (advanced setting). 
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The grid can be adjusted to available audio events, e.g. assigning beat 
numbers to certain time positions. You can either use the “Set new bar 
position marker” menu command to create a marker at a position within the 
project and can assign the corresponding bar position or, for smaller changes, 
"Alt + mouse click" on the respective bar grid position and immediately move it 
to the required time position, e.g. to the beginning of an object. 

If the project includes MIDI data, this is automatically adjusted (preset). The 
newly created tempo grid is used in the MIDI editor for subsequent editing or 
for a new composition (e.g. quantization). 

When working with MIDI files and complex tempo changes the tempo map can 
be deactivated and, if necessary, the tempo can be reduced before recording 
new MIDI files. After recording, the tempo map can be used again. The newly 
recorded MIDI data is now adapted automatically. 

 

Ignore all tempo markers, use project tempo only 

All tempo markers are ignored, only the project tempo is used. 

 

Solo JamSession 

Read more on this topic in the Solo JamSession (view page 274) chapter! 

Shortcut:  J 

 

MIDI record modes 

The MIDI record modes define how the newly recorded MIDI data is inserted 
into the VIP if there are already MIDI objects at the recording position. 

 

MIDI panic – All notes off 

This command sends a note off command to all MIDI devices which are not 
deactivated in the MIDI options for all 128 notes on all 16 channels. 
Furthermore, sustain (Controller 64) is switched off and the pitch wheel and 
modulation are set to 0. In addition, an all notes off command is sent to all 
VSTi's used in the project. 
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If MIDI tracks or objects exist in the project, the same function is also 
accessible by clicking the stop button in the transport console or toolbar when 
the project is in "STOP" state. 
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Automation menu 

First entries in the automation context menu 

The first entry indicates which parameter you have automated, e.g. Effect 0 
volume or Effect 1 pan. By checking the corresponding entry you can activate 
the corresponding automation curve. If you haven't activated an element, No 
effect (track) will be displayed. 

 

Editing curves 

Create 

The curve generator will create a beat-based volume curve for you which 
pulses according to eighth, quarter, half, or full notes. As an option for the 
beat-based envelope curve calculation you can enter a minimum and 
maximum value, or define the delay values. 

 

Alternatively, you can also let the curve generator write an envelope curve 
scan. 
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Invert 

This command inverts the active automation curves. 

 

Thin out 

This function thins out the active automation curve by reducing the number of 
automation events. While recording, the automation events are placed in very 
short intervals. The command "Thin out" reduces the number of curve points. 
The course of the automation is then displayed and reproduced even more 
accurately.  

 

Copy / Paste / Delete 

The activated automation curve can be copied/pasted into other tracks and 
deleted. 

 

Inactive 

Use this command to deactivate the selected automation curve. This means it 
will remain intact, but no longer affect the corresponding parameter. 

 

Delete all curves 

This command deletes all automation curves of the corresponding track. 



 
 

 410 Automation menu  

www.magix.com

 

Automation mode 

Specify the Automation mode here. 

 

Do not display automation. 

Deactivate the display of the automation curves for all tracks with this option. 

 

Display track automation (default setting) 

If you select this display option, then only the track automation will be 
displayed. 

 

Display selected curves only 

This function displays only the selected curves for the corresponding track. 
This helps to keep an overview if several automation curves have been 
created. 

 

Display unselected curves (cannot be activated) 
(Default setting) 

The unselected automation curves are grayed-out. They cannot be activated 
with the mouse. 

 

Display unselected curves (can be activated) 

The unselected curves are also grayed-out, but can now be activated with the 
mouse. 

The last section of the context menu lists the ranges for which automation 
parameters are available during automation of the corresponding track or the 
corresponding object.  
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Effects menu 

These menu entries permit access to effects at object level. Nearly all effects 
are also available as offline effects (destructive effects), which is why the last 
menu item is "Apply effects offline" (exception – Vintage Effects Suite is not 
available as an offline effect). 

This menu features different options for adding high-quality audio effects to a 
wave project. 

Notes on destructive effect editing: 

 Most functions can be applied directly to a VIP object. 
 Please note that most functions only work within the selected range in the 

wave window. To apply the functions to the entire sample, the entire sample 
has to be selected (key A, see menu point "Range -> Range all"). 

 Selected objects in VIP projects are changed independently of the selected 
range across the entire range (the only exception here is the "Get noise 
sample" function).  

 If you don't want to change the entire object, then the object must be split first 
(select the desired range and press "t"). It's a good idea to activate 
"Auto-crossfade" mode (key combination B/A) to avoid crackling transitions. 

 It's even possible to apply an effect to several selected objects. If multiple 
objects are selected in the VIP, the effect will be applied to the audio material 
referenced by the objects one after the other. 

 A note regarding the different behavior of RAM and HD wave projects: For 
RAM wave projects, you can decide after editing if you want to keep the 
changed audio material. So far it has only been changed in the RAM of the 
computer. 

 To keep the result, you have to save the project back to hard disk (key "S"). 
 For HD wave projects, on the other hand, the altered audio material will be 

written directly to the hard drive. For testing purposes, it's recommended to 
proceed as follows: 

 Use the preview or test functions of the effects. 
 At first, use a copy of the audio material. Copy the selected range into the clip 

first (key: "C"). Now open or activate the Clip window and then select the 
entire clip (Key A). You can now apply your effects to experiment. 

 The dialog windows for effects included as non-destructive real-time effects in 
the mixer can be accessed directly via the mixer. Simply right click on the 
respective effect in the mixer to start. This way all the parameters are available 
in the mixer as well.  
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Amplitude / Normalize 

Amplitude / Normalize > Normalize 

This function modifies the sample’s overall amplitude. The data is altered so 
that the maximum amplitude occurring in a specified range is set to 100% (or 
any other value between 1-400%). Samplitude 11.5 Producer attempts to 
detect the maximum and relate it to the selected percentage, and then all 
other values are weighted with the new factor. 

 

The "Normalize" function is designed to fully modulate or overmodulate 
samples. this can be useful for processing done before conversion from a 
higher sample resolution to a lower resolution. Since the dynamic range of the 
low resolution is smaller, it still can be fully utilized by applying the "Normalize" 
function. 

When you are working with sounds from a single instrument, you should set 
the factor to 100%. 

If, however, your audio material has background percussion, then you will be 
able to overmodulate the sample up to 120-200%. This will only cut off the 
new percussion peaks. The same method allows you to alter the sound of 
natural instruments by overmodulating them (clipping). 

As preparation for further physical processing, e.g. filters, reverb, dynamic 
compression, etc., a level reduction of 50-70% is suggested. This should avoid 
clipping during post processing. 

Important: If the volume level during the recording is relatively low and the 
material is normalized later, the result will not be of the same quality if the 
recording level is maximized to its fullest range. If, for example, the volume 
level was only set to 50% of the possible range, the audio material will be in 
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15-bit quality. Even normalizing the material to 100% will not change this 
aspect. 

Editing mode: In virtual projects, a virtual normalization function is available. 
Sample data remain unchanged — the object volume is adapted in such a way 
that the loudest passage in the object equals 0 dB (corresponding to 100%). 
This virtual normalization is non-destructive and extremely fast!  

Selecting several objects: If you have selected several objects, then you can 
decide whether you want to normalize them individually or as a whole. 

Quick access: This section allows you to set the parameters for quick access. 
Instead of having to open the dialog each time you want to normalize, simply 
press “N”. 

Keys:  Shift + N 

 

Amplitude / Normalize > Loudness adaption 

This function raises the sound volume of all objects to the maximum level 
without the clipping the material. Unlike the master normalization function, 
each object is normalized separately. It serves the purpose of reconciling 
finished songs (each as one object) in volume. This makes the volume of the 
songs uniform.   

Titles with full volume control can still sound different, since a crucial factor in 
the perception of volume is also the relationship between the soft and the loud 
parts of a piece of music. The average loudness (RMS) of the song therefore 
has to be identified in addition to the absolute level (which is the loudest part of 
the song) and the object level has to be adjusted accordingly.  

Therefore, it may happen that songs with high peak values but a lower level of 
loudness are normalized to a value above 0dB (full volume). In order to avoid 
clipping, the limiter (see MultiMax) is activated automatically. 

Tip: Volume fluctuations within a song can be removed with the “Leveler” 
presets in MultiMAX. 

 

Amplitude/Normalize > Fade in/out 

This function allows sample ranges to be faded in or out. The amplitude is 
varied according to time characteristic from the beginning start value to the 
range's final end value. When the function is activated, a window appears to 
specify the operations's parameters. 
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A simple fade-in operation would be performed with the parameters from 0% 
to 100%, whereas normal fade-out requires specification from 100% to 0%. Of 
course, you can also try other values to achieve interesting results. The 
transitions can be created with different curve types, from logarithmic to 
exponential. 

Please note that high-performance real-time fade and crossfade options exist 
in virtual projects, which normally eliminate the requirement of using 
destructive fade routines. 

Key:  F 

 

Amplitude/Normalize > Set zero 

Sample data values in a selected range are set to zero to eliminate noise and 
imperfections in a sample (reversible). 

 

Dynamics 

Dynamics 

Fundamentally, the compressor is an automated, dynamic volume controller. 
The dynamics of a piece are limited, loud sequences remain loud, quiet 
sequences become louder. Compression is often used to add power to audio 
material or to increase the loudness. The level of compression is adjusted by 
the ratio controller, while the activation threshold is determined by the 
threshold. You can also influence the attack and release. 

Editing is carried out using a “look-ahead” method, similar to high-quality 
studio appliances. There are no peak over-modulations or other artifacts, as 
the algorithm can never be ‘surprised’ by sudden level peaks. 

 

Sensor field: You can intuitively influence  the sensor field  of the 
compressor with mouse movements. The graphics  color and the respective 
effect settings change in response to each other. 

Ratio: This parameter controls the amount of compression. 



 
 

Effects menu 415  

 

www.magix.com

Threshold: Set the threshold, above which compression is applied. 

Attack: Sets the algorithm's reaction speed to increasing sound levels. Short 
attack times can create an undesirable "pumping" sound, as the volume is 
quickly reduced or increased correspondingly. 

Release: Sets the algorithm's reaction speed to falling sound levels. 

A/B: If you have selected a preset for the effect and make manual changes to 
it later, you can compare the original preset sound with the new settings by 
using the A/B-button. 

Reset: This resets the effect device to its original neutral starting point where 
minimal processing power is required and no effect is added to the sound. 

Load/Save: Here you can save the current settings as an effect file so that they 
can be used on other projects as well. 

 

Multimax 

MultiMax is a compressor with three independent frequency bands. The 
dynamics are edited separately for each band. 

The benefit of a multi-band compressor in comparison to a "normal" 
compressor is that the "pumping" tendency and other disturbing side effects 
are dramatically reduced when editing the dynamics. For instance, it can 
prevent a bass top peak from "reducing" the entire signal. 

Multi-band technology also lets you specifically edit individual frequency 
ranges. 

 

Link bands: When this function is activated and one fader is adjusted, all 
faders are changed in the same ratio. However, the way the dynamics are 
edited is not affected. 

Limiter: MultiMax includes a limiter that prevents clipping by automatically 
lowering the level if it is set too high. Quiet parts remain unaffected.  
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High quality: When the "High quality" setting is activated, an even more 
precise algorithm is used which, however, requires more processing power. 
We recommend that you switch on this setting before you export the project. 

Bass/Mid/High: These knobs control the level of compression for each 
frequency band. 

Setting the frequency bands: The settings of the frequency bands are 
changed directly in the graphic. Simply click on the separator lines and move 
them. 

Presets 

In MultiMax, you can use the presets to open further special functions: 

Dynamic expander: Too high a compression rate will result in audible noise 
(usually defined as a pumping sound). Radio recordings in particular are 
recorded with very high compression rates to increase the perceived volume. 
Unfortunately compression reduces the dynamics (interval between the 
quietest and loudest part). The expander enhances the dynamics of the 
recording. 

Tape NR-B Decoder: Samplitude 11.5 Producer simulates decoding of Dolby 
B + C noise suppression if no Dolby player is available. Cassettes recorded 
with Dolby B or C sound more muffled and slurry if played back without 
corresponding Dolby.  

Noise Gate: This cleaning function completely suppresses noises which are 
below a certain volume threshold. This lets you create song transitions that are 
entirely noise-free, for example. 

Leveler: This setting automatically sets the entire material to an identical 
volume level. The volume control knob is no longer required. You can use this 
function to equalize greater volume differences within a song. To equalize 
volume variations between different songs, you can also use the function 
"Loudness adaptation" from the Effects menu. 

DeEsser: These special presets are for removing overstressed hiss sounds 
from speech recordings. 

 

am-track SE 

This familiar and high-quality vintage compressor offers a combination analog 
compressor and tape simulator. High-quality tape machine sound emulation 
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makes typical aspects of the large, saturated sound characteristics of 
magnetic recordings a digital-quality reality. 

 

Frequency/Filter 

10-Band EQ 

The 10-band equalizer subdivides the frequency spectrum into ten areas 
(‘bands’) and equips them with separate volume controls. This way it is 
possible to create many impressive effects, from a simple boosting of the bass 
to complete elimination of a certain range of frequencies. Note: If low 
frequencies are boosted too much, the overall sound level is heavily increased 
which may lead to distortion. In this event, adjust the overall volume downward 
by using the "master volume" control situated in the main screen. 

 

Slider controls: Each of the ten frequency ranges can be separately boosted 
or turned down with the ten volume controls. 

Link bands: Using this button flexibly combines the frequency ranges with 
each other to avoid artificial-sounding overemphasis of an individual frequency 
range. 

A/B: If you have selected a preset for the effect and make manual changes to 
it later, you can compare the original preset sound with the new settings by 
using the A/B-button. 

Reset: This resets the effect device to its original neutral starting point where 
minimal processing power is required and no effect is added to the sound. 

Touch screen (right EQ section): This is the "sensor field" of the EQ. Here you 
can draw any type of curve with the mouse. This will be immediately translated 
into a corresponding control setting on the left side of the EQ. 

 

Parametric EQ 

This menu item opens the Parametric Equalizer (view page 98). 
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FFT Filter 

The FFT filter enables the wildest filter effects to be drawn simply with the 
mouse. 

 

A red line can be drawn in the graphic field using the mouse. The left side of 
the graphic is for the lower frequencies of the sound, the right for the higher. A 
"mountain" in the left part of the graphic creates a large increase in bass, a 
"mountain" in the right increases the highs noticeably. Often, interesting effects 
can be achieved when the filter curve is deleted for the entire range (i.e. set 
completely to the lowest value in the display). This practically deletes the 
sound. Now a pair of mouse clicks in the upper display area will only make 
individual frequency ranges audible, this way a normal drum loop is quickly 
turned into into a "science fiction" sound. 

Freehand drawing: With this pencil you can draw "freehand". Draw or rotate a 
straight line by pressing and holding the "Shift" key. 

Quantized drawing: This activates a quantization function to draw straight lines 
and angled figures. The farther away from the curve you are, the wider the 
bulge in the range. This effect can be increased with the "Ctrl" key. 

Reshape tool: This drawing tool lets you bend existing curves. Deformation 
can be achieved by pressing the mouse button repeatedly. 

Navigation tool: This lets you move the displayed area. 
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Zoom tool: With the left mouse button you can zoom into the display; zoom 
back out with the right. Keep the left mouse button pressed to drag out zoom 
areas. 

Reset: The Reset button quickly allows you to place the filter curve into the 
initial state again.   

Preset: Access the presets for certain applications here. 

Level: The "Level" slider allows you to enhance or diminish the differences in 
the curve movement. The result is a stronger or weaker modulation. 

Vol: The "Volume" controller controls the volume of the material. 

Sound cloner: With the sound cloner you can determine the sound 
characteristic of a song and transfer it to others. This way you can, for 
example, create a Pat Metheny song in the style of Madonna's producers. 
Load a track you really like, set the song's playback position and press the 
"Learn" button.  

Scale options: Accesses a settings dialog with options for scaling FFT curves 
(view page 371). 

 

Scaling options (FFT filter) 

Freq: This switch lets you choose between a logarithmic ("log") or a linear ("lin") 
frequency scale. The logarithmic display corresponds to the human perception 
of pitch. Like on the keyboard of a key instrument, the (graphic) spacing of the 
intervals, i.e. halftones, is uniform across the entire range. 

Freq.log: The upper labeling of the graphic can be switched between output in 
"Hz" or "Notes". Note output is only possible via logarithmic frequency display 
("log"). 

Value display: Here you can set a logarithmic or linear display as well as an 
enlargement of the filter curve. 

Value range: Here you can set the displayed value range in dB. 

Curve display: Here you can switch between a bar and a curved display. 

 

Filter 

Opens the Vintage Effect Suite's Filter (view page 107). 
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Delay / Reverb 

Room Simulator 

This function lets you add a high-quality room simulator to the audio material. 

 

Reverb type: Here you can choose between a short, medium and long sustain. 

Reverb share: Here you can set the balance between the original signal 
(without reverb) and the actual reverb. 

Preview: This button activates the preview function. A short reverb section is 
calculated and then played so that you get an impression of the settings. 

 

Reverb/Delay 

 

The reverb effect device offers newly developed and very realistic reverb 
algorithms to add more room depth to your recording. 
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Reverb 

Reverb gives you a high-quality reverb which can be specified further using the 
“Room Size”, “Time” and “Color” and mixed into the original sound with “Mix”. 

Room size: This controller controls a room simulator, which calculates the 
reverb effect according to the room size. If the controller is turned all the way 
to the left, then it sounds as if the audio object was recorded in a very small 
room. If it is turned all the way to the right, it sounds as if the audio object was 
recorded in a cathedral. 

Time: This is where you set the reverb tail's length, i.e. the sound's "sustain" 
level. 

Color: Control the sound of the reverb here,  dampen or brighten it. 

Mix: This controller determines how much of the unprocessed original sound 
(dry signal) is subjected to reverb (wet signal). Application of this effect in an 
AUX bus requires the controller to be set to 100% (all the way to the right). 

 

Delay 

This effect is like an echo which delays the signal and repeats it. 

Delay: This sets the period of time between the individual echoes. The more 
the control is turned to the left, the faster the echoes will follow each other. 

Feedback: This adjusts the number of echoes. Turn the dial completely to the 
left, there is no echo at all; turn it completely to the right and there are 
seemingly endless repetitions. 

Mix: This fader determines how much of the unprocessed original sound (dry 
signal) is subjected to the echo (wet signal). Application of this effect in an AUX 
bus requires the controller to be set to 100% (all the way to the right). 

 

efx_StereoDelay 

Opens the Stereo Delay (view page 117) in the essential FX (view page 117). 

 

Delay 

This opens the Analog Delay (view page 103) feature in the Vintage Effect 
Suite. 
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Time / Pitch 

Resample / Timestretching 

Opens the timestretching/resampling/pitchshifting editor. 

Note: If you only want to change the sample rate of an audio file, then use the 
"Adjust sample rate" option from the "Effects" menu. 

 

All algorithms in this dialog use the time factor parameter and pitch as input 
parameter.  

The time factor calculation (from the original length/original speed and the 
length required/speed required) can be comfortably activated on the right side 
of the dialog. 

 

Resampling 

Samplers and PCM synthesizers transpose samples during this procedure. 
Time factor and pitch are dependent upon each other; the shorter the audio 
material, the higher the pitch. This effect is comparable with changing the play 
back speed of record players or tape recorders.  

The effect is relatively loss-free, and the sound loss is less than all 
timestretching/pitchshifting procedures. If pitch change is justified by changing 
the speed (and vice versa), use this algorithm. 

When lengthening the audio material by resampling, very small aliasing effects 
may occur. The anti-aliasing filter helps correct this. Alternatively, since this 
filter creates additional CPU load, it can be activated for computation and 
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real-time previewing. The filter is also available for the other algorithms that use 
internal resampling during pitchshifting.  

 

Default 

"Standard" applies an algorithm which usually delivers very good results, 
including factors from 0.9 to 1.1, and operates in phase-locked mode to 
maintain the room effect of stereo signals. For drum loops or other "beat 
heavy" material, this algorithm is only partially suitable, since it can change the 
groove and even fade out or double beats in rare cases. 

Time compression (sample length is reduced) is more successful with this 
algorithm than timestretching, i.e. it is better to reduce the longer sample than 
vice versa when adjusting two samples to another. 

 

Smoothed 

A considerably more complex algorithm is used which requires more 
processing time. The material can now also be used on very large factors (0.2 - 
50) without bringing about strong artifacts. The material is "smoothed", making 
the sound softer and emitting it at an adjusted phase level. This smoothing is 
hardly audible with speech, singing, or solo instrumentation. Problems may 
arise with more complex spectra (sound mixes from various instruments or 
finished mixes). This algorithm is not very well suited to drum loops and other 
material with strong transients. The groove remains intact, but the attacks are 
slurred because of phase shifting. With small corrections (factor ca. 0.9 - 1.1) 
the setting of the smallest possible smoothing value should be used.   

Recommended for: 

 Orchestra instruments: String instruments, wind instruments, etc. 
 Speech, single voice, and multi-voice sections 
 Speech with background noise like video sound, etc. 
 Synthesizer areas, guitars, etc. 

Not suited for: 

 Stereo mix 
 Drum loops, percussion 

CPU strain: very high 

 

Beat marker slicing 

This mode focuses on customizing drum loops, but can also be used on other 
material like monophonic bass runs or sequencer lines. The algorithm splits the 
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material into individual components, individual notes, or beats, which are then 
selected via the beat marker. 

These "snippets" are then compiled into the new temporal measure. If the 
tempo is increased, then individual beats begin overlapping; if it is slowed 
down, then short pauses between the beats become audible. 

If this algorithm can be used, then it should be, since the time change occurs 
without any loss of quality at low CPU strain. 

Recommended for: 

 Samples which can be split into individual notes or beats. 
 Drum loops, if the beats do not overlap and there is not much reverb. 

Definitely not suited for: 

 Everything else where beat markers do not exist; the algorithm fails completely 
and silence is the result. 

CPU strain: minimal 

 

Beat marker stretching 

This algorithm functions similarly to the standard algorithm. Unlike the previous 
algorithm, this one synchronizes the stretched material with the beat markers. 
The groove remains perfectly intact, and duplicated or faded-out beats do not 
occur. Unlike the "Beat marker based slicing" algorithm, this algorithm doesn't 
fail fully when there are no markers, or when the markers are placed 
incorrectly, but the synchronization quality may be reduced or contain errors. 
In practice, automatic marker generation is usually enough for good results. 
You should avoid having beat markers which follow one another very closely 
(<1000 samples). 

 

Monophone voice 

This is a special timestretching and pitchshifting function for vocal solos, 
speech, or solo instruments. The material cannot contain background noise, 
and excessive reverb may also be detrimental to its effects. With suitable 
material the audio quality is very high. 

With the "Use formant correction" option the formants remain the same when 
pitchshifting, i.e. the "Mickey Mouse effect" does not occur. This way, realistic 
background choirs can be "composed" from just one solo voice. However, the 
formants can be shifted by +/- 12 half tones, and vocal distortions can result.  
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Typical usage of this algorithm: 

 Intonation correction: The note with the imprecise pitch should be cut out as 
an object, so that it can be manipulated independently of the other notes. 

 Harmonizer effects: An object with vocals can be copied and moved down. If 
the pitch is changed, then the second voice will be changed, etc.  

 Generating background vocals from existing vocal samples 
 Timestretch/Distortion of a speech sample, to make a "grandfather" voice. 

Recommended for speech, single voice vocals, single voice instruments 
without overlapping, with low reverb and low background noise. 

 

Elastic Audio easy 

Opens the Elastic Audio Easy dialog (view page 141) to edit monophonic 
material and to create harmonic voices. 

 

Distortion 

Distortion 

The Distortion effect (view page 111) in the Vintage Effect Suite opens. 

 

BitMachine 

This opens the BitMachine (view page 112). 

 

Vandal SE 

Vandal SE is a high-quality guitar amplifier simulation that will raise the heart 
rate of any guitar fan! 
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Restoration 

Declipping 

Samplitude 11.5 Producer contains a special function for removing digital 
clipping and analog distortions. Who isn't familiar with this situation? You've 
got a flawless live recording, but the decisive sections are overmodulated, 
rendering the recording useless. 

 

Using sophisticated algorithms, the overmodulated passages are interpolated 
based on audio material surrounding the clipping area. The entire volume of 
the material can then be reduced so that the interpolated parts can be played 
back without overmodulation. The De-clipping algorithm is particularly suitable 
for audio material with clearly audible overmodulation, e.g. distorted piano or 
vocals. The sound of overmodulated drumbeats on the other hand is hardly 
ever improved upon. 

Min. level of clipped samples: Here you can enter the level at which the 
algorithm will consider a sample to be clipped and correct it. This is important, 
as different sound cards show different clipping behavior. Some DAT recorders 
have a protective analog switch, so that the level never reaches the digital 
mains. In this case, a value of -0.5 dB or less is suitable. 

With an input of, for example, -6dB, all samples above half the control level are 
registered as overmodulated and recalculated. 

This way, material damaged by analog means can also be repaired. 
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Dehisser 

The Dehisser eliminates regular “white” noise, typically produced by analog 
tape recordings, microphone pre-amplifiers, or AD transformers. 

 

Noise Level: Here you should set the threshold of the DeHisser as precisely as 
possible. Values that are too low will remove the hissing insufficiently. 
Incomplete deletion of hissing produces artefacts and should be avoided. 
Settings that are too high lead to dull results – noise-like signal components 
(such as the blow-off of wind instruments) are also removed. 

The setting doesn't cause any problems at a reduced hissing level. 

Noise Reduction: Here you can adjust the dampening of the hissing in 
decibels. It is often better to reduce hissing by -3- to -6 dB rather than as 
much as is possible so as to keep the sound "natural". 

Removed hiss: The part of music that was filtered out by the DeHisser can be 
previewed for testing purposes. 
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Remove DC offset 

 

This function removes the DC offset of an object. This can be useful if your 
sound card overlays your sample with a constant DC offset during recording, 
which leads to crackling during playback or editing. 

 

Stereo / Phase 

Switch channels 

This function switches the left and right stereo channels.  

This is useful for correcting recordings with switched channels. This function 
can be reversed if you don't re-select the range; opening it again will bring 
back the original material.  
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Stereo FX 

The "Stereo FX" enhancer lets you edit the justification of the audio material in 
the stereo panorama. If stereo recordings sound unfocused and 
undifferentiated, an extension of the stereo base-width can often provide a 
better transparency. 

 

Base width controller: Adjusts the base width between mono (on the extreme 
left), unchanged base width (center), and maximum base width (”wide”, on the 
extreme right). Reducing the base width can produce a rise in the level. In 
extreme cases – when the left and right channels include identical material and 
the base width controller is pushed to the left on ”mono” – the result can be a 
level rise of 3 decibels.  

Raising the base width (values over 100) diminishes the mono compatibility. 
This means that recordings edited this way sound hollow when listened to in 
mono. 

Volume controller: Adjusts the volume of every single channel, thereby 
adjusting the entire panorama. The damping of left and right levels is displayed 
in dB underneath the controllers. A centered recording can later be moved to 
the left or right of the stereo picture.  

Stereo meter: This provides a graphical display of the phase relation of the 
audio signal. You can use it to review the justification of the signal in the stereo 
panorama and the effect of the stereo enhancer.  

In order to achieve the greatest possible compatibility with mono, the display 
should come closest to a diagonal line. Otherwise some frequency ranges may 
cancel each other out if the stereo signal is played on a mono device. 

Karaoke preset: This preset opens a special karaoke effect that more or less 
eliminates vocals. It deletes middle frequencies typical for human vocals during 
playback so that someone else can do the singing.  
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Invert phase 

The sample data is inverted along the amplitude axis, which means that 
negative values become positive and vice versa. This function allows you to 
adjust recordings with different phases to one another. 

An incorrect phase occurs if during an analog recording parallel cables are 
switched. To correct such errors, some mixers have a switch that can be used 
to invert the phase of an input. If you press the switch by mistake, errors might 
occur as well. 

This function is reversible, so if you repeat it, the original signal is restored. 

 

Modulation / Special 

Vocoder 

The vocoder principle: Carrier material (e.g. a surface sound or a synth chord) 
is affected by a modulator (e.g. language or singing) so that one gets the 
impression that it is speaking or singing. Rhythmic surface sounds can also be 
developed if modulated with a drum loop.  

This is done via the transmission of the frequency characteristics of the 
modulator (speech) on the carrier (chord).  

  
 

Carrier input 

Here you have to select the desired carrier sample. Some special carrier 
samples that have been loaded automatically from the "Vocoder" directory are 
listed. 

 
Use the "Carrier sample" check box to load any number of 
samples of the current project or predefined carrier sample. 

 Here you can play the carrier on its own for test purposes. 

Noise: This controller lets you add noise to the carrier sample. This makes 
sense if the carrier material can not be modulated sufficiently or is irregular. It's 
good for "filling" drum loops which have too many pauses between the beats. 
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Material containing all frequencies in equal amounts are particularly suitable, 
such as strings, orchestra chords, broad synthesizer pads, hissing, or wind 
noise. 

 

Filter 

Dynam: Influences the dynamics of the modulator signal to reduce the 
modulation depth of the vocoder. 

This prevents two often undesired side effects of modulation. On the one hand, 
the volume change of the modulator signal is added to the output signal in a 
slightly more moderate form which may improve the power of the vocoder 
voice. On the other, the low-level share of the modulator signal is ignored in 
order to prevent modulation of the carrier by breathing or noise. 

Smooth: Affects the speed at which the vocoder adjusts to the modulator 
spectrum. The greater the value, the "lazier" the vocoder follows the modulator 
and the "smoother" the sound changes in the carrier sound.  

 

Filter graphic 

Any frequency characteristic can be drawn in to optimize the results of the 
vocoder. For example, simple disturbing bass frequencies can be eliminated as 
the curve is corrected downwards to the left. Similarly, weak highs can be 
strengthened as the curve is raised to the right. 

 

Mixer 

In the mixer you can also mix parts of the carrier and modulator signal to the 
vocoder output signal ("Out").  

If the output signal of a track is used as a carrier in the vocoder, this track will 
be muted first, and then you can make it audible again in the vocoder mixer. 

 

Presets 

You can select predefined vocoder settings in the"Preset" list window. The 
presets all contain vocoder settings, except the selected carrier signal. "Reset" 
restores the vocoder default settings. 

 

efx_ChorusFlanger 

This opens the Chorus/Flanger effect in the essential FX. 

 

efx_Phaser 

Opens the Phaser in the essential FX. 



 
 

 432 Effects menu  

www.magix.com

 

Chorus 

This opens Chorus (on page 109) in the Vintage Effect Suite. Chorus is one of 
the most familiar and popular effects. 

 

Flanger 

Flanger (view page 105) is less known, but is a indispensable effect for many 
applications and is also available in the Vintage Effect Suite. 

 

Tape simulation 

The Tape Simulation adds a feeling of "warmth" to digital recordings that 
sound "cold"; something that used to be created by the tape saturation effect 
of analog equipment. 

 

Sample manipulation 

Change sample rate 

Use this function to change the sample rate of a whole audio file. This may be 
needed to convert a DAT recording at 48 kHz to 44.1 kHz for use on an audio 
CD. 

 

After choosing the new sample rate you can select a file name for the new 
project. 

If the resolution is increased the sample rate change will take place without any 
quality loss, and the sample material will not experience fidelity reductions, but 
the required hard disk space will increase. 

If the resolution is reduced, then the overtones or high frequencies may be lost 
during the sample rate change. For example, if the resolution of a 44.1 kHz 
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sample is reduced to 22.05 kHz, the frequency response of the resulting 
sample is reduced to 11.025 kHz. The frequency response is always half of the 
resolution specified. For a conversion from a 48 kHz sample to 44.1 kHz, this 
loss in quality is not significant, since the human ear only recognizes 
frequencies up to 20 kHz. (A resolution of 48 kHz is often only used because 
the digital to analog conversion can take place with much higher precision 
without a lot of effort.) 

Please note that resampling to 44.1 kHz can also be done while recording in 
real-time. 

The "Playback parameter" window ("P") contains a "Vari-speed" option for 
real-time resampling during playback. The "Record" window ("R") lets you 
resample to 44.1 kHz in real-time from any of the selected sampling rates. 

 

Reverse 

The sample data in the selected range is reversed along the time axis, i.e. the 
file will now play backwards with the end placed at the beginning. This can 
create very interesting effects, not to mention hidden messages frequently 
rumoured to be in various songs.... 

This function is reversible: if you do not select a new range, activating this 
function again resets the original material. 

The option is only available when working in destructive editing mode, i.e. on 
an HD wave file directly. 

 

Build physical loop 

This function utilizes a complex algorithm for optimizing loops in wave projects. 
It is useful when samples are to be used for instrumental sounds as well as the 
wave table synthesizer. 

Before you can process a sample you need to select a range in your sample 
that already defines the rough edges of the sample loop. Remember that you 
can shift and vary a range during playback to find the best loop position. A 
comfortable way to look at the loop positions is by activating the split range 
mode (“B”). The sample will be displayed in 3 sections. 

To gain an interruption-free loop, the outer limits of the range will be set to 
zero. By applying a crossfade to the material at the loop end containing the 
sample data in front of the loop beginning, Samplitude 11.5 Producer will 
create a "smooth" transition between loop's end and beginning. 



 
 

 434 Effects menu  

www.magix.com

When a marker is set in front of the selected range, the range between the 
marker and the beginning of the loop will be used for the crossfade. This offers 
you a feature found in professional hardware samplers. To achieve a short 
crossfade set the marker close to the loop beginning. To receive a long 
crossfade position the marker further away from the loop beginning. 

Notice that the distance between marker and beginning of the loop range 
needs to be smaller than the loop range itself to make a crossfade possible. 

 

Plug-ins 

 

This dialog allows you to use Microsoft DirectX and VST-compatible plug-ins 
for effects calculation in Samplitude 11.5 Producer. This allows you to use 
almost any effect algorithms of third parties in addition to the effects integrated 
in Samplitude 11.5 Producer.  

Samplitude 11.5 Producer's mixer enables plug-ins to be integrated as 
real-time effects. The plug-ins must be able to process audio data blocks 
instantly and completely without changing the length. This is normally the case 
for most plug-ins (e.g. reverb, echo, dynamic compressors, etc.). Other 
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algorithms are excluded here (e.g. timestretching plug-ins because of the 
resulting length-changing effect). 

 

Working method and use 

When you open the plug-ins dialog you will see a list of the DirectX and VST 
compatible plug-ins that are installed on your computer on the right-hand side. 
Activate one of them and press the arrow in the middle; the activated plug-in is 
transferred into the list of active plug-ins to the left. The surface of the plug-in 
is also opened to make specific changes to the effect settings. You can set up 
a chain of effects in this way, but it is important to ensure that the plug-ins are 
all compatible with one another. For instance, stereo and mono plug-ins must 
not be coupled together. The plug-in selected in each case in the list on the 
left can be deleted again with the “Remove” button. 

 

Dialog buttons 

Save/load: The two buttons in the upper right of the dialog field enable a 
complete plug-in setup (the sequence of plug-ins and all their set parameters) 
to be entered and saved. Plug-in setups can therefore be conveniently 
transferred if different options for plug-in use in Samplitude 11.5 Producer are 
used. 

Copy/paste: Entire plug-in configurations can be transferred between different 
tracks and objects.  

Play/stop: This button activates the real-time preview of the active plug-in 
listed on the left. This function is ideal for testing the settings of a plug-in if it 
operates quickly enough for real-time calculation. 

Settings: Opens the following dialog... 

 

DirectX / VST plug-in set-up 

 The “Write DirectX logfile” option only serves support purposes and should 
normally be switched off.  

 The “Start all object-related plug-ins” option can be activated at play/start. 
Some plug-ins cause delays when switched on, and in this case they should 
be switched on at play/start, because otherwise there could be a failure when 
the relevant object starts to play. 

 Deactivate all DirectX effects during the scrubbing/jogging: Under certain 
circumstance DirectX plug-ins can cause errors during the scrubbing/jogging 
or simply break down. With this option the link to the DirectX plug-ins can be 
deactivated and thus circumvented. 
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Essential FX 

MAGIX Essential FX is a collection of "bread and butter effects" for the most 
important applications. They are embedded as VST plug-ins (MAGIX plug-ins 
directory) and may be used in the object or in the track. For object application, 
see "FX plug-ins" in the "Audio effects" chapter or "Track effects" in the "Mixer" 
chapter. 

These are simple but solid tools with clear feature sets for daily application. 
They include fewer controllers and require less resources. 

 

Stereo delay 

The stereo delay is a simple too for typical bread and butter delay effects. The 
"analog algorithm" qualifies as a special feature that produces the sound of 
echo devices from the old days. 

 
 

Stereo delay parameters 

 Mode: This selects between the essential algorithms. 
 Digital: Normal, transparent delay 
 Analog: Simulation of a bucket brigade delay (BBD). These devices, which 

originate from the pre-digital era, used analog building blocks for storage. The 
signal was held for a short time in a relatively simple circuit and then moved on 
to the next. This "bucket brigade" principle created a longer signal delay. But 
since each element of the chain led to a loss of the signal and would increase 
the system noise with longer delays, the devices would use a compander: At 
the input, the signal's dynamics are compressed, and then they are expanded 
again at the output end. The simulation in the eFX delay mimics the loss and 
compander behavior to produce these typical audio characteristics, especially 
at longer delay periods and higher repetition rates (feedback). 

 Delay L/Delay R: Specify the delay period for the left and right channels here. 
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 Tempo sync: If this button is active, the plug-in is directed at the 
host/sequencer tempo. In this mode, changes are made to the delay period 
via the L/R delay using the musical snap grid (e.g. 1/4 note). 

 Damping: This specifies the cut-off frequency at which the highs are 
dampened during the delay. This useful for making the delays reverberate 
more naturally or for creating special effects (reggae/dub-style effects). 

 Feedback: This parameter regulates the internal amplitude of the delayed 
signal that is fed back to the input. In "Digital" mode, this process is 
completely transparent; in "Analog", on the other hand, higher values, a very 
loud input signal, or the sum of these will make the use of dynamics 
compression audible. In both modes, the nullification of the feedback 
parameter is in the center of the fader. To the right, the plug-in works in "Dual 
delay" mode (both sides work independently), and to the left, "Ping pong" 
mode will be activated (the delayed signal alternates between the left and right 
sides). 

 Mix: Regulates the mix ratio of the original signal and the delayed portion. 

 

Chorus/Flanger 

This plug-in offers a simple way to make signals sound more interesting, 
"spacier", thicker, etc. by modulating or delaying the pitch. The classical 
domain of application is for guitars, Hammond organs, electric pianos, or 
synths. 

Chorus and flanger are two closely related effects, which is why we have 
included them in a single plug-in. They normally differentiate in terms of delay 
time, type of modulation, and degree of internal feedback. 

 
 

Chorus flanger parameters 

 Mode: 

- Mono chorus: In this mode, the signal is fed through a delay unit and the 
pitch is modulated. Original and delay copy are mixed into a monophonic 
output signal. 
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- Stereo chorus: Compared to mono chorus, two copies of the original are 
created, modulated against each other, and then fed accordingly to the set mix 
ratio to the left and right output channel. 

- Mono flanger & stereo flanger: Similar to the other modes. In this case, lower 
delay periods and a slightly changed modulation are processed. 

 Rate: This specifies the speed of the modulation. Lower rates provide slight 
hovering effects, and high speeds produce a wobbling, typically distorted 
"underwater" sound. 

 Depth: This parameter specifies the depth of the modulation, i.e. the 
maximum deviation of the modulation and the resulting pitch bending. 

 Feedback: This parameter defines the portion of the delay that is sent back to 
the input. Feedback causes the effects of modulation to be more drastic and 
cutting.  

Nullification of the feedback is set at the middle of the fader. Set to the right, 
the feedback is fed to the input equi-phasal; to the left, the feedback occurs. 
Both variants may sound very different depending on the signal, since they 
prefer different frequency ranges for dissonance. 

 Mix: Regulates the mix ratio of the original signal and the delayed portion. 

 

Phaser 

The phaser is often mistaken for a flanger due to its typically sharper and 
cutting effect. In any case, the pitch is not modulated. Instead, the modulation 
process burrows multiple notches into the frequency response, somewhat like 
a comb filter. Just like an airplane taking off, the phaser functions with a similar 
jet effect. It is suitable for enduring signals like synth surfaces or for producing 
sound designs like atmosphere or distortion effects. 
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MAGIX Plug-ins 

Chorus 

This opens Chorus (on page 109) in the Vintage Effect Suite. Chorus is one of 
the most familiar and popular effects. 

 

Delay 

This opens the Analog Delay (view page 103) feature in the Vintage Effect 
Suite. 

 

Flanger 

Flanger (view page 105) is less known, but is a indispensable effect for many 
applications and is also available in the Vintage Effect Suite. 

 

Process only left (right) stereo channel 

Only the left/right channel of a stereo wave project will be affected by effects 
when ”Left/Right processing only” is activated. This options is only available 
when in wave editing /destructive editing mode. The same effect have the L/R 
buttons in the lower left corner of the wave project window.   

 

Waveform Generator 

This menu entry opens the Waveform Generator. 

 

SMPTE Generator 

This menu entry opens the SMPTE Generator (view page 273). This serves to 
create SMPTE timecode, which allows you to synchronize external, analog 
material. 

 

Apply effects offline 

All effects opened using this menu are calculated destructively, provided the 
option "Apply effects offline" is active. You do, however, have the option to 
work with a copy to be able to keep the original audio material. The "Create 
copy" option is already selected in the corresponding dialog. 
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CD menu 

The CD menu contains all special functions for audio CDs and CD mastering 
processes, e.g. setting CD tracks and subindexes as well as the "Create CD" 
function. The options at a glance: 

 

Load audio CD tracks 

This menu entry opens the dialog for loading audio CD tracks (view page 245). 

 

Make CD 

This opens the dialog for burning audio CDs (view page 241, view page 312). 

 

Indices (Track markers) 

Set CD track index 

Use this function to set track markers (index makers). All subsequent markers 
will be re-numbered automatically. Every title of a CD requires a track marker 
that is usually set after a short pause and before the start of the next title. 
Every track has to have a minimum length of 4 seconds. The maximum length 
of a track is limited by the CD that usually has a capacity of 74 minutes (or 650 
MB of data memory). 

Use the function "Indices at object borders" to automatically create a track 
maker at every object in the VIP or activate the special CD arrange mode 
before adding the new objects to the VIP! 

To manage or rename the markers, use the Marker/CD Track Manager (Tools 
menu). 

 

Set subindex 

Use this function to set a sub-index marker on the current play cursor position. 
All sub-index markers behind the insertion point will be renumbered. 

Sub indices are not necessary for your CD but useful for selecting several 
regions in one track.. 
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Set pause 

Use this function to set a pause marker on the current play cursor position. 
This lets the CD player switch the output to absolute silence while continuing 
playback until to the next track index/marker is encountered. 

 

Set CD end 

Use this function for setting an end marker for the CD you want to burn. 
Without the end marker, the CD you want to burn comprises the entire project 
to the project end. 

 

Set track markers automatically 

If you are inserting a larger audio file which contains various titles (for example 
a live take, or recordings on DAT), then you can automatically insert track 
markers between the titles using this function. 

 

Set track indices on object edges 

This function sets track markers (Index markers) automatically at the beginning 
of each VIP object in the first VIP track. 

Prior to using the function, execute "Remove all indices" to delete any possible 
track markers. 

If there are multiple objects that make up a single track or title, then you may 
want to use the "Bouncing" function to combine the objects to ensure proper 
track assignments. 

 

Remove index 

Use this function to remove a previously set track or subindex marker. First, 
click on the marker (the small rectangle below the number), and then activate 
this function to delete it! 

 

Remove all indices 

Use this function to remove all previously set track or sub-index markers. This 
can be helpful before calling the function “Set track markers on object edges”! 

 

CD track/index manager 

This dialog displays all the CD tracks and sub-indices in the current project in a 
list. If you select the markers, you can change their numerical position in the 
list via the corresponding time input field and name or rename them. 
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CD index options: Enables you to activate 
different options for the individual CD 
tracks, including Preemphasis, Copy 
Protection (SCMS), and Second 
Generation Protection. These settings can 
also be transferred to all indices. 

CD text settings: Opens a dialog for 
entering CD text information. 

You can set new markers, CD tracks, CD 
sub-indices, and CD pauses by clicking on 
the corresponding buttons. 

Delete selected: Deletes the selected 
markers. 

Delete all Markers: Deletes all markers. 

Play Marker: Starts playback from the 
position of the selected marker. 

Play Loop: Plays a loop around the marker. 

Stop: Stops playback. 

OK: Applies your settings. 

 

CD disc options 

This dialog configures settings for the current CD.  

 

CD title 

The title is written to the CD and is used in the TOC printer application to print 
the CD information. 

 

UPC / Ean code 

This code is also written to the CD and can be requested by special CD 
players that work with this format. 
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Number of first CD track 

Under certain circumstances, such as writing with "Track-at-once", the number 
of the first track can be determined with this setting. When using the 
"Disk-at-once" mode, this setting does not have any significance. The CD will 
always start with track 1 in this mode. 

 

CD text / MPEG ID3 editor 

This function allows you to supply data regarding a song or CD content, such 
as album, artist, etc. 

 

MP3 files do not only transport audio data, but also information about the 
coded music piece through so-called “ID3 tags”. These are file appendages 
into which an encoder can write standardized information. The ID3 tags are 
recognized by the decoders and displayed as music data by the MP3 player. 

 

Set pause time 

Use this function to set the length of the default pause between two tracks. 
The pause length is needed for the grid function which lets the sample objects 
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snap to the edges of other objects + this pause time. Normally a pause time of 
2 seconds is used. 

 

Set start pause time 

Use this function to set the length of the default pause before the first track. 
Normally a start pause time of 2 seconds is used. 

 

CD arrange mode 

If you activate this menu feature, Samplitude 11.5 Producer will arrange the 
next objects introducing a Red Book-standard pause between them.  

The following procedure highly recommended: 

 Open a new VIP with 4 tracks (for example), so that you may reedit it later on 
 Activate the "Special CD arrange" mode in the CD menu 
 Load wave files, audio tracks, or make a recording using the microphone 

You will notice gaps in the VIP between the individual objects; these represent 
the inserted breaks. You can adjust the length of the included pauses in the 
adjust pause length dialog, if you want. 

 

Get CD info (FreeDB Internet) 

Select this option to request FreeDB information for an audio CD. This function 
requires an Internet connection. You must be registered to use the FreeDB 
features. 

 

FreeDB options 

Submit CD to FreeDB 

Allows you to add a CD to the online CD database. The FreeDB™ project 
relies on user contributions to keep an updated database available. 

If you own a CD that’s not in the database, you may add it to the database.  

 Insert the CD in the drive 
 Select “Add CD to FreeDB” 



 
 

CD menu 445  

 

www.magix.com

 Enter data in the dialog. Please double check your data. 
 Press “OK” 
 Your contribution should be online after an hour or two 

 

Clear FreeDB cache 

The FreeDB™ online database assigns a cache to your hard disc containing all 
files that can be read online . This allows you to read files without having to go 
online. This option allows you to delete the cache.  

 

Show CD-R drive information 

This dialog shows you information about the active CD-R drive(s). Among the 
information displayed is the manufacturer, drive name, hardware revision, 
cache size, and the features supported by the drive mechanism. 

The “Disc at once” feature is extremely important, since it is needed to 
produce Red Book compatible audio CDs that are accepted as masters by 
pressing plants 

 

Show CD-R disc information 

This dialog shows information about the currently inserted CD-R media. The 
most important information is the maximum length that cannot be exceeded 
during the production (i.e. 74 minutes and 5 seconds). 

 

Audio ID 

It's possible to identify audio files with this function. In contrast to 
Freedb-Suche (view page 444), the audio file does not need to be a part of an 
album or CD, and it doesn't even need to be played back completely. 

Samplitude 11.5 Producer analyzes typical sound characteristics of a song or 
part of a song and sends this data as a query to the Internet server. The server 
compares this "acoustic  fingerprint“ with saved information about already 
known songs and then provides the required song information. 
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View Menu 

This menu contains tools for manipulating Samplitude 11.5 Producer's display. 

 

Mixer 

Opens the mixer. Please refer to the "Mixer" chapter! 

Key:  M 

 

Multitrack recorder MR-64 

This menu entry opens the multitrack recorder (MR-64). The multitrack 
recorder (MR-64) looks like a hardware mixer and can also be operated in the 
same way. It can also be launched as an alternative to the current mixer 
interface to make multitrack recordings just like with a real mixer. The MR-64 
unites the advantages of the analog look with digital technology: realistic 
appearance, direct workflows, and familiar functionality. 

Keyboard shortcut:  Shift + M 

 

Mastering Suite 

This opens the Mastering Suite. 

 

Transport control 

The transport control window contains the most important commands for 
playback, recording, and positioning. 

"Start", "Stop", "Forward", and "Rewind" buttons: These allow positioning 
similar to that of any audio player. 

Right clicking the "Playback" button opens the playback parameter window for 
the stereo master operation. This lets you determine the sample rate, playback 
device, and the scrubbing/varipitch options. 

Record: Starts recording for all active tracks. This means that tracks with the 
red REC button enabled need to be configured with the proper recording 
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devices prior to starting the recording. Right click on the REC button for each 
track to select the device. 

Right clicking "Record" displays the record parameters window. This lets you 
make settings such as "Playback during recording", and also lets you record 
material directly from the record parameter window. 

Time display: This displays the current playback position of the project. 
Double clicking on the window lets you numerically enter a new playback 
position. Clicking the green arrow lets you set various units of measurement. 

L/R time display: This displays the length of a selected range and is editable 
by double clicking the display. 

Marker 1-12: Clicking on one of the marker buttons saves the current playback 
position to the button. If it already contains a previously saved position (marker 
appears in light color), the program will place the playback position to the 
saved position. A right click clears the button memory and allows you to store 
a new position to the button. 

Marker: This button open the marker manager for more detailed marker 
editing. 

Punch: This button switch Samplitude 11.5 Producer into punch record mode. 
This means that the recording process can be started any time during 
playback. This is also called "On-the-fly recording". This can be repeated 
numerous times. Punch-in and out markers are set automatically. You can 
stop a punch in recording process with another click on the record button. 
However, this does not stop the playback of the project. 

Punch in: This sets the punch in position. 

Punch out: This sets the punch out position. If the both the punch in and 
punch out markers are set, the punch recording can be started with the 
"Playback" button. The program will play back the project until it reaches the 
punch in point. 

Sync: This button opens the synchronization window. 

Loop: The loop button activates loop mode, meaning that playback continues 
to loop through a previously selected range. 

RCMON: This button activates Samplitude 11.5 Producer's "Record 
monitoring" feature. All tracks that have their REC buttons activated are 
monitored with the peak meters. The inputs of the audio device(s) are directly 
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routed to the outputs of the sound card, if the sound card offers this 
functionality (check with your sound card manufacturer). This offers the same 
functionality as with audio players. 

Scrub >>  <<: These buttons allow you to scrub through your project. During 
scrubbing the playback of the project continues with varying speed while the 
playback direction can be changed. This also offers a convenient way of 
finding audio sections such as clicks or mistakes in the audio material. 

Jog & shuttle wheel: The transport control includes a jog & shuttle wheel 
which you can use to "scrub" over the files. The "Scrubbing" function behaves 
like the editing function of an audio player. The motor is switched off, the tape, 
however, remains at the sound head. With a digital system it is more difficult to 
realize scrubbing as there are no mechanical moving parts. Turning the tape 
reels manually moves the material slowly along the player. Using the scrubbing 
function in Samplitude 11.5 Producer is similar to using a tape player, since 
playback follows the movement of the mouse. Quickly moving the mouse 
increases the playback speed, while slowly moving it decreases the speed 
accordingly. 

Tempo: In the tempo section of the transport console you can change the 
playback speed and the beat of the whole arrangement. All objects in the VIP 
are adapted to the speed of your choice with timestretching. 

"Tap tempo..." opens a dialog where you can "tap in" the beat by clicking on 
the "Tap" button, or by pressing the "T" key on your keyboard. 

In addition, you can fade in the bar grid with the "SNAP“ button and switch on 
the metronome click with the "CLICK“ button. 

 

Time display 

Shows or hides the time display window 

This lets you read the current position while externally synchronizing large 
sections. Fonts and colors of the display can be selected in the context menu 
(right click on the time display). 

In the context menu of the time display the number of lines/fields that are to be 
displayed can be set between 1 and 5. For each line/field the size that is to be 
displayed can be selected from the menu. 
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Double clicking lets you edit the sizes (with the exception of the current mouse 
position and the current mixer value). 

The most important options: 

Position/Start of range: Displays the current position of the current play 
cursor, or of the beginning of the range. When moving the objects, you can 
see the starting position of the object here. Should you enter a negative 
number into the range when editing, the play cursor will be set to the end of 
the range. 

Range length: "Object -> Object Length; negative number" saves the end of 
the range instead of the start of the range. 

End of the range: "End of the object, negative number -> Start of the range". 

Current mouse position: Not editable 

Current mixer value: Value of the mixer fader which was just changed, or the 
volume or pan fader in the VIP; not editable. 

 

Visualization 

The visualization meter is a floating control which enables you to meter 
(measure) the audio in a variety of ways. 

You can choose between the following display options: Peak meter, 
oscilloscope, phase correlator, spectroscope, and spectrogram. 

The settings of the meter can be adjusted by right clicking on the meter and 
selecting the appropriate adjustment. Use the mouse to click on setup. A 
context menu now opens in which you can set the value ranges, update 
speeds, drop times, and colors. You can also reset the peak values. 

 

Peak meter 

 

The peak meter provides an exact display of the volume level. 
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Oscilloscope 

 
 

Phase correlation 

 
 

Spectroscope 
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Spectrogramme 

 
 

Tuner 

Tune guitars and other instruments with this option. The visualization will 
display a calibration line at note A0. If different tones are played, the deviation 
is indicated by the calibration line, and the tone pitch is displayed numerically 
and can be corrected accordingly. 

 
 

Export tool 

This menu entry opens the Export page (view page 35) for easily exporting the 
current project. 

 

Managers 

Please also read the corresponding chapter The managers (view page 262). 

 

Track editor 

This menu entry activates or deactivates the Track editor (view page 58) in the 
arrangement window in Samplitude 11.5 Producer. 
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Rebuild graphic data 

Display inaccuracies after complicated sample processing can be fixed by 
using this menu option. The screen (window) will be cleared and redrawn to 
display the project properly. 

 

Sections 

Samplitude 11.5 Producer allows the optional display of one, two, or three 
sections of the samples belonging to one wave project or the VIP itself. Other 
audio editing applications usually show only one window of a sample. 

If you select “2”, Samplitude 11.5 Producer will display the same sample in two 
window sections. Each section can be handled separately, and it is possible to 
represent the complete sample in one section and a zoomed-in version of a 
certain range in the other. 

“3 sections” mode is especially useful for searching for loop points in wave 
projects. 

The whole sample can be shown in the upper section, while the section on the 
lower left displays the beginning of the loop range and the section on the lower 
right the end of the range. Use the split range function for this purpose ("B"). 

Return to "1 view"  (Shift + B") 

This is only an example of the “3 view" mode. All sections can be handled 
independently.  

You can also drag ranges over the section borders. Establish the starting point 
of a range by holding the mouse button pressed and changing over to another 
section. Samplitude 11.5 Producer will show you the size of the range; release 
the left mouse button at the desired location to determine the end of the range. 

 

Hide submix / AUX buses 

This function lets you hide or minimize the tracks of the mixer buses. Please 
read the corresponding notes in the mixer chapter. 
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Grid view 

Show grid 

Defines the type of grid used for the "Show grid" option. Choose from several 
line styles. 

Key:  # 

 

Grid lines 

Defines the type of grid used for the "Show grid" option. Choose from several 
line styles. 

 

Units of measurement 

In this submenu, you can adjust the various measurement settings. They will 
affect the start and length details of the current range in the project window, 
the grid measurement, and the position details of the play cursor (position line). 
Measurement units like samples, milliseconds, SMPTE (with different frame 
rates), bars, and CD-MSF are commonly used. 

 

Snap to grid 

This function switches the grid on and off. 

When working with virtual objects the "virtual grid" becomes available. Objects 
can only be shifted to the beginning, to the end, or to the hot spot of another 
object. The reference point is usually the beginning of the object to be shifted 
to. A hot spot will be used as a reference point as well once defined. 

If several objects have been selected, the move is performed by lining up the 
beginning of the last selected object in the sequence with the reference object 
or grid point. All selected objects maintain their relative position to each other. 

This option can be used to easily rearrange objects with their audio patterns 
and gain sample-exact connections. 

Key:  R 
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Snap and Grid Setup 

In this dialog you can enter the type of grid and its activation.  

 

Grid: Here the grid can be switched on/off globally. 

Object grid: Activates the object grid. This lets objects snap exactly to the 
edges of other objects. 

Range grid: Activates the range grid and enables the "current range to be 
used as the grid basis". 

Beat grid: Activates a grid with bars as the base. 

Frame grid: Activates a frame-based grid. 

Grid offset to project start: Here the grid offset can be set relative to the 
beginning of the project. "Current position as grid start position" specifies the 
current position as the grid's zero position. 

Bar/BPM: Here the bar type (counter/signature), the tempo in beats per minute 
(BPM), and the timer resolution in peaks per quarter (clicks per quarter note) 
can be entered. 

Also use grid offset for grid: The grid offset is used as a reference size for the 
grid. 

Shortcut:  i 
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VIP display 

Definition 

Opens the general settings dialog in Design -> Display options (view page 
493). 

 

Mode 1 

Mode 1 has been selected for displaying virtual projects 

 

Mode 2 

Mode 2 has been selected for displaying virtual projects 

This mode also includes an enlarged display of volume and panorama points, 
and you can quickly switch between normal and enlarged display modes with 
"Tab". 

 

Change mode 

Switches the display of virtual projects between both modes. 

Key:  Tab 

 

Overview mode 

This mode provides navigation and overview in the arrangement. The actual 
arrangement window displays an overview of the arrangement. Selection 
matches the section which can be seen there. 
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Select a specific range in the overview and the corresponding section length in 
the arrangement will be zoomed into. Use the right mouse button to zoom in 
vertically. A single mouse click moves the visible section to the selected 
position. 

 
 

Horizontal 

This menu contains all the functions of the horizontal (red) position bar. 

 

Vertical 

This menu contains all the functions of the vertical (blue) position bar. 

 

Cascade 

This function arranges all open windows in a cascade style. 
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Tile 

All open windows are moved next to each other, making use of the whole 
display area. This is useful when dragging physical sample ranges into VIPs. 

Keys:  Enter 

 

Untile 

This function will return the window order to the previous state. 

Keys:  Shift + Enter 

 

Window 

Arrange icons 

All icons are rearranged along the lower portion of the screen. 

 

Close all windows 

Closes all opened projects. Before closing a window/project, Samplitude 11.5 
Producer will ask you whether you would like to save the project. 

Shortcut:   H 

 

Iconize all wave projects 

This function will reduce all wave projects to their icons to make room for the 
display of the virtual projects. 

 

Hide all wave projects 

This function will hide all wave projects to make room for the display of the 
virtual projects. 

 

Half height 

The Samplitude 11.5 Producer screen is shown in the upper half of the display. 

This is particularly useful if you want to simultaneously use a sequencer 
program so that both programs are operated simultaneously, without having to 
switch between programs with "Alt + Tab". 
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Toolbars 

Main toolbar 

Please use this command for hiding or showing the main toolbar (view page 
68). Here you will find buttons for frequently used Samplitude 11.5 Producer 
commands. 

A check behind the menu item indicates that the toolbar is visible. 

 

Position bar 

Shows or hides the positioning bar on the lower portion of the display. 

 

Mouse mode toolbar 

Shows or hides the mouse mode toolbar with buttons to select different mouse 
modes in VIPs. 

 

Range bar 

Shows or hides the range bar on the lower portion of the display. 

 

Workspace bar 

Displays or hides the workspace bar at the bottom part of the screen. 

 

Button bar 

Shows or hides the button bar at the bottom part of the screen which includes 
the 4 buttons "Object editor", "Visualization", "Transport", and "Mixer". 

 

Tabs toolbar 

This toolbar contains buttons for the step-by-step mode (view page 25). 

 

Menu search 

This toolbar is a search field. Enter the name of the function you are searching 
for or a keyword that you need help with and Samplitude 11.5 Producer will 
search for the corresponding function or help topic. 

 

Internet bar 

This toolbar enables access to Catooh, magix.info and MAGIX News Center. 
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Status bar 

Shows or hides the status bar on the lower portion of the display. A tick behind 
the menu point shows that the status bar is visible. 

The status bar is located at the bottom of the screen and describes the current 
status of the program. 

 

Tasks menu 

In this menu you will find direct solution and short video explanations on how 
to perform tasks in different topics. Not only will you find step-by-step 
instructions for sound and pictures here, but you also find quick access to 
many of functions.  

If you click on an entry with a camera symbol, then you will open a short 
tutorial video which displays a solution. Entries without camera symbols offer a 
solution to the problem immediately. 
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Online menu 

This is a list of menu entries regarding all of the services that are available 
directly from within Samplitude 11.5 Producer. 

 

Catooh – the Online Content Library 

Catooh provides you with high-quality photos, videos, and music for every 
theme, expanded by intelligent iContent with professional Soundpools, DVD 
menu templates, and brilliant MAGIX ShowMaker styles to help you make your 
photo, video, and music projects reality. All of this is available directly from 
your MAGIX software. 

Just choose "Online" from the menu "Catooh" to set up an Internet connection. 

Browse through the thematically sorted categories or view the results directly 
by entering a keyword. After downloading, you can drag the objects from the 
Media Pool directly into your arrangement. 

Tip: Read the introduction online http://rdir.magix.net/?page=JRF6LASAR2Z3! 

 

MAGIX Online Album 

With MAGIX Online Album you can publish your photos and videos directly to 
the Internet. You can also play your music as MP3s in the Online Album. 
Create your personal album website in no time with your own Internet address 
and showcase everything that's fun about multimedia to the world. 

 

http://rdir.magix.net/?page=JRF6LASAR2Z3�
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magix.info 

Share your knowledge & get answers This MAGIX service offers you and the 
MAGIX Community at large a central platform for exchanging knowledge, 
photos, videos, and music, for discussing and evaluating, for communicating 
with one another, for presenting yourself, and networking with other members.  

 

You will find the sections "Questions & Answers", "Show & Discuss", "Online 
Training", and "Chat" where you can play an active or passive role in the 
MAGIX Community. For this there's not only the www.magix.info 
http://www.magix.info/uk portal, but magix.info directly in your product. 

Ask questions online 

If you have questions or problems with your MAGIX program or you're looking 
for tips & tricks concerning multimedia, then you're at the right place. 

Display all questions & answers... 

Use the questions which other community members have asked and the 
collective knowledge of the answers to improve your own working methods, to 
solve problems, and to get to know the details of Samplitude 11.5 Producer. 

Launch the online training center 

http://www.magix.info/uk�
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Learn not only theoretically, but also practically what the program is capable 
of: "learning by doing", quickly and uncomplicated. 

Let your friends view the contents of your MAGIX.info screen over the 
Internet on their PCs. 

Ideal for viewing photos and videos together or for receiving support for 
questions arising during your creative workflow while using the program (a 
licensed client will be installed for this purpose). 

 

More online services 

MAGIX Website Maker 

MAGIX Website Maker helps you create a personal Internet showcase with a 
professional design in just a few mouse clicks – without prior knowledge, 
including your own chosen domain and email address. Publish slideshows and 
videos and accessorize your site with music and various effects  – anything 
from a simple business card to a fireworks display of effects, professional or 
private – show your best side! 

More about this topic can be found under MAGIX Website Maker. 

 

MAGIX Screenshare 

This function makes it possible for you to offer assistance to other users 
directly via the Internet, or to get help from others. To do this, you have to 
register Samplitude 11.5 Producer first. 

Hint: To inform the screensharing guests of exactly what is being shown, it is 
also a good idea to telephone or chat simultaneously. 

 

Register as host for a screen transfer 

1. If you want to start a screenshare instance yourself, then you have to 
register as a host first. To do this, open the menu "Online" and then select 
"Screen transfer as host...". 

2. In the dialog you can enter a name for the screen session. Your user 
account name is used here by default. 

3. Now click on "Start session". A small window will now open in the bottom 
right corner which displays the status of your screen session. A number will 
also be displayed (session ID) which serves as a password for your guests.  
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4. Start the screenshare instance. 

 

Register as guest of a screen session 

1. You have to register as a guest to view a screensharing instance. To do 
this, open the menu "Online" and then select "Screen transfer as guest...". 

2. Enter the password you received from your host (8-digit session ID). 
3. Now click on "Start session". A window will open displaying a smaller 

version of your host's screen. 
 

Manage login details 

These are options for managing user names (email addresses) and the 
associated passwords so that you are able to access your Online Services 
without having to enter the details each time. 

This information applies to all of my Online Services: If this option is 
activated, then the account details you have entered will be applied to all 
Online Services. Deactivate this option if you have different details for individual 
services, then choose the corresponding service via "Select service and enter 
the associated login details.  

 

 

Upload song to Soundcloud 

Soundcloud® is a community that is especially designed for musicians. The free 
version provides 120 minutes of storage space for your songs. Every song may 
be embedded as a player widget into external websites; the widget even 
allows comments along the timeline of the song and an optional download of 
the original song. 

For more information about the possibilities provided by the Soundcloud® 
community and the different premium accounts see 
http://www.soundcloud.com. 

http://www.soundcloud.com/�
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Help menu 

Help 

This command is available for almost every feature of the program, and it 
opens the "Help" file for the corresponding topic. Use this command to get 
help on any of Samplitude 11.5 Producer's functions. 

Keyboard shortcut: F1 

 

Help index 

Use this command to show the index of the help. From this page you can jump 
to specific commands or read through the instructions step by step. 

 

Context help 

Use this command to get help about any part of Samplitude 11.5 Producer. By 
pressing the "Context help" button in the top tool bar, the mouse indicator will 
become an arrow with a question mark. Then, click on any button or menu in 
one of the tool bars. Information about this topic will then be displayed. 

 

About Samplitude 11.5 Producer 

Copyright notices and version numbers are displayed. 

 

Watch the introductory video 

Use this command to start the introductory video, which outlines the major 
functions of Samplitude 11.5 Producer in a straightforward way. 

 

System information 

A window is displayed, containing information about the memory status and 
other parameters. 



 
 

Help menu 465  

 

www.magix.com

Particularly useful is the display of the free storage on all connected disk 
drives, the system resources being utilized by Samplitude 11.5 Producer and 
the memory usage. Make sure the parameter for system memory used by 
Samplitude 11.5 Producer never grows larger than the displayed overall 
system memory available (physical RAM). If this happens, the performance of 
Samplitude 11.5 Producer is reduced caused by page swapping (virtual 
memory) done to compensate for the missing memory. 

 

MAGIX auto-update 

Automatically searches the Internet for updates to Samplitude 11.5 Producer. 
An Internet connection must first be provided for this purpose. 

 

MP3 Encoder activation 

Why activate? 

For importing (decoding) or exporting (encoding) specific audio and video 
formats you require a suitable codec for importing or exporting such formats. 
Integrating third party de- and encoders usually incurs costs. By offering you 
such costs as an option and not including them in our programs in general, 
MAGIX will in future also be able to offer to you our software at good value for 
money. 

 

How does activation work? 

Activation is fee-based and can be done online or via post/fax. The quickest 
and easiest way to order an activation code is via the Internet. Ordering the 
activation code takes just a few minutes via email. The order of your activation 
code via post/fax takes a few days.  

 

This is how activation works: 

Order activation code online 
Click on "Order online..." (Field 1). Your web browser will open where you can 
register your Samplitude 11.5 Producer first (if you have not already done so). 
You will then be forwarded to a website where you can request the 
corresponding activation to be carried out. 

Order activation code via post/fax 
After clicking on "Order via post/fax" (field 2) your user code will appear. This 
automatically assigns your personal activation code to your PC. Click on 
"Continue to order form" to transfer your user code automatically to the 
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post/fax form. Now send the completed form as a print out to the address/fax 
no. mentioned. Once payment has been processed successfully, your 
activation code will be sent to you in the post/via fax in just a few days. 
Optionally it can also be sent by mail if an email address is stated.  

Enter activation code 
After receiving your personal activation code, you can use the activation dialog 
for the corresponding file format to start exporting for the respective format. if 
you receive the activation code via email, then copy it into the input field in the 
dialog and click  "Activate...".  

 

Activation problems 

Problem: The entered code is incorrect (telephone activation) 

Make sure your entry is correct; in most cases a typo is to blame. 
If the code is entered correctly, dial the number of our Call Center. Our support 
staff will help you personally. 

The MAGIX website won't open 

Check your Internet connection; you may have to use manual dial-up. 

The form for ordering via post/fax won't open 

 Check that an adequate text editing program is installed and activated (for 
example, MS Word). 

I still haven't received an email with the activation code 

 Check that your inbox isn't full. 
 Have a look in your spam folder. 

You can always send questions via email to our support whenever you like. 
Please have the following information at hand so that we can assist you as 
quickly and as specifically as possible. 

 Complete product name 
 Exact version number (to be found in the about box in the "About" menu item 

of the "Help" menu) 
 Encoder/Decoder name 
 Your user code (accessible via the "Activate via post/fax" dialog) 

Problem: I have installed Samplitude 11.5 Producer on a new computer, 
installed a new hard drive in my old computer (sound card, memory...), or 
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installed it multiple times on the same computer. My activation code is no 
longer accepted! 

If the program cannot be activated again after it has been activated multiple 
times, please contact the MAGIX customer service (view page 12). 
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Preset keyboard shortcuts 

All preset keyboard shortcuts can be displayed via the "Export list" option in 
the "Edit Keyboard Shortcuts, Menu and Mouse" (view page 489) dialog. 
Select "Copy" to copy the list to the clipboard and to add it to a spreadsheet 
or word processing program later. 

 

Mouse 

Center click Start/Stop playback 
Wheel Horizontal scrolling 
Shift + Wheel Fine tuning for active dials/faders 

+ Ctrl Horizontal zoom 
+ Shift Vertical zoom 
 (Enlarge/diminish waveform) 
+ Ctrl + Shift Vertical scrolling in VIPs (tracks) 
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General settings 

You can access the project-independent Samplitude 11.5 Producer settings 
this way. These settings are also global. 

"Easy mode" displays a simplified dialog with the most important basic 
settings. 

Keyboard shortcut: Y 

 

System / Audio 

In the “System” menu, you have options to fine-tune Samplitude 11.5 
Producer.  

In detail, these are: 

 Audio playback settings (playback devices) 
 Audio record settings (recording devices) 
 Program options 
 Paths/Skins 
 View options 
 Color setup (colors) 
 Metronome settings (MIDI options) 

Most of the dialogs can also be activated separately via the different menus 
and are explained at a the corresponding position. In the following, you can 
find the explanations on system settings directly via the system/audio dialog. 

 

Audio setup (audio playback settings) 

The installed sound cards are listed in the large window at the top of the 
dialog. The "Device info" button opens a small dialog. There you will find 
information on the sound card activated in the adjacent window (supported 
sample rates, manufacturer, etc.). 
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Device address/driver communication 

Here you can specify the bit resolution for addressing the audio driver for 
recording and playback. Usually, resolution selection is automatic. If the output 
device is not able to output at the desired resolution (e.g. 24-bit), Samplitude 
11.5 Producer automatically creates an appropriate lower resolution (dithered) 
which is then sent to the driver. In certain circumstances, if the driver triggers 
error messages (because it registers certain resolutions but can not actually 
play/record them), you can force a 16-bit driver address. 

Driver system 

You can choose between MME, multi-channel MME and ASIO. MME is the 
standard Windows multimedia driver system. multi-channel MME (WDM 
compatible): try to use this driver if your sound card supports 24/32-bit audio 
playback and problems occur when playing back high-resolution audio files. 
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ASIO 

However, if your sound card model uses ASIO drivers, you have some distinct 
advantages over MME: 

MAGIX LoLa is included, a universal ASIO driver which can be applied by many 
sound cards which do not have ASIO drivers. 

 Lower latency of the driver system. This results in considerably lower response 
times for real-time editing. This enables software monitoring of the inputs (and 
VST instruments). The CPU load of the system drops, more high-quality 
effects are possible without intermediate bouncing operations. 

 Driver-side synchronization between recording and playback is available. This 
ensures that overdub recordings are 100 % stable regarding timing. This also 
allows for mechanisms for compensating latency for effects permitting 
software FX monitoring. 

 ASIO also offers a general method for treating multi-channel audio. All 
bit-resolution and multi-channel problems which may appear with WDM 
drivers under Win2K/XP are avoided from the outset. 

 Advanced hardware monitoring options are possible due to the use of ASIO 
direct monitoring (flexible routing including pan & volume, regardless of sound 
card). 

ASIO setup 

ASIO drivers: The drivers of each ASIO device currently or previously available 
in the system are listed here. "Settings" opens the settings dialog of the sound 
card driver. Please refer to the sound card manual for more information. 

Buffer settings 

Play/Record buffer: Specifies the buffer sizes for playback or recording of 
audio data. 

In principle, the larger the buffer, the safer playback will operate on slower 
systems or at full load. The number of simultaneously playable tracks 
increases. However, this reduces the reaction time of the PC, which can 
particularly disturb processing of real-time effects. We therefore recommend 
searching for an optimum compromise for your system. 

When recording and playing simultaneously (record while play), the record and 
play buffer have to be the same size. 
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HD buffer: 8000 samples buffer are the default preset. This buffer is applied 
during playback directly in HD wave projects. Test smaller values here for even 
faster reaction times! 

VIP buffer: 16000 samples buffer are the default preset for use during 
playback of virtual projects. Since error-free playback is usually more important 
than fast reaction times, this value should be raised to 16000 or 32000 during 
playback occurs from various tracks. When playing virtual projects or using the 
mixer only these settings are relevant. 

Test buffer: 8000 values are the default preset. This buffer is only used for 
real-time preview of effects from the "effects menu". 

Buffer number: Specify here how many of the buffers described above should 
be used (between 2 and 10). More buffers increase reliability, but also increase 
the memory requirements. Reaction times become longer. You can check the 
current buffer usage levels in the status bar to the bottom right. 
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Record devices 

The installed sound cards are listed in the large window at the top of the 
dialog. With "Device info" you can open the small dialog for information on the 
sound card activated in the adjacent window (supported sample rates, 
manufacturer, etc.). 
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MIDI 

 

Playback devices: Here you can define which devices should be available for 
Samplitude 11.5 Producer and which should not. 

Global playback devices: Select the driver that Samplitude 11.5 Producer 
should use by default to play back MIDI tracks. Of course, an individual driver 
or one of the installed VST plug-ins (only in the VIP track) can be selected for 
any VIP track. 

Global recording devices: Select the driver Samplitude 11.5 Producer should 
use to record MIDI tracks. 

Recording offset: Here you can enter the delay in milliseconds to be used 
when starting recording.  

Audio/MIDI synchronization: If the box for synchronization punch through is 
checked you can specify the intensity of Audio/MIDI synchronization coupling. 

0% Very soft 
50% Mid-value 
100% Very strong 

Activate SysEx input: Selecting this option enables Samplitude 11.5 Producer 
to receive SysEx data from external devices. 
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System time as MIDI timestamp: If this option is activated, then the MIDI 
device driver's time stamp will be ignored. This is helpful if drivers provide a 
timestamp that is not synchronized with the audio or is completely incorrect. 
This function recognizes invalid driver time stamps and then provides 
automatic fallback onto the system time. This helps fix MIDI recording 
problems with MIDI devices. 

Couple VIP-Q and MIDI editor-Q: The quantization grid in the VIP and 
individual MIDI objects are always moved together.. 

Deactivate all MIDI functions: This allows you to disable all MIDI functions 
completely.  

Note On Chasing: "Note On Chasing" has the effect that held MIDI notes are 
also played back when they receive their "Note On" command before playback 
starts. 

Send "All Notes Off" to VST instruments on (monitor) stop: As an alternative 
to the "All Notes Off" mechanism, an individual "Note Off" mechanism is 
available for VST instruments, since "All Notes Off" is ignored by some VST 
instruments. You can completely shut off "All Notes Off for VSTis in the MIDI 
systems settings. 

 

Hardware controller 

Installing a hardware controller 

Open the hardware controller setup dialog by pressing "Y". You are now in the 
system/options dialog. Now open the subcategory "Hardware controllers". 

The hardware controller setup contains two tabs. The first one is used for 
general settings while the second one is used for learning functions. 
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1. Press the "Select controller" button. Then select your controller or a 
compatible model from the list. With Delete or "Del" you can remove 
selected controllers again. You can use the mouse to change the order of 
the controllers and their internal assignment. A controller that is indented 
corresponds to an expansion module. You can use the check box above 
the controller or the "Activate controller" button to temporarily deactivate a 
controller. 

2. On the right you can select the MIDI parts that are connected to your 
controller. 

3. Your controller is ready for action after you have closed the dialog. 

 

Track number 

Specifies the number of tracks in a bank available to the controller. These are 
usually 8 tracks. Mackie Control and HUI Protocol can only access 8 channels 
per bank. However, there are also controllers that have a native mode letting 
you learn several channels. Here you can set this value to 16 or 24 (max. 64). 
The value is set to "1" for single-track controllers. 

 

Ignore SysEx input data 

SysEx data sent by the controller is not processed by Samplitude 11.5 
Producer. 

 

Hardware controller – "Internal" mode 

The internal modes are used to adjust to different hardware controllers that 
operate differently. Depending on the mode, the controller display is addressed 
differently and Samplitude 11.5 Producer interprets the controller messages 
correspondingly. 

Hint: If you are using a controller which is different than the one listed here, 
then you should select one from the list that is similar to yours in concept and 
design. 

Internal modes description: 

Mackie Multitrack 

Track 

Press first time: Track mode 

Press second time: Active control mode 
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 Each activated mixer element (recognizable by the red marking) is controlled 
by the first fader 

PAN 

 Pan mode (like track mode, except for the display) 

EQ 

Press first time: EQ Phat Channel Bandwise mode 

 Gain, frequency, and quality accessible via the knobs 
 Use the bank switch keys to access the other bands 

Note: The bank switch functions have to be learned, which is usually the case 

Press second time: EQ Phat Channel Typewise mode 

 Gain, frequency, and quality accessible via the knobs (differently grouped than 
in Bandwise mode) 

 Using the bank switch keys, each of the other EQ functions can be accessed 

AUX 

Press first time: AUX track mode 

 AUX 1 to 6 of the active track using the knobs 

Press second time: AUX slot mode 

 Set AUX for each track 
 Select number of AUX tracks to be controlled using the Bank Switch keys 

Plug-in 

 The VST plug-in slots are listed for the active track (flip through via bank 
switch keys) 

 Selection of the VST plug-in to be adjusted by pressing the corresponding 
knob 

 Thereafter the parameters for the selected plug-ins are shown 
 Changing the parameter using the knob 
 Page through the parameters 
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Frontier AlphaTrack 

Track 

Press first time: Panorama mode 

 Panorama control 
 Navigate to markers 
 Move selected track 

Press second time: Active control mode 

 Changes the value of the selected element in the mixer with the fader. 

AUX 

 Select other track 
 Select other slot 
 Change AUX send of the selected track/selected slot 

EQ 

Controlling the input volume, frequency, and quality bands of the selected 
EQs. The individual bands are selected with "Mixer track up/down". 

Plug-in 

 Select track 
 Select plug-in slot in the track with "Mixer track up/down" key 

Now you can control 3 parameters of the corresponding plug-ins with the 
vpots. The display page is toggled with the keys "Mixer track   up/down". 

Frontier transport 

Functions: For transport only 

 

JLCooper (MCS) 

Track 

Press first time: Track mode 

Press second time: Active control mode 
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 Each activated mixer element (recognizable by the red marking) is controlled 
by the first fader 

AUX 

Controls all AUX sends in the selected channel. 

EQ 

Controls the EQ of the selected track via the knobs. 

 

Output 

Deactivate: If your PC does not have a motor fader, you can use this option to 
deactivate the transmission of controller data. 

Normal send: The MIDI controller data is received and processed. Program 
data (e.g. fade changes in the mixer) are sent to the controller. 

Send echo: The MIDI controller data is received and processed and forwarded 
straight back to the controller. Controllers need this for their displays (lamps, 
LEDs). Program data (e.g. fade changes in the mixer) are sent to the controller. 
If your controller has difficulties with this (e.g. .Logic Control), activate "Normal 
send". 

Send echo (without fader touch): The MIDI controller data is received, 
processed and returned to the controller. However, the fader values are not 
sent back while it is moved (activated fader touch). Only the last value is 
released to prevent increased data volumes. Program data (e.g. fade changes 
in the mixer) are sent to the controller. If your controller has difficulties with this 
(e.g. Logic Control), activate "Normal send". 

 

Customizing controllers 

Most devices available on the market understand protocols such as Mackie 
Control or HUI. If your device is not included in the list, simply select the 
nearest compatible device. 

If you can't find your device in the list or want to change the default settings, 
you should proceed as follows: 

Before adapting an existing template to your controller, you should save it 
under a new name using the "Save as..." option. 
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Now go to the "Adapt controller" tab. The following dialog appears: 

 

Use Mackie Control if your controller can emulate this mode. In this case 7-bit 
values are transmitted. You can see this in the MIDI Input Monitor. Pressing a 
displays a new line, another line is displayed upon release. HUI receives 14-bit 
messages, i.e. two lines respectively. 

In the mixer, which should be open at the same time, you can now select the 
element you wish to program on your controller. The saved function is 
displayed in the section Program function, e.g. "Fader master" for the fader in 
the Samplitude 11.5 Producer mixer. Alternatively, you can open the context 
menu in "Samplitude/Sequoia function". This contains a list of all remotely 
controllable functions in Samplitude 11.5 Producer. You can now assign them 
to your controller one after another. The uppermost commands are purely 
mixer functions and are suited solely for the controller connection. The lower 
ones represent the entire menu structure of Samplitude 11.5 Producer. You 
can use this to assign each command from a menu to a controller key. Please 
note that when working with menu commands, the key lights of the controllers 
don't work. 

Now move the fader or press the corresponding key on your controller. The 
MIDI data for this element is displayed in the section "Last MIDI data". Press 
the Learn button to allocate the new data to the function. 

Note: Hardware controllers with touch-sensitive faders transmit data to 
Samplitude 11.5 Producer when released again, so that the "learn" button has 
to be pressed after moving and before releasing a fader! 

If you want to use a key/fader for multiple tracks, e.g. learn mute, select 
"Mixer/Tracks/Track Mute" in "Samplitude 11.5 Producer functions. Now tick 
"Track "Auto Increment" and start programming the first track. After pressing 
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"Learn", the value of the track is automatically increased by "1". All you have to 
do is to actuate the next element on your controller and press "Learn" again. 

You can use the "Delete" button to unselect a function assignment. However, 
you can also simply overwrite the data by "relearning".  

If a controller should move in the wrong direction after programming, please 
repeat the programming sequence and activate Invert Vpot direction upon 
button release. 

If you want to know which functions have been assigned to a key of your 
controller, simply press this key. The data appears in the list of assigned 
functions. 

This way you can let Samplitude 11.5 Producer learn individual control 
elements of your hardware controller. 

Hint: If "Object" mode is active, you can jump to the next object with the 
hardware controller's  Rewind/FastForward transport controls. The same 
applies to Marker Mode, where you can jump to the previous or next controller 
in the project. 

 

Metronome options 

Please also read the section "Options -> Program settings -> Metronome 
options". 

 

Recording settings 

Format: The higher the bit depth, the more memory will be required; however, 
the quality of the recording will also be better. Higher bit depths are only 
sensible when the sound card records in this format. 

Note: Many sound cards are listed with 24-bit resolution, sometimes, however, 
this information refers to playback performance only. 

Record offset (samples): Enter the offset in sample values, which may develop 
in "Record-while-play" mode between playback and record start of the sound 
card. This allows you to balance the delay between record and play start of 
some cards. Typical values are between 20 and 1000 samples. You can 
determine this value by playing a project with a distinct start in a Multitrack VIP 
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and recording it simultaneously. You can then measure the offset precisely 
using the zoom functions. 

Update object during recording: The object is already displayed in the VIP 
during recording, allowing you to see it grow. 

Scroll recording position: Corresponding with playback settings, scrolling can 
also occur during recording. This means that the visible range of the 
arrangement follows the end of the current object. 

Show confirmation window (OK/delete) after recording: When recording 
stops, a dialog appears which asks if the recording should be accepted. 

Recording button ends playback after standard recording: When recording is 
stopped, playback also stops. 

 

Playback settings 

 

Keyboard shortcut:  P 
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Check the "Stop at current position" option to keep the play cursor at the 
current position when stopping playback. If this option is not active, the play 
cursor will jump to the original position or back to the start of the range when 
playback is stopped. 

The "Test space bar (play, stop) in the background as well" option also allows 
the space bar to be used for "Play" and "Stop" in Samplitude, even while using 
a different software application in the foreground. 

The keyboard combination "Ctrl + space bar for playback of selected 
objects" can also be used. 

The pre-roll time is a necessary parameter for editing in Samplitude. Pre-roll 
time is used to define the time section in seconds which is to be played before 
the start of the selected range. 

The maximum reverberation time for objects without fade-out can be set up 
to 60 seconds here. 

Note: Please note that long reverberation times can lead to performance 
problems. 

The option "Pre-run harmony display (beats)" ensures that the chords 
detected by the Harmony Agent are displayed in advance in the set number of 
quarter note beats. 

 

Autoscroll 

Use Autoscroll to activate a feature which is especially useful when working 
with long HD Wave Projects: The graphical display always changes when the 
playback marker (position line) leaves the visible section. This way you can 
always keep an eye on things, whereby it has proven most sensible to display 
the current project in two sections (Setup > 2 sections), one displaying the 
entire project and one in a useful zoom depth with Autoscrolling. 

You can choose between page and soft scrolling. But be careful: Scrolling 
requires a certain CPU power (depending on the processor, graphics adaptor 
and resolution), so that the computer may be overloaded in critical situations 
which may result in playback dropouts. You should then deactivate autoscroll 
mode. 
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Scrubbing 

If you press the Insert key (Ins or 0 on the number pad), Samplitude 11.5 
Producer will be in "Scrubbing Mode". This means that the playback speed 
can be controlled directly with the mouse. The further the mouse goes to the 
right, the faster Samplitude 11.5 Producer plays. 

In comparison to many HD recording systems, this even works in a virtual 
multitrack project. 

The Scrubbing Mode is great in finding passages in unsorted material, in 
tracking crackling, etc. in material – the older generation of sound engineers 
are, no doubt, very familiar with this method from analog tape editing. 

There are 2 scrubbing modes available (in the playback parameter window - 
Key P): 

Relative: The relative distance between the playback marker (position bar) and 
the mouse position can be used to control the speed. The playback marker 
follows the movement of the mouse. 

Absolute: You can use the absolute position of the mouse in the window to 
control the speed: 

 Left border = double speed backwards, 
 Mids = no movement, 
 Right border = double speed forward. 

Tip for scrubbing: For small buffer sizes (4000, 2000 samples) scrolling is 
"softer". Test if your computer functions at this buffer size without drop-outs. 
Combining with the Soft Scroll Mode guarantees that working on your 
computer is easy and fast. 

 

Global playback device 

Here   you can define the driver of the sound card which is to be used for 
playback if playback is to occur via a card. This is particularly important if you 
have a sound card with several outputs or if you have several cascadable 
sound cards in your computer.  
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Program 

General 

 

Open VIP and record window on program start: If this option is active, 
Samplitude 11.5 Producer will automatically open an empty virtual project (VIP) 
and the "Recording parameters" dialog when the program is started. 

Open wave projects in destructive editing mode: If this option is active, wave 
projects will be opened in destructive editing mode. 

Performance display: This option activates the DSP performance display in the 
lower left corner. Your PC is overloaded if the displayed rate is 100% or higher. 
Try one of the following steps: 

 Reduce the number of real-time effects in the mixer or in the object editor. 
 Reduce the number of tracks by muting tracks that are not needed. 
 Increase the VIP buffer size to 16000 or 32000 samples. 
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Please note the comments displayed in the status bar should an overload 
occur during real-time previewing of complex effects such as DeNoiser or FFT 
analyze filter. 

Lock VIP size against zoom out: If you zoom the virtual project out beyond the 
section size, this option will automatically stop it from being extended. 

Play cursor independent of range: This option allows the play cursor to be set 
independently in "Loop" mode and playback to be started outside of the 
selected loop range. 

Hide wave projects loaded into virtual projects: Hides windows in wave 
projects that are loaded directly into the VIP. 

Use project tooltips: If this option is active, additional information is displayed 
when the mouse pointer hovers over an interactive element. 

Show extended project tool tips: If this option is activated, the extended tool 
tips are displayed if the mouse pointer is held over an inactive element. 

Show window "Create new project": If you set the option "Do not show this 
window again" in the dialog, you can reset it here. Please also read the section  
"New virtual project (VIP)" (view page 315). 

Reset all "Don't show this message again" boxes: Press this button to 
reactivate all tips dialogs that have been deactivated. 

Folders 

New virtual projects: All new virtual projects as well as recorded and imported 
wave projects will be saved under this path. 

Project files: All other wave files which are to be saved on the hard drive and 
that cannot be allocated to a specific project are saved under the specified 
path. 

FTP download: All files downloaded via the integrated FTP client will be saved 
under the specified path. 

Temporary files: This preset path is directed to the standard temporary files 
folder. Please ensure that this folder should be on a hard drive or partition with 
sufficient free storage space. 
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Undo definitions 

The depth of undo can be specified when working with VIPs. A value of “20” 
means that the last 20 changes can be undone. 

 

Locking objects/tracks 

Here you can select which functions should not be permitted by locking the 
objects. 

Disable Moving: The objects cannot be moved unintentionally (default). This is 
especially useful for multi-track recordings to prevent inadvertent offset 
between each track from the beginning!  

Block volume changes: The object's volume handles are deactivated. 

Disable fade-in/out: Deactivates the fade handles of the objects. 

Disable Length Changes: Deactivates the length handles of the objects. 

 

VST/DirectX/ReWire setup/plug-in buffer 

The option "Write DirectX logfile" is for support purposes. This may normally 
remain inactive. 

You can also activate the "Start all object-related plug-ins at play start" 
option. Some plug-ins cause delays when switched on; in this case, these 
plug-ins should be switched on before starting playback, since otherwise 
errors may occur when the corresponding objects are played. 

Disable all DirectX effects while scrubbing/jogging: DirectX plug-ins may 
cause errors when scrubbing or jogging. Use this option to disable 
communication with DirectX plug-ins. 
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Plug-in buffer 

The default presets usually cover most applications when working with 
plug-ins. Try out various presets if you are experiencing problems with plug-ins 
or DSP cards. Specify the buffer size sent to the plug-in for XD and VST 
plug-ins directly.  

VST plug-in path: This sets the path to VST plug-in effects and VST 
instruments. The selected folder may be scanned for VSTs. Not only are all the 
plug-ins imported, but they are also checked for usability within Samplitude 
11.5 Producer. This scan is only necessary once, since available VST plug-ins 
are saved during this process. If more than one VST plug-in folder is present, 
then other folders may also be specified for scanning. Samplitude 11.5 
Producer automatically finds newly installed plug-ins in the specified folders 
only. The corresponding data is saved in the file "VSTplug-ins.ini". 

Activate ReWire: If this option is activated, rewire-compatible client 
applications may be integrated into Samplitude 11.5 Producer as synthesizers. 
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Additional information about ReWire can be found in the chapter "Software 
instruments/VST plug-ins/ReWire -> ReWire client applications". 

 

Edit keyboard shortcuts and menus 

In this dialog you can freely specify keyboard shortcuts for all menu functions 
in the main menu and for the Solo JamSession. This way, it's possible to set 
the commands you use most often to a special key combination so they can 
be opened quickly. 

 

The shortcut settings are saved into the MusStu.ini file in the Windows 
directory when you exit Samplitude 11.5 Producer. It's also possible to export 
sets of keyboard shortcuts or menu definitions in files. 

Note: Users of previous Samplitude 11.5 Producer versions can thus load the 
old menu structure; we have included a "Menu" file for this purpose. 
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The display of the entire menu tree of Samplitude 11.5 Producer is the key 
function of the dialog. 

Here, you can select for which menu item you want to create a new shortcut or 
whether the menu item should appear in the main menu of Samplitude 11.5 
Producer. 

Note: Shortcuts in brackets (<>) cannot be changed. 

 

Shortcut list 

Export list: You can use this to export the shortcut as a list in a text file in 
different formats. A window will open in the shortcut editor which displays a 
complete list of the current shortcuts. The "Copy" button can be used to copy 
this list to the Windows clipboard to be edited and printed using a text editor. 

Reset: Activates all preset shortcuts again. 

Load/Save: Previously saved shortcuts are loaded and activated or the current 
shortcuts are saved under a file name. 

 

Shortcut 

To add a new shortcut, click on the desired menu item and then on the input 
box at the bottom. Then click on the shortcut key. 

You can also use combinations of any key with "Shift", "Alt", or "Ctrl". Please 
do not use the space bar, "Esc", or "Insert" key ("0" on the number block), 
since the functions of these keys are permanently set in Samplitude 11.5 
Producer and cannot be changed. 

Assign shortcut: This button can be used to activate the key sequence on the 
left as a shortcut. A warning will be displayed if this command has already have 
been assigned. However, you can also check in advance whether the key 
combination has already been assigned. To do this, click "Search" (binoculars) 
once the key sequence has been entered. An assigned menu command will 
then be displayed in the top list.  

Delete: Deletes the selected shortcut. 

Assigned: Shows all the shortcuts assigned to menu points. You can assign 
menu commands to multiple shortcuts. 
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Mouse 

You can define several special options for keyboard and mouse to achieve 
compatibility with older versions. These are: 

 Disable range zoom for double mouse clicks 
 Zoom lasso allows vertical zoom without "Shift" key  
 Disable zoom for vertical mouse movement in timeline 
 Downward compatible use of "Shift - click" on mute/solo/record (instead of 

"Alt + Shift" - click). This lets you change the keyboard shortcut for "exclusive 
switching" of solo, mute and record. By clicking the "Solo/Mute/Record" 
button for the selected key combination "Shift + Alt" / "Shift", you can switch 
the individual channels temporarily to "Exclusive" mode.  

 Treat knobs like faders: If this option is active, knobs can be pulled up and 
down like faders by dragging with the mouse. 

 2nd click required to move objects: This option requires a second click for 
moving objects. The first click selects objects and prevents unintentional 
moving. 

 Move delay: When an object is selected by clicking on it, you might 
unintentionally move the object. If "Move threshold" is activated, Sequoia will 
wait the set time before it performs the shift. 

"Mouse wheel" allows you to re-define the function of the mouse wheel for 
zooming and scrolling in the virtual project. You can define which modifier 
("Alt", "Ctrl", "Shift") controls which function in combination with the mouse 
wheel. 

 

Solo JamSession 

Editing here is basically identical to editing in the main menu. However, you 
cannot set any keyboard shortcuts, but rather MIDI commands or joystick 
actions. 

The commands listed here do not exist in any menu, therefore the buttons 
"Show menu/Hide menu" and "Reset" (from the menu command show/hide) 
are grayed out. The list cannot be exported or saved. 

Reset: Activates all preset shortcuts again. 

Note: The MIDI input device can be set in the metronome options. 

Keyboard shortcuts 
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To assign a new shortcut to a command, enter the type of shortcut in the flip 
menu "Status". 

Note: MIDI commands can also be learned. If you use control change events 
for remote controlling, you can choose between "CtrlUpDn" and "CtrlChg" in 
the "Status" menu after learning. 

 CtrlUpDn: This is a special adaptation for use with a sustain pedal from the 
MIDI keyboard. A command is activated only when the pedal is "tapped" 
lightly, because, when playing, the sustain pedal is typically held longer than it 
takes to actually activate an assigned command. 

 NoteOn: Note On events are always transmitted when a key on the MIDI 
keyboard is pressed. It may also be possible for other keys of the MIDI 
keyboard to transmit Note On events. Please refer to the instructions of your 
MIDI device. 

 CtrlChg: Control Change events are transmitted to the MIDI device if the 
controllers are adjusted. It may be possible to program the MIDI device so that 
pressing a key will transmit such a Control Change event. Please refer to the 
instructions of your MIDI device. 

 PrgChg: Program Change events are actually there to effect a sound change 
in the synthesizer. 

 PitchWheel: The Pitch Wheel normally serves to modulate the pitch of the 
sound played. When using it, a quick movement is all that's necessary to 
execute an assigned command. 

 Joystick1/2: Use the buttons 1-4 of your joystick to control the Solo Jam 
Session. In the field beside it, "Button", enter the corresponding number of the 
desired button. Here, you cannot set the channel as joysticks don't have 
anything to do with MIDI devices. 

 Channel: MIDI Channel 1 is always set as the default. In case your MIDI device 
transmits to a different MIDI channel, you can set it here. 

 Assign: With this button you can activate the specified MIDI event or the 
joystick button as a new shortcut. A warning will be displayed if it has already 
been assigned to another command. 

 Delete: Deletes the selected keyboard shortcut again. 
 Shows all shortcuts assigned to the function. You can assign multiple 

shortcuts to a function. 

Learning MIDI commands 

1. Select the function you want to remotely control via MIDI from the list at the 
top. 

2. Click on "Learn". This now turns red. 
3. Activate the MIDI command from the MIDI device to start the function. 
4. In the dialog, click on the "Assign" button to complete the learning process. 
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Design 

Display options 

This dialog can be used to change and select both alternative display formats 
for objects in virtual projects. 

Keyboard shortcut: Shift + Tab 

 
 

Draw mode 1/2 

Switching between the two modes is possible by pressing "Tab". You can also 
toggle between mode 1 and mode 2 by selecting the appropriate mode from 
the menu item.  

 

Waveform display 

Draw samples: The audio sample representation is switched on. Usually you 
will leave this on, but it can be advantageous to deactivate sample 
representation if you want to see the volume and pan curves more clearly.  

Scale with fades/curves: In this default representation mode the waveform 
drawing is scaled according to the settings of the fade in/out or volume curves. 
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The decay of the sound during a fade out (or volume changes caused by a 
volume curve) are more obviously visible. 

  

Halve: The graphical representation of the audio material can be displayed as a 
whole waveform or half the form for higher definition. Checking this box will 
display the waveform with half its information. This mode is recommended, 
because the grid function (key #) and the vertical zoom functions ("Ctrl + 
cursor up/down") are perfectly adapted to this draw mode. Volume curves 
results also display better in this mode. 

 

Separate stereo: If this option is active, stereo tracks in VIP projects are 
displayed with a two-channel waveform. This allows you to expand the display 
to both channels rather than displaying just one composite channel display. 
Please keep in mind that this will also affect the wave project display for stereo 
wave projects. 

 

Envelope only: When this radio button is selected only the waveform outline 
(envelope) is drawn. This can be useful when constructing crossfades, allowing 
for easier view of the overlapped waveforms. 
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Transparent: When this radio button is selected the colors of both crossfade 
waveforms are overlapped. This works best in front of a dark background 
(default). We recommend that you combine this mode and the draw mode 
option "Waveform colors -> Red/Blue alternation" to display the crossfade 
areas optimally. 

 

Interleaved: When this radio button is selected a sample of the left object and 
a sample of the right object is drawn alternately within a crossfade. You can 
then visually assess the fade area, especially if the adjacent objects have 
different colors. 

 
 

VIP 

Various VIP components (buttons/sliders, peak meters, show borders, 
arrangement text, and vertical auto zoom) can be activated and deactivated 
here. 

 

Objects 

Background: Each object in the VIP track can be assigned its own color. The 
color is displayed if this option is checked.  

Object name: Objects in VIP windows can have their own name. If this option 
is checked, the object name is displayed.  

Large object handles: When selected, larger handles for objects and volume / 
panorama curves will be displayed.  

Project name: Samplitude 11.5 Producer also allows you to display the audio 
file name in each object. This is especially useful if you quickly want to identify 
the wave project used in an object.  

Object properties: This shows you which object related effects are applied to 
the object, e.g. EQ for equalizers, DYN for dynamics etc... 
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Group number: Objects in VIP windows can be grouped together. When 
grouping objects, it is helpful if the group number is displayed in the object. 
This option allows you to display that information in the object. 

Object lock button: When locked, an object cannot be moved. Setting this 
option will let you comfortably change the lock/unlock status of an object by 
clicking on the key in the lower region of the object. 

 

Waveform colors 

Red/Blue alternation: This representation mode alternately colors the 
waveforms of adjacent objects red and blue, to improve the visibility of 
crossfades in the transparent and interleaved drawing modes. 

 

Colors 

All colors used in the program can be set here. You can also load and save 
these colors as presets. 

Use automatic sample colors for record: Here a separate random color is 
chosen for each recorded object per track. 

Restore 

Restore last state: Restores the last status of the color settings before the 
dialog was opened. 

Original state: Resets all colors to their default settings. 

Semitransparent display 

There are transparent displays in several effects dialogs and editors. These can 
be deactivated here to increase performance. 

 

Easy setup 

Sound card & drivers 

Select the driver system or the sound card. Entries which start with "Asio" are 
ASIO drivers which enable shorter latencies, e.g. to play VST plug-ins live, etc. 

Note: If your sound card offers ASIO drivers, then it's best to use them. Only 
use "ASIO MAGIX Low Latency" drivers if you are having problems. 
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Audio: Input & Output 

Select the input and output channels for your sound card which should be 
preset for recording or playback. 

MIDI: Input & Output 

Select the MIDI input and output devices which should be preset for recording 
or playback. 

Mixer preset: 

These are the most conventional presets for different applications concerning 
track number, AUX and submix busses. 

Plug-ins directory 

Enter the path to the installed VST plug-ins. 

"Advanced" switches to the Settings dialog with all available options (view 
page 468). 
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Project settings 

Here you will find all information regarding settings that are dependent of a 
wave project (.HDP) or virtual project (.VIP). 
 

Project options 

 

This will show you information on the current project, including creation date, 
memory size, paths, and file names. For virtual projects, a list of all included 
physical files is displayed. Virtual projects also display a list of linked wave 
projects. 

Volume reduction in virtual projects: In "Project information for virtual 
projects", you can reduce the level in 6 dB steps. This volume reduction is 
necessary for multitrack virtual projects, since the sum of all tracks in this case 
must not exceed 16-bit (0 dB). Theoretically, each track of a 4 track stereo 
project must be reduced by 2 bits (12 dB). In the real-world application, tracks 
are often not recorded or played back at the maximum level so that the 
reduction can be adjusted accordingly. However, raising the volume reduction 
setting can result in clipping. 

Please keep in mind that Samplitude 11.5 Producer reduces the volume of 
wave projects to the setting in the virtual project that uses the wave project. 
This allows you to switch between the VIP and the wave project without the 
usual volume differences between project types. If a wave project is opened by 
itself (without using the wave project in a VIP), Samplitude 11.5 Producer 
automatically uses the maximum volume playback. 

Key:  I 
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Mixer setup 

Opens the mixer setup dialog where you adjust the general settings for the 
mixer routing design.  

 

Project and mixer configuration: Sets the number of VIP and mixer tracks as 
well as the submix and AUX buses. 

Device setup: Sets the various routing paths. 

 

Synchronization 

Opens the synchronisation dialog (view page 239). Here you can specify 
whether Samplitude 11.5 Producer should operate as master or slave, which 
protocol to use, and which interface should be used to send or receive 
synchronization data. 
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Recording options 

 

Keyboard shortcut:  R 

Recording mode: Choose between stereo, mono, and different bit depths.  

Preload: The recording is prepared, all buffers are loaded. A requester 
appears; by clicking it you can start recording without delay. This function is 
useful if the recording it to start without delay.  

Sample rate: This option allows you to select a sample rate. Please make sure 
your sound supports the selected sample rate. 

Resample to 44100 Hz: With this button you can specify whether a recording 
with, for example, 48 kHz or 32 kHz should be converted into 44.1 kHz even 
while recording. This is useful, for example, when recording from DAT 
recorders via a digital sound card if the material is to be used on CDs with 44.1 
kHz.  

Recording start/length: Here you can program a recording. The recording 
length can be specified in different time formats.  

Record device: Here you can select the sound card driver that is to be used 
for recording. If there is no entry here, or a wrong one, then the card is not 
installed in Windows™ correctly. Try to do this later on via Control Panel > 
Driver. 
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Info: Here you can access a dialog that provides information on the sound 
card properties. If your sound card supports 24-bit recordings, you can 
activate this record mode via the Info dialog. 

File name/file path: The name of the audio file that is to be created and the 
preset directory path are displayed in the bottom record window. Both can be 
changed by clicking on the folder button. 

Play while recording:This option corresponds to the option in the recording 
options with the same name. 

Create VIP object: With this mode you can specify whether all recordings 
should be automatically integrated into a virtual project or not. 

Set CD Track marker: While recording you can already set track markers by 
clicking on the button "Set CD Track Marker" in the record dialog. 

Automatic recording stop: If this field is activated, recording will cease 
automatically after approx. 16 seconds of silence. This means you can leave a 
recording running without having to worry about stopping it at the end of the 
record.  

Automatic CD track recognition: If this field is activated track markers are 
automatically set at the end of the pauses between the tracks. 

Advanced options: Opens the system options with the advanced  record 
settings (view page 481).  

Monitor: Here the control displays can be activated. Please note that the 
correct recording device must be selected prior to beginning this. While 
recording, the control displays move slower, but they nevertheless show each 
maximum level. 

Visual: Indicates whether the level of the signal that is to be digitized is 
adjusted correctly. To do so, play the loudest part of the material you want to 
record and monitor the display. 
Too too low level settings have adverse effects on sound quality, distortions 
lead to unpleasant "clippings". 
You can adjust the recording level either on the sound source itself or with the 
mixer window of your sound card. 

Osci./Correl: Here you can open a oscillograph or phase correlator. The 
oscillograph displays the wave form at the input in a scaleable window. 
The phase correlator displays the phase level of a stereo signal. A vertical line 
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corresponds to a mono signal, and a horizontal line corresponds to a 180° 
phase-inverted signal which usually indicates an incorrect cable connection. 

Reset peak meter: Here you can reset the LED peak meters (Peak Hold 
Display). 

Tuner: Tune guitars and other strings with this option. The visualization 
displays a calibration line at note A0. If divergent tones are played, the 
deviation can be read off the calibration line, and the numerically displayed 
tone pitch directly and can be corrected accordingly. 

Set Marker 1: While recording you have the option of selecting a marker at the 
current position of the playback marker (position line), in order to, for example, 
mark an incorrect passage for correction later. 

Recording: Click this button to start the actual recording process. Please note 
that with active external synchronization as a Slave, the recording does not 
start immediately, but rather at the start of each master. 

Stop: Ends a running recording process. Should the computer be overloaded, 
for example, as a result of swapping or disk access, the recording can be 
canceled by pressing the right mouse button. 

OK: Closes the recording window. 

 

Varipitch/practice mode 

Samplitude 11.5 Producer supports any tempo changes during playback - 
even in virtual multi-track projects. Right-click on the scrub control of the 
transport control.  

Active: Activates the Varispeed mode.  

Note: Once the Varispeed mode has been activated, you can close the dialog, 
control occurs via the scrub control of the transport control.  

Practice mode: If the practice mode is activated the pitch remains 
independent of the playback speed. It is especially useful for pieces used for 
practice (e.g. an accompaniment with guitar) that must be played slower 
because the player might otherwise feel overstrained.  
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Vertical controller: The playback speed can be changed manually from -200% 
to + 200%. 

Pitch: The speed factor can be specified precisely, for example, 0.5 for half 
speed. 

Internal rate: Here you can specify a sample rate for the Varispeed calculation. 
If, for example, a wave project with 48 kHz is to be played on a sound card 
that only supports 44.1 kHz, enter 44100 as playback rate (left in the dialog) 
and 48000 as internal rate. What follows is a real-time resample during 
playback - a strong feature for all those, who have to convert between DAT (48 
Khz) and CD (44.1 Khz) a lot.  

BPM: Here you can specify an original and a target speed in BPM. Samplitude 
11.5 Producer calculates the Varispeed factor from the ration to play a 120 
bpm sample in real-time with 135 bpm, for example.  

Important: Varispeed also works during recording!  

If your singing voice does not quite hit the highest note, simply set Varispeed 
on -2 halftones during recording and record - also with "Playback while 
recording".  

Deactivate Varispeed after that and your voice will reach undreamt of highs. 
But be careful, if used too in excess, Mickey mouse is not far away.   

Keyboard shortcut:  P 
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Automation menu 421 
Automation mode 169, 423 
Automation modes 170 
Automation of twin-channel Surround 248 
Autoscroll 496 
AUX 60 
AUX bus 365 
AUX buses 182 
Axes labelling and legends 155 

B 

Bar position markers (Advanced Tempo Mapping) 415 
Bass amplifier 137 
Batch processing 260 
Beat marker slicing 388, 436 
Beat marker stretching 389, 437 
Beat markers 324, 400 
Beat signature 221 
BeatBox 2 plus 294 
Before you start 15 
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Beginning of range < 0 359 
Beginning of range > 0 359 
BitMachine 112, 372, 438 
BPM value 324, 401 
Build loop object 377 
Build physical loop 446 
Burn 326 
Burn CD 53 
Burn project backup on CD 341 
Burning CDs 255, 453 
Burning CDs in  Samplitude 11.5 Producer 256 
Buses and routing 182 
Button bar 471 
Button overview 69, 471 

C 

Cabinet simulation 142 
Calculating audio effects 51 
Carrier input 392, 443 
Cascade 469 
Catooh – the Online Content Library 473 
CD arrange mode 345, 457 
CD disc options 455 
CD menu 453 
CD text / MPEG ID3 editor 456 
CD title 455 
CD track/index manager 454 
Change mode 468 
Change play direction 403 
Change range borders 79 
Change sample rate 445 
Changing object borders in virtual projects 74 
Channel strips 176 
Check and correct the automatic harmony recognition 273 
Checking the automatic tempo and bar recognition 267 
Chorus 109, 304, 370, 371, 393, 394, 445, 452 
Chorus flanger parameters 119, 450 
Chorus parameters 110 
Chorus/Flanger 118, 450 
Chromatic tuner 125 
Clean up 340 
Clear FreeDB cache 458 
Clef 221 
Close all windows 470 
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Close project 342 
Color selector 347 
Color setup 347 
Colors 509 
Comments 60 
Comp (opto compressor) 139 
Compressor 94 
Connect external equipment 185 
Context help 477 
Context menu 296 
Contour 138 
Controller editor 202 
Convert audio 337 
Convert MIDI objects into audio files 186 
Copy 214, 351 
Copy / Paste / Delete 168, 422 
Copy / Paste track effects settings 368 
Copy objects 375 
Copy to... 351 
Copy track(s) 365 
Copyright 2 
Corrections: Manual tempo and onbeat / offbeat setting 267 
Create 167, 421 
Create ranges 65 
Crossfade 362 
Crossfade Editor 264, 362 
Crossfade with clip 354 
Curve mode 66 
Curves / Object mode 65 
Customizing controllers 492 
Cut 351 
Cut mode 66 
Cut objects 375 
Cut track(s) 368 

D 

Declipping 439 
Default 388, 436 
Defining and search for ranges 285 
Definition 468 
Dehisser 91, 440 
Delay 369, 370, 372, 386, 395, 434, 452 
Delay / Reverb 369, 385, 433 
Delete 354 
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Delete all curves 169, 422 
Delete all markers 414 
Delete freeze data 342 
Delete HD wave project 341 
Delete hotspot 398 
Delete marker 414 
Delete notation symbol 215 
Delete notes 214 
Delete objects 376 
Delete track(s) 365 
Delete undo levels 351 
Delete unused samples 341 
Delete virtual projects 340 
Deleting markers, changing marker name, position, and type 284 
Deleting, renaming and editing objects 281 
Description of all control elements 157 
Design 506 
Destination files 263 
Destructive wave edit mode 345 
Dialog buttons 448 
Dialog menu 237 
Digital audiometer 102 
Digital transfer 85 
DirectX / VST plug-in set-up 448 
DirectX plug-Ins 373 
Display elements 245 
Display mode 347 
Display options 468, 506 
Display selected curves only 169, 423 
Display track automation (default setting) 169, 423 
Display unselected curves (can be activated) 169, 423 
Display unselected curves (cannot be activated) 
 (Default setting) 169, 423 
Distortion 111, 305, 372, 438 
Distributing sounds on multiple single tracks 236 
Do not display automation. 169, 423 
Draw mode 1/2 506 
Draw panorama mode 67 
Draw volume mode 67 
Drawing 249 
Drive 140 
Drum & Bass machine 2.0 306 
Drum editor 207 
Drum kit 296 
Drum map editor 209 
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Drum maps 209 
DSP display 257 
DSP display and writing speed 257 
Duplicate and move 376 
Duplicate objects multiple 376 
Duplicating objects 64 
Dynamics 368, 369, 380, 427 

E 

Easy setup 509 
Echo / Reverb 95 
Edit 375 
Edit automation curves 172 
Edit keyboard shortcuts and menus 346, 481, 502 
Edit menu 349 
Edit MIDI 45, 48 
Edit object parameters 281 
Edit range 357 
Edit range parameters 285 
Edit toolbars 346 
Edit window 155 
Editing 30 
Editing curves 167, 421 
Editing events: Piano roll 198 
Editing keyboard shortcuts and menus 346 
Editing MIDI data in the score sheet 213 
Editing MIDI objects 190 
Editing notes with the mouse 200 
Editing objects 42, 44 
Editing selected events (edit fields) 201 
Editing velocities and automation values 298, 299, 300 
Effect calculations 165 
Effects 51, 261 
Effects and effect plug-ins 90 
Effects and effects plug-ins 23 
Effects menu 332, 424 
Effects rack with presets from professional studio producers 22 
Effects section 302 
efx_ChorusFlanger 393, 444 
efx_Phaser 393, 444 
efx_StereoDelay 386, 434 
Elastic Audio easy 390, 438 
Elastic Audio Easy 154, 390, 438 
Embedding external effects devices 183 
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End of range < 0 359 
End of range > 0 359 
EQ 60 
Equalization 135, 141 
Equalizer 93 
Essential FX 117, 386, 434, 449 
Examples for working with ranges 80 
Exit 348 
Export 35, 335, 464 
Export and use 20 
Export tool 464 
Export video sound... 338 
Extract 355 

F 

Fade in / Fade out and object volume 74 
Features of the CD-ROM drive configuration dialog 259, 334 
Features of the drive list dialog 259, 333 
Features of the track list dialog 258, 333 
FFT Filter 383, 431 
File manager 276, 332 
File menu 328 
Filter 107, 372, 384, 392, 432, 444 
Filter graphic 392, 444 
Filter parameters 107 
First entries in the automation context menu 167, 421 
FLAC 336 
Flanger 105, 304, 372, 393, 395, 445, 452 
Flanger parameters 106 
Flip range left 358 
Flip range right 358 
Font for time display 346 
Font selection 346 
Formats and interfaces 22 
FreeDB options 399, 457, 458 
Freezing instruments (freeze) 241 
Frequency/Filter 369, 381, 430 
From MIDI to audio 50 
Functional overview 73 
Fundamental frequency analysis correction 162 
Fundamentals of the Elastic Audio editor 156 
Further recording dialog possibilities 86 
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G 

Gain control 138 
General 498 
General information on the Elastic Audio editor 154 
General settings 482, 510 
Generate a complete new file 326 
Generating remix objects 269 
Get CD info (FreeDB Internet) 457 
Get range 361 
Get range length 361 
Global playback device 497 
Global settings 180 
Grid lines 466 
Grid view 466 
Group objects 378, 396 
Groups 396 
Guitar amp 128 

H 

Half height 470 
Hard drive recording 83 
Hardware controller 488 
Hardware controller – 489 
Harmony Agent 272, 399 
Harmony display 399 
HD wave project 330 
Help 477 
Help index 477 
Help menu 477 
Hide all wave projects 470 
Hide submix / AUX buses 465 
Horizontal 469 
Horizontal movement of a range 79 
Hotspot 398 
Housing selection 144 
How does activation work? 478 

I 

Iconize all wave projects 470 
Ignore all tempo markers, use project tempo only 357, 419 
Ignore SysEx input data 489 
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Importing MIDI data 189 
Inactive 168, 422 
Indices (Track markers) 453 
Input 366 
Input level: VANDAL and the real world 121 
Input level reloaded: VANDAL's input level 123 
Insert 353 
Insert empty track 363 
Insert new notes 214 
Insert new tracks 363 
Insert notation symbols 214 
Insert objects 376 
Insert silence 355 
Insert track(s) 365 
Installation 16 
Installing a hardware controller 488 
Installing VST plug-ins 165, 229 
Instrument panel and parameter dialog 237 
Instruments with multi-channel outputs 236 
Integrate audio material 38 
Interface connection 185 
Internet bar 472 
Introduction 20 
Invert 168, 422 
Invert phase 391, 443 

J 

Jam Session 24 
Jump to and play from marker position 284 
Jump to marker 413 

K 

Keyboard commands and mouse-wheel assignments 164 
Keyboard shortcuts 298 

L 

L&R wave > 2 mono 337 
Lasso function 64 
Latency 239 
Leaving a range 78 
Left/right movement in page/scroll mode 412 
Linear view 211 
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List editor (midi event list) 205 
LiViD - Little Virtual Drummer 309 
Load / Import 331 
Load audio CD track(s) 258, 332, 453 
Load audio CD tracks 453 
Load audio file 331 
Load effects plug-ins 233 
Load files from the browser into projects 277 
Load instruments 230 
Load MIDI file 332 
Load plug-ins at master level 233, 235 
Load plug-ins at object level 233 
Load plug-ins at track level 234 
Load ranges from wave projects into the VIP 73 
Loading an audio file into a VIP object 73 
Loading options 332 
Loading routing settings with software instruments 231 
Lock objects 378 
Locking objects/tracks 378, 500 
Locking options 378 
Lo-fi 305 
Loop mode 403 
Loop Overdub 288 
Loop recording 288 
LR wave > 1 mono 338 

M 

MAGIX auto-update 478 
MAGIX Mastering Suite (Mixmaster) 98 
MAGIX News Center 19 
MAGIX Online Album 473 
MAGIX Plug-ins 371, 394, 452 
MAGIX Premium Club 18 
MAGIX Screenshare 475 
MAGIX Website Maker 475 
magix.info 474 
Main toolbar 471 
Make CD 325, 453 
Manage login details 476 
Managers 24, 275, 276, 464 
Marker 413 
Marker left 412 
Marker manager 276, 283 
Marker right 413 
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Marker view and selection 283 
Markers on range borders 413 
Master 136, 142 
Master section 178 
Mastering 34 
Mastering Suite 459 
Maximize track 366 
Menu search 471 
Metronome 290 
Metronome active 357 
Metronome options 347, 357, 494 
Metronome settings 347, 357 
Microphones 145 
MIDI  59, 187, 274, 346, 487 

Import, record, edit 187 
MIDI / Joystick setup 291 
MIDI bouncing 339 
MIDI cabling 185 
MIDI editor 48, 194, 374 
MIDI editor shortcuts 227 
MIDI functions 200 
MIDI Humanize Q 379 
MIDI in Samplitude 11.5 Producer 185 
MIDI input Q (global) 380 
MIDI integration 23 
MIDI object editor 191, 275 
MIDI panic – All notes off 419 
MIDI quantization (standard) 379 
MIDI record modes 47, 419 
MIDI recordings 45 
MIDI score settings dialog 218 
MIDI settings 187, 346 
Minimize none 366 
Mix with clip 354 
Mixer 88, 174, 393, 444, 459 
Mixer setup 342, 512 
Mixing 33 
Mode 1 468 
Mode 2 468 
Modes 288 
Modulation / Special 370, 391, 443 
Monitor 290 
Monitoring 238, 410 
Monitoring > Input monitoring on/off 410 
Monitoring > Peak meter monitoring 411 
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Monitoring > Software monitoring / Software FX monitoring 411 
Monitoring > Tape player monitoring 410 
Mono 247 
Mono delay (tempo sync / millisec.) 303 
Monophone voice 389, 437 
More 368 
More > Copy and silence 351 
More about MAGIX 18 
More Help 21 
More online services 475 
Mouse 481, 504 
Mouse functions and mouse modes 63 
Mouse functions for the upper half of the track: 63 
Mouse mode bar 70 
Mouse mode toolbar 471 
Mouse modes 208 
Move and transpose 214 
Move automation curve with audio/MIDI data 172 
Move object 396 
Move objects step-by-step 397 
Move play cursor 411 
Move range end to left/right 358 
Moving and duplicating objects 74 
Moving and zooming 195 
Moving objects 63 
MP3 336 
MP3 Encoder activation 478 
Multimax 101, 428 
Multi-object editing 50 
Multi-object editing (MO editing) 196 
Multitrack recorder (MR-64) 24 
Multitrack recorder MR-64 459 
Multi-view 204 
Multi-voice notation 217 
Mute objects 378 
myGOYA 18 

N 

Name 246 
Navigation / Favorites 276 
New instruments 21 
New MIDI object 375 
New MIDI track 363 
New submix / AUX bus 365 



 
 

 516 Index  

www.magix.com

New synth object 375 
New track folder 364 
New Virtual Project (VIP) 328, 499 
Normal 288 
Notation display in piano roll and  
controller editor (with velocity curves) 194 
Notation display, movement, zoom 194 
Notation symbols 221 
Note allocation in multiple staves 215 
Note display: Interpretation options 219 
Note for users of older versions of MAGIX 11.5 Producer 293 
Note parameters 214 
Number of first CD track 456 

O 

Object 330 
Object background color 398 
Object border left 412 
Object color / name 398 
Object edge right 412 
Object editor 75, 292, 374 
Object effects 380 
Object foreground color 398 
Object lasso 395 
Object level 83 
Object lock definitions... 347 
Object manager 276, 280 
Object menu 373 
Object mode 349 
Object name 398 
Object synths and track synths 292 
Object to original time position 397 
Object to play cursor position 397 
Object view and selection 281 
Objects 508 
Off mode 170 
OGG Vorbis 336 
Online menu 473 
Open 287, 330 
Open the dialog 245 
Opening the score editor 210 
Opening the synthesizers 291 
Operating the mixer 175 
Operating the mixer with the mouse and keyboard 175 
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Operation 287 
Optional accompaniment 21 
Options 290 
Oscilloscope 463 
Output 492 
Output mode 83 
Overdub 288 
Overlapping objects 75 
Overview 174, 324 
Overview mode 468 
Overwrite with clip 354 

P 

Package contents 15 
Page format settings 222 
Page view 212 
Parallel 248 
Parametric EQ 369, 382, 430 
Parametric equalizer 98, 369, 382, 430 
Parametric equalizer (track effects, mixer channels, Mixmaster) 97 
Paste from clip 353 
Patches in brief 324 
Pattern editor - matrix 298 
Pattern editor buttons 297 
Peak meter 462 
Performance 89 
Phase correlation 463 
Phaser 120, 304, 451 
Phaser parameters 120 
Pitchshift / Timestretch mode 67 
Pitch-sliced-objects and VIP objects 162 
Play and monitor instruments live 238 
Play cursor 65 
Play in range 402 
Play loop 402 
Play once 402 
Play only selected objects 402 
Play while recording 406 
Play with preload 402 
Playback / Record menu 402 
Playback mode 403 
Playback options 343, 404 
Playback settings 495 
Plug-ins 60, 233, 371, 394, 447 
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Position bar 471 
Position bar (left side) 71 
Position bar (right) 71 
Possibility 2 Drawing mode in the Surround panning dialog 249 
Possibility 3 Drawing automation curves in the VIP track 249 
Practice speed 290 
Pre & post gain 133 
Preamp channels 130, 131 
Preface 3 
Preparation - Setting the start marker and object end 267 
Preparing a MIDI recording 46 
Preset keyboard shortcuts 481 
Preset management 241 
Presets 393, 444 
Preview audio files 277 
Print notes 223 
Print TOC 326 
Printing score 222 
Process only left (right) stereo channel 452 
Processing the Surround Sound automation 249 
Program 498 
Program desktop overview 54 
Program settings 345 
Programming the synth object 292 
Project information 345 
Project options 511 
Project properties 342 
Project settings 511 
Project status 345 
Punch in mode active 406 

Q 

Q/MIDI length quantization 379 
Q/MIDI quantization start and length (start and length) 379 
Quantization 209, 379 
Quantization grid ( 224 
Quantization settings 200, 201, 204, 225 
Quantize 223 
Quantize controller events 201, 204 
Quantize note ends 380 
Quick setup 26 
Quick switch to other mouse modes 66 
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R 

Rack effects (FX1/FX2) 148 
RAM wave project 330 
Range 357 
Range all 357 
Range bar 72, 471 
Range length 360 
Range manager 284, 362 
Range mode (safe mode) 65 
Range start to left/right 357 
Range to beginning 358 
Range to end 358 
Range trackbouncing 340 
Ranges 77 
Reactivating the range 79 
Read Mode 170 
Rebuild graphic data 465 
Recall last range 362 
Recently opened files 348 
Record 83, 406 
Record another track 37 
Record devices 486 
Record mode / Punch in 406 
Record options 407 
Record without playback 406 
Recording 28, 287 
Recording / Playback 89 
Recording and playback of an instrument 239 
Recording automation in 171 
Recording in the Arranger 36 
Recording MIDI tracks 187 
Recording options 513 
Recording settings 494, 514 
Recording source 84 
Recording the first track 36 
Red Book 255 
Redo 350 
Register as guest of a screen session 476 
Register as host for a screen transfer 475 
Remix Agent 265, 398 
Remix agent - Tempo and beat assignment 266, 398 
Remove all indices 454 
Remove DC offset 441 
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Remove index 454 
Remove punch markers 414 
Rename project 340 
Rename, delete, and insert tracks 282 
Requirements 266 
Requirements for playing live 238 
Resample / Timestretching 387, 435 
Resampling 387, 435 
Reset MIDI quantization 380 
Reset toolbars 346 
Reset track effects settings 368 
Restart play 403 
Restoration 439 
Reverb 136, 369, 386, 434 
Reverb/Delay 369, 385, 433 
Reverse 446 
Revolta 2 321 
Revolta 2 interface 322 
ReWire 243 
Robota 310 
Room reverb / Hall reverb 304 
Room Simulator 385, 433 
Route MIDI instrument inputs 235 
Routing instrument outputs 240 
Routing MIDI instrument inputs 241 
Routing the signal 183 
Routing VST instruments using the VSTi manager 240 

S 

Sample manipulation 445 
Samplitude 11.5 Producer as an external effects device 166 
Samplitude 11.5 Producer preset and scene selection 124 
Save complete VIP in 340 
Save in format 338 
Save object 335 
Save project 334 
Save project as 335 
Save project as template 335 
Save session 335 
Saving and opening ranges/special range commands 79 
Saving effect parameters (preset mechanism) 91 
Scaling options (FFT filter) 384, 432 
Schematic illustration of the Robota synthesis 312, 313 
Score editor 210 
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Score editor modes 211 
Score sheet 213 
Scrub mouse mode 67 
Scrubbing 497 
Section to play cursor/last stop position 413 
Sections 465 
Select all objects 395 
Select next object 396 
Select objects 63, 395 
Select objects > Switch selection 396 
Select previous object 395 
Selecting a range 77 
Selecting an object with the Mouse 73, 360 
Selection 202, 213 
Selection of MIDI events (piano roll, drum editor, 
controller editor, list editor, score editor) 197 
Separate MIDI objects according to channels 378 
Sequencer 316 
Serial number 16 
Session 330 
Set CD end 454 
Set CD track index 453 
Set end marker 414 
Set markers 362, 413 
Set markers on silence 414 
Set new beat marker 357, 415 
Set new beat position marker 357, 415 
Set new original time position 397 
Set new tempo marker 356, 414 
Set pause 454 
Set pause time 456 
Set range start to left marker 359 
Set range start to right marker 359 
Set silence 355 
Set start marker 414 
Set start pause time 457 
Set subindex 453 
Set the end of the range to the right object edge 360 
Set the start of the bar 268 
Set track indices on object edges 454 
Set track markers automatically 454 
Settings 246 
Setup 307 
Setups, drum kits, presets, and patterns 318 
Shortcut 503 
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Shortcut list 503 
Show CD-R disc information 458 
Show CD-R drive information 458 
Show grid 466 
Show TOC 327 
Silence 355 
Smoothed 388, 436 
SMPTE Generator 286, 452 
Snap and Grid Setup 467 
Snap point (Hotspot) 398 
Snap to grid 466 
Software / VST instruments 229 
Solo JamSession 287, 289, 291, 419, 504 
Solo playback of VSTi instrument outputs 241 
Sound field 246 
Sound synthesis 311 
Soundpool 278 
Soundpool manager 24 
Source files 260 
Speaker selection 143 
Special selection options in the piano roll 197 
Spectrogramme 464 
Spectroscope 463 
Split 353 
Split objects 275, 353, 377 
Split objects at the project marker position 353 
Split objects at the track marker position 353 
Split objects on marker position 377 
Split range 360 
Split range for video 360 
Start of range to left object edge 359 
Start Q/MIDI quantization 379 
Start selection 27 
Status bar 472 
Stave settings 219 
Step 3 Use of the BPM and beat recognition 268 
Step-by-step mode 21, 25, 471 
Stereo / Phase 370, 390, 441 
Stereo and mono signal processing with twin-channel Surround 247 
Stereo delay 117, 386, 434, 449 
Stereo delay (tempo sync / millisec.) 303 
Stereo delay parameters 117, 449 
Stereo FX 390, 442 
Stereo thru 248 
Stereo wave -> Mono 337 
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Stomp Boxes (pedals) 126 
Stop 403 
Stop and go to current position 403 
Store range 361 
Submit CD to FreeDB 457 
Submix bus 366 
Submix buses 182 
Support 13, 480 
Surround editor 370, 373 
Surround panorama module 245, 248 
Surround sound 245 
Switch channels 390, 441 
Switch workspace 35 
Synchronization 250, 346, 512 
Synchronization / Synchronization settings 252, 346, 512 
Synchronization formats 250 
Synchronized MIDI editor and VIP screen view 195 
Synth objects 291 
Synthesis models 302, 306 
Synthesizer 299, 301 
Synthesizers 22 
System / Audio 345, 482 
System information 477 
System requirements 15 

T 

Tabs toolbar 471 
Tape simulation 372, 393, 445 
Tape simulation (plug-in) 116 
Target format 262 
Tasks menu 472 
Tempo 356 
Tempo / Time signature 356 
Tempo and beat recognition 398 
The bass section (bottom half) 309 
The best possible sound quality 22 
The features 22 
The object effects window 75 
The pitchshifting / timestretching window 76 
The position / fades window 76 
The rhythm section (top half) 307 
The Vita interface 320 
Thin out 168, 422 
This is how activation works: 478 
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Tile 470 
Time / Pitch 387, 435 
Time display 461 
Timestretch patcher 324 
Timestretch/pitchshift patcher 399 
Timestretch/Pitchshift Patcher - Overview 399 
Timestretch/Pitchshift Patcher – Patching 400 
Tips & tricks 87 
Tips and tricks 183 
Tips on handling virtual instruments 243 
to beginning 411 
to end 411 
to end of range 412 
to range start 411 
To start of section 412 
Toolbar (left section) 69 
Toolbar (right section) 70 
Toolbars 471 
Tools 203 
Tools and wizards 258 
Tools in the Elastic Audio easy editor 159 
Touch mode 170 
Track box 55, 61 
Track delay/reverb 153 
Track dynamics 151 
Track dynamics (track effects, mixer channels) 369 
Track editor 58, 464 
Track effect settings 368 
Track effects 368 
Track freeze 51, 367 
Track Freeze 367 
Track information 368 
Track level 83 
Track manager 282 
Track menu 363 
Track number 489 
Track properties 372 
Track settings 273 
Track size 366 
Track type 365 
Track unfreeze 368 
Track view and selection 282 
Trackbouncing (internal mixdown) 339 
Transport control 55, 459 
Trim MIDI objects 378 
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Trim objects 378 
Tuner 464 
Tutorial 25 

U 

Undo 350 
Undo definitions 347, 500 
Undo History 350 
Undo settings 347 
Ungroup objects 396 
Units of measurement 466 
Universal mode 63 
Unlock objects 378 
Unselect objects 396 
Untile 470 
UPC / Ean code 455 
Upload and Sharing 21 
Upload song to Soundcloud 476 
Use harmony recognition 273 
Using markers 81 
Using the controller editor 50 
Using the keyboard 175 
Using the MIDI editor: Selecting events 197 

V 

Vandal SE 121, 438 
VANDAL SE vs. VANDAL 150 
Varipitch/practice mode 515 
Velocity 209, 299, 300 
Vertical 469 
Video height 346 
View Menu 459 
Vintage compressor 306 
Vintage Effects Suite (track effects, mixer channels, mix master) 103 
VIP 508 
VIP and wave projects 38 
VIP display 468 
VIP mouse mode 349 
VIP window 54 
Virtual project 330 
Virtual projects (VIP) 352 
Virtual wave editing 81 
Visualization 462 
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Vita 319 
Vitalizer 95, 99 
Vocoder 391, 443 
Voicing 134 
Volume 82, 246 
Volume and length of individual objects 64 
Volume and panorama automation curves 64 
Volume and panorama gradients for the whole track 66 
Volume and panorama rubber band 66 
VST plug-in/VST parameters dialog 171 
VST/DirectX/ReWire setup/plug-in buffer 500 
VSTi manager 285 

W 

Watch the introductory video 477 
WAV 336 
Wave edit mode (only wave projects) 67 
Wave editing 374 
Wave Project Level 82 
Wave Project mouse mode 349 
Wave projects 351 
Waveform colors 509 
Waveform display 506 
Waveform Generator 452 
What effects are there, and how are they used? 90 
What is MIDI? 45, 185 
What is Samplitude 11.5 Producer? 20 
What’s new in Samplitude 11.5 Producer? 21 
Why activate? 478 
Window 470 
Windows Media 336 
Working in wave projects 80 
Working method 182, 291 
Working method and use 448 
Working with objects in the VIP 73 
Working with projects 87 
Working with tempo and bar markers 416 
Working with the matrix editor 49 
Workspace bar 471 
Workspaces 62 
Writing 255 
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X 

X-Sym. 247 
XY-Sym. 248 

Y 

Y-Sym 247 

Z 

Zoom 65 
Zoom mode 68 
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